Table of Contents

Legal Notices ................................................................. 19
Getting Started ............................................................ 21
  About CW Evolve .......................................................... 21
  Key Concepts ............................................................... 22
  Meta Model Considerations ........................................... 25
  Displaying Diagrams in Evolve Sites ............................... 26
  Users, Roles and Access Rights ...................................... 27
  Running Evolve Designer ............................................... 29
  Product Licensing .......................................................... 31
  URLs, File Paths and Directory Structures ........................ 33
  Creating your First Evolve Site ........................................ 36
Creating Sites and Pages .................................................. 37
  Create a Site ............................................................. 37
Layouts and Behaviors Explained ................................................................. 41
Working with Index Pages ........................................................................ 45
  Index Pages Explained ........................................................................... 45
  Create an Object List Index Page ........................................................... 46
  Create an Empty Index Page .................................................................. 48
  Create a Diagram Index Page ................................................................. 50
  Create a Graphical Index Page ............................................................... 51
  Create Multiple Index Pages for an Object Type ................................... 52
Working with Object Pages ....................................................................... 53
  Object Pages Explained ....................................................................... 53
  Create an Object Page ........................................................................... 54
  Creating Objects from an Object Grid Using Object Pages (4.0.2 onwards) .................................................................................. 56
  Object Page Views ................................................................................ 57
Working with Menus .................................................................................. 58
  Create and Edit a Menu ........................................................................ 58
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu levels</td>
<td>59</td>
</tr>
<tr>
<td>Publishing</td>
<td>63</td>
</tr>
<tr>
<td>Publish your Site</td>
<td>63</td>
</tr>
<tr>
<td>Command Line Publishing</td>
<td>64</td>
</tr>
<tr>
<td>Use Tabs to Present your Data</td>
<td>65</td>
</tr>
<tr>
<td>Use Custom Display Strings</td>
<td>68</td>
</tr>
<tr>
<td>Static Pages in a Dynamic Site [2018.0.2+]</td>
<td>70</td>
</tr>
<tr>
<td>In-Page Static Content Refresh</td>
<td>72</td>
</tr>
<tr>
<td><strong>Data Layout Options</strong></td>
<td>74</td>
</tr>
<tr>
<td>Working with List (Simple)</td>
<td>74</td>
</tr>
<tr>
<td>Working with Accordion</td>
<td>76</td>
</tr>
<tr>
<td>Working with Tables (Simple)</td>
<td>79</td>
</tr>
<tr>
<td>Working with Tables (Complex)</td>
<td>81</td>
</tr>
<tr>
<td>Working with a Simple Matrix</td>
<td>85</td>
</tr>
<tr>
<td>Working with an Advanced Matrix</td>
<td>86</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Working with Tabs based on Lookup Values</td>
<td>93</td>
</tr>
<tr>
<td>Filtering Data</td>
<td>95</td>
</tr>
<tr>
<td>Page Queries and Filters</td>
<td>95</td>
</tr>
<tr>
<td>Property Groups</td>
<td>98</td>
</tr>
<tr>
<td>Working with Property Groups</td>
<td>98</td>
</tr>
<tr>
<td>Property Group Layouts</td>
<td>100</td>
</tr>
<tr>
<td>Data Visualizations</td>
<td>103</td>
</tr>
<tr>
<td>Visualizing Data in Evolve</td>
<td>103</td>
</tr>
<tr>
<td>Working with Pie Charts based on Lookup Values</td>
<td>104</td>
</tr>
<tr>
<td>Working with Recursive Pie Charts</td>
<td>105</td>
</tr>
<tr>
<td>Working with Roadmap Gantt Charts</td>
<td>108</td>
</tr>
<tr>
<td>Working with Lifecycle Roadmaps</td>
<td>110</td>
</tr>
<tr>
<td>Working with Cost/Benefit Charts</td>
<td>112</td>
</tr>
<tr>
<td>Working with Vector Maps</td>
<td>114</td>
</tr>
<tr>
<td>Working with Bar Charts (Simple)</td>
<td>116</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Parent object and Parent object name</td>
<td>239</td>
</tr>
<tr>
<td>Linking Parent Object to Child Drafts</td>
<td>250</td>
</tr>
<tr>
<td>Using Explode Diagram in erwin Web Modeler</td>
<td>254</td>
</tr>
<tr>
<td>Enable One Draft Mode</td>
<td>259</td>
</tr>
<tr>
<td>Load Balancing with erwin Web Modeler</td>
<td>262</td>
</tr>
<tr>
<td>Configuring MongoDB Replication</td>
<td>262</td>
</tr>
<tr>
<td>Configure Evolve Server</td>
<td>263</td>
</tr>
<tr>
<td><strong>Automatic Diagrams (Diagram Designer)</strong></td>
<td>267</td>
</tr>
<tr>
<td>Create an Automatic / Visualization Diagram</td>
<td>267</td>
</tr>
<tr>
<td>Enabling a Model</td>
<td>268</td>
</tr>
<tr>
<td>Designing a Layout</td>
<td>270</td>
</tr>
<tr>
<td>Create a new Layout</td>
<td>270</td>
</tr>
<tr>
<td>Designing a Layout</td>
<td>271</td>
</tr>
<tr>
<td>Working with Diagram Designer</td>
<td>272</td>
</tr>
<tr>
<td>Running a Layout</td>
<td>278</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Batch Generation of Automatic Diagrams</td>
<td>280</td>
</tr>
<tr>
<td>Log Files</td>
<td>280</td>
</tr>
<tr>
<td>Additional Layouts</td>
<td>282</td>
</tr>
<tr>
<td>Jump and Merge Layout</td>
<td>282</td>
</tr>
<tr>
<td>Diagram Association Layout</td>
<td>284</td>
</tr>
<tr>
<td>Advance Filtering</td>
<td>287</td>
</tr>
<tr>
<td>Filter by Base Object [2018.0.1+]</td>
<td>287</td>
</tr>
<tr>
<td>Intersection Object Filter [2018.0.1+]</td>
<td>288</td>
</tr>
<tr>
<td><strong>Navigating your Site</strong></td>
<td>290</td>
</tr>
<tr>
<td>Overview</td>
<td>290</td>
</tr>
<tr>
<td>Smart Crumbs</td>
<td>291</td>
</tr>
<tr>
<td>Diagram Navigator</td>
<td>293</td>
</tr>
<tr>
<td>Share Diagram Link</td>
<td>294</td>
</tr>
<tr>
<td><strong>Enhanced erwin Evolve Plugins</strong></td>
<td>297</td>
</tr>
<tr>
<td>Overview</td>
<td>297</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Action On Object Page</td>
<td>298</td>
</tr>
<tr>
<td>Validate on Edit Properties</td>
<td>302</td>
</tr>
<tr>
<td>Enhanced Custom Display String</td>
<td>306</td>
</tr>
<tr>
<td>Enhanced Diagram Display</td>
<td>308</td>
</tr>
<tr>
<td>Duplicate Object</td>
<td>320</td>
</tr>
<tr>
<td>Custom Homepage</td>
<td>323</td>
</tr>
<tr>
<td>Page Search</td>
<td>330</td>
</tr>
<tr>
<td>Enhanced Property Display</td>
<td>331</td>
</tr>
<tr>
<td>Redirect Edit View</td>
<td>337</td>
</tr>
<tr>
<td>Complex Table</td>
<td>339</td>
</tr>
<tr>
<td>Settings</td>
<td>342</td>
</tr>
<tr>
<td><strong>Workflow Explained</strong></td>
<td><strong>344</strong></td>
</tr>
<tr>
<td>Overview</td>
<td>344</td>
</tr>
<tr>
<td>Enable Workflow for your Evolve Server</td>
<td>346</td>
</tr>
<tr>
<td>Review and Approval Workflow</td>
<td>349</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Setup Approval Workflow Roles and Users</td>
<td>353</td>
</tr>
<tr>
<td>Object Validation Workflow</td>
<td>357</td>
</tr>
<tr>
<td>Set Up the Object Validation Workflow</td>
<td>358</td>
</tr>
<tr>
<td>Required Metadata</td>
<td>358</td>
</tr>
<tr>
<td>Configure Site to Enable Object Validation</td>
<td>358</td>
</tr>
<tr>
<td>Evolve Workflow Configuration</td>
<td>363</td>
</tr>
<tr>
<td>Page Review Workflow</td>
<td>374</td>
</tr>
<tr>
<td>Working with Tasks</td>
<td>375</td>
</tr>
<tr>
<td>Follow an Object</td>
<td>389</td>
</tr>
<tr>
<td><strong>Social Interaction Features</strong></td>
<td>390</td>
</tr>
<tr>
<td>Social Interaction Features Explained</td>
<td>390</td>
</tr>
<tr>
<td><strong>Questionnaires</strong></td>
<td>391</td>
</tr>
<tr>
<td>Questionnaires Explained</td>
<td>391</td>
</tr>
<tr>
<td>Question Weights and Values</td>
<td>392</td>
</tr>
<tr>
<td>Create a Questionnaire</td>
<td>393</td>
</tr>
</tbody>
</table>
View Questionnaire Results ................................................................. 395
Edit a Questionnaire ........................................................................... 396
Delete a Questionnaire ....................................................................... 397
Reference .............................................................................................. 398
Site Configuration Reference ............................................................ 398
Validate Repository for Global Search .................................................. 405
  Introduction ....................................................................................... 405
  Running the Validation ...................................................................... 405
  Verify and Fix Issues with the Repository ......................................... 406
Validate Repository for Global Search Re-indexing ............................... 409
  Introduction ....................................................................................... 409
  Running the Validation ...................................................................... 409
Global Search ....................................................................................... 411
  Global Search - Advanced Filters [2018.0.2+] ...................................... 414
  Global Search - Favorite Search Filters [2018.0.2+] ................................ 416
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Structure</td>
<td>419</td>
</tr>
<tr>
<td>Required MIME Types</td>
<td>421</td>
</tr>
<tr>
<td><strong>Configuration and Administration</strong></td>
<td>422</td>
</tr>
<tr>
<td>Server Configuration</td>
<td>422</td>
</tr>
<tr>
<td>Configure your Server</td>
<td>422</td>
</tr>
<tr>
<td>Authentication and SAML2</td>
<td>426</td>
</tr>
<tr>
<td>Configure SAML2 Authentication and SSO</td>
<td>426</td>
</tr>
<tr>
<td>Configuration and Administration</td>
<td>429</td>
</tr>
<tr>
<td>Server Configuration</td>
<td>429</td>
</tr>
<tr>
<td>Configure your Server</td>
<td>429</td>
</tr>
<tr>
<td>Authentication and SAML2</td>
<td>432</td>
</tr>
<tr>
<td>Configure SAML2 Authentication and SSO</td>
<td>432</td>
</tr>
<tr>
<td>Authentication and SAML 2</td>
<td>436</td>
</tr>
<tr>
<td>Configure SAML2 Authentication and SSO</td>
<td>436</td>
</tr>
<tr>
<td>Authentication and SAML 2</td>
<td>440</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Advanced Configuration</td>
<td>482</td>
</tr>
<tr>
<td>Configure TLS 1.2 (Transport Layer Security)</td>
<td>482</td>
</tr>
<tr>
<td>Advanced Configuration</td>
<td>484</td>
</tr>
<tr>
<td>Configure TLS 1.2 (Transport Layer Security)</td>
<td>484</td>
</tr>
<tr>
<td>Evolve REST API (2018.1.0.79 and above)</td>
<td>487</td>
</tr>
<tr>
<td>Site Administration</td>
<td>489</td>
</tr>
<tr>
<td>Site Administration Pages</td>
<td>489</td>
</tr>
<tr>
<td>Working with Roles</td>
<td>490</td>
</tr>
<tr>
<td><strong>Customizing Your Site</strong></td>
<td>493</td>
</tr>
<tr>
<td>Customization Explained</td>
<td>493</td>
</tr>
<tr>
<td>Basic Customization</td>
<td>495</td>
</tr>
<tr>
<td>Customizing Styles using LESS variables</td>
<td>495</td>
</tr>
<tr>
<td>Use Custom Site Logos</td>
<td>516</td>
</tr>
<tr>
<td>Use Custom Site Images on the Multi-Sites Page</td>
<td>518</td>
</tr>
<tr>
<td>Use Custom Icons for Pages</td>
<td>518</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Style Development</td>
<td>519</td>
</tr>
<tr>
<td>Advanced Customization</td>
<td>521</td>
</tr>
<tr>
<td>Evolve Advanced Customization Guide</td>
<td>521</td>
</tr>
<tr>
<td>Advanced Customization</td>
<td>522</td>
</tr>
<tr>
<td>Evolve Advanced Customization Guide</td>
<td>522</td>
</tr>
<tr>
<td>Custom CSS &amp; JavaScript</td>
<td>523</td>
</tr>
<tr>
<td>Using Custom Images</td>
<td>525</td>
</tr>
<tr>
<td>Creating Custom Layouts</td>
<td>526</td>
</tr>
<tr>
<td>Custom Visualizations</td>
<td>528</td>
</tr>
<tr>
<td>Data Structure: allItems</td>
<td>531</td>
</tr>
<tr>
<td>Data Structure: item</td>
<td>532</td>
</tr>
<tr>
<td>Data Structure: properties</td>
<td>533</td>
</tr>
<tr>
<td>Get Ready For Development</td>
<td>534</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>536</td>
</tr>
<tr>
<td>Issues</td>
<td>536</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Global Search</td>
<td>537</td>
</tr>
<tr>
<td>CMI (Casewise Analytics)</td>
<td>539</td>
</tr>
<tr>
<td>Error messages</td>
<td>542</td>
</tr>
<tr>
<td>Font Size Too Big on Diagrams</td>
<td>542</td>
</tr>
<tr>
<td>Elastic/Global Search Using Too Much Memory</td>
<td>544</td>
</tr>
<tr>
<td>Introduction</td>
<td>544</td>
</tr>
<tr>
<td>Elastic/Global Search Using Too Much Memory</td>
<td>544</td>
</tr>
<tr>
<td>Introduction</td>
<td>544</td>
</tr>
<tr>
<td>Option File Changes</td>
<td>544</td>
</tr>
<tr>
<td>Updating the Service</td>
<td>546</td>
</tr>
<tr>
<td><strong>Upgrading</strong></td>
<td><strong>547</strong></td>
</tr>
<tr>
<td>Upgrading from Evolve Web Platform 2020.1.x</td>
<td>547</td>
</tr>
<tr>
<td>Upgrading</td>
<td>549</td>
</tr>
<tr>
<td>Upgrading from Evolve Web Platform 2020.1.x</td>
<td>549</td>
</tr>
<tr>
<td>Upgrading from Evolve Web Platform 2020.0.x</td>
<td>550</td>
</tr>
</tbody>
</table>
© 2023 Quest Software Inc.
ALL RIGHTS RESERVED.

This guide contains proprietary information protected by copyright. The software described in this guide is furnished under a software license or nondisclosure agreement. This software may be used or copied only in accordance with the terms of the applicable agreement. No part of this guide may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording for any purpose other than the purchaser’s personal use without the written permission of Quest Software Inc.

The information in this document is provided in connection with Quest Software products. No license, express or implied, by estoppel or otherwise, to any intellectual property right is granted by this document or in connection with the sale of Quest Software products. EXCEPT AS SET FORTH IN THE TERMS AND CONDITIONS AS SPECIFIED IN THE LICENSE AGREEMENT FOR THIS PRODUCT, QUEST SOFTWARE ASSUMES NO LIABILITY WHATSOEVER AND DISCLAIMS ANY EXPRESS, IMPLIED OR STATUTORY WARRANTY RELATING TO ITS PRODUCTS INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. IN NO EVENT SHALL QUEST SOFTWARE BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, PUNITIVE, SPECIAL OR INCIDENTAL DAMAGES (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION OR LOSS OF INFORMATION) ARISING OUT OF THE USE OR INABILITY TO USE THIS DOCUMENT, EVEN IF QUEST SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Quest Software makes no representations or warranties with respect to the accuracy or completeness of the contents of this document and reserves the right to make changes to specifications and product descriptions at any time without notice. Quest Software does not make any commitment to update the information contained in this document.

If you have any questions regarding your potential use of this material, contact:

Quest Software Inc.
Attn: LEGAL Dept
4 Polaris Way
Aliso Viejo, CA 92656

Refer to our Web site (https://www.quest.com) for regional and international office information.

Patents

Quest Software is proud of our advanced technology. Patents and pending patents may apply to this product. For the most current information about applicable patents for this product, please visit our website at https://www.quest.com/legal .

Trademarks

Quest, the Quest logo, and Join the Innovation are trademarks and registered trademarks of Quest Software Inc. For a complete list of Quest marks, visit https://www.quest.com/legal/trademark-information.aspx. All other trademarks and registered trademarks are property of their respective owners.
Legend

**META MODEL:** This icon indicates Meta Model information.

**CAUTION:** A CAUTION icon indicates potential damage to hardware or loss of data if instructions are not followed.

**IMPORTANT, NOTE, TIP, MOBILE, or VIDEO:** An information icon indicates supporting information.
About CW Evolve

CW Evolve is a powerful and customizable web platform which can be configured to offer different experiences for different audiences within your organization.

Using Evolve you can share information from your CW repository across your organization - but only the data you want to share.

Depending on your configuration and the roles you set for your users, people can either read the data, follow it to keep up to date, comment on it, or even edit it directly.

System Architecture
Key Concepts

To help understand Evolve and the instructions in this guide, this page lists the key concepts you'll run into when working with Evolve.

Sites
Evolve deployments are called Sites - that is a collection of custom web pages based on data from a CW Model. In Evolve, these web pages are called Index Pages and Object Pages.
You can deploy your Site in two ways: as a Static Site, or a Dynamic Site - or both, if you have a Dynamic license.
You can create as many Sites as you like but only one per Model.

See URLs, file paths and directory structures to understand the URLs used to access your Sites.

Top-level IIS Site
The top-level IIS Site is only used when Dynamic Sites have been deployed and lists all the Sites the logged on user has permission to view. Users can choose a Site to view and then that Site is displayed.

Evolve Static
A Static Evolve Site is a read-only deployment which displays data from your repository taken at a fixed point in time. It is therefore not live data and does not allow anyone viewing the web pages to edit it.
Static Sites do not support user login and therefore do not support access control or social features such as Comments, Questionnaires and Favorites.

Evolve Dynamic
A Dynamic Evolve Site shows live data from the CW repository and allows people viewing the data to edit it - assuming you have configured it that way and the users have sufficient permissions to do so.
Using Evolve's social features, a Dynamic Site enables Followers to read the data, create a custom homepage and set favorite pages, while Contributors can additionally edit data and participate in the review and approval workflow.
Index Pages

Index Pages are the top-level pages in your Site. They are the pages that the main Menu navigation links to and they are generally the starting point for users browsing your Site.

Index Pages essentially display lists or representations of objects which can be expanded on by supporting Object Pages which show more information about the object in question.

There are three types of Index Page:

1. **Object listing pages**, such as lists, tables, or boxes.
2. **Graphical pages**, such as dashboards and charts.
3. **Diagram pages**, showing CW Modeler diagrams or visualization diagrams.

Object Pages

An Object Page is used to present the details of an object instance - you select an object on an Index Page, and the Object Page displays its properties. You must have an Object Page configured for each type of object you want to see the details of in your Evolve Site.

Views

An Object Page can be configured to offer more than one View of the object being observed. If you make more than one Object Page for an Object Type, those pages will be offered as Views to the user. The links to the different Views are displayed as sections in the page's left-hand navigation panel.

Layouts and Behaviors

There are many ways you can display your data in Evolve web pages. The basic display options for Index Pages and Object Pages are simple lists or property groups. You can however use a wide variety of layouts and behaviors to extend on these basic display options to include elements such as Pie Charts, Bubble Charts, Cost/Benefit Charts, Bar Charts, Maps, Roadmaps and Tables.

Evolve Designer

Evolve Designer is the desktop application you use to create, configure and manage your Evolve Sites. It is installed on the web server machine which hosts your Evolve Site.

Diagram Designer

Diagram Designer is the desktop application you use to create and configure Diagram Visualizations. It is installed on the web server machine which hosts your Evolve Site.

Roles

Roles are used to group users for the purpose of control Site access and capabilities.

You use Roles to control visibility to your Site pages, as well as whether those users are Social or Contributing users - so who is a read-only user and who can also edit data.

In addition, Roles are used in Evolve Workflow to determine which users must review and approve other users’ edits to data.

Deployment

A Deployment is the location of your published Evolve Site running on a web server. Once you create and configure your Site, you deploy it to the web server so other people can access it.

Workflow
Workflow is a component of Evolve which provides some useful workflow processes based on creating, editing and deleting data, as well as reviewing content.

Glossary
The terms mentioned above are only some of the concepts you'll come across when working with Evolve.
For a full list of the common concepts and terms, please use the Glossary in the left-hand pane.
Meta Model Considerations

Your model’s meta model is a consideration for Evolve for the following reasons:

1. When you create an Evolve Site, certain changes are made to your model's meta model.

2. Certain Evolve features, such as graphs, dashboards or features on Object Pages, can only be used if your objects have specific corresponding Property Types or Association Types.

3. If you change your meta model - such as by creating new Object Types, Property Types or Association Types, then you must use the Update Meta Model feature in Evolve Designer to ensure Evolve is aware of the changes.

Throughout this documentation, when meta model changes are required or are enforced, the topic is highlighted in the following way:

This feature requires specific Property Types or Association Types for the Objects in question - and therefore may require changes to your meta model.
Displaying Diagrams in Evolve Sites

This page explains how to display diagrams in your Evolve web pages.

There are two types of diagram that can be displayed in Evolve web pages:

1. **CW Modeler diagrams** - any diagram created in CW Modeler in your model.
2. **Visualization diagrams** - auto-generated diagrams created using Diagram Designer.

Both of these types of diagram can be displayed in either Index Pages or Object Pages.

When a diagram is displayed in a page, the objects on it are clickable - but you must have Object Pages for each of the Object Types otherwise the user will see an error.

On CW Modeler diagrams you can also configure Diagram Popouts to display the data behind objects on your diagrams in a pop-out panel on the diagram page itself.

⚠️ In order to display a diagram in Evolve, your model must contain a Template Diagram with the same Rule and Category as the one you want to show.

*Note: There must be just one template for each Rule/Category combination.*

If you try to display a diagram that does not have a corresponding Template Diagram, Evolve will not be able to show it.

What do you want to do?

- Display a CW Modeler diagram in your Site
- Display a Visualization diagram in your Site
- Display object data with a Diagram Pop-out
- Display a diagram on the home page of your Static Site
Users, Roles and Access Rights

Evolve Web Platform 2020.0.1 and below:

Users, Roles and Access Rights are only relevant to Dynamic Sites.

Static sites are open to everyone to see who has access to the URL, and as the data is fixed and read-only permissions are irrelevant.

If your Site configuration includes Access Rights and Roles, but you want to publish a Static version of the Site, then those elements are ignored in the generation.

Evolve Web Platform 2020.0.2 and above:

Whilst the Roles and Access Rights for the generated content are still operated at generation time, the gate to access to the site can now be controlled by Evolve Web Platform. This means that, when Static Authentication is turned on, users must be given 'Static' access, at a minimum to be able to access the site.

If Static Authentication is turned off, Evolve Web Platform will still be required to check the usage mode, but will then pass through any requests for data, without further authentication.

In order to view an access controlled Evolve Site, a User must log in with a valid Username and Password (or be given permission through Active Directory or SAML2 group access). There are three types of User:

- **Static Users** - who can access a pre-generated static site. (If Static Authentication is turned off, anyone with access to the webservers will be admitted).

- **Social Users** - who only have read-only access to data, but can use all the Social features of Evolve, so they can Rate objects, set Favorites, collaborate using Comments and Questionnaires, and can Share pages with other users

- **Contributors** - who can do all of the above, but can additionally **Edit** data as well, and can be involved in Workflow tasks.

- **Diagrammers** - who have the same rights as Contributors but can additionally edit and create Diagrams using eModeler.

All Evolve Sites can have Static and Social Users, however a special license is required to have Contributors - and the license also controls how many Contributors you can have.

Web Modeler, for example, is a licensed application. Additional licenses are required on a per user basis in order to use Web Modeler on your Evolve Site.

**Controlling who can see what?**

There are two factors that determine which content a User can see in an Evolve Site:

- **Roles** - determine which Site **pages** a User can view

- **CW Suite Access Rights** - determine which **objects** a User can see, and whether they can **create, read, edit or delete** those objects.

**NOTE:** With Active Directory or SAML2 Authentication and a large number of users, it is likely that only Roles are used.
Roles

Roles are used to determine which pages within the Site a User is able to view. That means the Menus and links in the interface are updated to remove all links to pages that the Role determines the User should not be able to see.

If a page has no Roles assigned to it, then all users in any Role can view it.

As an Evolve Administrator you can create as many Roles as you like, assign Users to those Roles, and then specify exactly which pages a Role is able to view.

If a User is in more than one Role, Evolve looks at all relevant Roles to see if the User is able to view the page.

Roles are also used with Evolve Workflow to specify who must approve changes made to data by other users.

For details on Roles and assigning Users to Roles, see: Working with Roles.

CW Suite Access Rights

While the type of User you are (Social User or Contributor) specifies what you can do in Evolve, and Roles control which pages you can see, CW Suite Access Rights and Extended Access Controls are used to determine what capabilities a User has with specific objects at a granular level.

CW Suite Access Rights can be used to make a User Read-Only, control which Models they can see, and what they can do with certain types of objects, like ones that are Frozen.

Extended Access Controls can be used to specify whether a User can Create, Read, Update or Delete objects based on either their Object Type or Category.

CW Suite Access Rights and Extended Access Controls are the final level of access control within Evolve. Even though a User might be a Contributor, and they can view a Table listing some Processes, they may not be able to edit all of the Processes listed. They may not even see all the Processes - and another User may see a different list of Processes.

For full details on CW Suite Access Rights and Extended Access Controls, please refer to the CW Suite documentation.

Active Directory or SAML2 Authentication

You can configure an Evolve Dynamic Site to automatically authenticate users based on Active Directory or SAML2 group membership.

Users authenticated in this way only have to browse to the Evolve URL and they are automatically signed in, without having to enter a username and password.

As an Evolve Administrator, you can state that Users in a specific Active Directory group should be Static Users, Social Users, Contributors or Diagrammers and you can assign them to an Evolve Role, and a CW Group.
Running Evolve Designer

Evolve Designer is the application used to create, configure and manage Evolve Sites.

In order to run Evolve Designer you must log in with a CW user that has System Manager rights.
In addition, certain functions performed by Evolve Designer require that the application is run with administrator privileges on your machine.

How to access and run Evolve Designer

For Dynamic Sites, or Static Sites that are directly published to a web server machine running Microsoft Internet Information Services (IIS), Evolve Designer must run on the web server itself.

We recommend that you do the following two steps to access and run Evolve Designer:

1. Create a Desktop shortcut for Evolve Designer.
2. Configure the shortcut to force the application to run with administrator privileges.

What do you want to do?

Create a Desktop shortcut for Evolve Designer

To create a Desktop Shortcut for Evolve Designer:

1. Right-click on your Desktop background and select New > Shortcut
   The Create Shortcut wizard opens.
2. Click the Browse button to navigate to and select evolveDesigner.exe.
   The normal installation path is C:\Casewise\evolve\Site\bin\evolveDesigner.exe.
3. Click Next.
4. Enter a name for the shortcut.
5. Click Finish.
   The shortcut is created.
Configure Evolve Designer to run with administrator privileges

To configure Evolve Designer to run with administrator privileges:

1. Right-click the Desktop shortcut and select **Properties**.
2. Click Advanced.
   The *Advanced Properties* dialog opens.
3. Select the **Run as administrator** check box.
4. Click **OK**.
   The *Advanced Properties* dialog closes.
5. Click **OK**.
   The shortcut *Properties* dialog closes.

Now, when you click the Evolve Designer shortcut on your Desktop, the program will run with administrator privileges.
Product Licensing

As of the 2020.1.1 release of erwin Evolve Suite / Web Platform, licensing is migrating to the standard Quest Inc. license system. During the migration, there will be a grace period, whereby existing customers can continue to use their existing Casewise licenses. Quest do not intend to force customers onto the new licensing and will work with them to ensure a successful migration.

If you are considering upgrading to 2022, you should not be concerned with the new licensing system, as its usage is optional at the moment.

Activating your Quest License

The process for activating an erwin Evolve license is:

1. Support will provide you with one or more license files per Server machine that requires licensing.

   For example:

   ![license.png](attachment:license.png)

2. Having installed the software, copy this file to your server's desktop.

3. Double click on the file. You will be presented with a warning:

   ![User Account Control.png](attachment:User_Account_Control.png)

4. Click Yes to allow the tool to change the registry.
5. The software now has the purchased licenses activated on the server. To verify this, load the License Manager. Open erwin Evolve suite - Start Here.

6. Click **License Manager**, and login.

7. License Manager will show the license code, and various other attributes.

---

**Returning your erwin License**
If you need to move the license from one server to another, you must contact support, who will assist with the migration.

## URLs, File Paths and Directory Structures

This page explains how the URLs, file paths and directory structures work in Evolve.

### Evolve Site URLs

There are three different URLs you can use to access Evolve, depending on how your deployment is configured.

#### Accessing the main Evolve IIS Site

The main Evolve IIS Site is only accessible if you use Evolve Dynamic Sites. If you use only Evolve Static, then this site is still created, but does not display anything.

When you install Evolve and **Configure the Server**, it creates a top-level Evolve IIS Site.

The Site is used to provide the Evolve login dialog, as well as to show the page displaying the list of Model Sites that are available.

The site can be accessed using the following URL:

```
http://<server-name>/<evolve-IIS-site-name>/
```

where `<server-name>` is the name of your web server machine, and `<evolve-IIS-site-name>` is the name you specified in the Server Configuration application.

Depending on which authentication method your Evolve server is configured to use, when you access the Evolve IIS Site you log on and are then shown a list of all the Dynamic Model Sites you have access to. You can click any of the Model Site links to visit that Site.

#### Accessing a Dynamic Site

Dynamic Sites are published at the following URL:

```
http://<server-name>/<evolve-IIS-site-name>/sites/<site-url-name>/
```

#### Accessing a Static Site

Static Sites are published at the following URL:

```
http://<server-name>/<evolve-IIS-site-name>/statics/<site-url-name>/
```

### File paths and directory structures

This section explains the folder structure used by Evolve on the web server machine. The names used are the default names for a typical configuration.

The Evolve files are typically found at **C:\Casewise\Evolve**

Within this directory, the following directories exist:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>This folder contains all the necessary site-specific files created when you publish a Site.</td>
</tr>
<tr>
<td>Folder</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Common</td>
<td>The Common folder contains all resources that are shared across all Dynamic Sites in Evolve, such as translated text and Site logos. Logos for Model Sites listed on the top-level Evolve Site are also stored here.</td>
</tr>
<tr>
<td>Sites</td>
<td>The Sites folder contains a folder for each of the Dynamic Sites that are published. Each of these directories is named according to the Site ID in the deployment settings for the Site, and contains the css, js, images and webdesigner sub directories.</td>
</tr>
<tr>
<td>Statics</td>
<td>The Statics folder contains a folder for each of the Static Sites that are published, which in turn contain all the published files and resources for the Site.</td>
</tr>
<tr>
<td>Site</td>
<td>Contains all the application files required for Evolve to run. Also is the home of the custom folder used to store customizations such as js, css, themes and images. Log files.</td>
</tr>
<tr>
<td>Content</td>
<td>This folder will only exist if you have had a previous version of Evolve on the machine.</td>
</tr>
<tr>
<td>Static</td>
<td>This folder will only exist if you have had a previous version of Evolve on the machine and had a Static Site published.</td>
</tr>
</tbody>
</table>

Accessing object pages directly by the URL

There are two ways to access content directly in Evolve using URLs.

The Standard URL

Using the 'Share' button:

[![Share button](image)](image)

Will allow a user to share a page with another user. It is also possible to gain the same behaviour by copying the address bar URL from your browser and sharing this with other users. These URLs are model and site dependent. This means that they will only work for a given site, generated by a given model. This is because the identifier for the object is an ID that is local to the model. This is normal, and in almost all cases, is exactly what is required.

A sample of a Standard URL:

`localhost/evolve/sites/voxdnoev/index.html#/cwtype=single&cwview=process&lang=en&cwid=1767`

Where: `cwid=1767` is the local ID for an object.

The UUID URL [Evolve 2016.1.1 and above]

A UUID based URL differs in the way that it identifies objects in Evolve. A UUID URL is still site dependent, in that the first part of the URL identifies the Evolve web site, however the latter part can be used with any site that supports the given object type, and has an object with the matching UUID. This means that objects which have been copied, or transferred by XML (or other means) from one model to another, will still be considered to be the same object.

A sample of a UUID URL:
localhost/evolve/sites/voxdnoev/index.html#/cwtype=single&cwview=process&lang=en&cwuuid=f0a9ed615e7b11e48273a08869a4da20

Where: **f0a9ed615e7b11e48273a08869a4da20** is the UUID of the object.

How does this work?

When you access a URL using the cwuuid, Evolve will do a lookup in the model and redirect the page to the matching cwid.

![Warning]

*If both cwid and cwuuid are supplied in the URL, Evolve will ignore the cwuuid parameter.*

Why might UUID based URLs be useful?

Take an example where you are running a master model in English, and take copies of this model to translate into French. You want to add the ability to reference the translated object from the English object. However, the IDs of the objects within the French model, may differ from those in the English model. It is therefore not possible to create a simple reference.

In this instance it is possible to use the UUID based URL. You can simply take the site portion of the French URL, and add the Object UUID from the English URL, and you have a new URL that can jump from French to English.

NB: To find the UUID of an object, either display this in your Evolve site design, or if you are developing a custom view, look to the JSON data structure that is returned by the Evolve server.
Creating your First Evolve Site

If you are new to Evolve, once you have familiarized yourself with the Key Concepts, Metamodel Considerations and how to Run Evolve Designer, you can use the following pages to help you get your first Site up and running.

Once you have completed these tasks, you should have a simple working Site containing all the fundamental elements. Only once you have done this do we recommend that you go on to try different options.

1. Configure your server
2. Create a Site
3. Create a basic Index Page displaying a simple list of objects
4. Create a simple Object Page
5. Create a Menu to link to your Index Page
6. Publish your Site
7. Once you have published your Site and tested that it works, you can go on to explore how to extend your Site by creating more adventurous pages using the information in the Layouts and Behaviors section.

Important factors to remember when extending your site

As you go on to add more content to your site, remember these important factors:

- You must create an Object Page for each type of object you want to view.
- Your CW model must contain a Template Diagram with the same Category and Rule combination for every Diagram you want to display in Evolve. This must be one template only for each Category and Rule - if you have multiple templates then Evolve will report an error.
Creating Sites and Pages

Create a Site

Before you can create a Site, you must ensure you have completed the configuration of your Evolve Server.
See Configure your Server for details.

These instructions explain how to set up a basic, empty Site, and then how to configure the deployment settings so that it can be published.

Once the Site is created, you should follow the instructions in the rest of the help to learn how to create Index Pages, Object Pages and a Menu.

An Evolve Site is explicitly linked to one CW Model. You can create one Site in each Model in your repository.

Creating a Site makes changes to your Model's meta model, resulting in new Object Types and Associations being added to the Model.

If you are using Evolve for the first time and want to experiment with creating a Site, we recommend that you create a copy of an existing Model and use that as the basis of your Site.

Step 1 - Create a Site in your Model

To create a Site in your Model:

1. Run Evolve Designer.
2. Select the Model you want to create a Site in.

   The page updates to show Sites in your Model.

   If your Model is not listed, you must enable it to support having an Evolve Site. To enable your Model:

   i. Click the plus (+) icon in the top-right of the dialog.

   A pop-up menu listing all the models in your repository is displayed.

   ii. From the pop-up, select the Model you want to use for your Site.

   Your Model's meta model is updated with the new Object Types and Association Types required for Evolve. This process may take a few moments.

   Once the Model is updated, an icon representing the Model is displayed in the Evolve Designer window.
3. On the Sites page, click the (+) icon in the top-right of the dialog.

   The New Site dialog is displayed.
4. Enter a Name for your Site in the Site Name field.
5. Click Create.

**Step 2 - Configure the Site settings**

**To configure the Site settings:**

1. In Evolve Designer click the top Site node.
2. Review the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Language</td>
<td>Choose the language of the Site if you want to override the global Evolve setting.</td>
</tr>
<tr>
<td>Number Separator</td>
<td>Select 'None' (default), 'Comma' or 'Space' to specify which number separator is used when displaying numbers on your Evolve Site. For example: None - 1000 or 1000000 Comma - 1,000 or 1,000,000 Space - 1 000 or 1 000 000</td>
</tr>
<tr>
<td>Less Theme</td>
<td>Choose the theme of the Site if you want to override the global Evolve setting.</td>
</tr>
<tr>
<td>Export Diagram Images</td>
<td><strong>Static Sites only.</strong> Use this option if you are publishing your Site in Static mode and you are showing Diagrams created in CW Modeler using the CW Modeler Diagram behavior. You can leave this option unselected if you are not displaying diagrams or are only using the Vector (HTML5) behavior to prevent images of diagrams being generated when you publish your Site - a process which can take some time.</td>
</tr>
</tbody>
</table>

See the *Evolve Configuration Reference* for details on the full list of settings.

3. Select the Deployments > [server name] > Model node (showing the Scriptname of the Model your Site is in).

   The settings are shown in the right-hand pane.
4. Complete the following fields:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site URL Name</td>
<td>Specify the name of this Model Site as it appears in the URL, such as http://&lt;servername&gt;/&lt;evolve-IIS-site-name&gt; /[sites][statics]/&lt;site-url-name&gt;/ Ensure that the name is all lower-case and has no spaces or special characters. To change the Site URL Name for an existing Site, see: Change the URL Name of</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Site Display Name</strong></td>
<td>Enter the name of your site. This is only displayed on the top-level Evolve Sites page.</td>
</tr>
<tr>
<td><strong>AD Mapping</strong></td>
<td><strong>Dynamic Deployments Only</strong>&lt;br&gt;This control now replaces the single mapping per license type, allowing a much greater level of control of groups. &lt;br&gt;The control is used for both Active Directory and SAML2 configurations. &lt;br&gt;<strong>AD Group</strong> - is used to specify the name of the Active Directory group you want to use for this configuration. It is also used for the name of the &quot;Outgoing Claim Type&quot; in a SAML2 configuration. &lt;br&gt;If a user is a member of this AD Group or Claim, then they will assume the permissions indicated on this row of the table. If a user is a member of multiple Groups or Claims, then they will receive the aggregate of the permissions, with the exception of CW User Type, which will be promoted to the highest license type they are allowed. &lt;br&gt;<strong>Dynamic Deployments Only</strong> - this can be one of &quot;Social&quot;, &quot;Contributor&quot;, &quot;Diagrammer&quot;.</td>
</tr>
<tr>
<td><strong>AD Default Social Role Name</strong></td>
<td><strong>Dynamic Deployments Only</strong>&lt;br&gt;Only used if the Evolve Authentication Method is set to Active Directory. Specify the default Role you want newly created Evolve Social users to be given.</td>
</tr>
<tr>
<td><strong>AD Default Contributor Role Name</strong></td>
<td><strong>Dynamic Deployments Only</strong>&lt;br&gt;Only used if the Evolve Authentication Method is set to Active Directory. Specify the default Role you want newly created Evolve Contributor users to be given.</td>
</tr>
<tr>
<td><strong>Display Model in Evolve</strong></td>
<td>Applies to Dynamic Sites only. Use this option to specify if this Model Site is available or disabled in Evolve.</td>
</tr>
</tbody>
</table>

See the *Evolve Configuration Reference* for details on the full list of settings.

5. Save the Site.

The settings are complete.

**Step 3 - Publish your Site**

Now the Site and IIS are configured, you must publish your site so that all the required files are generated and placed in the correct location on the web server.

**To publish your Site:**

In Evolve Designer, click **Dynamic Site** or **Static Site** in the **Publish** area on the **Home** menu. All the Site’s files are generated in the correct location for the web server to host them.

The status area at the bottom of Evolve Designer updates as the various processes involved in publishing are performed. Once the operation is complete, it reports ‘Site generated in’. 
These instructions are for publishing your Site for the first time - there are different publishing options for when you are editing a Site that has already been published. See Publishing your Site for full details.

**Accessing a Dynamic Site**

You can access a Dynamic Site at the following URL:

```
http://<server-name>/<evolve-IIS-site-name>/sites/<site-id>/
```

**Accessing a Static Site**

You can access a Static Site at the following URL:

```
http://<server-name>/<evolve-IIS-site-name>/statics/<site-id>/
```
Layouts and Behaviors Explained

Evolve offers many different possibilities for how you want the information in your Index Pages and Object Pages to be displayed.

These display options are controlled by Layouts and Behaviors. Layouts control the physical structure of the web page, whereas Behaviors control how the data is displayed inside the Layout. Some Behaviors can only work with certain Layouts. Additionally, some Layouts and Behaviors can only be used on Index Pages, while others can only be used on Object Pages. However, some can be used on both.

Use the table below to see all the page display options available in Evolve, then follow the links to find out how to create them in your own Site.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Editable?</th>
<th>Used in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple List</td>
<td>The Simple List is the default Layout for all new Index Pages and displays objects in a simple bulleted list. On Object Pages this layout is used to show related objects, such as Associations or Diagrams the object appears on.</td>
<td>No</td>
<td>Index Pages, Object Pages</td>
</tr>
<tr>
<td>Accordion</td>
<td>An Accordion is an Object List where each object reference is clickable and can be expanded to show further information about the object - either properties of the object, or associations. When you use an Accordion, you can nest other Layouts and Behaviors inside it, such as another list of Associated Objects.</td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>Table (Complex)</td>
<td>A Table (Complex) behavior displays objects and properties in table format. You can choose which properties to display as columns, and you can include associations. Users can sort the list by clicking column headings, and they can optionally edit objects directly in the Table itself.</td>
<td>Yes</td>
<td>Index Pages, Object Pages</td>
</tr>
<tr>
<td>Table (Simple)</td>
<td>The Table (Simple) layout creates a basic table for displaying lists of data, with the ability to open the Object Page for a listed item.</td>
<td>No</td>
<td>Index Pages, Object Pages</td>
</tr>
</tbody>
</table>

There are a number of different options for how you want to display the properties of objects on Object Pages. For full details on these display options see:

*Working with Property Groups and Property Group Layouts*
<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Editable?</th>
<th>Used in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Matrix</td>
<td>A <strong>Simple Matrix</strong> creates a table which displays <strong>Associated Objects</strong> for the object in question, and shows which other similar objects these Associated Objects are associated to. For example, you could show which Risk objects your Process is associated with, and which other Processes are associated with those Risks.</td>
<td>No</td>
<td>Object Pages</td>
</tr>
<tr>
<td>Tabs based on Lookup Values</td>
<td>This list-type display <strong>organizes your objects into groups</strong> based on the value of Lookup properties (drop-downs such as <strong>Category</strong>). Vertical tabs on the left side of the page are used to represent the values, while the objects themselves in each tab are displayed in simple lists. Option You can optionally include an <strong>Overview Chart</strong> which creates an 'Overview' tab displaying a Pie Chart showing the proportion of each value.</td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>Pie Chart based on Lookup Values</td>
<td><strong>The Pie Chart based on Lookup Values</strong> display creates a chart for a specified Object Type showing the percentage of objects with values from one Lookup (drop-down) property. The chart is identical to the optional <strong>Overview Chart</strong> offered by the <strong>Tabs based on Lookup Values</strong> display.</td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>Recursive Pie Chart</td>
<td>A <strong>Recursive Pie Chart</strong> allows you to show a <strong>top-level chart</strong> which <strong>sums the values of properties of associated objects</strong> (or Intersection Objects), and then allows users to click those items to view a <strong>second chart</strong> showing all the objects associated to the selected object.</td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>Roadmap</td>
<td>A <strong>Roadmap</strong> is a type of Gantt Chart that enables you to <strong>show a number of objects and their start and end dates</strong>.</td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>Lifecycle Roadmap</td>
<td>A <strong>Lifecycle Roadmap</strong> is a type of Gantt Chart that enables you to <strong>show a number of objects</strong>, displaying their overall time frame, as well as highlighting in different colors any number of <strong>phases of their</strong></td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>Type</td>
<td>Description</td>
<td>Editable?</td>
<td>Used in</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Cost Benefit Chart</td>
<td>A Cost/Benefit Chart enables you to compare properties you class as Costs in your organization against properties you class as Benefits. The result is a chart that allows you to evaluate your expenditure in terms of business importance.</td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>Simple Bar Chart</td>
<td>The Simple Bar Chart behavior displays a simple bar chart on your Index Page, listing a maximum of 20 objects on the y axis and referencing a simple number property on the x axis.</td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>Multi-Axis Bar Chart</td>
<td>On your Index Page, the Multi-Axis Bar Chart behavior displays a simple bar chart which compares the values of two properties of the objects referenced.</td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>Simple Bubble Chart</td>
<td>Simple Bubble Charts allow you to compare objects of the same type, by analyzing three levels of data and using the values to affect the size and position of the representations on the chart.</td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>Cluster Bubble Chart</td>
<td>Cluster Bubble Charts are similar to Simple Bubble Charts, except they allow you to visualize the properties of an Associated Object (directly or indirectly), or an Intersection Object.</td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>Visual Identity</td>
<td>The Visual Identity layout is used to show a list of objects with visual indicators to represent some of their properties. The layout displays each object as a rectangle, and then at the bottom of each shape you can show icons to represent the values of one or more properties of your object. The Visual Identity layout requires a Custom Site deployment.</td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>External Picture</td>
<td>The External Picture layout can be used to display an image, stored on the Evolve server, which is referenced as a property of an object. The External Picture layout requires a Custom Site deployment.</td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>Image</td>
<td>The Image Layout is used to display an image for an object that is referenced using a Single-Line Text or URL Property.</td>
<td>No</td>
<td>Index Pages</td>
</tr>
<tr>
<td>Type</td>
<td>Description</td>
<td>Editable?</td>
<td>Used in</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------</td>
<td>------------------</td>
</tr>
<tr>
<td>Vector Map</td>
<td><strong>Vector Maps</strong> enable you to <strong>highlight countries or places on a map</strong> so that the user can click through to see more detailed information about that area.</td>
<td>No</td>
<td>Index Pages, Object Pages</td>
</tr>
<tr>
<td>Radar</td>
<td>The <strong>Radar Layout</strong> is used to display and compare three or more properties of an Object, or many Objects, in one chart. It is used on its own, not together with other properties, so suits larger images more.</td>
<td>No</td>
<td>Index Pages, Object Pages</td>
</tr>
<tr>
<td>View Box</td>
<td>Layout reserved for internal Evolve use.</td>
<td>No</td>
<td>Index Pages, Object Pages</td>
</tr>
</tbody>
</table>
Working with Index Pages

Index Pages Explained

Index Pages are the top-level pages in your Site. They are generally the starting point for users browsing your Site. For navigation purposes, in order to view an Index Page it must be linked to a Menu.

Index Pages essentially display lists or representations of objects which can be expanded on by supporting Object Pages which show more information about the object in question.

So users typically find objects they are interested in on Index Pages and follow links to Object Pages providing more detail.

Index Pages are generally tied to a specific Object Type, but you can have multiple Index Pages per Object Type.

There are three types of Index Page:

1. **Object listing pages**, such as lists, grids, and accordions
2. **Graphical pages**, such as bar charts, maps, pie charts and roadmaps
3. **Diagram pages**, showing CW Modeler diagrams or visualization diagrams.

What do you want to do?

- Create an Object List Index Page
- Create an Empty Index Page
- Create a Diagram Index Page
- Create a Graphical Index Page
- Use Tabs to organize content on an Index Page
- Create Multiple Index Pages for an Object Type
- Extend display options with Layouts and Behaviors
Create an Object List Index Page

The instructions on this page detail how to create a basic Index Page which displays a simple list of objects. This is the default display setting for all new Index Pages.

Basic Object List Index Pages only display the Name of the objects listed within them.

While these instructions describe how to create a basic Object List page, Evolve offers many different options for how you want to display content in your pages. To find out more about these different display options and how to configure them, see Working with Page Layouts and Behaviors.

Creating a basic Object List Index Page is a two-step process. Follow the steps below.

Step 1 - Create the page

To create a new Index Page:

1. In Evolve Designer, expand the Site node.
2. Right-click the Index Pages node.
3. Select Add Index Page for Object Type.
4. Scroll through the pop-up list to select an Object Type to base the Index Page on

   The new Index Page is created and is placed at the bottom of the list of Index Pages in the tree. It is given a default name of index_<object-type-name>

   If you close and reopen Evolve Designer, then the new page will be listed alphabetically.

Step 2 - Specify the page properties

Once you have made an Index Page you should configure its properties.

To specify the page properties:

1. Select the node for the Index Page
   The right-hand panel shows the properties for the page
2. Edit the page's properties:
   - Use Page Name to specify the name of the page as it appears in the URL.
     Please note you can only use lower case letters with no spaces.

   The Page Name must be unique, but generally you can leave it as the default. The only time you will need to edit the Page Name is if you have more than one Index Page per Object Type. See Creating Multiple Index Pages for an Object Type for more information.

   If you change the Page Name and you already have a Menu linking to the page, you must also change the Menu Link as it is not updated automatically.
Use **Page Display Name** to set the name of the page as it appears in Evolve web pages, in Menus.

- **Page Title** is not available for index pages.

Use **Add Page Filter** to specify if you want the filter control available on the page - so a user can filter the displayed list of objects.

Use **Has Image** to specify the image and styling to be used when the page appears in a menu.

Selecting Has Image enables the following properties:

- Use the **Custom Image** drop-down list to select an icon to be displayed alongside the Page Display Name in the published web pages. These icons are part of the Theme applied to your Site.
- If you chose a Custom Image, use **Apply Color Transformation** to specify the color transformation to the icon
- If you chose to Apply Color Transformation, select the color to use from the **Color Transformation** drop-down list
- To apply a hover effect to the icon, use the **Apply hover effect to the image** check box.

3. **Save** your Site.

   The Index Page’s properties are saved.

   *Remember that to view your page you must have a Menu which links to it.

   See **Create and Edit a Menu** for more details.

**Related Topics**

Use Page Queries and Filters to display just the objects you want

Use Tabs to present your data

Use a Custom Display String to show more than just the object Name

Display your data using different Layouts and Behaviors
Create an Empty Index Page

The instructions on this page detail how to create an empty Index Page that is not linked to any Object Type.

You might want to do this if you are creating some of the more complex page types, such as Cluster Bubble Charts and so on.

Once you have created the page, you can then add an Object Type node, a Tab Controller, or both, depending on what the behavior you plan to use requires.

What do you want to do?

Create an empty Index Page

To create an empty Index Page:

1. Right-click on the Index Pages node and choose Add Index Page.
   A new Index Page node is added to the bottom of the list of Index Pages
2. Select the new Index Page node and edit its settings accordingly, particularly Page Name and Page Display Name
   - Use Page Name to specify the name of the page as it appears in the URL.
   - The page Name must be unique and can only contain lower case letters, numbers, dashes and underscores, with no spaces.
   - If the Page Name is not unique, or it contains illegal characters, you will see an error when you try to Save the Site.
   - Use Page Display Name to set the name of the page as it appears in Evolve web pages, such as for its title or in Menus.
3. Save your Site.

Remember that to view your page you must have a Menu which links to it.
See Create and Edit a Menu for more details.

Add an Object Type node to an empty Index Page

To add an Object Type node to an empty Index Page:

1. Right click the Index Page node and choose New Object List > [object-type]
   Where [object-type] is the name of the Object Type you want to add.
   An Object Type node is added to the Index Page.
2. Save your Site.

Add a Tab Controller to an empty Index Page
To add a Tab Controller to an empty Index Page:

1. Right-click on the Index Page node and choose New Tabs Controller
   A new Tabs node is added.
2. Save your Site.

Related Topics

Use Page Queries and Filters to display just the objects you want
Use Tabs to present your data
Use a Custom Display String to show more than just the object Name
Display your data using different Layouts and Behaviors
Create a Diagram Index Page

A Diagram Index Page is used to display either a single CW Modeler diagram, or a Visualization diagram. Shapes in the diagram are clickable, linking through to the relevant Object Pages for the Object Type selected.

In order to display diagrams in Evolve Sites, you must ensure you have a template diagram in your model which has the same Rule and Category as the diagram you want to display.
If you do not have an equivalent template diagram, the diagram will not be able to be displayed.

What do you want to do?

Display a CW Modeler Diagram on an Index Page.

These instructions assume you know how to Create a basic Object List Index Page.

To display a CW Modeler Diagram on an Index Page:

1. Create a new Index Page for the Object Type ‘Diagram’.
2. On the ‘Diagram’ node, use the Filter Properties area to specify exactly which diagram you want to show.
   We recommend you use the ID property as the reference and specify the ID of the diagram you want.
   Remember that any properties you reference in the Filter Properties area should also be selected in the Selected Properties area.
3. Right-click the Layout node and choose Switch Layout > CW > Diagram.
4. Right-click the Layout node and choose Add Behaviors > CW Modeler Diagram.
5. On the CW Modeler Diagram node, use the Full Screen setting to specify that the diagram is displayed in full-screen mode.
6. Save your Site.

If you plan to publish your Site as a Static Site, you must ensure you use the Export Diagram Images option on the Site node settings to ensure images of your diagrams are generated.
Create a Graphical Index Page

There are several different display options for graphical Index Pages, including:

- Pie Charts (including Pie Charts based on Lookup Values and Recursive Pie Charts).
- Bubble Charts.
- Bar Charts - Simple (Limited) and Multi-Access.
- Roadmaps - Basic and Lifecycle.
- Cost-Benefit Chart.
- Vector Maps for displaying locations.

Each of these different types of Graphical Index Pages start out as basic Index Pages.
Create Multiple Index Pages for an Object Type

While Index Pages are typically linked to a specific Object Type, you are not restricted to having just one page per type. Evolve allows you to create as many Index Pages as you want for any given Object Type.

You might do this to have different Index Pages for different Categories of an Object Type, or to display only those objects associated with another object. You can then use Sub-Menus to link to the different Index Pages you have.

If you do want to use more than one Index Page for an Object Type, there is one important factor you must be aware of:

The Page Name of an Index Page must be unique.
When you create additional Index Pages for an Object Type, the default Page Name is always the same -index-[object type name], such as index-process.
You must ensure that you give a unique name to each page to avoid any conflicts.
When editing the Page Name, you can only use lower case letters, numbers, dashes and underscores, with no spaces.
Working with Object Pages

Object Pages Explained

An Object Page is used to present the details of an Object Instance - a web user selects the object on an Index Page or Diagram, and the Object Page displays its properties.

You must have an Object Page configured for each type of Object you want to see the details of in your Evolve Site.

You can organize the information presented in an Object Page into Tabs, and you can present different views of the data using Object Page Views.

In addition to just an object's properties, Object Pages can be used to display Diagrams - both Visualization Diagrams and standard Diagrams that relate to the object - as well as Associated Objects in Lists or Tables.

What do you want to do?

Create a new Object Page
Create an Object from a Grid
Present your data using Tabs
Offer different perspectives with Object Page Views
Create an Object Page

An Object Page is used to present the details of an Object Instance - a web user selects the object on an Index Page or Diagram, and the Object Page displays its properties.

You must have an Object Page configured for each type of Object you want to see the details of in your Evolve Site.

You can create more than one Object Page per Object Type. Additional Object Pages you create for an Object Type are displayed as Views.

For more information about creating multiple Object Pages as Views, see: Object Page Views.

Important: You can only display an individual Property Type, or an Association Type, once on an Object Page, including across Tabs.

Creating a basic Object Page is a multi-step process. Please follow the steps below.

Step 1 - Create the Page

To create an Object Page:

1. In Evolve Designer, expand the Site node.
2. Right-click the Object Pages node.
3. Select Add Object Page for Object Type.
4. Scroll through the pop-up list to select the Object Type the Object Page represents.

The new Object Page is created and is placed at the bottom of the list of Object Pages in the tree. It is given a default name of <object-type-name>.

If you close and reopen Evolve Designer, then the new page will be listed alphabetically.

Step 2 - Specify the page properties

Once you have made an Object Page you should configure its properties.

To specify the page properties:

1. Select the node for the Object Page.
   The right-hand panel shows the properties for the page.
2. Edit the page's properties:
   ○ Use Page Name to specify the name of the page as it appears in the tree in Evolve Designer. Please note you can only use lower case letters with no spaces.

   We recommend you do not change the Page Name, unless you are creating an additional Object Page for the Object Type to act as a View- in which case you must give it a unique name to avoid a conflict.

   ○ Use Page Display Name to set the name of the page as it appears in Evolve web pages, such as in the menu of Views.
Use **Page Title** to set the name of the page as it appears in Evolve web pages, as the title of the Page. Introduced in version 2018, it has possible to use a Custom Display String, to format the Title.

3. **Save** your Site.

   *The Object Page's properties are configured and saved.*

   *You have now created an Object Page, but it will not yet display any content.*

**Step 3 - Show some content**

The instructions here explain how to insert a simple Property Group displaying the basic properties from the ‘General’ Pane of the object. Object Pages can display much more than this simple element.

You can also use **Tabs** to display more content on Object Pages, including Object Lists for Associated Objects, rather like you would on an Index Page.

The simplest way to display some content is to show some properties of the Object being viewed.

You do this by inserting a **Property Group**.

**To insert a simple Property Group:**

1. Expand the node for the Object Page
2. Right-click the Object Type Name node, for example ‘Process’, and choose **New Property Group > From CM Panel > General**

   A ‘General’ node is added beneath the Object Type Name node.
3. **Save** your Site.

   The Object Page is saved.

To read more about Property Groups and how to use them, see [Working with Property Groups](#).
Creating Objects from an Object Grid Using Object Pages (4.0.2 onwards)

You can new create objects in an Object Grid by utilising an existing Create Object page.

To do this:

1. Check the **Add Object** box
2. Check the **Use Object Page For Add** box
3. In the **Create Object Page Name**, select the Object Page from which you wish to generate additional objects.
Object Page Views

Just as you can have **Multiple Index Pages for one Object Type**, you can also have **multiple Object Pages** for an Object Type.

When you have more than one Object Page for an Object Type, it is called a **View**.

You can use Views to **offer a different perspective** on the object in focus, perhaps showing a different set of properties to the default page, or show the object in context, based on its relationships to other objects.

When a user views an Object Page, the **default page** is the one which has a **Page Name matching the Object Type name**, such as 'process' for the Process Object Type. Any other pages, or Views, are displayed as links in a menu above the page title, so the user can click them to view the pages.

**Creating Object Page Views**

To **create an Object Page View**, simply **create a new Object Page** for your Object Type - in exactly the same way you would for any Object Page.

However, you must **make sure your new Object Page has a unique Page Name** - you cannot for example have two Object Pages titled 'process', so you should rename the new one so that it is different.

In every other respect, creating an Object Page View is the same as creating a standard Object Page.
Working with Menus

Create and Edit a Menu

The Menu appears on the left-hand side of your Evolve web pages and links to pages you have created in your Site. However, you must add the links in the menu yourself, giving you full control over how they are displayed and in what order the menu items appear.

You can add menu links to the following items:

- Index Pages.
- Create Object pages (Dynamic Sites only) - Object Pages that allow users to create new objects.
- Administration Pages (Dynamic Sites only) - either for viewing administration data such as Roles, Questionnaires and so on, or as Create Object pages to allow users to create new objects of these types.

To use a Create Object page in your Dynamic Site, you must have created an Object Page or Object Page View in advance, and you must make sure that the Object Page is configured using Property Groups to display all the properties that the user must enter - including all mandatory properties.
Menu levels

The Menu in Evolve is structured so that there are **top-level menu items** each with **one or more sub-menu items**. Top-level menu items cannot be configured to link to individual pages, only sub-menu items can link to actual pages. Therefore you should think of the top-level menu items more as **groups of sub-menu links**.

You can also add **sub-menu groups**, which contain sub-menu links. In fact, you can create multiple levels of nested menus using this method.

**What do you want to do?**

**Add a new top-level menu item**

*To add a new top-level menu item:*

1. In Evolve Designer's **Layout** pane, right-click the **Menu** node.
2. From the pop-up menu, choose **Add Menu Link**.
   A new node titled 'Menu Link' is created beneath the **Menu** node.
3. Select the new **Menu Link** node
4. Enter a title for the Menu Link using the **Node Name** field
   This is the name of the top-level menu item as it appears in the web pages.

**Set an icon for a menu item**

*To add icons to display next to menu items:*

1. In Evolve Designer's **Layout** pane, click the **Menu** node to display the menu links within it
2. Select the **Menu Item** you wish to set an icon for
3. Select the **Icon Library**, **IconColor** and **Icon** for the menu item.
4. **Save** your Site.

**Add a link to an Evolve page**

You can add menu links to **Index Pages and Object Create pages** which allow users to create new objects.

You add a menu link to a page by creating a new sub-menu item for an existing top-level menu item or sub-menu group item.

*To add a menu link to an Evolve page:*

1. Right-click the menu node you want to add the menu link to.
2. Add your link:
To add a link to an Index Page, choose Add Index Page Link > Custom Pages > and select the Index Page you want the sub-menu item to link to.

To add a link to a Create Object page to allow a user to create an Object in your model, choose Add Create Object Page > Custom Pages > and select the Object Page you want to link to.

A new sub-node is created representing the sub-menu item that will appear in that menu group.

3. Select the new sub-node.

4. Use the Node Name field to enter the name of the sub-menu item as it will appear in the web pages.

5. Save your Site.
Add a sub-menu group node

Sub-menu group nodes are used to create multiple menu levels. You can add one to a top-level menu, or to any existing menu item. Like top-level menu items, sub-menu group nodes do not link to a page, instead they are used to contain or group one or more sub-menu links.

To add a sub-menu group node:

1. In Evolve Designer's Layout pane, expand the Menu node.
2. Right-click the menu item you want to add the sub-menu group to.
3. From the pop-up menu, choose Add Menu Link
   A new node titled 'Menu Link' is created beneath the selected node
4. Select the new Menu Link node.
5. Enter a title for the Menu Link using the Node Name field.
   This is the name of the menu item as it appears in the web pages.

You can now add sub-menu links to this new node.

Add a link to an Evolve Administration Page

You can add menu links to built-in pages to view administration data, such as Roles, Questionnaires and so on, as well as to Object Create pages which allow users to create new Objects.

You add a menu link to a page by creating a new sub-menu item for an existing top-level menu item or sub-menu group item.

To add a menu link to an Evolve Administration Page:

1. Right-click the menu node you want to add the menu link to.
2. Add your link:
   - To add a link to an Administration Index Page, choose Add Index Page Link > Standard Pages > and select the Administration Page you want the sub-menu item to link to.
   - To add a link to an Administration Create Object page to allow a user to create an administration object, such as a Role or Question, choose Add Create Object Page > Standard Pages > and select the page you want to link to.
     A new sub-node is created representing the sub-menu item that will appear in that menu group.
3. Select the new sub-node.
4. Use the Node Name field to enter the name of the sub-menu item as it will appear in the web pages.
5. Save your Site.

Change the order of the top-level menu

The order of the top-level menu can be changed by selecting and dragging the top-level menu nodes and dropping them on main Menu node.

When you drag a node and drop it to the main Menu node, that node is then placed at the bottom of the list.
To create the order you want, drag and drop the top-level menu nodes until the tree is ordered accordingly.

Change the order of sub-menu items
The order of the sub-menu items can be changed by selecting and dragging the sub-menu nodes and dropping them on parent top-level menu node.

When you drag a sub-menu node and drop it to the top-level menu node, that node is then placed at the bottom of the list.

To create the order you want, drag and drop the sub-menu nodes until the tree is ordered accordingly.

Delete a top-level menu or sub-menu item

To delete a top-level menu or sub-menu item:

1. In Evolve Designer’s Layout pane, expand the Menu node.
2. Select the top-level menu node or sub-menu node you want to delete.
3. Right-click and choose Delete.

   The item is deleted. If you deleted a top-level menu node, all its sub-menu items are also deleted.
Publishing

Publish your Site

Evolve offers different options for publishing a Site. Use the table below to determine which option to use at any given time.

You can also publish your site via batch command or scheduled task. To find out more about batch publishing, see Command Line Publishing.

Menu: Home

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Site</td>
<td>Use when you publish your Dynamic Site for the first time, or when you want to do a full re-publish - including all of the other options detailed below.</td>
</tr>
<tr>
<td>Static Site</td>
<td>Use when you publish your Static Site for the first time, or when you want to do a full re-publish - including all of the other options detailed below.</td>
</tr>
</tbody>
</table>

Menu: Dynamic Deployment / Static Deployment

The following functions are duplicated on the Dynamic Deployment and Static Deployment menus, as they perform the same function and are different only in the respect of whether you are publishing a Dynamic or Static Site.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagram Templates</td>
<td>Use this option if you show Diagrams in your Site and have edited any of the Templates they are based on.</td>
</tr>
<tr>
<td>Note: Only the Diagram Templates are updated during this operation - changes to Site pages are not published.</td>
<td></td>
</tr>
<tr>
<td>Note: Web Modeler Diagram Templates will be kept up to date automatically, there is no need to use this option when you make changes to templates in Evolve Suite.</td>
<td></td>
</tr>
<tr>
<td>Theme &amp; Pictures</td>
<td>Use this option if you have changed the Site's Theme or any of the icons used for the Menu or Pages - this includes adding new Pages that have custom images.</td>
</tr>
<tr>
<td>Note: Only the theme and pictures are updated during this operation - changes to Site pages are not published.</td>
<td></td>
</tr>
<tr>
<td>Deploy Site</td>
<td>Use this option to publish just the Site pages without updating Diagram Templates, Theme and Pictures.</td>
</tr>
<tr>
<td>Save &amp; Deploy Site</td>
<td>Use this option to Save the Site, then publish just the Site pages without updating Diagram Templates, Theme and Pictures.</td>
</tr>
<tr>
<td>It is likely you will use this option most of the time when creating and configuring your Site.</td>
<td></td>
</tr>
</tbody>
</table>
Command Line Publishing

You can if you wish publish your Site using a Command Line operation - which you could use to create a scheduled task, or batch command.

You might want to do this if you have a Static Site and want to ensure your users are viewing the latest data in your Model - so you could re-publish the Site daily or weekly.

To create a batch command for Command Line publishing:

1. In Evolve Designer, right-click the Model node for your Deployment and choose Add Batch Node.
   
   A Batch Node is added below the Model node.

2. Select the Batch Node and configure the settings as follows:
   
   i. Use Node Name to change the name of the Batch Node
   ii. Use Connection to select the CW repository you want to publish from
      
      By default the Connection you are using while logged in to Evolve Designer is selected
   iii. Use CW User Name to enter the name of the CW User you want to generate your Site as
   iv. Use CW User Password to enter the password for the above User, ensuring you click the Encrypt button

3. Save the Site

4. Right-click the Batch Node and choose 'Copy batch script into clipboard'
   
   The command is copied to the clipboard for you to paste where you need it.

You can now open a Command Prompt and paste the command into it, paste it into a batch file, or paste it into a Scheduled Task configuration.
Use Tabs to Present your Data

Tabs are used as a way of grouping and controlling the way you present different information in your Index Pages and Object Pages.

For example, on an Object Page, you might have a Tab showing the General properties of an object, then use another Tab to show a list of Associated Objects, or Diagrams that the object appears on.

On an Index Page you might want to display some charts and a Table, offering different views of the same information.

By using Tabs you can include much more information than the basic object list or object details, but all content on the page must be displayed on a Tab.

Please note that having multiple Tabs each referencing different Object Types could impact the performance of your page, so we recommend being careful about not overloading the page with content.

What do you want to do?

Add Tabs to an Object Page

These instructions assume you do not yet have any Tabs, but you do have a clean Object Page node, with an Object Type node already set to an Object Type, and a Layout set to Object Page.

To add Tabs to an Object Page:

1. Under the Object Page node, right-click the Object Type node and choose New Tab Controller.
   A new Tab node is added to the tree.
2. Select the Tab node and use the Side drop-down to choose whether you want the tabs to be displayed Horizontally or Vertically in your page.
3. Right-click the Tab node and choose New Tab
   A new Tab titled 'Tab' is added to the tree
4. Select the 'Tabo' node and edit the Tab Name to what you want to be displayed in the web page.
   Repeat steps 3 to 4 to add multiple Tabs to your page.
5. Save your Site.
Add content to a Tab on an Object Page

Once you have one or more Tabs, you can choose what content to display in them. Within a Tab you can display Property Groups, or Associated Objects displayed as a list, Table, or other layout option.

When you add new content, you use the Tab itself as the parent node.

See Working with Property Groups to find out how to add Property Groups to a Tab.
See Working with Layouts and Behaviors to find out the different display options within Object Pages.

Add Tabs to an Index Page

You cannot add Tabs to an Index Page that already includes content - you must either Delete the existing content first, or create a new Index Page.

If you want to add Tabs to an Index Page, the Tab node must be the top-level node for that page in Evolve Designer.

There are two ways to achieve this:

1. Create a new Index Page, but instead of using the Add Index Page for Object Type option, use Add Index Page
2. Use an existing Index Page, but Delete the Object Type node and everything below it - do this by right-clicking the Object Type node and choosing Delete. All previous content will be lost if you do this.

The instructions below assume you have a clean Index Page node with no other nodes beneath it.

To add Tabs to an Index Page:

1. Right click the Index Page node and choose New Tabs Controller.
   A Tabs node is added below the Index Page node.
2. Select the Tabs node and use the Side drop-down to specify whether you want the Tabs to be displayed Horizontally or Vertically on the page.
3. Right-click the Tabs node and choose New Tab.
   A new Tab node is added.
4. Select the Tab node and use the Tab Name field to specify the name of the Tab as you would like it too be displayed in the web page.
5. Right-click the Tab node and choose New Object List > [object-type]
   An Object Type node and a Layout node are created.
6. Save your Site.
   You can now configure the content in the same way as you would for a normal Index Page without Tabs.

Add content to a Tab on an Index Page

Once you have a Tab on an Index Page, you must create an Object Type node for the Tab - until you have an Object Type node you cannot add any content.
To do this:

1. Right-click the Tab node and choose New Object List > [object-type]
   An Object Type node and a Layout node are created.

Once you do have an Object Type node, you can add content just as you would for any Index Page.
See Working with Layouts and Behaviors for instructions on adding the different content types.

Add a new Tab to an existing Tabs Controller

To add a new Tab to an existing Tabs Controller:

1. Right-click on the Tabs node and choose New Tab
   A new Tab is added to the bottom of the list of Tabs.

Change the order of Tabs in your page

You can change the order of Tabs in your page by dragging and dropping Tabs to the parent Tab node. When you do this, the Tab you moved is placed at the bottom of the list. By dragging and dropping Tabs in the same order you want them to appear on the page, you can make the tree show them in the correct order.

Delete a Tab

To Delete a Tab:

1. Right-click the Tab you want to delete and choose Delete.
   A confirmation dialog is displayed.
2. Click Yes.
   The Tab is deleted.
Use Custom Display Strings

On certain page layouts and behaviors you can now build a custom string to display the properties of your objects or associated objects.

So, instead of just showing the Name of an object, you can build a string mixing one or more property values of the object with some standard text.

For example, if you are listing Application objects, and they have a number property titled ‘Cost’, you could specify a custom string to display the Application Name, followed by the Cost - such as ‘Application 1 - $500’.

You can even show some meta data, such as the Object Type Name or Plural name, or lookup abbreviation.

And, if you have a Custom Site which is configured to support Visual Indicators, you can display them within a Custom Display String.

A simple syntax means it’s easy to build the custom strings, using curly brackets {} to display property values and all other text being displayed as it is.

You can use custom property strings with the following layouts and behaviors:

- **Accordions** - including when nested
- **Simple Lists**
- **Tables** - when listing Associated Objects in a column
- **List Boxes**
- **External Picture layout**
- **Visual Identity layout**

---

The page filter/search does not work with custom display strings and can only filter based on Name. URL property types are displayed as plain text with no hyperlink.

**What do you want to do?**

**To create a Custom Display String**

**To create a custom display string:**

1. Select the **Object Type** or **Association Type** node you want to create the string for
2. Ensure all the properties you want to include in your string are selected in the **Selected Properties** area
3. Select the **Layout node** for your page
4. Enter your custom string in the **Custom Display String** field, for example '{name}: {type} $500' to display the object's Name, followed by a colon and its Category in brackets.

**Use the following syntax rules:**

- Use curly brackets {} to surround Property Type scriptnames, for example `{name}`
- Scriptnames must be entered in **lower case**
All other characters not included in curly brackets {} will be displayed as **plain text**.

- Use `{cwobjecttype}` to display the Object Type Name, for example, 'Process'
- Use `{cwobjecttypes}` to display the Object Type Pluralname, for example, 'Processes'
- Use `'*_abbreviation'` after a lookup scriptname to display the Abbreviation for the drop down value, for example `type_abbreviation`
- Use `'*_id'` after a lookup scriptname to display the ID for the drop down value, for example `type_id`.

If you leave the Custom Display String field blank, your layout or behavior will default to displaying the Name.

If you enter incorrect syntax, it will be rendered as text in the web page.

5. **Save** your Site.

**Use Visual Indicators inside a Custom Display String**

If you have a Custom Site which is configured to support the use of Visual Indicators, you can display them directly in a Custom Display String.

To do this, simply insert the reference in the custom string using the following syntax:

`{<property-type-scriptname>_image_mapping}`

For example:

`{type_image_mapping} or {validated_image_mapping}`

Remember to ensure the properties you reference here are also selected in the Selected Properties area for the parent node.

The image will be displayed within the string alongside any other properties you reference.
Static Pages in a Dynamic Site [2018.0.2+]

What does this mean?
A Dynamic Site offers a read, write access to your model, which means that content is generated as it is requested by users. This generation, whilst highly efficient, can be slow when large volumes of data are requested. Often pages which have large amounts of information, do not contain data which changes often. Such pages could therefore be pre-generated, saving much server time, and make the user's experience much more desirable. The disadvantages to this method of generation are that the content is not modified until the page is regenerated. Also the page is not access controlled by Roles, so is available to all users. None the less, this is often a tradeoff worth making for complex pages.

How to make a page Static?
1. Define a page in your site as usual.
2. From the page settings, tick the checkbox, 'Display as Static Page'
3. You will be warned that new content will not appear in the site, until the static page is regenerated.
4. To generate (and regenerate) content for this page, right click on the page in tree
5. Choose the option 'Generate Content - Static Mode Only'
6. The page will be regenerated.
   OR allow your end users to regenerate the page themselves with 'in-page refresh'.
Fig. Generate Static Content
In-Page Static Content Refresh

Allow Users to Refresh Static Pages in a Dynamic Site [2018.1.0+]

What does this mean?

As the name suggests, a Static Page is generated at a point in time, and then made available. Its content does not change.

Why would you want a static page?

Sometimes a page is made static because it is a baseline, other times it is static to improve load performance, as it changes less frequently.

If the page is static for performance, it might be nice to allow a user to refresh the page themselves. So Evolve offers an In-Page refresh button.

Enabling In-page Refresh

1. First configure the page to be static
2. You will now be able to access the 'Allow refresh' options; "Disabled", "Everyone" or Roles. that exist in your site.

Fig. Refresh static content settings
3. Choosing "Disabled", which is default, will ensure that no-one can refresh the page from the site. Choosing "Everyone", will enable the refresh button for all users of the site. Choosing a specific Role, will enable the refresh button for users who are members of that Role.

Each static page has a "Last generated" time stamp, to indicate when it was last refreshed. A user can then press the regenerate button and have the server make the refresh. Once refreshed, the page will reload with the updated content. This content will be available for all users who subsequently visit the page.

![Fig. Refresh static content, end user view](image)

**Help me choose an option**

- When a page is a baseline, it may be most appropriate to disable the ability for end users to refresh the content. This means the site administrator would be required to use Evolve Designer to regenerate the content when a new version is released. Often this is done with a batch run, overnight, or on another trigger. However, it may be that the page could change throughout the day, and you'd like an administrator to control when this happens. Going to Evolve Designer each time, can be time consuming, so choosing a Role that your Administrators are a member of, will ensure only they can refresh the page from within the site.

- Perhaps the page is owned by a particular department, and they like to make changes behind the scenes, and then publish them. Again using the Role restriction will ensure only the owners can update the page.

- In some environments the flexibility of allowing Everyone to refresh pages, is fine. If someone visits a page, and would like to see the most up-to-date details, they can tap refresh and everyone will now see the latest and greatest, when they visit.

**Caveats**

In 2018.1.0 this feature updates ALL object pages of the same type, and not just the page you are viewing. While this could be useful, it was not intended. We plan to reduce the scope in subsequent releases, to just the page you are viewing.

Also, it is not possible to make a page both static AND editable. So the page would need to be duplicated in Evolve Designer, with one page static, and one page dynamic. The dynamic page would be made available, only to roles who are contributors. In this way a contributor would see the page twice. If they were to edit, the editable version and save the changes, these changes would not be seen on the static page, until that page was also refreshed.

This feature is in an early adopter stage, and we welcome comments and suggestions for improvement.
Working with List (Simple)

The List (Simple) layout is the most basic display option for showing a list of objects. It is the **default Layout for all new Index Pages** and displays objects in a simple bulleted list. When used on an Object Page, a Simple List shows related objects, such as Associations or Diagrams the object appears on.

**Technologies**

- .Net
- Active Directory (AD)
- Active Navigation
- ADS/O (IDMS 4GL)
- Ajax
- Anzio
- ASP.Net
- Batch COBOL
- Blackberry
- C
- C#.Net
- C++
- Cache
- Call Routing
- OCS COBOL
- Cincinnati Report Server
- Cisco Computer Telephony Integration (CTI)
- Citrix
- CLASS Development mainframe
- CLASS Production mainframe
- COBOL
- CORBA
- Customer Service Desktops
- Customer WorkStation
- CWAS
- DB2
- Desktop App
- Disaster Recovery mainframe
What do you want to do?

Use the List (Simple) layout on an Index Page:
You can use a **Simple List** in more than one way on an Index Page.
To use as the main element of the page or Tab to list the objects returned:
Ensure the *Layout* node beneath the *parent* node is set to **Layout List (Simple)**. No other controls, layouts or behaviors are required.
To use inside an Accordion to list Associated Objects:
Ensure the *Layout* node beneath the *Association* node is set to **Layout List (Simple)**.

[Read more about *Working with Accordion*.

Use the List (Simple) layout on an Object Page
The Simple List layout can only be used on an Object Page to show objects that are related to the object which is in focus.
You must therefore have a **Association** node in your Object Page before you can use it.
You can add an **Association** node at the top-level of the page - with an **Object Page Layout**, or inside a **Tab**, where the top-level node in the Tab is an **Association** node.
To use a Simple List to display your Associated Objects:
Ensure the *Layout* node immediately beneath the *Association* node is set to **Layout List (Simple)**.

Display a title above your list

*To display a title above your list, wherever you use it:*
1. Select the **Layout List (Simple)** node you want to have a title
2. Enter the title you want to use in the *Node Name* field
3. Select the **Display Title** check box.
Working with Accordions

This page describes how to create an Accordion within one of your Evolve Site.

Accordions are used on Index Pages to display a list of objects, and then for each object a set of related information, such as the object's properties, its associations, which diagrams it appears on, and so on.

Accordions are usually configured to contain other layouts and behaviors inside them, which are exposed when the user expands the node.

You can also nest Accordions inside other Accordions, typically for listing Associated Objects.

What do you want to do?

Display a top-level Accordion in an Index Page

These instructions assume that you have already created a basic Object List Index Page which displays the list of objects you want to appear in your Accordion.

To display a top-level Accordion in an Index Page:

1. Expand the node for the Index Page you want to add an Accordion to
2. Expand the Object Type node with the name of the Object Type, for example 'Process'
   
   You should have a node representing the default layout 'Layout List (Simple)'. If not, right-click the layout node and select Switch Layout > CW > List (Simple)
3. Right-click the node 'Layout List (Simple)' and select Add Behaviors > Navigation > Accordion

   A new sub-node is created under the layout node, titled 'Accordion'
4. Specify the settings for the Accordion
   
   - **Remove accordion header if empty** is only relevant if you are displaying another Accordion, nested inside this one, so this setting can be ignored if you only have one level.
     
     *If you do plan to have another Accordion nested inside this one, such as to list some Associated Objects, you can switch off this check-box to specify that you want the top-level Accordion item to be omitted from the displayed list if it does not have any Associated Objects.*
   
   - Use **Collapse by default** to specify whether the Accordion is presented in a collapsed or expanded state when viewed.
5. **Save** your Site.
   The changes are saved.

**Display data inside an Accordion**

Once you have an Accordion, you need to specify what you want to be displayed inside it when a user expands the node for each object.

You do this by adding one or more **Property Groups** to the parent node for the Accordion - this is usually the **Object Type node** for a top-level Accordion, or the **Association Type node** if the Accordion is nested.

For a full explanation of using Property Groups, see: *Working with Property Groups.*

**The instructions below detail how to add a generic Property Group.**

1. Right-click the parent node for the Accordion and select **New Property Group** > **Empty Group**
   The Property Group node is added.

2. In the Property Group's properties, choose the **Layout** you want and use the **Selected Properties** area to choose which properties to display

3. **Save** your Site
   The changes are saved.

**Display an Accordion nested inside another Accordion**

*These instructions assume that you have already created an Object List Index Page which includes a top-level Accordion displaying a list of objects, and that these objects have Associated Objects.*

**To display an Accordion nested inside another Accordion:**

1. Expand the node for the Index Page you want to add a nested Accordion to

2. Expand the Object Type node with the **name of the Object Type**, for example 'Process'

   You should have a node representing the default layout 'Layout List (Simple)', under which you should find the top-level Accordion.

3. Right-click the Object Type node and select **New Association** > **[Object Type]** > **[Association Type]** to create an Association node

   *If you already have a node representing the Association Type you want to use with your nested Accordion, skip this step*

4. Expand the Association node

5. Right-click the **Layout List (Simple)** node and choose **Add Behaviors** > **Navigation** > **Accordion**

   The new Accordion node is created.

6. Specify the settings for the Accordion
Ignore **Remove accordion header if empty** as it cannot be used at this level.

- Use **Collapse by default** to specify whether the accordion is presented in a collapsed or expanded state when viewed.

7. **Save** your Site.

   *The changes are saved.*
Working with Tables (Simple)

A Table (Simple) layout displays data in a simple tabular format. You can choose which columns you want to be displayed, representing properties of the objects, or Associated Objects, and you can link to the Object Page for the objects it shows.

<table>
<thead>
<tr>
<th>Options</th>
<th>Name</th>
<th>Category</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Automodeler</td>
<td>Application</td>
<td>products/am.png</td>
</tr>
<tr>
<td></td>
<td>Casewise Modeler</td>
<td>Application</td>
<td>products/cm.png</td>
</tr>
<tr>
<td></td>
<td>Gallery</td>
<td>Application</td>
<td>products/gallery.png</td>
</tr>
<tr>
<td></td>
<td>Matrix</td>
<td>Application</td>
<td>products/matrix.png</td>
</tr>
<tr>
<td></td>
<td>Model Explorer</td>
<td>Application</td>
<td>products/me.png</td>
</tr>
<tr>
<td></td>
<td>Object Explorer</td>
<td>Application</td>
<td>products/oe.png</td>
</tr>
<tr>
<td></td>
<td>Simulator</td>
<td>Application</td>
<td>products/sim.png</td>
</tr>
</tbody>
</table>

However, unlike the Table (Complex) behavior, you cannot edit content in a Simple Table.

**Why and how should you use one?**

Use a Simple Table when you want to show more details for lists of objects than the other behaviors allow, but you are not interested in sorting the columns or editing the displayed data.

**Where and when can you use one?**

Use the table below to see where you can use a Simple Table:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Parent node</th>
<th>Tabs</th>
<th>Number on page</th>
<th>Editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Page</td>
<td>Object Type node</td>
<td>Yes - optional</td>
<td>1 - the Table must be the only element on the page</td>
<td>No</td>
</tr>
<tr>
<td>Object Page</td>
<td>Association Type node</td>
<td>Yes - mandatory</td>
<td>1</td>
<td>No</td>
</tr>
</tbody>
</table>

**What do you want to do?**

**Insert a Table (Simple) into your Index or Object Page**

**To insert a Simple Table into your page:**

1. Select the parent node - Object Type node for Index Pages, Association Type node for Object Pages
2. Switch the Layout node beneath the parent node to Table (Simple)
   
   *To do this: Right-click the Layout node and choose Switch Layout > CW > Table (Simple)*
3. Right-click the parent node and choose to add a New Property Group > Empty Group or From CM Panel.
   
   *This node is the parent node of the 'Layout Table (Simple)' node. For full details on Property Groups, see [Working with Property Groups](#)*
4. Select the Property Group and use the Selected Properties area to choose all the properties you want to be represented as columns in the Table
   
   *Add as many Property Groups as you want if you want complete control over the ordering of your columns.*
5. **Save** and **Publish** your Site.

Show Associated Objects in a Simple Table

You can configure your Table to include one or more columns displaying Associated Objects.

**To add a column showing Associated Objects:**

1. Right-click the **parent node** - Object Type node for Index Pages, Association Type node for Object Pages - and select **New Association > [Object Type] > [Association Type]** to create an Association node
   
   A new node representing the Association Type is created at the bottom of the list.

2. **Save** and **Publish** your Site.

   The Associated Objects column is displayed as the last column in your table.
Working with Tables (Complex)

A Table (Complex) behavior displays data in a grid format. It has columns that can be sorted or filtered, and optionally you can specify that users can edit the data presented in the Table, either inline, directly in the cells, or by using a pop-up window.

You can use Tables on Index Pages and Object Pages to display properties of Objects and Associated Objects, and on Object Pages only, you can also show properties of Intersection Objects.

Editing content in a Table

A Table is the only display option that enables you to edit data in an Index Page.

When you edit data in a Table you can edit the object's properties and associations (if you have associations displayed).

You can choose whether to edit data inline or using a pop-up dialog. You must use a pop-up if you want to edit associations.

You can also allow users to create new objects on a Table page, by using the Add Object setting.

Why and how should you use one?

Use a Table when you want to show more details for lists of objects than the other behaviors allow - and if you want users to be able to edit the data.

Where and when can you use one?

Use the table below to see where you can use a Table:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Parent node</th>
<th>Tabs</th>
<th>Number on page</th>
<th>Editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Page</td>
<td>Object Type node</td>
<td>Yes - optional</td>
<td>1 - the Table must be the only element on the page</td>
<td>Yes</td>
</tr>
<tr>
<td>Object Page</td>
<td>Association Type node</td>
<td>Yes - mandatory</td>
<td>1</td>
<td>Yes</td>
</tr>
</tbody>
</table>

What do you want to do?

Insert a Table (Complex) into your Index or Object Page

To insert a Table into your page:
When you use a Table in an Index Page it must be used on its own - that is it cannot be contained within an Accordion or other page display type.

1. Select the parent node - Object Type node for Index Pages, Association Type node for Object Pages - and use the Filter Properties area to apply any filtering

2. Switch the Layout node beneath the parent node to Empty
   To do this: Right-click the Layout node and choose Switch Layout > CW > Empty

3. Right-click the Layout node and choose Add Behaviours > Tables > Table (Complex)
   A new node is added below the Layout node, titled 'Table (Complex)'

4. Select the new Table (Complex) node

   The Table's settings are displayed

5. Edit the Table's settings:
   - Use Add Object to place an Add Object button on the page so users can create new objects
   - Use Edit Mode to specify if you want the objects listed to be editable, and whether you prefer inline editing in the Table or to use a pop-up window
     Leave Edit Mode unset if you do not want to allow editing.

   If you show a multi-line text property, such as Description, in your table, and the content includes HTML formatting, users will not be able to edit the content via the table.

6. Object Pages do not support pop-up editing, only inline editing is supported.
   - Use Intersection Object Grid if you want to be able to display the value of an Intersection Object

   See Display data from an Intersection Object in a Table (below) for further details.

7. Right-click the parent node and choose to add a New Property Group > Empty Group or From CM Panel
   This node is the parent node of the 'Layout Empty' node referenced in step 3. For full details on Property Groups, see Working with Property Groups.

8. Select the Property Group and use the Selected Properties area to choose all the properties you want to be represented as columns in the Table
   Leave the Layout setting as 'table'.

8. Save your Site.
   The changes are saved.

Include a Table column showing Associated Objects

You can configure your Table to include one or more columns displaying Associated Objects.

When you display Associated Objects in a Table, they can only be displayed as a simple List, showing just the Name of the Associated Object.
Associations can only be edited in a Table if you set the Table to have an Edit Mode of ‘Pop-up’.

To add a column showing Associated Objects:

1. Right-click the parent node - Object Type node for Index Pages, Association Type node for Object Pages - and select New Association > [Object Type] > [Association Type] to create an Association node
   A new node representing the Association Type is created at the bottom of the list. By default it is given a List (Simple) layout - which is the only layout you can use.

2. If your Table is editable, or you plan to make it editable, you must choose which properties of the Associated Objects to display on the pop-up edit dialog by adding a Property Group to the Association node and selecting the properties to display, as nothing is displayed by default:
   i. Right-click on the Association node and choose New Property Group > Empty Group or From CM Panel > [Pane Name]
   ii. Use the Selected Properties area to choose which properties to display in the edit dialog
      For full details on Property Groups, see Working with Property Groups.

3. Save your Site.
   The changes are saved.

Display data from an Intersection Object in a Table

You can configure a Table, based on an Association Type, to display data from an Intersection Object.
A Table configured in this way will only show the Name of the Associated Object and then any properties of the Intersection Object you choose.

You can only display Intersection Object data in a Table when the Table is used on an Object Page.

To do this:

1. Follow the instructions above to create a Table for your Index or Object Page, basing it on an Association Type node
   Your tree should look like this: Association Type node > Layout Empty > Table (Complex)
   You do not need to add a Property Group to control which properties of the Associated Objects are displayed, as Name is displayed by default.

2. Right-click the Association Type node and choose New Intersection Object
   A new node is added for the Intersection Object, and it is given a List (Simple) layout by default

3. Right-click the Association Type node and choose New Property Group > Empty Group or From CM Panel > [Pane Name]

4. Use the Selected Properties area to choose which Property Types are shown in the Table
   Each property you select is shown in a separate column in the Table.

5. Save your Site.
Your Table is configured. When the page is viewed, you should see a Table showing the Name of Associated Objects in the first column, followed by the properties of the Intersection Objects in the following columns.
Working with a Simple Matrix

The Simple Matrix requires that you have an Association Type defined between the two Object Types you want to show.

A Simple Matrix can only be used on an Object Page, where one object is therefore the focus.

It creates a table which shows Associated Objects for the object in question as column headings, and then within the cells shows other objects that are also associated to those Associated Objects.

For example, if your Object Page was focused on a Process, you could use the Simple Matrix to show which Risk objects your Process is associated to, and then beneath each Risk also show which other Processes are also associated to those Risks.

When you use a Simple Matrix, the first level of Associated Objects are listed as columns in the table - consequently the more you show, the wider the table will be.

We therefore recommend that you restrict the number of Associated Objects displayed in the Matrix or it may become unusable.

To display a Simple Matrix in your Object Page:

These instructions assume that you are adding your Simple Matrix to a Tab on an existing Object Page, and that the new Tab node already exists.

1. Right-click the Tab you want to add the Simple Matrix to, and choose New Association > [object-type] > [association-type]
   This is to choose the Association Type you want to use to populate the column headings
   An Association Type node is added.
2. Expand the Association Type node and switch the Layout to Empty.
   To do this: Right-click the Layout and choose Switch Layout > CW > Empty
3. Right-click the Layout Empty node and choose Add Behaviors > Matrix > Matrix (Simple)
4. Right-click the Association Type node created at step 1 and choose New Association > [object-type] > [association-type]
   This is to choose the Association Type you want to use to find out which other objects are associated to each Associated Object returned by the parent node.
   An Association Type node is added.
5. Save your Site.

Please ensure you use unique Object Group IDs for the Association Type nodes.

If you have IDs which are the same as ones you have used elsewhere, you will see an error reported when attempting to Deploy the Site.
Working with an Advanced Matrix

The Advanced Matrix is used to display associations between two Object Types, and can be used on either an Index Page or an Object Page.

To display an Advanced Matrix in an Index Page:

1. An Index Page can be added for an Object Type. In this example an Application has been added;

2. A related Object Type can also be added to the same Index Page. In this example a Technology has been added;

3. The first object type should have its Layout switched to Casewise > Empty, to allow a Matrix > Matrix (Advanced) Behaviour to be added. The second object type should have its Layout switched to Casewise > Empty, to prevent a list of these objects from being output.

The first object type will be the Row of the matrix, the second object type will be the Column.
4. The first object type should identify the relationship to be represented in the Matrix. A **New Association** allows the relationship to the second object type to be selected. In this example the **Application - Technology ()** has been selected;

5. The Association should identify its **Intersection Object Type**. In this example it is a **Reason for Involvement**:

6. The Matrix (Advanced) behavior can now have its **Intersection Properties** added, and the **Row Object Group ID** and **Column Object Group ID** updated from the Application and Technology object types;
By default, the matrix cell will contain the (name) of the Intersection instance as its Display String, until Intersection Properties are added. In this example the Reason for Involvement has had its Name property added, which Automatically Generates the Custom Display String (FUNCTIONSYNONYM).

The **Intersection Node ID** is automatically updated when the Intersection Object Type is established.

**The Published Example Advanced Matrix:**

Both Application and Technology object types have been restricted to Include Objects Only If they Have Associations. This will reduce the size of the matrix, and consequently the time it will take to refresh.

- Objects with Associations Only

> It might also prove useful to Add a Page Filter to enable the size of the matrix to be reduced. An active filter is likely to reduce the time to generate the matrix.
The Row and Column objects could be filtered to reduce the number of rows or columns. For example, the Applications could be filtered to only include those with a Category = ERP.

Filtering Objects

A matrix with too many rows and columns could take an unacceptable amount of time to generate.

Displaying Intersection Properties:

In the example output above, the **Custom Display String** for each cell has been set to the Name of the Intersection object. None of the Reason for Involvement associations have been given a name, as a consequence the shaded cell contains no detail. The following example has the Number of Resources displayed in each cell:

- Intersection Property
To display an Advanced Matrix in an Object Page:

The Advanced Matrix on an Object Page is similar to one created for an Index Page, but like the Simple Matrix on an Object Page, the focus is on a single object.

1. An **Object Page** can be added for an **Object Type**. In this example a **Process** is to be added.

2. This object type should identify a relationship to the objects to be represented in the matrix rows. A **New Association** is added under the object type. In this example a **Process - Application** is to be added.

3. The related object type should have its Layout switched to **Casewise > Empty**, to allow a **Matrix > Matrix (Advanced)** Behaviour to be added.

4. The first related object type should now identify the relationship to be represented in the Matrix. A **New Association** allows the relationship to a second related object type to be selected. In this example the **Application - Technology** is to be selected.

5. The Association should identify its **Intersection Object Type**. In this example it is to be a **Reason for Involvement**.
6. The Matrix (Advanced) behavior can then have its **Intersection Properties** added, and the **Row Object Group ID** and **Column Object Group ID** updated from the **Process - Application ()** and **Application - Technology ()** nodes;

![Image of Matrix Diagram]

The need to reduce the size of the Object Page matrix is less likely, as only the objects related to the selected object, and their related objects will be included in the matrix.

**The Published Example Advanced Matrix:**

- An Application to Technology matrix for a selected Process;

![Image of Published Matrix Example]

**Editing Intersection Properties:**

In the example output above, the **Custom Display String** for each cell has been set to the Name of the Intersection object. None of the Reason for Involvement associations have been given a name, as a consequence the shaded cell contains no detail. It is possible to Edit the Intersection Properties, by clicking on the Edit button above the matrix;
• Editing the Name of an Intersection.

It is possible to create new relationships by clicking on the 'link' icon, or to delete existing relationships by clicking on the 'bin' icon.
Working with Tabs based on Lookup Values

Tabs based on Lookup Values is a list-based display that organizes your objects into groups based on the value of 'Lookup' (drop-down) properties such as Category.

Vertical tabs on the left side of the page are used to represent the values, while the objects themselves in each tab are displayed in simple lists.

Objects listed using this display type cannot be edited directly.

You can optionally include an Overview Chart which creates an 'Overview' tab displaying a Pie Chart showing the proportion of each value. The Overview Chart is identical to the chart displayed when using the Pie Chart based on Lookup Value behavior.

The Tabs based on Lookup Values display requires that you have drop-down properties in your model. It will work with the default drop-down Category, as well as any user-defined drop-down properties in your model.

To create an Index Page using Tabs based on Lookup Values:

1. Create a New Index Page with a List (Simple) layout
2. On the Object Type node, ensure you select 'Category' in the Selected Properties area
3. Right-click the Layout List (Simple) node and choose Add Behaviors > Navigation > Tabs on Lookup Values

   A Tabs on Lookup Values node is added below the Layout node.
4. Select the Tabs on Lookup Values node and enter the Scriptname of the drop-down property you want to refer to in the Filter Lookup field

   You can find the Scriptname in Model Explorer's Design View. The scriptname for the default Category drop-downs on objects is always 'TYPE'.

93
5. Use the following optional settings:
   - Use **Overview Chart** to specify that you want the first tab to be an Overview tab showing a Pie Chart summarizing the distribution of the values
   - Use **Not Display Undefined** to specify that the page should not include or display any objects that has a value of ‘Undefined’.

6. **Save** your Site.

   *Remember to add a Menu item for your new page.*
Filtering Data

Page Queries and Filters

This page explains how to use page queries and filters so that your pages only display objects that match certain conditions that you specify.

By default Index Pages, and Association Type nodes on Object Pages, list all the instances of the Object Type you specified - for example all Processes in your model.

However, you can create association queries and conditional filters which result in only a restricted list. For example, you might want an Index Page which shows a list of Processes, but you only want to see Processes of a certain Category, or that are associated to another object.

These queries and conditional filters can be applied to most Index Pages, as well as most Object Pages which use Association Type nodes to display Associated Objects.

There are two types of conditional filters that can be applied to the results to form a query:

1. Filters based on object properties
2. Filters based on associations.

Filter Operators

Text-string filters and select-list filters can be combined in a formula using filter operators. This allows for greater versatility when filtering objects.

The filter operators and their functions are listed below:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>equals</td>
<td>Matches to any values that are equal to the inputted value.</td>
</tr>
<tr>
<td>!=</td>
<td>does not equal</td>
<td>Matches to any values that are not equal to the inputted value.</td>
</tr>
<tr>
<td>&gt;</td>
<td>is greater than</td>
<td>Matches to any values that are greater than the inputted value.</td>
</tr>
<tr>
<td>&lt;</td>
<td>is less than</td>
<td>Matches to any values that are less than the inputted value.</td>
</tr>
<tr>
<td>&gt;=</td>
<td>is greater than or equal to</td>
<td>Matches to any values that are equal to or greater than the inputted value.</td>
</tr>
<tr>
<td>&lt;=</td>
<td>is less than or equal to</td>
<td>Matches to any values that are equal to or less than the inputted value.</td>
</tr>
<tr>
<td>IN</td>
<td>is within</td>
<td>Matches to any values that are one of the inputted list of values. Operates with List, Text and Numeric values.</td>
</tr>
</tbody>
</table>

Filter based on object properties
Filters based on object properties can be applied to any Layout or Behaviour on any Index Page or Association Type node on an Object Page.

These filters restrict the results based on one or more properties of the objects to be displayed.

You can add multiple property filters, which combine to form a single query where each condition must be met for the object to be included in the results, so for example:

\[
\text{Display all Processes where:} \\
\text{Category = 'X'} \\
\text{AND Validated = 'TRUE'}
\]

While individual conditions are joined with the AND operator in your complete filter query, when you add a condition referencing a Drop-down, ID or Single Line Text property, you can specify multiple values which are treated as OR within that particular condition. So, for example, you could create a filter query like:

\[
\text{Display all Processes where} \\
\text{Category = 'X' OR 'Y' OR 'Z'} \\
\text{AND Validated = 'TRUE'}
\]

**IMPORTANT:** You can only use OR conditions with the following standard property types: Name, Category, UUID, ID. User-defined property types are not supported.

In addition, you can only use one OR condition in a filter set.

**NOTE:** The OR operator is shown as 'IN' in the Evolve Designer interface.

### Add a property-based filter

**Filters based on association**

**IMPORTANT:** You can only use a filter based on association when you are not already using an Association Type node for any other purpose in your Index or Object Page.

In addition to property based filters, you can restrict the list of objects displayed on a page by way of association. This could be by association to any object of a specified type, or to a specific object or objects of a specified type.

For example, you could create a filter like:

\[
\text{Display all Processes where Category = 'X'} \\
\text{AND Process Is Associated To any Location.}
\]

You could extend the filter to reference a specific associated object, such as:

\[
\text{Display all Processes where Category = 'Y'} \\
\text{AND Process Is Associated To Location 'Z'.}
\]

You can even extend these basic examples to add multiple nested association conditions to filter the results by way of indirect association. For example:

\[
\text{Display all Processes where Process Is Associated To any Location} \\
\text{AND where Location Is Associated To Organization 'UK'.}
\]

Finally, you can of course add property-based filters to any association filter, enabling you to create sophisticated page queries such as:

Display all Applications where Date for Review > 'date' \\
AND Application Is Associated To an Organization
where Organization Category = 'X' OR 'Y'
AND Organization Is Associated To the Location 'US'

When filtering results by association on an Object Page, remember that the parent node will always be an Association, so the list you are filtering is a list of associated objects.

On an Object Page it is not possible to present a list of objects indirectly associated to the object that is the subject of the page. It is only possible to list objects that are indirectly associated to objects that are associated to the subject.

Add a filter based on association

Filters Properties

The following properties can be used to configure a filter:

<table>
<thead>
<tr>
<th>Name</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Rating</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td></td>
</tr>
<tr>
<td>Created By</td>
<td>Format: DD/MM/YYYY HH:MM:SS E.g.: 22/12/2015 14:34:42</td>
</tr>
<tr>
<td>Creation Date</td>
<td>Format: DD/MM/YYYYHH:MM:SS E.g.: 22/12/2015 14:34:42</td>
</tr>
<tr>
<td>Date Validated</td>
<td></td>
</tr>
<tr>
<td>Display Name</td>
<td></td>
</tr>
<tr>
<td>Freeze Level</td>
<td></td>
</tr>
<tr>
<td>Id</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Owner</td>
<td></td>
</tr>
<tr>
<td>Template</td>
<td></td>
</tr>
<tr>
<td>Total Comment</td>
<td></td>
</tr>
<tr>
<td>Unique Identifier</td>
<td></td>
</tr>
<tr>
<td>Updated By</td>
<td></td>
</tr>
<tr>
<td>Updated Date</td>
<td>Format: DD/YY/MMMM HH:MM:SS E.g.: 22/12/2015 14:34:42</td>
</tr>
<tr>
<td>Validated</td>
<td></td>
</tr>
</tbody>
</table>
Property Groups

Working with Property Groups

Property Groups are page elements that display the properties of the object in question. They are used on Index Pages, such as within an Accordion, or Table, or in Object Pages.

There are two ways you can enter Property Groups into your pages:

1. By using the Empty Group option
2. By using the From CM Panel option.

The Empty Group option creates one group within the page and then you can choose which of the object's properties to display within it - nothing is selected for you by default.

The From CM Panel option allows you to choose a group based on one of the Panes in the object's properties, such as General, and automatically selects all the properties within that Pane to be displayed in the group.

When inserting a Property Group, we recommend you only display a small number of properties in any particular group - your page will look much better if you restrict the number of properties in each one.

Property Group Layouts

When you insert a Property Group there is a Layout setting which determines how the content within the group is displayed.

Certain layouts only work with certain types of properties. Please use the Property Group Layout Table to see which layout to use when.

Property Groups and Tables

The Property Group feature is also used when configuring a Table to specify which properties you want to be displayed as columns in the Table. The details for using Property Groups in this way are included in the instructions for creating a Table. See Working with Tables for further information.

What do you want to do?

Insert a Property Group on an Object Page

If you use Tabs on your Object Page you can only insert a Property Group beneath a Tab node. If you do not use Tabs, you can insert the Property Group beneath the main Object Type node.

To insert a Property Group on an Object Page:
1. Expand the node for the Object Page you want to add the Property Group to.
2. Right-click the node (Tab or Object Type) you want to add the Property Group to and choose
   New Property Group > Empty Group, or New Property Group > From CM Panel > [Group Name]
   See the beginning of this page for explanations of each option.
3. Configure the Property Group settings:
   - Use **Property Group Name** to specify the name of the group as it is displayed in the web page.
   - The **Identifier** setting holds a unique identifier for the Property Group. You should have no reason to change this setting.
   - Use **Layout** to specify which layout to apply to your Property Group.
   See **Property Group Layouts** for explanations of each layout type.
   - Use **Selected Properties** to specify all the properties that will be displayed in the Property Group.

Remember, we recommend only using a small number of properties in any one group.

4. **Save** your Site.
   The Index Page's properties are saved.

**Insert a Property Group inside an Index Page Accordion**

To insert a Property Group inside an Index Page Accordion:

1. Expand the node for the Index Page you want to add the Property Group to.
2. Right-click the node that is two steps above the Accordion you want the Property Group to be displayed in and choose
   New Property Group > Empty Group, or New Property Group > From CM Panel > [Group Name]
   See the beginning of this page for explanations of each option
3. Configure the Property Group settings:
   - Use **Property Group Name** to specify the name of the group as it is displayed in the web page.
   - The **Identifier** setting holds a unique identifier for the Property Group. You should have no reason to change this setting.
   - Use **Layout** to specify which layout to apply to your Property Group.
   See **Property Group Layouts** for explanations of each layout type.
   - Use **Selected Properties** to specify all the properties that will be displayed in the Property Group.

Remember, we recommend only using a small number of properties in any one group.

4. **Save** your Site.
   The Index Page's properties are saved.
# Property Group Layouts

When you use Property Groups to display object properties within your Site Pages, you must choose a **Layout** to apply to the group.

The layout controls how the properties are displayed, but some layouts are only to be used with certain types of property.

The table below details each layout and in which case it should be used:

<table>
<thead>
<tr>
<th>Layout</th>
<th>Description</th>
<th>Used for</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>table</strong></td>
<td>This is the default layout which can be used with any type of property. Properties are displayed in a tabbed format with property name &gt; property value.</td>
<td>Any type of property, except multi-line text fields.</td>
</tr>
<tr>
<td><strong>FlatList</strong></td>
<td>The FlatList layout is especially useful on Diagram Popouts as it can be used to <strong>combine multiple properties</strong>, including multi-line texts, in one simple 'flat' layout.</td>
<td>Any type of property - especially on Diagram Popouts</td>
</tr>
<tr>
<td><strong>memotext</strong></td>
<td>This layout is especially for <strong>multi-line text properties</strong>, such as 'Description'. It is better at presenting potentially longer pieces of text than the standard table. The use of Enhanced Multi-line Text Control will enable the use of rich text formatting for HTML content.</td>
<td>Multi-line text fields with plain text content.</td>
</tr>
<tr>
<td><strong>htmlbox</strong></td>
<td>This layout is has been deprecated in version 3.0 and replaced with the Memotext Layout (above).</td>
<td>n/a</td>
</tr>
<tr>
<td><strong>helptext</strong></td>
<td>This layout allows users to proceed without selecting any properties. The Property Group Name can then be used to display help text</td>
<td>Displaying help text</td>
</tr>
<tr>
<td><strong>gauge</strong></td>
<td>The gauge layout displays a visual gauge on a scale of 0 to 100. The pointer represents the value of the property. This type of layout is especially useful for displaying percentages in a visual way.</td>
<td>Number fields where the value is between 0 and 100. Text fields which include just a number will also work.</td>
</tr>
<tr>
<td><strong>embedURL</strong></td>
<td>The embedURL layout creates a frame within your page that can open and display the target of a URL property - as long as it is properly formatted and starts with 'http://'. Therefore, if you have a URL property which contains a link to your corporate website, you can display the web site within the frame in your object page. If you want to use this layout in your Property Group, you can only use the group to reference one property. <strong>Note:</strong> In order for URLs to work in this way, the URL property on your object must be on its own Pane. See the CW Suite help for positioning Property Types on Panes. <strong>Note 2:</strong> You cannot edit the URL Property using the embedURL layout. To make a URL property editable in Evolve you must expose the property on another part of the Object Page. [<strong>Note 3:</strong>] You reference a PDF document, ensure that if you...</td>
<td>URL property types only.</td>
</tr>
<tr>
<td>Layout</td>
<td>Description</td>
<td>Used for</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>users are accessing your Site using Internet Explorer</td>
<td>that they have a PDF reader plugin installed.</td>
<td></td>
</tr>
<tr>
<td>image</td>
<td>The image layout is used to display properties that are image files, and result in the image being displayed in the web page. Images are not commonly used as properties.</td>
<td>Image property types only.</td>
</tr>
<tr>
<td>imageFromURL</td>
<td>The imageFromURL layout is used to display an image for an object which uses a Single-Line Text or URL Property Type to store an HTTP reference to an image file. If you want to use the imageFromURL layout in your Property Group, you can only use it to reference one property.</td>
<td>URL or Single-Line Text properties used to store HTTP references to an image file.</td>
</tr>
<tr>
<td>radar</td>
<td>The radar layout is used to create a chart that displays three or more Object properties on different axes which start from the same central point.</td>
<td>Number fields</td>
</tr>
</tbody>
</table>

**Property Group Name**

The property group name is displayed in the title bar of the property group. In the case of options such as 'embeddedURL' or 'imageFromURL' the default title is the full URL.

Since Evolve 2016.1.1 the ability to use a 'Custom Display String' means it is now possible to use any text, or property variables in this display.

For example: The default use of an embeddedURL may look like this:

![Embedded URL Example](https://help.cosmelix.com/evolve/2016-1/docs/Evolve-Release-Notes.pdf)

However the URL is seldom a useful attribute. So using the 'Custom Display String' to display some simple text, and optionally a variable (e.g. Name), it is possible to adjust the configuration like this:
Data Visualizations

Visualizing Data in Evolve

There are a number of ways you can use Evolve to visualize the data in your model.

- Use Diagram Designer visualizations
- Use dedicated behaviors like Pie Charts, Bubble Charts, Bar Charts, Roadmaps, Cost-Benefit Charts and Vector Maps
- Use Visual Indicators

These features each offer different ways of allowing you to present your data in a visual way, from giving high-level dashboard views, to exposing the details behind individual objects.
Working with Pie Charts based on Lookup Values

Pie Chart based on Lookup Values gives you a **percentage view** of the number of objects of a specified Object Type that are set to the different values for a specified Lookup (drop-down) property, such as **Category**.

It creates the same pie chart as the one displayed on the optional Overview Chart created by the **Tabs based on Lookup Values** behavior.

**To create an Index Page using Pie Chart based on Lookup Values:**

1. Create a **new Index Page**
2. Right-click the **Layout** node and choose **Switch Layout > CW > Empty**
3. On the Object Type node, ensure you select 'Category' in the **Selected Properties** area
4. Right-click the **Layout Empty** node and choose **Add Behaviors > Pie Charts > Pie Chart (On Lookup Value)**
   
   *A Pie Chart (On Lookup Value) node is added below the Layout node.*

5. Select the **Pie Chart (On Lookup Values)** node and enter the Scriptname of the drop-down property you want to refer to in the **Group By** field.

   *You can find the Scriptname in Model Explorer's Design View. The Scriptname for the default Category drop-downs on objects is always 'type'. Scriptnames must always be entered in lower case.*

6. **Save** your Site.

   *Remember to add a Menu item for your new page.*
Working with Recursive Pie Charts

Unlike the standard Pie Chart based on Lookup Value which shows you the break-up of objects based on a drop-down property, the Recursive Pie Chart allows you to show a top-level chart which sums the values of properties of Associated Objects (or Intersection Objects), and then allows users to click those items to view a second chart showing all the objects associated to the selected object.

You can include multiple levels of associations in one chart, so users can drill down from one to another.

The Recursive Pie Chart requires at least one Association Type to work, as well as a Whole Number or Decimal Number property on the Associated Object - or Intersection Object.

Why and how should you use one?

You should use a Recursive Pie Chart when you want to get an overview of some underlying data by way of an Association. Think of it as a visual representation of the sum of a numeric property on associated objects.

For example, you have some Technology objects, each with a Cost property, and in your model, Technologies are associated to Organization objects which are used to represent Departments in your business.

In this example you could use the Recursive Pie Chart to show Technology Cost per Department. The chart is configured to show Organization objects - but the size of each piece is based on the total (summed) Cost of the Technology objects associated to each one.

While the above example examines one level of association, you can extend this basic functionality to include more steps, by adding additional Association Types, allowing you to visualize the data of objects Indirectly Associated to the higher-level objects. The result is to have more click-through pie charts, one focusing on a different Object Type in the chain.

For example, if your Organization owns a number of different companies, your data could consist of:

- Company objects used to define companies in the group
- Country objects used to define countries where you have offices
- Department objects used to define departments within the company
- Technology objects used to define server machines.

The Technology objects have a Cost property to specify the running costs per year for each machine.
Your model has Association Types linking these Object Types together - in the following path: **Company > Country > Department > Technology**

You could then use a Recursive Pie Chart to show the summed costs of server machines (Technologies) per **Company**, then after clicking through by Country, and then by Department, in one interactive chart.

See Use multiple Association Types to visualize Indirect Associations below for details.

You can sum properties of the Intersection Object instead of the Associated Object if you wish.

**Where and when can you use one?**

Use the table below to see where you can use a Recursive Pie Chart:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Parent node</th>
<th>Tabs</th>
<th>Number on page</th>
<th>Editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Page</td>
<td>Object Type node</td>
<td>Yes - optional</td>
<td>1 or more</td>
<td>No</td>
</tr>
<tr>
<td>Object Page</td>
<td>Association Type node</td>
<td>Yes - mandatory</td>
<td>1 or more</td>
<td>No</td>
</tr>
</tbody>
</table>

**What would you like to do?**

**Add a Recursive Pie Chart to your page**

These instructions lead you to create a basic Recursive Pie Chart, which results in a pie chart showing instances of the first object, sized by the sum of a property of the associated objects, then a second pie chart users can drill down to which shows instances of the associated objects for just one of the top-level objects.

By following these instructions you could create the Organization to Technology (Cost) example described above.

The parent node mentioned in the instructions is the Object Type node for an Index Page - optionally within a Tab - or is the Association Type node within a Tab on an Object Page.

1. Select the **parent node** - Object Type node for Index Pages, Association Type node for Object Pages - and use the **Filter Properties** area to apply any filtering
2. Switch the **Layout** node beneath the parent node to **Empty**
   
   To do this: Right-click the Layout node and choose Switch Layout > CW > Empty

3. Add the **Recursive Pie Chart** behavior to the **Layout** node
   
   To do this: Right-click the Layout node and choose Add Behaviors > Pie Charts > Pie Chart (Recursive)

   A Pie Chart (Recursive) node is added

4. Add an Association to the parent node - choosing the Associated Object Type which has the property you want to sum
   
   To do this: Right-click the parent node and choose New Association > [object-type] > [association-type]

   A new Association Type node is added

5. Select the **Association Type** node and in the **Selected Properties** area, tick the property you want to sum on the chart

6. Select the **Pie Chart (Recursive)** node and configure the following settings:
Use the **Node Name** to set the name of the node as it appears in the tree - you only need to edit this if you are using multiple Recursive Pie Charts

- Use **Leaf Object Type Scriptname** to specify the Scriptname of the Associated Object Type - for example, 'technology'

- *Always use lower case when referring to Scriptnames*

- Use **Property Scriptname to Sum** to enter the Scriptname of the property on the Associated Object you want to sum

- Use the **Where is the Property to sum** drop-down to choose whether you want to sum a property of the Associated Object, or a property of the Intersection Object

*See the separate instructions below for more details on using the Intersection Object.*

- Use **Property Unit** to specify the text to be displayed on the chart for the sum value

- Use **Intersection Object Type Scriptname** to specify the Scriptname of the Associated Object Type

> *Use the same Scriptname as for the Leaf Object Type Scriptname*

7. **Save** your Site.

**Use a property of the Intersection Object for the sum**

You can configure your Recursive Pie Chart to **sum the values of Intersection Objects** rather than values of the Associated Objects themselves.

> *Just as with values for Associated Objects, the properties must be Whole Number or Decimal Number.*

**The instructions for creating a Recursive Pie Chart in this way is exactly the same as for referencing an Associated Object, with the following exceptions:**

1. Set the **Where is the Property to sum** drop-down to 'On the intersection before'

2. Use **Property Scriptname to Sum** to enter the Scriptname of the property on the Intersection Object you want to sum

3. Use **Intersection Object Type Scriptname** to specify the Scriptname of the Intersection Object Type.

**Use multiple Association Types to visualize Indirect Associations**

**If you want to add more steps in your Recursive Pie Chart using multiple levels of associations, you should follow the points below:**

- Nest additional Association Type nodes beneath each other - add the next Association Type by right-clicking on the Association Type node you want to nest beneath

- On the Recursive Pie Chart node the settings should reference the object at the end of the chain - in the example case, the Technology.
Working with Roadmap Gantt Charts

Roadmaps require two Date/Time properties on your object to store the Start and End date of each item you want to display.

A Roadmap is a type of Gantt Chart that enables you to show a number of objects and their start and end dates. For example, you could have a Project object, which has Start Date and End Date properties. On your Roadmap you could show all the Projects associated to a specific Department and what their start dates and end dates are, viewing any overlaps or gaps.

You can optionally display Categories like a menu in the web page which allows users to filter the list dynamically when viewing the page.

You can use Roadmaps as the main element on Index Pages, or beneath an Association Type node on Object Pages.

What do you want to do?

Create a new Roadmap Gantt Chart for your page

These instructions assume that you have already created your page, including any filtering you may want so that only the objects you want displayed are shown.

To create a new Roadmap Gantt Chart for your page:

1. Ensure the Layout node for your element is set to Empty
   For an Index Page the Layout node is the one directly under the Object Type node.
   For an Object Page the Layout node is the one directly under the Association Type node
2. Right-click the Layout node and choose Add Behaviors > Gantt Charts > Gantt Chart (Roadmap)
   A Gantt Chart (Roadmap) node is added below the Layout node
3. Select the Gantt Chart (Roadmap) node and set the properties

   Use lower case to enter Scriptnames.

   i. Use the Start Date field to enter the Scriptname of the property used to store the start date
   ii. Use the End Date field to enter the Scriptname of the property used to store the end date
   iii. Use the Filter Lookup Property field to enter the Scriptname of a drop-down property that you want displayed like a menu in the web page so that users can click to filter the displayed list of objects in the Roadmap
4. Select the Object Type node and use the **Selected Properties** area to select all the properties you referenced at step 3 - that is the **Start Date** and **End Date** properties, as well as the **Category**.

5. **Save** your Site.

    *The Site is saved and the Roadmap Gantt Chart is created.*
Working with Lifecycle Roadmaps

A Lifecycle Roadmap is a type of Gantt chart that enables you to show a number of objects, displaying their overall time frame, as well as highlighting in different colors the phases involved in their lifecycle.

You can display any number of phases in your lifecycle.

When you use a Lifecycle Roadmap you can also show the names of each of the phases in a color-coded legend so users can understand the chart.

You can use Lifecycle Roadmaps as the main element on Index Pages only.

Lifecycle Roadmaps require that you have a total of Date/Time properties on your object to represent the Start dates of each phase in the cycle, and an additional Date/Time property is required to store the End date of the final phase.

Why and how should you use one?

Use a Lifecycle Roadmap when you want to view the lifespan of an object, such as a Project, but you also want to see the breakdown of phases within the overall timeframe.

For example, you could have a Technology object representing a server, which has four lifecycle phases: Development, Testing, Active, and Retirement. Each stage has a corresponding Date/Time property to represent the start date of the phase, and the final phase also has a corresponding end date property.

Where and when can you use one?

Use the table below to see where you can use a Recursive Pie Chart:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Parent node</th>
<th>Tabs</th>
<th>Number on page</th>
<th>Editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Page</td>
<td>Object Type node</td>
<td>Yes - optional</td>
<td>1</td>
<td>No</td>
</tr>
<tr>
<td>Object Page</td>
<td>Association Type node</td>
<td>Yes - mandatory</td>
<td>1</td>
<td>No</td>
</tr>
</tbody>
</table>

What do you want to do?

Create a new Lifecycle Roadmap for your page

These instructions assume that you have already created your page, including any filtering you may want so that only the objects you want displayed are shown.

To create a new Lifecycle Roadmap for your page:
1. Use the **Selected Properties** area on your Object Type node to select all the properties you want to reference on the roadmap.

2. Ensure the **Layout** node for your element is set to **Empty**
   - For an Index Page the Layout node is the one directly under the Object Type node.
   - For an Object Page the Layout node is the one directly under the Association Type node.

3. Right-click the Layout node and choose Add Behaviors > Roadmap Lifecycle
   - A Roadmap Lifecycle node is added below the Layout node.

4. Select the **Roadmap Lifecycle** node and set the properties:

   **Use lower case to enter Scriptnames.**

   i. Use the **Dates** field to enter a comma-separated list representing the **start dates** of all the phases in your roadmap, as well as the **end date** of the final phase.
   
   *Enter the Scriptnames of the start date properties for each of the phases in the lifecycle, followed by the Scriptname of the end date property of the final phase.*
   
   *For example: astart,bstart,cstart,dstart,dend* 

   ii. In the **Steps** field enter the **names** of each of the four phases as you want them to be displayed in the web page, separating them with a comma.
   
   *Example: ‘Development,Testing,Active,Retirement’*

5. **Save** your Site.

   *The Site is saved and the Lifecycle Roadmap is created.*
Working with Cost/Benefit Charts

A Cost/Benefit Chart enables you to compare properties you class as Costs in your organization against properties you class as Benefits.

The result is a type of color-coded bar chart which highlights the costs and benefits, as well as a calculated cost/benefit value.

There is no limit to the number of cost and benefit properties you use, but obviously the more you do use, the more unusable the chart will become.

Cost/Benefit Charts require that you have Whole Number or Decimal Number properties for your Costs, and either Whole Number, Decimal Number of Drop-down properties for your benefits.

If you do use Drop-down properties for benefits, these should include a number, such as:

1 - Low
2 - Medium
3 - High

You can have multiple costs and multiple benefits on one chart.

Why and how should you use one?

An example of using a Cost/Benefit Chart might be to show the business benefit of expenditure on software applications.

A number property could be used to store the actual monetary cost of the application in your organization, while a drop-down could be used to assign the importance of the application to the business - from 1 to 10.

Using the chart, you would then be able to get an overview as to whether you were spending a lot of money on applications that have little business value.
Where and when can you use one?

Use the table below to see where you can use a Cost/Benefit Chart:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Parent node</th>
<th>Tabs</th>
<th>Number on page</th>
<th>Editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Page</td>
<td>Object Type node</td>
<td>Yes - optional</td>
<td>1</td>
<td>The Chart must be the top-most item on the page</td>
</tr>
</tbody>
</table>

What do you want to do?

Create a new Cost/Benefit Chart

To create a new Cost/Benefit Chart for your page:

1. Ensure the Layout node for your element is set to Empty
2. Right-click the Layout node and choose Add Behaviors > Other Charts > Cost - Benefit Chart
   A Cost-Benefit Chart node is added below the Layout node.
3. Select the Cost-Benefit Chart node and set the properties.
   i. In the Costs area, select the properties you want to use as costs on the chart.
   ii. In the Benefits area, select the properties you want to use as benefits on the chart.
   iii. Use the Multiplier field to enter the multiplier number for equalizing calculations.
   Costs tend to have higher values than those you assign to determine benefits such as business importance. For example a cost might be 10,000, but the business importance might be 3 - High.
   The Multiplier can be used to set a value to multiply the benefits by so they can be brought into line with the costs for comparison.
4. Right-click the Object Type node and choose to add a New Property Group
   Use New Property Group > Empty Group or From CM Panel depending on your preference.
   See Working with Property Groups for more details on Property Groups.
5. Select the Property Group and use the Selected Properties area to choose all the cost and benefit properties you want to reference on the chart
6. Save your Site.
   The Site is saved and the Cost/Benefit Chart is created.
Working with Vector Maps

Vector Maps require that you have a specific Single Line Text property on your object which is used to store a country code value, or a latitude/longitude value. The map will not work without one of these codes.

Vector Maps enable you to highlight countries or places on a map so that the user can click through to see more detailed information about that area.

You can use them on an Index Page, or on an Object Page to show locations that are associated to the main object. It works by using a single object in your model to represent an area on the map - either a country, or a place within a country - that area is highlighted and is clickable so that a supporting Object Page can be used to show additional information.

Example

Use Location objects to highlight each country where your organization has an office, and then use an Object Page for the Location to show detailed information about each one, such as which Functions (associated) are performed there.

There are two types of map available, each with several different built-in maps available:

- **Worldwide maps (used to show countries):** World, Europe
- **Country maps (used to show places):** Belgium, France, India, Italy, Netherlands, Philippines, South Africa, United Kingdom, United States.

If you want to view another map not currently on the list, please review this list of available maps, then raise a request with your Account Manager or with the erwin Support Team.

**Highlighting countries on Worldwide maps**

When using Worldwide maps, you must have a user-defined property on the object to store the country code. This must be a Single-Line Text property.

The country code is a two-letter code which adheres to the ISO 3166-1 standard, such as GB, US, FR. Read more about ISO 3166 here, or here on Wikipedia.

**Highlighting places on Country maps**

When using Country maps, you must have a user-defined property on the object to store the latitude and longitude reference for the place you want to show. This must be a Single-Line Text property.

The format for the value is `[latitude],[longitude]` - such as 48.856614,2.352222 for Paris.

- **Latitude values can be either North (N) or South (S), while Longitude values are either East (E) or West (W).**

  When entering these values in Evolve, please use a plus sign `+` instead of N and E, and use a minus sign `-` instead of S and W.

**What do you want to do?**
Create a new Vector Map for your page

These instructions assume that you have already created your page, including any filtering you may want so that only the objects you want displayed are shown.

To create a new Vector Map for your page:

1. Ensure the Layout node for your element is set to List (Simple)
   For an Index Page the Layout node is the one directly under the Object Type node.
   For an Object Page the Layout node is the one directly under the Association Type node
2. Right-click the Layout node and choose Add Behaviors > Maps > World Map (jVectorMap)
   A World Map (jVectorMap) node is added below the Layout node
3. Select the World Map (jVectorMap) node and set the properties:
   i. Use the Map drop-down to select the map you want to use
   ii. If you are using a Country Map to show places in a country, use the Lat Lang field to enter the Scriptname of the Property Type used to store the latitude/longitude value
   iii. If you are using a Worldwide Map to show countries, use the ISO Code field to enter the Scriptname of the Property Type used to store the ISO value
      Always use lower case for Scriptnames.
4. Save your Site.
   The Site is saved and the map is created.
Working with Bar Charts (Simple)

The Simple Bar Chart behavior requires that you have a specific Whole Number or Decimal Number property on your object which is used to store the value you want displayed on the chart.

The Simple Bar Chart behavior displays a simple bar chart on your Index Page, listing objects on the y axis and referencing number properties on the x axis.

You can specify the maximum number of objects to display.

To create a Simple Bar Chart display on your Index Page:

1. Ensure the Layout node for your element is set to Layout (Empty)
2. Right-click the Layout node and choose Add Behaviors > Bar Charts > Bar Chart (Simple)
   A Bar Chart (Simple) node is added below the Layout node.
3. Select the Bar Chart (Simple) node and set the properties:
   i. Use the Node Name field to set the title of the chart as it is displayed in the web page.
   ii. Use the Unit field to enter the name of the unit that is displayed on the x axis.
   iii. Use the Limit Number field to enter the maximum number of objects to display in the chart.

The name displayed on the legend at the top of the bar chart is taken from the Name of the Property Type you are using on the x axis.

4. Right-click the Object Type node and choose New Property Group > Empty Group
   An Empty Property Group is added below the Object Type node
5. Select the Property Group and in the Selected Properties area, select the property you want to base the bar chart on
6. Save your Site.

The Site is saved and the bar chart is created.
Working with Multi-Axis Bar Charts

The Multi-Axis Bar Chart behavior requires that you have a two specific Whole Number or Decimal Number properties on your object which are used to store the values you want displayed on the chart.

The Multi-Axis Bar Chart behavior displays a simple bar chart on your Index Page, which compares the values of two properties of the objects referenced.

The chart has two scales, one for each property shown.

To create a Multi-Axis Bar Chart on your Index Page:

1. On the Object Type node, in the Selected Properties area, select the two properties you want to be referenced on the chart.
2. Ensure the Layout node for your element is set to List (Empty)
3. Right-click the Layout node and choose Add Behaviors > Bar Charts > Bar Chart (Multi-Axis)
   - A Bar Chart (Multi-Axis) node is added below the Layout node
4. Select the Bar Chart (Multi-Axis) node and set the properties:
   - i. Use the Node Name field to set the title of the chart as it is displayed in the web page.
   - ii. Use the Value Axis-1 field to enter the Scriptname of the first property you want to be displayed.
   - iii. Use the Value Axis-2 field to enter the Scriptname of the second property you want to be displayed.
   - iv. Use the Axis-1 Unit field to enter the name of the unit that is displayed for the first property.
   - v. Use the Axis-2 Unit field to enter the name of the unit that is displayed for the second property.

The name displayed on the legend at the top of the bar chart is taken from the Name of the Property Types you are referencing.

vi. Use the Direction drop-down to choose whether you want the chart to be displayed horizontally or vertically

vii. Use the Legends Min/Max/Step field to specify the scale of each axis, setting the low end of the scale, the top end of the scale and the interval value - using for format low:high:int,low:high:int

   For example 0:100:10,0:500:100 means that Axis 1 starts at zero and ends at 100 with steps of 10 units, while Axis 2 starts at zero, ends at 500 and has steps of 100.

viii. Use the Hide Empty Data check box to specify that the chart should not display any objects where the two properties referenced have no value.
5. **Save** your Site.

*The Site is saved and the chart is created.*
Working with Simple Bubble Charts

A Simple Bubble Charts allow you to compare objects of the same type, by analyzing three levels of data and using the values to affect the size and position of the representations on the chart.

One value is used to position the bubble on the X-axis, another value is used to position the bubble on the Y-axis, while the size of the bubble is based on the third property.

With its accompanying Data Quality Chart, it also enables you to see where your data is incomplete, by highlighting objects that do not have values set for the properties you are referencing.

If you want to use a Bubble Chart that visualizes data from associated or indirectly associated objects, see Working with Cluster Bubble Charts.

The Simple Bubble Chart requires three properties to compare - and these must all be either Whole Number or Decimal Number properties - or they can be Drop-Down properties where the Abbreviation contains a number.

Why and how should you use one?

You should use a Simple Bubble Chart when you want to visualize a comparison between objects based on three properties.

A typical example would be to have some Application objects with three useful properties:

1. **Cost** - a Whole Number property to represent the monetary cost of the application
2. **Business Alignment** - a Drop-Down property ranging from '0 - Unknown' to '5 - Very High', which represents how important the application is to the business
3. **IT Alignment** - a Drop-Down property with the same range as Business Alignment, which represents how well aligned the application is to your current IT infrastructure, support and competencies

In this example the **IT Alignment is used as the X-axis**, the **Business Alignment is the Y-axis**, and the **size of each bubble is based on the Cost**.

Where and when can you use one?

Use the table below to see where you can use a Simple Bubble Chart:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Parent node</th>
<th>Tabs</th>
<th>Number on page</th>
<th>Editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Page</td>
<td>Object Type node</td>
<td>The chart must be in a Tab, but there can only be one Tab</td>
<td>The Bubble Chart must be the only item on the page</td>
<td>No</td>
</tr>
</tbody>
</table>
What would you like to do?

Add a Simple Bubble Chart to your page

These instructions assume you have an Index Page node, containing a Tab Controller with one Tab that includes an Object Type node.

The result will be an Index Page including two Tabs, one which you created and named yourself and that holds the Bubble Chart, and the second which is automatically created and is used for the Data Quality Chart.

1. Select the Object Type node and ensure all the properties you want to reference are selected in the Selected Properties area.

2. If you want to filter the list of objects displayed, use the Filter Properties area to apply any filtering.

3. Switch the Layout node beneath the Object Type node to Empty

   To do this: Right-click the Layout node and choose Switch Layout > CW > Empty

4. Add the Bubble Chart (Simple) behavior to the Layout node

   To do this: Right-click the Layout node and choose Add Behaviors > Bubble Charts > Bubble Chart (Simple)

   A Dashboard Bubble Chart node is added

5. Select the Bubble Chart (Simple) node and configure the following settings:

   - Use the Node Name to set the title of the chart as it appears in the web page
   - Use Circle to specify the Scriptname of the property you want to use to affect the size of the bubble
     Always use lower case when referring to Scriptnames
   - Use X to enter the Scriptname of the property you want to use on the X-axis
   - Use Y to enter the Scriptname of the property you want to use on the Y-axis
   - Use the three Data Quality settings to choose whether the corresponding properties are Drop-Downs (Lookups) or number properties
     Choose 'Lookup_Abbreviation_Not_o’ if the property is a Drop-Down
     Choose 'Not_Equal_To_o’ if the property is a number
   - Use Circle Unit to specify the text to be displayed on the chart for the bubble size value
   - Use X Unit to specify the text to be displayed on the X-axis - leave blank to use the Property Type Name
   - Use Y Unit to specify the text to be displayed on the Y-axis - leave blank to use the Property Type Name
   - Use Circle Intersection Object Type to specify the Scriptname of the Object Type used on the Object Type node

6. Save your Site.
Working with Cluster Bubble Charts

Cluster Bubble Charts are similar to Simple Bubble Charts, except they allow you to visualize the properties of an Associated Object (directly or indirectly), or an Intersection Object.

You can analyze three levels of data of the Associated Objects, using the values to affect the size and position of the representations on the chart.

One value is used to position the bubble on the X-axis, another value is used to position the bubble on the Y-axis, while the size of the bubble is based on the third property.

The way the Cluster Bubble Chart evaluates Associated or Indirectly Associated Objects is very similar to the way Recursive Pie Charts work, however, instead of creating one chart that you can drill down through, it creates a number of Tabs, one for each of the items in the top-level Object List, and then creates a Bubble Chart on each one.

The Cluster Bubble Chart does not display a Data Quality Chart like the Simple Bubble Chart does.

The Cluster Bubble Chart requires at least one Association Type to exist - plus three properties on the Associated Object to compare.

These properties must all be either Whole Number or Decimal Number properties - or they can be Drop-Down properties where the Abbreviation contains a number.

Why and how should you use one?

You should use a Cluster Bubble Chart when you want to visualize a comparison between objects based on three properties - but you want to take a higher-level view by using one or more associations.

A typical example would be like the example for Simple Bubble Charts, to have some Application objects with three useful properties:

1. Cost - a Whole Number property to represent the monetary cost of the application
2. Business Alignment - a Drop-Down property ranging from '0 - Unknown' to '5 - Very High', which represents how important the application is to the business
3. IT Alignment - a Drop-Down property with the same range as Business Alignment, which represents how well aligned the application is to your current IT infrastructure, support and competencies

In this example the IT Alignment is used as the X-axis, the Business Alignment is the Y-axis, and the size of each bubble is based on the Cost.

However, where this differs from the Simple Bubble Chart is that instead of having one chart showing all the objects, your Applications are associated to different Location objects and you want to see a chart for each Location showing only the Applications associated to it.

The result is a Tab for each Location object and then a Bubble Chart for each showing just its associated Applications.
While this example shows one level of association, you could make your chart use several, such as Location > Organization > Application, or more.

Where and when can you use one?

Use the table below to see where you can use a Cluster Bubble Chart:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Parent node</th>
<th>Tabs</th>
<th>Number on page</th>
<th>Editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Page</td>
<td>Object Type node</td>
<td>You must have an empty Tab Controller on the page</td>
<td>The Bubble Chart must be the only item on the page</td>
<td>No</td>
</tr>
</tbody>
</table>

What would you like to do?

Add a Cluster Bubble Chart to your page

1. Create a new empty Index Page with an empty Tab Controller and an Object Type, both added to the Index Page node, in that order
   See Create an Empty Index Page for instructions
2. Select the Object Type node and use the Filter Properties area to apply any filtering
3. Switch the Layout node beneath the Object Type node to Empty
   To do this: Right-click the Layout node and choose Switch Layout > CW > Empty
4. Add the Bubble Chart (Cluster) behavior to the Layout node
   To do this: Right-click the Layout node and choose Add Behaviors > Bubble Charts > Bubble Chart (Cluster).
   A Bubble Chart (Cluster) node is added.
5. Add an Association node to the Object Type node
   To do this: Right-click the Object Type node and choose New Association > [object-type] > [association-type]
   A new Association Type node is added.

   If your chart examines indirectly associated objects, add all the additional Association Types required, nesting them beneath each other
   The last Association node you add is for the Object Type you want the bubbles on the chart to represent.

6. Select the Bubble Chart (Cluster) node and configure the following settings:
   ○ Use the Node Name to set the title of the chart as it appears in the web page
   ○ Use Circle to specify the Scriptname of the property you want to use to affect the size of the bubble
     This should be from the Associated Object - or, if you are referencing an Indirect Association, from the last Associated Object in the path.

   Always use lower case when referring to Scriptnames.
- Use **X** to enter the Scriptname of the property you want to use on the X-axis.
- Use **Y** to enter the Scriptname of the property you want to use on the Y-axis.
- Use the three **Data Quality** settings to choose whether the corresponding properties are Drop-Downs (Lookups) or number properties.

*Choose 'Lookup_Abbreviation_Not_o' if the property is a Drop-Down*

*Choose 'Not_Equal_To_o' if the property is a number*

- Use **Circle Unit** to specify the text to be displayed on the chart for the bubble size value
- Use **X Unit** to specify the text to be displayed on the X-axis - leave blank to use the Property Type Name
- Use **Y Unit** to specify the text to be displayed on the Y-axis - leave blank to use the Property Type Name
- Use **Circle Intersection Object Type** to specify the Scriptname of the Associated Object Type

7. **Save** your Site.
Working with Radar Layout

A Radar layout is used to create a chart that displays three or more* Object properties on different axes which start from the same central point.

A simple Radar chart uses one line to display the different properties of a single object (a Property Group).

The Radar layout can also overlay multiple lines into a single chart to display the various properties of an Object List. Each line is used to represent a different Object.

With the Radar layout, you can use one chart to visually consolidate multiple values of a single object, or multiple values of many objects, against one another.

*We recommend that 3-10 properties or values are used per Object for clarity purposes.

Why and how should you use one?

Use the Radar layout when you want to visually compare the different properties of a single object, or of many objects, against each other.

You can use radar layout list in an index page or a single page. To do this, add an index page (or add a "New Association" for single pages).

Next, add a properties group and under “Selected Properties”, tick the properties that you wish to display in the radar layout. Please note that only integer properties (i.e numbers) can be represented in radar layout.

Where and when can you use one?

Use the table below to see where you can use the Radar Layout:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Parent node</th>
<th>Tabs</th>
<th>Number on page</th>
<th>Editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Page</td>
<td>Object Type node</td>
<td>Yes - optional</td>
<td>Any</td>
<td>No</td>
</tr>
<tr>
<td>Object Page</td>
<td>Association Type node</td>
<td>Yes - mandatory</td>
<td>Any</td>
<td>No</td>
</tr>
</tbody>
</table>

What do you want to do?

Use a Radar Layout

To create a Radar layout for the properties of a single object:

This is either the Object Type Node on an Index Page or an Association Type Node on an Object Page.

Selection is only applicable for integer Properties as Radar Layout requires that only integer values are used to create charts. Decimal numbers are permitted, however.
1. In Evolve Designer, locate the Parent Node that you want your Radar Layout to be applied to.
2. From the Layout drop-down menu, select Radar.
3. In the Selected Properties area of the Parent Node, select all the properties that you want to display in the Radar.
4. Save and Publish your Site.
5. Navigate to the appropriate Object or Index Page on your Site, and the Radar chart will be displayed.

To create a Radar layout for the properties of many objects:

This is either the Object Type Node on an Index Page or an Association Type Node on an Object Page.

Choose Switch Layout > CW > Radar.

1. In Evolve Designer, locate the Parent Node that you want your Radar Layout to be applied to.
2. Right-click beneath the Parent Node Layout to change the Layout to Radar:
3. In the Selected Properties area of the Parent Node, select all the properties that you want to display in the Radar.
4. Save and Publish your Site.
5. Navigate to the appropriate Object or Index Page on your Site, and the Radar chart will be displayed.
When inserting a Property Group, we recommend you only display a small number of properties in any particular group - your page will look much better if you restrict the number of properties in each one.
Working with the Visual Identity Layout

The Visual Identity layout is used to show a list of objects with Visual Indicators to represent some of their properties, rather like you can with Shape Regions in CW Modeler.

The layout displays each object as a rectangle, and then at the bottom of each shape you can show icons to represent the values of one or more properties of your object.

It means you can build a dashboard-like page for a set of objects, highlighting important data about each one, for example, showing a red circle if an object has a Business Risk of ‘3 - High’ or a green circle if it has a Business Risk of ‘1 - Low’, and so on.

As for all Visual Indicators, the Visual Identity layout only supports lookup (drop-down) and check box (true or false) properties of your objects.

In order to use the Visual Identity layout you must have configured a Custom Site to support the use of Visual Indicators.

Why and how should you use one?

Use the Visual Identity layout when you want to create a dashboard-like view of a set of objects or associated objects, highlighting some of the important data about the objects displayed.

For example you could use the layout to provide an overview of the state of a set of Server objects, using the indicators to show high-level data about each server.

Where and when can you use one?

Use the table below to see where you can use the Visual Identity layout:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Parent node</th>
<th>Tabs</th>
<th>Number on page</th>
<th>Editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Page</td>
<td>Object Type node</td>
<td>Yes - optional</td>
<td>One, or one per Tab</td>
<td>No</td>
</tr>
<tr>
<td>Object Page</td>
<td>Association Type node</td>
<td>Yes - mandatory</td>
<td>One per Tab</td>
<td>No</td>
</tr>
</tbody>
</table>

Use the Visual Identity layout

These instructions assume you have already configured your Custom Site to support the use of Visual Indicators for the Object Types and Property Types you want to reference.

To use the Visual Identity layout:

1. In Evolve Designer, locate the parent node you want your Visual Identity layout to be applied to

   This is either the Object Type node on an Index Page or an Association Type node on an Object Page

2. In the Selected Properties area of the parent node, select all the properties you want to use as visual indicators

3. Switch the Layout of the node to Visual Identity

127
Right-click the layout beneath the parent node and choose Switch Layout > CW > Visual Identity

4. Select the **Layout Visual Identity** node

5. In the **Properties List** field, enter the Scriptname of the Property Type you want to be used as an indicator

   You can reference multiple Property Types by entering the Scriptnames of each, separated using commas

6. **Save** and **Publish your Site.**
Working with Visual Indicators

Visual Indicators are small icons or images that are displayed to represent the values of properties of your objects, rather like you can with Shape Regions in CW Modeler.

It means you could use a series of colored discs to represent Categories of an object, or tick and cross icons to show whether a value is true or false.

They can be used with the Visual Identity layout, and with Custom Display Strings.

In order to use Visual Indicators though, you must deploy your site as a Custom Site, as the images you want to use as your indicators must be stored on the Evolve server and deployed with your Site when you publish it.

Visual Indicators can only work with lookup (drop-down) and boolean (true or false) properties of your objects.

Configure your Custom Site to support the use of Visual Indicators

To use Visual Indicators on your Site, you must place image files in the correct location in a Custom Site folder, and make sure they have the correct file names.

Folders

For each Object Type you want to use a Visual Indicator with, create a directory with the name as the Scriptname of the Object Type in your Custom Site 'images' folder.

For example

<your-custom-site-folder>/images/image_mappings/application
<your-custom-site-folder>/images/image_mappings/process

Inside each Object Type folder, you must create additional folders for each Property Type you want to use as an indicator, again named according to the Scriptname of the Property Type.

For example

<your-custom-site-folder>/images/image_mappings/application/validated
<your-custom-site-folder>/images/image_mappings/application/type

Files

In each Property Type folder, you should place image files for each of the possible values that can be set.

Files should be named as follows:

- Use 'true' or 'false' for boolean Property Types
- Use the Abbreviation for lookup (drop-down) Property Types.

If you want to show an indicator for the 'Undefined' value for a lookup, create an image named 'undefined'.


Evolve supports PNG, JPEG and GIF for the images, but as images look best when they use a transparent background, we recommend using PNG files.

In the Site the images are re-sized to be displayed at 16x16 pixels, so we recommend creating square images that will not be skewed when re-sized. For optimization reasons, we recommend creating images that are already 16x16 pixels.
Working with External Pictures

An **External Picture** layout is used to show a picture for each object in a list, and works by using a property on your objects to reference images on the Evolve server.

An **External Picture** layout is used to show a picture for each object in a list, and works by using a property on your objects to reference images on the Evolve server.

It is similar to the **Image** layout, except it is much better suited to displaying smaller images.

For example, you could have a number of 'Product' objects, each one with a 'logo' property. If you upload an image for each product to your Evolve server, you can enter the image name in the 'logo' property for each product, and using the External Picture layout, display that logo on an Index Page or Object Page (if listing Associated Objects).

In order to use the External Picture layout, you must have a Property Type on your object which can be used to **store the image file reference**. This must be a **Single-Line Text** property.

Note the scriptname of this Property Type.

The External Picture layout also requires you publish your Site as a **Custom Site**, and image files must be uploaded to your Evolve server.

**Why and how should you use one?**

Use the External Picture layout when you want to display an image for each object in a list.

**Where and when can you use one?**

Use the table below to see where you can use an External Picture:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Parent node</th>
<th>Tabs</th>
<th>Number on page</th>
<th>Editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Page</td>
<td>Object Type node</td>
<td>Yes - optional</td>
<td>Any</td>
<td>No</td>
</tr>
<tr>
<td>Object Page</td>
<td>Association Type node</td>
<td>Yes - mandatory</td>
<td>Any</td>
<td>No</td>
</tr>
</tbody>
</table>

**What do you want to do?**

**Use an External Picture layout**

1. Ensure you have a **Single-Line Text** Property Type on your Object Type where you can enter the image name. If you do not have one, use CW Suite to create a new one.

   For example, create a new Property Type titled 'logo'.
2. Upload all the image files you want to use to the 'images' folder, or a sub-folder within it, in your custom Site folder. All standard web image formats are supported.

3. For each of the objects you want to use an image with, enter the image file name in the new property field. What you enter here must be the full path to the image file, with the root being the 'images' folder in your custom Site folder. Therefore, if you uploaded your images directly into the 'images' folder, you can simply enter the image file name. However, if you created a sub-folder there, you should enter: <sub-folder-name>/<image-file-name>, such as 'logos/myimage.png'.

4. In Evolve Designer, locate the parent node you want your External Picture page to sit beneath. This is either the Object Type node on an Index Page or an Association Type node on an Object Page.

5. In the Selected Properties setting for the parent node, ensure you select the new Property Type which stores the image reference.

6. Right-click the layout beneath the parent node and choose Switch Layout > CW > External Picture.

7. In the Layout ID setting for the External Picture layout node, enter the scriptname of the Property Type which stores the image reference.

8. Save and Publish your Site. Please remember that now you are using a custom Site you must select that custom Site in the Deployment node settings for your Site.
Working with the Image Layout

An Image layout is used to show a picture to represent each object in a list, and works by using a property on your objects to reference an image file on a web server.

It is similar to the External Picture layout, except it is much better suited to displaying large images.

Users visiting your page can choose to navigate to the Object Page for that object, or can view the image in fullscreen mode.

If one or more of the objects returned by the list do not have a value for the image URL property, that object is omitted from the displayed list.

To display the same image as a property of your object in an Object Page, use the ImageFromURL Property Group layout.

In order to use the Image layout, you must have a Property Type on your object which can be used to store the image file reference. This must be a Single-Line Text or URL property.

Note the scriptname of this Property Type.

The path to the file must be a full URL, such as:

http://www.mysite.com/images/myimage.png

The following image formats are supported: PNG, JPEG, GIF.

Why and how should you use one?

Use the Image layout when you want to display a large image for each object in a list, whether that's a list of objects on an Index Page, or a list of Associated Objects on an Object Page.

Where and when can you use one?

Use the table below to see where you can use the Image layout:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Parent node</th>
<th>Tabs</th>
<th>Number on page</th>
<th>Editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Page</td>
<td>Object Type node</td>
<td>Yes - optional</td>
<td>One, or one per Tab</td>
<td>No</td>
</tr>
<tr>
<td>Object Page</td>
<td>Association Type node</td>
<td>Yes - mandatory</td>
<td>One per Tab</td>
<td>No</td>
</tr>
</tbody>
</table>

What do you want to do?

Use an Image layout

These instructions assume you have already created the Property Type to store the reference, have populated the property for some of the objects, and have images stored in the locations you reference.

To use the Image layout:

1. In Evolve Designer, locate the parent node you want your Image layout to be applied to

   This is either the Object Type node on an Index Page or an Association Type node on an Object Page
2. Switch the Layout of the page to **Image**
   _Right-click the layout beneath the parent node and choose Switch Layout > CW > Image_

3. Enter the scriptname of the Property Type you are using to store the image file reference in the **Image URL Property Scriptname** setting.

4. _Save and Publish your Site._

   _The Custom Display String feature does not work with the Image layout._
Working with View Box Layout

The View Box layout is a display function used internally by Evolve. This option is reserved and is not intended for customer use.

What do you want to do?

Select an Alternative Layout
Working with the Custom URL Layout

The Custom URL layout is a display function used to display a URL property as a hyperlink, with a custom display string for the caption.

1. Create a property group, and select a single property to display in that group.
2. Use the Custom Display String to define the text to display to represent the link.
3. Select the Layout 'URL'
4. When the property is displayed in the page, it will now show the Custom Display String, but have the original URL.

![Diagram of property group and layout options]

Fig. URL Property

Related Topics

Select an Alternative Layout
Working with Text Editor

The Text Editor has an HTML content editor for formatting rich text in multi-line field. To use the Text Editor, you must enable "Enhanced Multi-line Text Control" on the Property Type Page for the Memotext Property Type. Without enabling this property, the Memotext field provides either read-only HTML or editable plain text fields.

Further, the Memotext field on a site can be edited in the text mode. However, you convert it to HTML in the Object Explorer, you can no longer edit the field.
You can edit the HTML content of your site with the Text Editor. Like Word processors, the Text Editor offers additional formatting options.
You can use the Text Editor to enter HTML code (including hyperlinks and images), print multi-line text, and copy and paste formatted text into other applications such as Microsoft Word.

Content pasted will have the formatting simplified to match the capabilities of the Editor. Styles such as Headings will be mapped to equivalent HTML styles.

The Text Editor uses an open-source TinyMCE program and can be found in the following location: Bin>WebDesigner>JS>External_async>TinyMCE

*TinyMCE is an open-source, platform-independent Javascript based WYSIWYG HTML editor and is released as open software under the LGPL license.

What Do You Want To Do?

Enable Enhanced Multi-line Text Editor for Internet Explorer

To use the Enhanced Multi-line Text Editor with Windows Internet Explorer, your server must enable a font setting under Internet Options.

To enable Enhanced Multi-line Text Editor for Internet Explorer:

1. Go to Start, enter control panel, and then select Control Panel.

The Control Panel window appears.
2. Click **Network and Internet**.

3. Click **Internet Options**.

   Internet Properties dialog box appears.

4. Under Security, click **Local intranet**.
5. Click **Custom level**.

   Security Settings - Local Intranet Zone dialog box appears.

![Security Settings - Local Intranet Zone dialog box]

6. Scroll to **Font Download** and click **Enable**.

![Font Download settings]

7. Click **OK**.
A Warning about changing the settings appears.

8. Click **Yes**.
9. Click **Apply**.
10. Click **OK**.

Enhance Multi-line Text Editor will now be enabled for use with Internet Explorer.

`Restart Internet Explorer to apply this setting change.`

**Enable Enhanced Multi-line Text Editing**

*To enable the Text Editor:*

1. Start the erwin Evolve Suite.
2. Click **Model Explorer**.
3. In the left pane, click the **Design** tab.
4. Expand the required model. For example, **EA Foundation - Sample Model**.

5. Select the required object type. For example, **Applications**.

6. In the right pane, double-click **Description**.

   The Property Type properties: Description dialog box opens.
Ensure that Data Type is Multi-line text before selecting Enhanced Multi-line Text Control check box.

7. Under **General**, select the **Enhanced Multi-line Text Control** check box.

   The Enhanced Multi-line Text Control pop-up appears.

8. After reading pop-up information, click **OK**.

9. Click **OK**.

10. Start Evolve Designer.

11. Click a model. For example, **EA Foundation Sample Model**.

12. Click **Site**.

13. Expand **Site > Object Pages > application > Application > Tabs > Properties**.
14. Click Description.

15. Under Layout, select memotext.

16. Click Save and then click Dynamic Site.

Before editing the HTML text field in erwin Evolve Web and erwin Web Modeler, ensure that TinyMCE is available in Model Explorer.

To view TinyMCE in the Model Explorer:
1. Start the erwin Evolve Suite.
2. Click Model Explorer.
3. Expand the required Model. For example, EA Foundation - Sample Model.
4. Click **Applications**.

![Application tree]

5. Double click the application for which you want to view TinyMCE. For example, **Salesforce**.

Application properties - Salesforce dialog box opens.

![Salesforce dialog box]

6. Click **Description**.

The TinyMCE editor opens.
Ensure that TinyMCE is available for selected object.

7. Click **OK**.

8. On the View menu, click **Refresh List**.


*To edit the HTML text field in erwin Evolve Web:*

1. Open the browser and login to erwin Evolve Web.
2. Click a model. For example, **EA Foundation - Sample Model**.
3. In the left pane, click **Application**.
4. Click **Application List**.
5. Click , to open the required application properties.
6. Click the Edit icon to edit the Description.

The TinyMCE editor opens for Description.

7. Edit the Description and click the Save Changes icon.

The Update Summary details appear in right pane.
8. Click Submit.

To edit the HTML text field in erwin Web Modeler:

1. Open the browser and login to erwin Evolve Web.
2. Click a model. For example, EA Foundation - Sample Model.
3. In the left pane, click Application.
4. Click **Application Architecture**.

5. Click the **Edit Diagram In Web Modeler** icon.

The available draft diagrams appear.

6. To open any draft diagram in erwin Web Modeler, Click ![Open Draft](image)

   The erwin Web Modeler editor opens in a new tab with the predefined Shape Palette of the template chosen.

7. Select the required application object. For example, **Salesforce**.

8. Click ![View Object Properties](image) to view the object properties.

9. Scroll to Description and click the **Edit** icon.
10. Edit the description as you want and click **Update**.

11. Click ⬇️ to publish the diagram.

12. **Click Confirm Publish.**

Once the diagram is published in the erwin Web Modeler, it can be accessed from the Modeler in the desktop application.

**Review and Approval Notifications**

If **Workflow** has been enabled for your site, when a text field has been altered using the Text Editor and a user desires to save the changes made, the designated Approver is sent a 'Pending Changes' notification email. Any changes made will not be implemented until authorized by the Approver. The Approver will receive an email stating: 'This property contains HTML content. Please review this change in Evolve'. -prompting them to access Evolve and assess the detail of all HTML changes made. This content is not included within the email as email systems will often display this incorrectly and cause confusion for the user.

See **Working with Tasks**
Displaying Diagrams

Display a CW Modeler Diagram

Any diagram in your model created in CW Modeler can be displayed in your Evolve Site.

You can display diagrams on any Object Page where the focus is the Diagram Object Type, or on Object Pages where the focus is a different Object Type, but a Tab is used to display diagrams the object appears on or details.

You can also display diagrams on Index Pages where one or more diagrams are returned. For performance and usability reasons it may not be appropriate to display multiple diagrams on one Index Page, however you could easily use the page filters so that only one diagram is returned in the results.

The default method for displaying CW Modeler diagrams is to use the CW Modeler Diagram behavior, but you can experiment with a newer behavior - Vector (HTML5) - which provides improved quality and scaling.

Display a CW Modeler diagram

These instructions detail how to display a CW Modeler diagram on an Object Page for the Diagram Object Type.

You can of course show Visualization diagrams in other places, such as below an Association node in a Tab on an Object Page, or below an Object Type node on an Index Page.

To display a CW Modeler diagram:

1. In Evolve Designer, expand the Object Type node
2. Right-click the Layout node and select Switch Layout > CW > Diagram
   A Layout Diagram node is added.
3. Right-click the Layout Diagram node and select Add Behaviors > CW > CW Modeler Diagram
   The CW Modeler Diagram node is added.
4. Select the CW Modeler Diagram node and edit its properties:
   ○ Use Full Screen to specify if the diagram should be shown in full-screen mode.
   ○ Use the Diagram Popouts area to specify any Diagram Popouts you want to configure for this page.
5. Save and Publish your Site.
Display a Visualization Diagram

This page explains how to display Diagram Designer Visualization diagrams in your Evolve Site.

Visualization diagrams are typically used to **visually-represent an object and its relationships to other objects**, allowing you to **see a specific object in context**.

However, rather than being a fixed diagram created in CW Modeler, they are **automatically generated** at the time of viewing.

Visualization diagrams are created as 'layouts' in Diagram Designer. The layout defines which Object Type is the focus of the diagram, which other Object Types and Associations should be shown, and how the diagram should be organized, but it **does not specify which object instances** should be shown.

In Evolve, you can configure a page to show a diagram generated from one of these layouts, resulting in a dynamically-generated view of an object in context.

You most commonly display Visualization diagrams on **Object Pages**, where you want a visual representation of the subject of the Object Page. However you can also display them on Index Pages.

⚠️ *This Help does not explain how to create Diagram Designer layouts.*

*Evolve only supports Diagram Designer layouts which have one object instance as the focus.*

**Display a Visualization diagram on your web page**

These instructions detail how to display a Visualization diagram in a new Tab on an Object Page.

You can of course show Visualization diagrams in other places, such as below an Association node in a Tab on an Object Page, or below an Object Type node on an Index Page.

**To display a Visualization diagram on your web page:**

1. In Evolve Designer, expand the Object Page node where you want your diagram to be displayed
2. Right-click the **Tab** node and select **Add Layout > CW > Diagram**
   
   *The Layout Diagram node is added.*
3. Right-click the **Layout Diagram** node and select **Add Behaviors > Diagram > Visualization (Automatic Diagram)**
   
   *The Visualization (Automatic Diagram) node is added.*

4. Select the **Visualization (Automatic Diagram)** node and edit the settings:

   *Use Diagram Design Name to select the Diagram Designer layout you want to use on this page. Only layouts focused on the same Object Type as the Object Page are listed.*

   *Use Display Mode to choose how you want the diagram to be displayed, either constraining it by diagram height, or displayed in full-screen mode.*

5. Save and Publish your Site.

**Related Topics**

Create a Visualization / Automatic Diagram
Display Object Data with Diagram Pop-outs

This page explains how to create and use Diagram Pop-outs to display the data behind objects that appear on diagrams.

You can use Diagram Pop-outs with all display Layouts in Evolve. See Layouts and Behaviors Explained for a full list of supported Layouts.

Diagram Pop-outs are used to display information about objects that appear on a diagram. When a user clicks on an object on a diagram in the Site, a pop-out panel showing the object's details is displayed on the right of the browser window.

Diagram Pop-outs are completely customizable, so you can choose exactly what data you want to show for any given object, and you can even display different pop-outs depending on the Category of the object.

Pop-outs are constructed in a similar way to Object Pages, although you cannot use Tabs, but as such they can include properties of the object, lists of associated objects, as well as some visualizations. Behaviors are not supported in Diagram Pop-outs.

Like Object Pages, Diagram Pop-outs are Object Type specific, so you must create a pop-out for each type of object you want to view the details of.

There are two steps to getting Diagram Pop-outs working on your Site:

1. Create a Diagram Pop-out
2. Configure a page to use a Diagram Pop-out.

To do this:

i. Open your Site in Evolve Designer
ii. Right-click the Site node and select Add Diagram Popout Node

The Diagram Popouts node is added to the bottom of the Site tree.

What do you want to do?

Create a Diagram Pop-out

To create a Diagram Pop-out:

1. In Evolve Designer, right-click the Diagram Popouts node and select Add Object Page for Object Type > [object type]

A node is added for the Object Type you selected
2. Configure your pop-out to display some object data and/or associations
You configure the pop-out to display data in a similar way to how you build an Object Page, using Property Groups and Associations. However, there is one important difference to an Object Page - you cannot use Tabs.
You can use multiple Property Groups, and you can use multiple Associations.

See here for information on using Property Groups

The Property Group Layout 'FlatList' particularly useful on Diagram Pop-outs, as it combines multiple properties in a simple display format.

3. See here for working with layouts and behaviors for Associations

4. When you have completed the configuration of your pop-out, Save it.

In order for your pop-out to display on a diagram page, you must configure the page to use it.

Configure a page to use a Diagram Pop-out

Even if you have created a Diagram Pop-out, you must configure individual pages in your Site to use it.

You can display a Diagram Pop-out on any Object Page or Index Page which is configured to display a diagram.

To configure a page to use a Diagram Pop-out:

1. On your page, select the diagram behavior node you want the pop-out to work with
   The CW Modeler Diagram, Vector (HTML5), or Visualization (Automatic Diagram) node

2. Use the Diagram Popouts area to choose the pop-outs you want to use for different Object Types that appear on the diagram
   Use different rows to specify different pop-outs for different Object Types or Categories of the same Object Type.
   i. Use the Object Type drop-down to select the Object Type you want a pop-out for
   ii. Use the Category drop-down to select the Category of the Object Type you want the pop-out for - or leave the Category as 'UndefinedValue' if you want your pop-out to apply to all instances of the selected Object Type
   iii. Use the Diagram Popout drop-down to select the specific pop-out you want to use for the Object Type and Category combination you have chosen

3. Save and Publish your Site.

Create Category-specific Diagram Pop-outs

You can show different pop-outs for different Categories of the same Object Type.

To do this, create multiple pop-outs for one Object Type, then, when configuring your page to use the pop-outs, choose different pop-outs for different Categories of objects.

If you want to have just one Category of Object Type showing a different pop-out to the others, create a generic pop-out and set it to 'UndefinedValue' on the diagram page, then specify the Category pop-out just for that specific Category.
Display a Diagram on the Home Page of your Static Site

If you publish your Site as a Static Site, you can create a special home page which displays a CW Modeler diagram. This feature does not work with Dynamic Sites.

To display a diagram on your Static Site home page:

1. Create a new Diagram Index Page
2. Enter 'home' as the Page Name
3. Ensure your page filter is configured so that only one diagram is selected
   
   For example: 'ID = 12'
4. Save and Publish your Site.
Displaying Vector (HTML5) for Displaying Diagrams

This page explains how to display CW Modeler diagrams in Vector (HTML5) format in your Evolve Site.

Vector (HTML5) diagrams introduce a new method for displaying CW Modeler diagrams, bringing increased load performance, better picture quality and perfect scaling.

Use the Vector (HTML5) Diagram display

To use the Vector (HTML5) Diagram display:

1. If you want to compare the appearance of the Vector (HTML5) version of your diagram and the original CW Modeler version, you can display both versions in your page. To do this, each diagram must be displayed in a different Tab. Ensure that you enter a specific Layout ID for each. This is a useful way to provide us with feedback about the differences you experience.

2. Open one of your existing Diagram pages.
3. Add a new behavior to the Layout Diagram node you want to change, ensuring you choose the Vector (HTML5) option.
4. Delete the existing CW Modeler Diagram node.

Support for diagram elements

The Vector (HTML5) diagram behavior supports all diagram elements typically available to CW Modeler diagrams, except for the following:

The following elements are NOT supported:
- Association Type Regions

The following elements are PARTIALLY-supported:
- Version Control (all items except for the Detailed Object section)
- Free Text (only Free Texts referenced on the palette)

IMPORTANT

Vector (HTML5) Diagrams will not correctly display any diagram element where the formatting of the element is applied directly on the canvas.

Only formatting applied to items on the New Objects Palette of the corresponding template diagram are displayed correctly.

Diagram Shapes

There is partial support for available for the following diagram shapes:
\text{RED} = \text{Not Supported}

\text{BLUE} = \text{Supported with differences to the original CW Modeler diagram.}

\textit{Please note that due to the rendering limitations of Internet Explorer 9 and 10, using shapes with a dashed outline may prevent the diagram from rendering properly.}

\textit{Lines and Connectors}

All lines and Connectors are supported.

\textit{Shape Regions}

The following table shows the support for shape regions:

<table>
<thead>
<tr>
<th>Region</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Supported</td>
</tr>
<tr>
<td>Association Type</td>
<td>Supported</td>
</tr>
<tr>
<td>Association Type (Custom)</td>
<td>Not supported</td>
</tr>
<tr>
<td>Property Value</td>
<td>Supported</td>
</tr>
<tr>
<td>Property Value (Custom)</td>
<td>Supported</td>
</tr>
<tr>
<td>Property Visualization using Reference property</td>
<td>Supported</td>
</tr>
<tr>
<td>Property Visualization using Palette value</td>
<td>Supported</td>
</tr>
<tr>
<td>Explosion with rule and category</td>
<td>Supported</td>
</tr>
<tr>
<td>Property gauge using a reference property</td>
<td>Supported</td>
</tr>
<tr>
<td>Property gauge using Palette</td>
<td>Supported</td>
</tr>
<tr>
<td>Region</td>
<td>Level</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Property Gauge as date range</td>
<td>Supported</td>
</tr>
<tr>
<td>Explosion</td>
<td>Supported</td>
</tr>
<tr>
<td>Explosion with rule</td>
<td>Supported</td>
</tr>
<tr>
<td>Navigation</td>
<td>Supported</td>
</tr>
</tbody>
</table>

A yellow triangular (⚠️) Warning icon will display next to the action buttons in the top right hand corner when:

- If there is misalignment between the Template Palette and the Diagram Palette. However, the icon will not display if the misaligned objects in the palette use names that have previously been accepted for aligned objects, even if their settings have been changed.
- A diagram uses unfinished or missing connectors. Close and reopen the diagram in Corporate Modeler. If the Warning icon remains, this is likely due to another issue.
- Missing Shapes create a Broken Layer. Close and reopen the diagram in Corporate Modeler. If the Warning icon remains, this is likely due to another issue.

Please be aware that certain fonts are not supported by all browsers. When using the HTML5 Canvas, some fonts will therefore be substituted for alternative styles, depending on your browser type.

**Publishing Static Sites**

*If you only use the Vector (HTML5) behavior to display diagrams in your Static Site, you can tell Evolve to no longer generate image files of the diagrams in your repository when you publish the Site.*

Generating diagram image files is often the most time-consuming part of publishing a Static Site and they are not needed for the Vector (HTML5) behavior, so choosing not to export them can significantly speed up publication.

*Use the Export Diagram Images option on the Site node settings to disable diagram image generation.*
Editing Business Process Diagrams

Please check with your Administrator that firstly, your Server and Internet Browser meet the necessary system requirements to use BP modeler. Secondly, check with your Administrator that the eModeler feature is enabled.

**BP modeler** is used to both edit and create Process Diagrams online, using predefined Dynamic Templates and Themes.

The different features within the Editor are detailed below:
<table>
<thead>
<tr>
<th><strong>Title Bar</strong></th>
<th>Displays the Diagram Draft and related Template Names</th>
<th><strong>Rent a Movie (Process Capture)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zoom Controls</strong></td>
<td>Zoom In, Reset Scaling, Zoom Out and Full Screen. Click and move the ‘Radar’ view to zoom around the diagram.</td>
<td></td>
</tr>
<tr>
<td><strong>Canvas Controls</strong></td>
<td>Undo, Redo, Save &amp; Publish, Help and Exit Edit Mode.</td>
<td></td>
</tr>
<tr>
<td><strong>Editor Menus</strong></td>
<td>Home to the different BP Modeler Panes: Diagram, Appearance, and Actions.</td>
<td></td>
</tr>
<tr>
<td><strong>Canvas Area</strong></td>
<td>The area where the edited/created Process Diagram will display.</td>
<td><strong>Canvas Area</strong></td>
</tr>
</tbody>
</table>

**Navigation**

BP modeler controls that can be used when editing a diagram.

**Click Summary**

<table>
<thead>
<tr>
<th><strong>Mode</strong></th>
<th><strong>Click Type</strong></th>
<th><strong>Behavior</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Single</td>
<td>Displays the Context pane for that Shape/Connector in the Menu pane (edit properties, connect another Shape, add/remove Swimlane).</td>
</tr>
</tbody>
</table>
### Mode Click Type Behavior

<table>
<thead>
<tr>
<th>Mode</th>
<th>Click Type</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double</td>
<td>Click</td>
<td>Opens the Properties sub-menu and enables the Name and Title fields for entering or editing the Shape/Connector's name.</td>
</tr>
</tbody>
</table>

### Keyboard Shortcut Summary

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+ +</td>
<td>Zoom In</td>
</tr>
<tr>
<td>Ctrl+ -</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>Esc</td>
<td>Deselect all shapes</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo the last change</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>Redo the last change</td>
</tr>
<tr>
<td>Enter</td>
<td>Save Diagram/Shape/Connector changes when editing properties</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes selected Shape(s)/Connector(s)</td>
</tr>
</tbody>
</table>

*BP modeler is a licensed application. In order to use it, additional licenses are required on a per user basis.*

### Drafting & Publishing

When **BP modeler** is enabled for an Object Type, 2 menus are created; a drafts menu and a published menu.

**Drafts Menu**

The Drafts menu displays all the current drafts for the specified object type. Drafts can be viewed in Tile view, or Full view. Hovering over the draft will reveal the draft controls:

These controls allow you to view, edit, delete or open the diagram in the Object page.

**Published Menu**
The Published menu displays all the published diagrams for the specified object type. Drafts can be viewed in Tile view, or Full view. Hovering over the draft will reveal the diagram controls:

These controls allow you to view, edit or open the diagram in the Object page.

**Creating New Diagrams**

In the top-right of the Drafts and Published pages there is an icon that can be clicked to create a new diagram:
Duplicating Diagrams
To duplicate diagrams, edit an existing diagram and navigate to the Actions menu:

![Actions Menu]

Clicking the first icon will result in a duplicate of the current draft being created.

What do you want to do next?

Enable BP modeler

BP Modeler is not enabled by default.

To Enable BP modeler:
The Server Configuration Dialog will open.

BP modeler will be enabled for use on your Site.

1. Open Evolve Designer and select the Evolve Designer Models launcher dialog, click on the Server Configuration button:

![Server Configuration Button]

2. Open the Features tab and check the Enable BP modeler check box.

![Features Tab]

3. With the function enabled, Open the Dynamic Deployment tab and click the Save button to commit the changes to your Site.
Adding BP modeler Pages to Object Types

If you already have eModeler enabled (from version 3.1 or lower) for an Object Type you will need to remove or delete the eModeler nodes prior to completing these steps.

In Evolve Designer, right click on Object Pages and hover over Add BP modeler Page for Object Type to expand the list of Object Types. Simply click an object type and Evolve will automatically add the pages to view BP modeler drafts and published diagrams.

Once your configuration is complete, publish your Evolve site as usual.

Configuring a dynamic template to support BP modeler

You should already have a Process diagram template configured in CW Modeler that offers the shapes you would like to use in your Process diagram palette.

Launch Evolve and login as a System Manager and you will now have an Administration menu, under which you will see Dynamic Template Editor.
**Create a New Diagram from an Existing Template**

*To Create a New Diagram from An Existing Template:*

A sub-menu for that process will open, listing three options to select from:

The **Process Flow** page will open.

The **BP modeler** canvas will open and you can begin to create your new Process Diagram.

1. Open Evolve and click on the Processes tab.
2. Click on the All Processes option to display a list of all available processes.
3. From the list displayed, select the Process that you wish to build a Diagram for.
   - Process
   - Process Flow
   - Properties
4. Click on the **Process Flow** option.
5. Click on the *Create a new diagram based on the template [Template Name]* link at the top of the screen.

**Create a Basic Linear Process Diagram**

A basic Process Diagram will capture three simple steps: The **Event** that triggers the process, an **Activity or Decision**, and a **Result**.

*To Start Your Basic Process Diagram:*

See Create a New Diagram from an Existing Template.
The Shape will be transferred to the Canvas Area.
The description will be added to the Shape:

The Next Shapes available for selection will then display in the Shape Menu Pane:

The second Shape will be transferred to the Canvas Area and connect to the existing Event Shape:

The Next Shapes available for selection will then display in the Shape Menu Pane:
This final Shape will be transferred to the Canvas Area and connect to the existing Activity/Decision Shape:

![Diagram of Process Trigger, Activity/Decision, Result]

Your basic Process Diagram is now ready to be saved.

See Saving your Work in eModeler.

1. Open eModeler and select the appropriate Process from which to create the new Diagram.
2. In the Shape Menu Pane, click on the appropriate Event Shape.
3. Add a description or title to the Shape by entering details into the Name field in the Properties Menu Pane.
4. Click on the green circle containing a tick, the **Validate your Changes** button, displayed beneath. Alternatively, press the Enter button on your keyboard.
5. Select the next Activity/Decision Shape by clicking on it.
6. Add a description or title to the Shape and save it.
7. Select the available Result Shape by clicking on it.
8. Add a description or title to the Shape and save it.
9. Save your Diagram.

**Saving your Work in eModeler**

To Save a Draft

Drafts save automatically as they are edited, so you will never have to worry about accidentally closing the browser and losing all of your changes.

To Do Menu Pane

There is a fourth, hidden, menu pane called **To Do**, which only appears if there are any aspects of your Diagram requiring action. The **To Do** menu will list these actions and the Shapes relating to these tasks will be highlighted by a red border. Users will be prevented from saving your work until these actions are addressed.

![To Do Menu Example]

Once the actions have been completed, you will be able to successfully save your work.
1. Select a Task from the list to be taken to the relevant aspect of the Diagram requiring action.

Add Descriptions and Properties to a Shape

To Add a Description or Property to a Shape:
As soon as new information is added to the fields, a green circle containing a tick, the Validate your Changes button, displays beneath.

![Diagram showing process and shapes with properties](image)

eModeler supports all diagram elements typically available to CW Modeler diagrams, except for the following Property Types:

- Date Range
- Distribution Properties
- The use of Memotext in HTML5

For a full list of the existing Regions supported, see: Shape Regions.

1. Click on the Diagram tab to select the required Shape and add it to the Diagram.
2. In the Properties section of the Diagram tab, enter the desired information into the Name and Title fields.
3. Click on the Validate your Changes button to save your new description to the Shape.

Create a Connection between Shapes: Add Alternative Branches (Simple)

There are three ways to create a connection between two shapes. Each method is described below.

To Create a Connection Between Two Shapes, Either:
The Shape will be highlighted by a solid border to indicate that it has been selected.
A Connector linking the Shape to your mouse pointer will appear.
The linked Connector follows the mouse pointer. The Connector will turn red when encountering Shapes that cannot be connected to, and green with those Shapes that it can.

The Connector will link the two Shapes, indicating that a connection between the two has been made.

1. Select the first shape by clicking on it.
2. Click on a Connector from the Shapes Menu pane.
3. Move your mouse pointer to the Shape you would like to connect to (target Shape).
4. Click on the Canvas to end Shape selection.

OR

The Shape will be highlighted by a dashed border to indicate that it has been selected.

A Connector will link the two Shapes, indicating that a connection between the two has been made.

1. Click and hold (long-click) on the first Shape to select it.
2. Double-click on the target Shape.

OR

A Connector will link the two Shapes, indicating that a connection between the two has been made.

1. Hold down the Shift key and click on the first Shape to select it.
2. Double-click on the target Shape.

---

For Shapes that are not rectangular in nature, Connectors will connect to the Shape's boundary, and not directly to the Shape itself.

---

Create a Connection between Shapes: Add Alternative Branches (Multiple)

There are three ways to create connections between multiple Shapes. Each method is described below.

**To Create a Connection Between Multiple Shapes:**

The Shape will be highlighted by a solid line to indicate that it has been selected.

Each additional Shape will be highlighted with a dashed border to indicate Multiple Selection Mode.

Connectors will link the Shapes, indicating that connections have been made between them.

1. Select the first shape by clicking on it.
2. Hold down the Shift key and click on the next shape.
3. Double-click on the final target Shape to end the multiple selection.

OR:

The border of the Shape will be highlighted with a dashed border to indicate that it was been selected.

Each additional Shape will be highlighted with a dashed border to indicate Multiple Selection Mode.

Connectors will link the Shapes, indicating that connections have been made between them.

1. Select the first shape by clicking and holding on it (long-click).
2. Click on the extra Shapes required.
3. Double-click on the final target Shape to end the multiple selection.

OR:

Each Shape will be highlighted with a dashed border to indicate Multiple Selection Mode.
Connectors will link the Shapes, indicating that connections have been made between them.

1. Press and hold down the Shift key.
2. Click and drag your pointer over the area containing the Shapes to be selected.
3. Once you are happy with the Shapes selected, release the Shift key stop dragging across the area.
4. Double-click on the final target Shape to end the multiple selection.

For Shapes that are not rectangular in nature, Connectors will connect to the Shape's boundary, and not directly to the Shape itself.
Delete Shapes from the Diagram

To Delete a Single Shape or Connector from your Diagram:
The Clear Shape icon will display:
The Shape or Connector is deleted.
1. Select the Shape or Connector.
2. Click on the Clear Shape icon

To Delete Multiple Shapes or Connectors from your Diagram:
The Clear Shape icon will display.
The Shape or Connector is deleted.
1. Select the necessary Shapes or Connectors.
2. Click on the Clear Shape icon.

To Delete a Swimlane from your Diagram:
The Swimlane will be deleted but the Shape[s] attached to it will remain.
1. Select the Swimlane and proceed to delete as with a Shape or Connector.

Assign Swimlane Elements to your Process

It is possible to group or assign various aspects of your diagram to a particular Swimlane element. Assigning Shapes to a Swimlane can provide clarification about which organizational roles or functions are responsible for which parts the process being captured in your diagram.

To Assign a Shape[s] to a Swimlane:
1. Click on the required Shape[s] that you would like to assign.
2. In the Selection Menu Pane, a Swimlane Sub-menu pane will appear. The sub-menu will use the same title as the element placed inside the Swimlane category in the Diagram Template Editor. In the example below, the Swimlane element is 'Organization'.
3. You will be prompted to either search for or create a the new group to assign the Shapes to:

   ORGANIZATION

   Search or Create

   The previously selected Shapes will be assigned to the new group.
   1. Select (or create) the desired group.

To Change the Name of a Group/Swimlane Element:
A solid border will appear around the element Shape (Organization grouping).
The Swimlane (Organization) sub-menu will appear in the Editor Menus area.
The new description will be added to your Shape.

1. Select the Swimlane element by clicking on it.
2. Enter the new element name into the properties field provided.
3. Click on the green **Validate your Changes** button to save your new description to the Shape. Alternatively, press the Enter key on your keyboard.

![Diagram](image)

**To Remove a Swimlane from your Diagram:**

A solid border will appear around the element Shape (Organization grouping).
The Swimlane (Organization) sub-menu will appear in the Editor Menus area.
The Swimlane element is removed from your Diagram.

1. Select the Swimlane element by clicking on it.
2. Click on the **Clear Shape** icon located in the in the Properties section of the pane:

![Clear Shape Icon](image)

**Change the Appearance of your Diagram**

When creating your Diagram, it is possible to adjust the both the orientation of the Diagram and the Theme used.

**To Open the Appearance Options:**

The Appearance Menu options will display:
1. Open your Diagram Draft and click on the Appearance Menu Pane.
2. Select the appropriate option.

*To Change the Orientation of your Diagram:*

Alternatively;

The Diagram will change orientation accordingly.
1. Open the Appearance Menu Pane.
2. Click on the **Left to Right** icon to display your Process Diagram from left to right across the screen:
3. Click on the **Top to Bottom** icon to display your Process Diagram from the top to the bottom of the screen:

**To Change the Theme Used by your Diagram:**
A list of Themes available for selection will display in the Theme sub-menu.

<table>
<thead>
<tr>
<th>THEME</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Dev 1</td>
<td>![Theme 1 Icon]</td>
</tr>
<tr>
<td>Dev 2</td>
<td>![Theme 2 Icon]</td>
</tr>
</tbody>
</table>

---

1. Open the Appearance Menu Pane.
2. Select your chosen Theme by clicking on the relevant pane:

**Exit eModeler**

**To Exit the Application:**
The screen returns to the previous Process Summary page.

1. Click on the **Close Edit Mode** icon at the top of the screen:
Overview of Web Modeler - Editing Diagrams Online

Please check with your Administrator that firstly, your Server and Internet Browser meet the necessary system requirements to use Web modeler. Secondly, check with your Administrator that the Web Modeler feature is enabled.

Web modeler is used to both edit and create any Evolve Diagram online.

The different features within the Editor are detailed below:
<table>
<thead>
<tr>
<th>Diagram Title</th>
<th>Editable title for the diagram, this differs from the diagram name, which must be unique</th>
<th>Click to rename the title</th>
</tr>
</thead>
</table>
| **Zoom Controls** | Zoom % - Click to choose presets  
Zoom in and out - [+ and -]  
Zoom Slider  
Radar button  
Click and move the 'Radar' view to zoom around the diagram.  
All can be collapsed to a single magnifier button. | | ![Zoom Controls](image) |

| **Shape Palette** | The Shape Palette contains all the shapes that can be used on the diagram.  
Drag and drop the shapes from the palette onto the diagram surface  
Note that lines / connectors are drawn from the (+) buttons around the sides of a selected shape. | ![Shape Palette](image) |
### Diagram Title
Editable title for the diagram, this differs from the diagram name, which must be unique

### Shape and Diagram Tools
Home to the different Web Modeler Panes: Properties, To Do, Settings and Styles.

### Canvas Area
The area where the edited/created Process Diagram will display.

### Navigation
*Web modeler* controls that can be used when editing a diagram.

### Click Summary

<table>
<thead>
<tr>
<th>Mode</th>
<th>Click Type</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Single</td>
<td>Selects a shape and updates the &quot;Shapes and Diagram Tools&quot; pane for that</td>
</tr>
<tr>
<td>Mode</td>
<td>Click Type</td>
<td>Behavior</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
<td>----------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shape/Connector, if the pane is open.</td>
</tr>
<tr>
<td>Double</td>
<td></td>
<td>Opens the “Shapes and Diagram Tools” pane, if it is closed, and navigates to the Name and Properties tab. For easy access to the object details.</td>
</tr>
</tbody>
</table>

**Keyboard Shortcut Summary**

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+ +</td>
<td>Zoom In</td>
</tr>
<tr>
<td>Ctrl+ -</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>Esc</td>
<td>Deselect all shapes</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes or Clears the selected Shape(s)/Connector(s)</td>
</tr>
</tbody>
</table>

Web modeler is a licensed application. In order to use it, additional licenses are required on a per user basis.
Enable Web Modeler

This page explains how to enable web modeler step by step

**Steps to Configure Evolve Web Platform:**

1. Logon to Evolve Designer.
2. Go to the Features tab
   - **Enable Diagramming** - Choose **Web Modeler** from the drop-down list.
   - Check the **Enable Swimlane Diagramming**.
3. Click on Save.
4. Then click on the **Configure IIS** button to configure Evolve Web Platform.

**Steps to Setup Global Search:**

In Evolve Designer:

1. Select the model you wish to work with, e.g. **Sample Model** and then click on **Site**.
2. If your meta-model is out of date you may need to update it. If so, click on **Update Meta Model & Themes**.
3. Click on **Show/Hide Object Types** to show the hidden object types. You will need this in the later steps when you enable a user as a Diagrammer.

4. Under the **Layouts** tab, expand the nodes of **Site, Deployments**. Select the deployment node of your device.

5. Scroll down to the bottom and check the **Enable Global Search**. Global search is required to enable the Web Modeler to find pre-existing objects in your model. This is needed where you wish to add them to your diagrams.

6. A popup appears which says populate the Object Revision History with data for current records. Click **OK**.
7. Then click on Dynamic Site to republish the site.

**Steps to Configure the CW User as a Diagrammer:**

1. Go to erwin Evolve Suite, then click on Object Explorer.
2. Expand your Model, e.g. EA Foundation - Sample Model.
3. Scroll down and click on CW User.
By default, all the user **Categories** will be shown as a **Contributor**.

4. Double click on the user you wish to change to be a **Diagrammer**. e.g. **ADMIN**.

The **CW User Properties** window appears and under the tab **General** choose **Diagrammer** from the drop-down list of **Category** and then click **OK**.

Now, when that user logs in, as they are now a Diagrammer, they will see the web modeler.
Configuring Drafts and Publishing Diagrams

This page explains how to configure Drafts and Publish diagrams in Web Modeler.

Add the Publish and Drafts tabs to your Object Page:

These instructions detail how to add the built-in tabs to control draft diagrams, to an Object Page. Unlike other elements in Evolve, these tabs are limited to Object Pages, and all diagrams must be associated to an Object.

E.g. Process Object is associated to a Process Diagram. The diagram is describing graphically the Process Object.

To add the tabs to an Object Page:

1. Logon to the site
2. Expand Site and Object Pages
3. Right-click on Object Pages, hover on Add eModeler Page for Object Type.
4. Select the object type you wish to create diagrams against, e.g. Application.
5. Scroll down to see <object-type>_cw_emodeler, e.g. application_cw_emodeler and click on it.

6. Change
   - Page Display Name to Web Modeler
   - Object Page Order to 2
7. Further, expand `<object-type>_cw_emodeler`, e.g. `application_cw_emodeler`, to display the Layout eModeler Page and Tabs with sub-tabs.
8. Click Vector (HTML5)

**Configuring Diagram Popouts for Draft Diagrams:**

In order to edit more object properties than the basic ones, you will need to configure a Diagram Popout. See here, for Diagram Popout configuration. Then, to enable this Popout for Web Modeler:

1. Go to Diagram Popouts, choose Object type as the object type that represents this diagram, e.g. Application, click on Category, if your Popout is defined correctly, it should fill out the fields automatically as they are predefined by the Popout.

Check eModeler Editor.
2. Scroll down to **CM Templates**.

Check the templates you wish to associate with this Web Modeler page, e.g. **Application - Services**, **Application - Technology Context** and **Application - Architecture**

Click on **Save** under the **Home** tab and then click on **Dynamic Site** to generate the site.

**Note:** Once the eModeler Editor is checked, it ensures that all these Popout properties are editable inside the Web Modeler application.
Drafts and Published Diagrams in Web Modeler:

*Drafts and Published are the two tabs under the Web Modeler menu.*

*This section can be viewed only when the Web Modeler has been setup in Evolve Web Platform.*

**To view Drafts and Published Diagrams in Web Modeler.**

1. Open the browser and login to Evolve.

   Select your Model, e.g. **EA Foundation - Sample Model**

2. Go to the page you configured.

   e.g. From the sample, **Application** from the left menu. Click **Application List**.

   Choose the desired application from the list.

   For instance, choose the first application from the list in the picture.
3. The new tab will be visible in your **Object Page**, e.g. **Web Modeler**.

Under the drop-down menu **Web Modeler**,

- **Drafts** - Collection of saved diagrams are displayed under tab **Drafts**. Initially this will be empty. Each time you press the **Save** button in Web Modeler, the draft will be updated in Evolve. Note that this is not the same as Publishing; a draft is a diagram in a transitional state. When a draft is published, it becomes a real Evolve diagram, and the objects it contains are updated in the
Evolve Model.

Activity Monitoring

Each Draft has controls that allow you to Edit and to open the diagram in the Object Page.

- Published - Collection of all published diagrams are displayed under tab Published.

Each published diagram has controls that allow to View, Edit, and open the diagram in the Object Page.

Creating and Publishing a new Diagrams using Web Modeler:

1. To create and publish a new diagram, go to tab Published (initially the space under the tab shows as empty).

Click on icon from the top-right corner of the page that displays the list of templates chosen while configuring CM Templates.
Choose the desired template to start creating the new diagram.

**Evolve Web Modeler** editor opens in the new tab with the predefined **Shape Palette** of the template chosen.

2. To publish the diagram, press the button. You will be asked if you wish to publish. Press to confirm.

Once the diagram is published in the **Web Modeler**, the same diagram can be accessed from **Modeler** in the desktop application.

_A Diagram and Palette properties can be modified if required from the desktop application._

**To set the Parent object and object name in Evolve Web:**

_Before setting the Parent object and Parent object name in Erwin Evolve web, first, we need to enable these options (Parent object and Parent object name) in Evolve Designer and publish them on the site._
To enable the Parent Object in Evolve Designer:

1. Run the Evolve Designer.
2. Click a model. For example, **EA Foundation - Sample Model**.
3. Click **Site**.
4. Expand **Site** and **Object Pages**.
5. Right-click **diagram** and click **Expand All**.
6. Click **General**, select the **Parent object** and **Parent object name** check box.

7. Click **Save** and then, click **Dynamic Site** to generate the site.

*To set the Parent object and object name in Evolve Web*
1. Open the browser and login to Evolve.

2. Click a model. For example, **EA Foundation - Sample Model**.

3. Click **Diagram List** from my menu.

   ![Diagram List](image)

   The Diagram list appears.

4. Search the diagram name in **Filter the content of this page** box.

   ![Filter the content of this page](image)

5. Click the **Open related object page** icon.

   ![Open related object page](image)

   The diagram will be visible on your object page.

6. Click **Properties** under Diagram dropdown.

   ![Properties](image)

7. Click the **Edit** icon to edit the Parent object and Parent object name.
8. Click **Parent object** dropdown and select required option.
9. Click **Parent object name** dropdown and select required option.

![Image](image.png)

10. Click the **Save changes** icon.

*The Update summary pane appears on right-hand side.*

11. Click **Submit**.
### Update Summary

#### Property Changes

**Parent object**
- Application
- Network

**Parent object name**
- Finance-Suite
- LAN New-York

[Submit]
To set Parent object and object name in Web Modeler

1. Click **View** under Diagram dropdown.
2. Click **Edit Diagram In Web Modeler** icon.
3. Click **Create new draft**.
Evolve Web Modeler editor opens in the new tab with the predefined Shape Palette of the template chosen.

4. Click on the icon to see the diagram properties.

5. Click on the icon.

Parent Object Details popup opens.

6. Click Object Type dropdown and select the required option.

7. Click Category dropdown and select the required option.

8. Click Object dropdown and select the required option.

9. Click Save.
To publish the diagram:

1. Click Publish Diagram icon.

2. Click Confirm Publish.

Once the diagram is published in the Web Modeler, it can be accessed from the Modeler in the desktop application.

A Diagram and Palette properties can be modified if required from the desktop application.
Configuring Diagram Properties

You can use the Diagram Popout object in Evolve Designer to configure diagram properties other than the default ones. Once configured, these properties are then visible in erwin Web Modeler under diagram properties.

To configure Diagram Popout in Evolve Designer:

1. Start Evolve Designer.
2. Click a model. For example, EA Foundation - Sample Model.
3. Click Site.
4. Expand Site > Diagram Popouts.
5. Right-click Diagram Popout and click Add Diagram Popout for Object Type > Diagram.

The Diagram Popout is created for the Diagram object type.
6. Expand diagram_diagram_popout.
You can add any Property Group that you want to display in erwin Web Modeler.

8. Click **General**.

9. Under Selected Properties, select the properties that you want to display as diagram properties in erwin Web Modeler.

10. Click **Save**.

11. Click **Dynamic Site**.
The newly configured diagram properties are available only for new and duplicate drafts.

To view the newly configured properties in erwin Web Modeler:

1. Click the **Edit Diagram In Web Modeler** icon.

2. Click **Create new draft**.

The erwin Web Modeler editor opens in a new tab with the predefined Shape Palette of the template chosen.

3. Click **i**.

The properties that you selected in Evolve Designer are now visible under diagram properties.
To update the properties in erwin Web Modeler:

1. Click the required property that you want to update. For example, Title.

2. Update the Title and click to publish the diagram.

3. Click Confirm Publish.
   The Title is updated.
   Similarly, you can view and update properties for duplicate drafts.

The newly configured diagram properties are available only for new and duplicate drafts.
Association Property

In erwin Web Modeler, you can now edit or set the properties of association objects and lines during diagram creation. To achieve this, you must first create and configure the diagram pop-out and then link it to the diagram.

To configure Diagram Popout in Evolve Designer:

1. Start Evolve Designer.
2. Click a model. For example, EA Foundation - Sample Model.
3. Click Site.
4. Expand Site > Diagram Popouts.
5. Right-click Diagram Popup and click Add Diagram Popout for Object Type > Diagram.
6. Expand diagram_diagram_popup.
You can add any Property Group that you want to display in erwin Web Modeler.

8. Click **General**.

9. Under Selected Properties, select the properties that you want to display as diagram properties in erwin Web Modeler.
10. Click **Save**.

11. Click **Dynamic Site**.

   The newly configured diagram properties are available only for new and duplicate drafts.

**To create a diagram popout:**

1. Right-click association type.
2. Go to **New property Group > From CM Panel > General**.

   You can see General is added to the node.
Also, it has some properties such as, Name, Category, and Allow Automatic Deletion.

The configuration of properties is same for the current object popouts. For example, in the above image, the group, General is selected and it has a name, category, and allow automatic deletion properties selected. You can also select multiple property groups. For example, in the below image, the group, General, Description, Status is selected.

Once the diagram popout is created. We need to assign it to the diagram.

To assign this diagram popout to the diagram:
1. Expand **Object Pages** node.

![Object Pages node expansion](image)

2. Expand **Diagram** node.

![Diagram node expansion](image)

3. Go to **Diagram > Tabs > View > Layout Diagram > Corporate Modeler Diagram**.

![Corporate Modeler Diagram](image)
In the diagram popout, you can see list of available association type with category, diagram popout, and eModeler Editor.

4. Select the association type from the Object Type drop-down. For example, Association IT Portfolio Application.

Based on the above selection, Category and Diagram Popout appears.

5. Select the eModeler Editor check box.

The diagram popout is available in erwin Web Modeler.

Now, when you open the diagram in erwin Web Modeler and select any line, you can see and edit all the properties.

To update the association properties in erwin Web Modeler:
1. Click the required property that you want to update. For example, **Name**.

2. Update the Name and click **Save**.

3. Click **to publish the diagram.**

4. Click **Confirm Publish.**

   The Title is updated.
Associating Non-Diagram Objects

You can associate any object with another object that is not part of the diagram. Additionally, you can view, add, update and delete multiple associated objects and their properties in erwin Web Modeler by configuring Evolve Designer.

To view the list of Object Types displayed in the Diagram Popouts:

1. Start Evolve Designer.
2. Click a model. For example, EA Foundation - Sample Model.
3. Click Site.
4. Expand Site > Object Pages.
5. Right-click diagram and click Expand All.
6. Click Corporate Modeler Diagram.
The list of Object Types appears under Diagram Popouts.

To create an Object Type Association:

1. Start Evolve Designer.
2. Click a model. For example, **EA Foundation - Sample Model**.
3. Click **Site**.
4. Expand **Site > Diagram Popouts > application_diagram popout > Application**.
5. Right-click **Application** and click **New Association > Technology > Application - Technology**.

6. Click **Application - Technology** node.

7. In the **Node Name** box, replace "Application - Technology ()" with "Technologies".

You can add any **Object Type Associations**.
8. Optional: If you want the diagram user to be forced to have at least one associate object, then select the **Mandatory Association** check box.

A Set Mandatory Association pop-up appears.

9. Click **OK**.
10. Click **Save**.
11. Click **Dynamic Site**.

The Associated Objects are now visible in the diagram.

**To view the Associated Objects in the diagram:**

1. Open the browser and login to erwin Evolve Web.
2. Click a model. For example, **EA Foundation - Sample Model**.
3. In the left pane, click **Application**.
4. Click **Application Architecture**.

5. Click the required object for which you want to view Associated Object. For example, **Salesforce**.

   The Associated Objects Types are now visible in the right pane.

   ![Diagram showing the process of adding associated objects in erwin Web Modeler](image)

   **To add Associated Objects in erwin Web Modeler:**
1. Click the **Edit Diagram In Web Modeler** icon.

![Diagram in Web Modeler](image1.png)

2. Click **Create new draft**.

![Available drafts for this diagram](image2.png)

The erwin Web Modeler editor opens in the new tab with the predefined Shape Palette of the selected template.

3. Select the object for which you want to add Associated Object. For example, **Salesforce**.

4. Click ![Object Associations](image3.png).

The Object Associations list appears.

5. Click the **Technologies** drop-down list.

6. Click **Add Associated Object**.
Associated Objects pop-up opens.

The Object Type field is pre-populated with the Object Type to which you want to add an Associated Object.

7. Click the Category drop-down list and select the required option.
8. Click the Object drop-down list and select the required option.
9. Click Save.
10. Click .
11. Click Confirm Publish.

Once the diagram is published in the erwin Web Modeler, you can access it from the Modeler in the erwin Evolve Suite.

Mandatory Association

Mandatory Association enforces you to add at least one Object Association.

If no Associated Object is added, a pending task appears in the To-do List and the Publish Diagram is disabled.

To add Mandatory Association:

1. Click .

To-do List opens.
2. Click the pending task. For example, "Mandatory Technologies association required". Once pending task selected, the object is selected automatically, and the Object Association section appears in the right pane.

3. Click the Technologies drop-down list.

4. Click Add Associated Object.

The Associated Objects pop-up opens.

5. Click the Category drop-down list and select the required option.

6. Click the Object drop-down list and select the required option.
7. Click Save.

8. Click 

9. Click Confirm Publish.

Once the diagram is published in the erwin Web Modeler, it can be accessed from the Modeler in the erwin Evolve Suite.
Formatting Shapes In Web Modeler

Please check with your Administrator that firstly, your Server and Internet Browser meet the necessary system requirements to use Web modeler. Secondly, check with your Administrator that the Web Modeler feature is enabled.

This page explains how to format shapes in the Web Modeler online step by step.

Adding Shapes, Connecting Lines To The Diagram, and Changing Properties

To add shapes to the diagram,

1. Drag and drop the required shape from the Shape Palette.
2. Double-click on the object shape to edit the Title and its Properties.
3. Click Save.

You can use a Connector to link two Shapes, indicating that there is a connection between the two shapes.

In-Place editing in the shape,

You can edit the name of a shape in the diagram editor using in-place editing.

To edit the name of the shape,

1. Select the shape you wish to edit.
2. Click again on the shape and then enter the text.
3. Either press Enter or click anywhere on the editor to finish editing.
To add the connector between the shapes,

1. Select the first shape by clicking on it.
2. Click on one of the + symbols to add the connector and move your mouse pointer to the shape you would like to connect to.
3. Click on the shape to end the selection.
4. If there are multiple connection types between these kinds of objects, you will get a menu to choose the connection that is appropriate.

To Clear or Delete Shapes from the Diagram

Object Shapes can be Cleared or Deleted from the diagram in two ways.

To Clear a Shape:

When you choose to Clear a shape, it removes the shape from the diagram, but it does not remove the object it represents from the model.

1. Select the shape you wish to Clear.
2. Click on the icon.

Or

1. Select the shape you wish to Clear.
2. Press the Delete button on your computer’s keyboard.
3. Confirm to **Clear**.

**To Delete a Shape:**

When you choose to **Delete** a shape, it removes the shape from the diagram, and when published will remove the object representing from the model too.

1. Select the shape you wish to **Delete**.

2. Click on the **icon**.

Or

1. Select the shape you wish to **Delete**.

2. Press the **Delete** button on your computer's keyboard.
3. Confirm to **Delete**.

If a shape is deleted, any connector associated with the object shape also gets deleted.

When object shapes are deleted using the **Delete** option, it adds the item to the Trash can icon called **Deleted Objects** on the right-hand pane.

**Adding Background Colors and Borders to the Shapes**

Every Shape from the Palette has a definite background color, border size, and border color.

You can format the shape by

1. **Background Color** of the shape.
2. **Border Size** to the shape.
3. **Border color** to the shape.
Some shapes may have Region shapes and Region formatting which overrides these styles such that the style options will not work.

Example: A shape may be set with color because of the “Category” of the object, i.e. the shape may be Red because it is a critical object (as defined in one of its properties).

Aligning Shapes

Object shapes in the Web Modeler editor can be aligned using Align Nodes placed on the toolbar.

Object shapes can be aligned to the Left, Right, and Center horizontally, and also Top, Bottom, and Center vertically, which can also be evenly Distributed Horizontally or Vertically.

Resizing Shapes to match others

In the Web Modeler Editor, the object shape can be adjusted to the height and width of the other shape using Resize Nodes.
Move Shapes from Back and Front

In the diagram, if one shape is put on top of another, it may conceal the other.

Move To Back and Move To Front buttons help to show/Hide the object shape.

Text Formatting and Fonts

The Title of Object shapes can be formatted according to:

1. Font and its Font Size
2. Text in Bold, and Italic
3. Text alignment to Left, Center, and Right.
4. Vertical Alignment.
5. Text Color.
Some shapes may have Region shapes and Region formatting which overrides these styles such that the style options will not work.

Example: A shape may use a different property for the Title, that is defined in a region. This region's style cannot be overridden by Web Modeler.
Gallery Manager In erwin Web Modeler

In the Diagrammer, you can upload pictures to the shape palette of the diagram and publish them. To upload the pictures:

1. Go to the diagram template or the existing diagram to which you wish to add pictures.
2. From the shape palette, drag and drop the picture template. Double-click on it to view the properties pane on the right side.
3. Click on the icon to open the gallery manager.

   Gallery Manager displays all pictures available in the model with the most recent pictures at the top.

4. To upload a picture, click on Upload at the top-right corner.
5. Select an image and click on Select.
The picture appears on the draft diagram.

6. Once the draft is ready, click **Publish Diagram** icon.

7. After publishing the draft, picture can be viewed in erwin Evolve Web or erwin Evolve Suite.
General Operations in Web Modeler

Options that are generally available for any diagram in the canvas are:

1. Duplicate Draft
2. Publish Diagram
3. Save Diagram
4. Download Diagram
5. Undo and Redo
6. Diagram Settings

**Duplicate Draft**

To duplicate the working draft of the diagram, click on **Duplicate Draft** on the toolbar.

By doing this, a copy of the draft will be created, and you will be taken immediately to the draft diagram. It will also be available in the **Web Modeler Home**.

The draft diagram will be associated with the originally published diagram, and on publishing will replace the same published diagram.

> To create a separate published diagram, you should duplicate the published diagram instead.

**Publish Diagram**

To publish the diagram, click on **Publish Diagram** icon on the toolbar.

Before proceeding to **Publish** the diagram, make sure you don’t have any incomplete items in To-Do list. Once published, the draft diagram will be deleted, and the published diagram will be available on the Evolve site and in Modeler.

**Save Diagram**

To save the diagram, click on **Save Diagram** on the toolbar.

Although drafts are continuously saved to a secondary storage, saving your draft diagram ensures it is kept in your Evolve database and can be backed up with your main database backup.

**Download Diagram**
To download the diagram in the form of an image to your machine, click on **Download Diagram** on the toolbar.

**Undo and Redo**

You can **Undo** or **Redo** the changes made in the diagram editor. To apply click on **Undo/Redo** options on the toolbar.

**Diagram Settings**

To apply the settings related to the diagram **Grid**, **Animation** and **Guiding lines** in the editor, click on **Diagram Settings** on the toolbar.

You will see a panel popped up on the right-side of the screen to work on settings.
Working with Connector Lines

The lines which associate the two objects in the diagram are called **Connector Lines**.

Lines can be applied in two ways:

1. **Direct Route** - connects the objects using the shortest path.
2. **Avoid Route** - connects the objects avoiding the other objects in the diagram structure.

Lines are of three types are available to connect the objects:

1. **Orthogonal Lines** - Orthogonal Lines are when the line appears with right angles in order to connect the two objects when it cannot be drawn horizontally or vertically.

   *This line is available only under Direct Route and will be disabled for Avoid Route.*
2. **Jump Lines** - **Jump Lines** are when one connecting line passes over another, and it appears with an arc over it. This button are used in conjunction with the orthogonal lines button. If an orthogonal line is off for a particular line then the jump line button is disabled.

Jump is a property of an individual line, so if the lines cross and neither have the jump property then they look like straight lines passing through one another. Jump lines will be seen if both lines have jump property.

3. **Lock/Unlock Link Port** - Link Ports can be Locked or Unlocked. To lock them, either press the button or move the connection point (port) of the line, around the shape. When you select a location to port the line to the shape, it will become locked. If you want the diagrammer to automatically reposition the port, select the line, and press the unlock button, to release the lock.

Locking the link ports helps to keep the specific connection point when the shapes are moved around the canvas.

**Naming on Association Links**

To show the flow between the shapes, **Association Names** can be placed on **Association Links**.
To place the name on the link,

1. Double-click on Link or Connector Line you wish to add on.
2. A property panel will be opened on the right-side of the screen.
3. Enter Name and then click on Save on the bottom of the screen.

4. The Association Name can be moved around the screen by Clicking and Dragging it to a new location.

How to Add Missing Associations?

Associations between the shapes can be automatically displayed if a new object is added to the existing diagram. This will render the associations between the existing objects and the newly added objects in the existing diagram.

You can also place associations between any two or multiple objects using the button on the toolbar called Add Missing Associations.

Associations can be applied in three ways:

- **Upon Single Selection** - Select any single object shape in the diagram and then click on Add Missing Association button to display the associations related to the selected object shape and the other shapes in the diagram.
- **Upon Multi Selection** - Selection of any two or more shapes will render the missing associations to the objects that are already defined between them.
- **No Selection** - This will render all possible associations between the shapes in the diagram.
Web Modeler Home Page

Web Modeler Home page also known as Draft Manager [from version 2020.2.0] allows more control over your drafts. Providing significant features such as Search, Sort and Filters.

A new diagram can be created by choosing from the available templates in Web Modeler.

- **Search** - You can search for existing diagrams with the keywords in the **Search Box**.

- **Sort** - You can **Sort** the diagram drafts with several available options.
  - Name or Title of the diagram
  - Who it was last Modified by
  - Who originally Created the draft
  - Sort the list by Ascending and Descending order
• **Filters** - Diagrams in the draft manager can be filtered by,
  - Diagram Type
  - Creator of the diagram
  - Modified Date - 'From Date' to 'To Date'

To reset the applied filters, click on **Reset**.

• **Toggle between Name and Title** - List of diagrams will be displayed as per the toggle selection. You can choose to display the diagrams as per the **Name** or **Title** of the diagram.

• **Create New Diagram** - A new diagram can be created from the scratch by using the existing template.
- Click on + symbol from the bottom right of the screen.

![Diagram Types](image)

- Enter Name of the new diagram > Select Template > click on Create.
Parent object and Parent object name

The instructions on this page detail how to set a Parent object and object name in erwin Evolve Suite (CW Suite), erwin Evolve Web, and erwin Web Modeler.

To set the Parent object and object name in erwin Evolve Suite:

1. Start the erwin Evolve Suite.
2. Click Modeler.
3. Select the Model and Template that you want use to create a diagram.
4. Enter the name of the diagram in the Name box and then, click Create.
5. Drag and drop the required shapes from the palette onto the diagram surface.

6. Double click on the diagram surface or under the Home tab, click **Properties**. The Diagram properties dialog box appears.
7. Click the first drop-down list box under **Parent object** and select the required parent object.

8. Click the second drop-down list box under **Parent object** and select the required parent object name.

9. Click **OK**.

10. Click on the **Refresh** icon.

You can see the same Parent object and Parent object name on the left pane.
Before setting the Parent object and Parent object name in erwin Evolve Web, first, we need to enable these options (Parent object and Parent object name) in Evolve Designer and publish them on the site.

To enable Parent object and Parent object name in Evolve Designer [Evolve 2022.0.0 and above]:

1. Start Evolve Designer.
2. Click on a model. For example: A Foundation - Sample Model.
3. Click Site.
4. Expand Site > Object Pages.
5. Right-click on diagram and click Expand All.
6. Click **General** and under Selected Properties, select **Parent object** and **Parent object name**.

7. Click **Save** and then, click **Dynamic Site** to generate the site.

---

*To set the Parent object and Parent object name in erwin Evolve Web:*
1. Open the browser and login to erwin Evolve Web.

2. Click on model. For example: **A Foundation - Sample Model**.

3. Under my menu, click **Diagram List**.

   The Diagram List appears.

4. Enter the diagram name in the **Filter the content of this page** box.

5. Click on the **Diagram** icon.

   The diagram opens on your object page.

6. In the Diagram drop-down list, click **Properties**.

7. Click the **Edit** icon to edit the Parent object and Parent object name.
8. Click the **Parent object** drop-down list and select the required option.

9. Click the **Parent object name** drop-down list and select the required option.

10. Click the **Save changes** icon.

The Update Summary details appear on right pane.

11. Click **Submit**.
To set Parent object and Parent object name in erwin Web Modeler:

1. Click View.
2. Click the Edit Diagram In Web Modeler icon.
3. Click Create new draft.
The erwin Web Modeler editor opens in a new tab with the predefined Shape Palette of the template chosen.

4. Click on the icon to view diagram properties.

5. Click on the icon.
Parent Object Details popup opens.
6. Click the **Object Type** drop-down list and select the required option.
7. Click the **Category** drop-down list and select the required option.
8. Click the **Object** drop-down list and select the required option.
9. Click **Save**.

**To publish the diagram:**

1. Click the **Publish Diagram** icon.

2. Click **Confirm Publish**.
Once the diagram is published in the erwin Web Modeler, it can be accessed from the Modeler in the erwin Evolve Suite.

Diagram and Palette properties can be modified, if required, from the desktop application.
Linking Parent Object to Child Drafts

To link parent objects to existing child draft diagrams:

1. Open the browser and login to erwin Evolve Web. The list of available models appears.
2. Click a model. For example, EA Foundation - Sample Model.
3. Under my menu, click Diagram List.

   my menu

   Framework  Process Architecture  Service Architecture  Application Architecture
   Technology Architecture  Information Architecture  Diagram List  Page Picker

   The list of diagrams opens.

4. Enter the diagram name in the Filter the content of this page box.

5. Click the Open related object page icon. The diagram opens on your object page.

6. Click the Edit Diagram In Web Modeler icon.

---

250
In the absence of the Edit Diagram In Web Modeler option, ensure that the Web Modeler is enabled with a Diagrammer license for you.

8. Click **Create new draft**.

![Available drafts](image)

Evolve Web Modeler editor opens in a new tab with the predefined Shape Palette of the chosen template.

9. Select an object.
   Options are now enabled.
10. Click the drop-down arrow on the Explode New Draft button. The Link Draft Diagrams option appears.

11. Click Link Draft Diagrams. The Add Link to Existing Draft appears. Add Link to Existing Draft

12. Select any child draft diagram to link with an object.
13. Click **Add Link**.

The child draft diagram is now linked to a parent object.

You can now see that parent object has draft child diagram available in the properties. Also, the name of the parent object is included in the child draft diagram.
Using Explode Diagram in erwin Web Modeler

The instructions on this page detail how to use the Explode Diagram feature to:

- Create links from parent to child diagrams
- Open existing child diagrams linked via the feature
- Return to the parent diagram

To use the explode diagram feature in erwin Evolve Suite:

1. In the diagram, right-click an object.
2. Hover over Explode New.
3. Click Diagram.

The New Diagram screen appears.
4. Click OK.

The selected object is linked to a new diagram. You can explode the object to view or open the diagram.

**To view an exploded diagram:**

1. On a linked object that is represented on a diagram, click the indicator inside the shape.

   The list of exploded diagrams appears.

2. Select a diagram from the list.

3. Click Open.

   The exploded diagram opens. You can view the parent object’s details in the properties of the exploded diagram.

**To view parent object or diagram of exploded diagram:**

1. Under the Home tab, click Return to Parent.
To create an exploded diagram in erwin Web Modeler [Evolve 2022.0 and above]:

1. Open the browser and login to erwin Evolve Web Platform.

   The list of available model appears.

2. Click on the model, e.g., EA Foundation - Sample Model.

3. Under my menu, click Diagram List.

   The list of diagrams opens.

4. Click Diagram List available under my menu.

5. Enter the diagram name in the Filter the content of this page box.

6. Click the Open related object page icon.

   The diagram opens on your object page.
7. Click the **Edit Diagram In Web Modeler** icon.

   If this icon is not present, please check you have a license for Web Modeler, that Web Modeler is enabled, and you are allocated a Diagrammer license.

8. Click **Create new draft**.

   Evolve Web Modeler editor opens in the new tab with the predefined Shape Palette of the template chosen.
9. Select an **object**.

10. Click ![icon].

    The Diagram Types screen appears.

![Diagram Types](image)

11. Enter **Name** and select a **Template**.

    A blank exploded diagram is created. Now, you can drag and drop objects from the shape palette.

12. To **publish the diagram**, click the ![icon] icon. You will be asked if you wish to **publish**. Click to confirm.

    Once the diagram is published in the Web Modeler, the same diagram can be accessed from the Modeler in the desktop application.
Enable One Draft Mode

The One Draft Mode enforces only one draft per published diagram. Thus, preventing multiple drafts of the same diagram being edited at the same time.

To enable the One Draft Mode in Evolve Designer:

1. Start Evolve Designer.
2. On the Evolve Designer Models launcher dialog box, click the Configure Evolve Server button.
   
   The Evolve Server Configuration dialog opens.
3. Under Features, select the **Enable One Draft Mode** check box.
4. Click **Save**.
5. Click **Configure IIS** and perform full deployment.

   This enables the One Draft Mode. Once it is enabled:
   - The “Available drafts for this diagram” option is disabled.
     
     Clicking the **Edit Diagram In Web Modeler** icon bypasses the “Available draft for this diagram” option and redirects you to erwin Web Modeler.
The “Duplicate Draft” option in erwin Web Modeler is disabled.

Clicking displays a notification, “Cannot create duplicate draft as one draft mode is enabled”.

The “Create new draft” button is disabled.
If a diagram has more than one draft diagram created prior to the setting being enabled, clicking Create new draft displays a notification, “Unable to create a draft because single draft mode is enabled.”
You can delete unwanted drafts. Once done, you will be redirected to erwin Web Modeler.

If the diagram already has a draft created, and someone modifies the published diagram via the desktop modeler, then beware that any changes made in the published diagram won't be synchronized in the draft diagrams. To see the changes, delete the unwanted drafts and create a new one.
Load Balancing with erwin Web Modeler

Previously if you wanted to use Web Modeler you were restricted to a single server installation. We have now extended the configuration to allow for multi-server (or load balanced) environments.

Configuring MongoDB Replication

This topic explains the process to configure MongoDB Replication. This process is only required if you are serving Evolve Web Platform from more than one web server, in a load balanced array.

*Configure MongoDB Replication*

1. Press the Windows key and then click Start.
2. Search for *Services*.
   
   The Services window appears.

3. Select *MongoDB Server*.

4. Click *Stop*.
   
   MongoDB Server service stopped.

5. Go to MongoDB bin folder available at `C:\Program Files\MongoDB\Server\4.2\bin`.

6. Open `mongod.cfg` file in text editor (For example, Notepad).

7. Update replication property as follows:

   replication:
   replSetName: "rs0"

8. Bind your system IP address in the following format:
net:
  port: 27017
  bindIp: <enter system ipv4>, 127.0.0.1
9. Save the `mongod.cfg` file.
10. Start **MongoDB Service**.
11. Go to C:\Program Files\MongoDB\Server\4.2\bin and open the command Prompt.
12. Run the mongo.exe command.
13. Run the following command:
    ```
    rs.initiate({_id: "rs0",members: [{_id: 0, host: "<enter system ipv4>:27017"}]
    ```

    *The default MongoDB port number is 27017. If required, you can update it to a different port number.*

14. Run the rs.status() command to check whether replication is configured successfully.

Successful MongoDB replication is indicated by a response where the members array has the name and IP properties according to the values configured in step 13.

**Configure Evolve Server**

The instructions below explain Evolve Server Configuration to publish your sites on it.

**On the main/master server:**

1. Start Evolve Designer.
2. On the Evolve Designer Models launcher dialog, click the Configure Evolve Server button.

The Evolve Server Configuration dialog opens.
3. Under Server, select the **Primary Server, Share Data Folder** and **Share MongoDB** check boxes.

   ![Screen Shot](image)

   *In the MongoDB URL option, the IPv4 address will be replaced with the host address, unless you manually update the main machine IP address.*

4. Click **Save**.

5. Click **Configure IIS** and perform full deployment.

**On the secondary server:**

1. Start Evolve Designer.

2. On the Evolve Designer Models launcher dialog, click the **Configure Evolve Server** button.

   ![Configure Evolve Server](image)

   The Evolve Server Configuration dialog opens.
3. Under Server, select the **Use the Share Data Folder** and **Use the Shared MongoDB** check boxes.

4. Click Features and in the **Web Modeler API URL** box, replace your host IP address with "localhost".

   The address should be “http://localhost:3001/” after replacing IP address.
Before deploying, ensure that MongoDB and Diagrammer services are running.

5. Click **Save**.
6. Click **Configure IIS** and perform full deployment.

Verify whether the database property is added to the environment variables.

7. Restart the secondary server.
8. Open erwin Web Modeler.

Verify whether it displays the main server’s erwin Web Modeler drafts and data. This indicates that both machines are connected to the same MongoDB database.
Automatic Diagrams (Diagram Designer)

Create an Automatic / Visualization Diagram

Diagram Designer allows the automatic creation of diagrams in erwin EA / BP.

You will be able to:

1. Enable a model
2. Create a new layout / auto diagram
3. Generate the diagram
Enabling a Model

The first time you launch Diagram Designer, you may not have any models enabled. You need to enable a model in order to use Diagram Designer.

To enable a model,

1. Start Diagram Designer (You can find this in your Window's Start Menu)

2. Once it has loaded, and you have logged in, click on the “Enable a Model Icon”

3. Select the model you want to enable for Diagram Designer from the drop down.
This operation take some time depending on your model's size, when done your application will restart. When the application has restarted you may then choose your model.

4. Choose a Model by clicking on the "Model icon" with the name of your model.

Related Topics

Create a new Layout
Designing a Layout

Create a new Layout

Once your model is activated you are ready to add diagram layouts.

On first use, you will not have any diagram layouts created, so you need to create your first diagram layout.

To create a diagram layout, click on the “Add a Layout Icon” a popup will appear asking you to fill the following information:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout Name</td>
<td>The name of your automatic diagram template (diagram layout). This name will help you to find your template layout</td>
</tr>
<tr>
<td>Diagram Template</td>
<td>The erwin EA/BP Desktop Modeler template which is used by the Diagram Designer to generate a diagram. The elements in the Palette of the diagram template are used for the default size of the shapes. If the Object Type is not in the template palette, you will not be able to choose it in the creation of your diagram layout.</td>
</tr>
<tr>
<td>Output type</td>
<td>There are 2 options for the output type of your diagram : Group one or more objects on a diagram. This option is used for heat map or big pictures diagrams. Generate on diagram for each base object. This option allows you to create one diagram for each base object you will choose later. This option is used for spider or flow diagrams.</td>
</tr>
</tbody>
</table>

Related Items

Designing a Layout
Designing a Layout

To configure your diagram layout, you need to be in the design mode, changing the mode is possible using the Tabs below the options toolbar.

The design of your diagram layout is decomposed on the following steps:

1. Creation of the diagram layout
2. Definition of the object type(s) to select (Node)
3. Definition of output layout(s) to apply to the selected objects (Display)
4. Repeat step 2 as needed
   That is, each time you choose a node (Set of Object Types) and a layout (Display), you can then if required, add a sub level node using an Association Type.

In Diagram designer the selection of data is done using a graph structure. You will need to select the Object Type(s) from which you want to start and then select Association Types from this object. A selection of objects is called a "node". For each node of objects you have to define which layout will be used to display them in the diagram.

Three main layouts are available to apply to a Node:

1. Include layout : Have objects contained within a diagram or other object
2. Vertical layout : Have objects displayed to the right or left of the parent object
3. Spider layout : Have objects placed around the parent object

From each Node it is then possible to repeat the process of decomposing to sub nodes through associations, to sub nodes.

Related Items

Working with Diagram Designer

Running a Layout
Working with Diagram Designer

The Diagram Designer is designed to help you and propose you the next step depending on where you are in the configuration of your automatic diagram template.

Each time a node has a red background, the meaning is that something is wrong or an action is required. The Next step text is here to guide and help you. To see the message you need to hover with your mouse over the element which has a red background.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Node Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="design_layout.png" alt="Design Layout" /></td>
<td>Design Layout, contain the design options</td>
</tr>
<tr>
<td><img src="object_node.png" alt="Object Node" /></td>
<td>Object Node, either Object Type or Association Type</td>
</tr>
<tr>
<td><img src="node_layout.png" alt="Node Layout" /></td>
<td>Node Layout, used to define the display type of the objects in the diagram</td>
</tr>
</tbody>
</table>

**Design Mode**

Once your configuration layout has been created you will be able to select objects and define a diagramming layout. Depending on the output type you have choose the diagram layout options vary.

**Group Mode Output Type Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Diagram Name</strong></td>
<td>As you have choose the group mode, you will need to define the name of your diagram, as you will choose one or several objects to display on the diagram, the Diagram Designer can't define the name.</td>
</tr>
</tbody>
</table>
Single Mode Output Type Options

The name of your diagram in the single mode will be the concatenation of *the defined prefix + the name of the primary object + the defined suffix*.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Diagram Name Prefix</strong></td>
<td>This text will be used to prefix the name of the primary object to create the name of the diagram. This option should be customized in order to avoid collision with existing diagram. Please include a space character after the prefix if you want a space between the prefix and the name of the primary object.</td>
</tr>
<tr>
<td><strong>Diagram Name Suffix</strong></td>
<td>The suffix will be used for the name of the diagram. It will be set just after the name of the primary object.</td>
</tr>
</tbody>
</table>

To define the options for your diagram layout, left click on the root node and you will have the options at the right side of the screen.
Add Objects to the Diagram

**Primary Object:**
To add a primary object group you need to right click on the diagram layout node and choose the Object Type you want to use.

*Notice that only Object Types on the palette entry of your diagram template are displayed.*

Notice also when you create the primary object node you have an include type layout which is automatically added as a children of your object type node. This is because the first layout should always be an Include Layout.

**Association Types:**
To continue adding objects, you need to right click on the parent node where you want to add an Association Type, Objects Type associated to the selected Object Type are proposed in the context menu.

*Notice that the Target Object Types should be present on the palette entry in order to have them in the contextual menu.*

Then from any association type node you can do the same operation.

*Notice that when you create an Association Type node, you will have to add the associated design layout. Please refer to the “Add a Design Layout” section.*
Object Node Options

The Object Selections node is used to specify the rules that determine which instances should be displayed at the level you are working.

Here are the available options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort on</td>
<td>Which property to sort the results by</td>
</tr>
<tr>
<td>Sort Reverse</td>
<td>Sort in reverse order</td>
</tr>
<tr>
<td>Filter Properties</td>
<td>Use this section to choose some rules for specifying exactly which objects you want returned - &quot;where Category = A&quot; etc</td>
</tr>
</tbody>
</table>

Notice that filters are using the “AND” operator when several filters are available. If you put two filters like Category = A and Category = B, nothing will come out as it’s impossible to have 2 categories at the same time.

Design Types

Add a design layout

To add a Design Layout, you need to right click on an object node without any Design Layout. On the context menu you will have the option “Add Diagram Layout”, and then choose the diagram Layout you want to use depending on your requirements.

Notice if your node has already a design layout attached, and you want to change it, you need first to delete the existing design layout then you will be able to create a new one.
Available Design Types
The following design types are available:

Include Layout:
The include layout allows to include some objects in the diagram or in another object.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Margin</td>
<td>When used at the top level, if the diagram has shapes already on it (the template may already have some shapes) then a point is taken which is the bottom leftmost point of the bottom leftmost shape - that is the zero point. Use the margin top and margin left to specify where the first new shape should start. On the first level, if you know there are no other shapes on the diagram, ignore all the margin settings.</td>
</tr>
<tr>
<td>Space Children X</td>
<td>Use the Spacing settings to space the objects created at this level. This one is the X/Horizontal axis.</td>
</tr>
<tr>
<td>Space Children Y</td>
<td>Use the Spacing settings to space the objects created at this level. This one is the Y/Vertical axis.</td>
</tr>
<tr>
<td>Columns</td>
<td>Use the column setting to determine how many columns will be used to arrange the objects.</td>
</tr>
<tr>
<td>Reset Cursor</td>
<td>If the include margins should be defined from the parent shape and not from the last rule's shape, check reset cursor. This is useful if only you have several include layout at the same level.</td>
</tr>
</tbody>
</table>

Vertical Layout:
The vertical layout allows you to add an object at the right or left of the parent object.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side</td>
<td>Use the Side setting to choose whether the shape should be drawn to the left or right of the parent shape.</td>
</tr>
<tr>
<td>Horizontal translate</td>
<td>Use the Translate settings to specify the distance between this object and its parent.</td>
</tr>
<tr>
<td>Vertical translate</td>
<td>Use the Space Children setting to specify the distance between instances at this level.</td>
</tr>
</tbody>
</table>
| Connect shapes  | • No: Do not connect the shapes in the diagram.  
• Association Joiner: If the palette has an association type as a line for the association type being used here, then connect the child to its parent using that line.  
• Connector: If you do not use the set joiner's option, you can instead use the set connectors option to connect the child to its parent using a standard connector on the palette. |

Notice, if there is more than one instance of an object returned at this level, then the object will be displayed multiple times on the diagram.

Spider Layout:
The spider layout allows putting the objects around the parent object.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distance from parent</td>
<td>Allow defining the minimum distance between the parent and the children shapes, if a bigger distance is required this distance will not be used.</td>
</tr>
<tr>
<td>Connect</td>
<td>• No: Do not connect the shapes in the diagram.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| shapes | • Association Joiner: If the palette has an association type as a line for the association type being used here, then connect the child to its parent using that line.  
• Connector: If you do not use the set joiners option, you can instead use the set connectors option to connect the child to its parent using a standard connector on the palette. |

**Related Items**

- Designing a Layout
- Running a Layout
Running a Layout

The run mode allows you to generate the diagrams depending on the configurations you have selected. When your diagram layout is correct, the run mode tab will appear next to the Design tab.

You can click on it in order to view the run mode.

Notice that depending on your design output type (single or group), the run mode varies.

The run mode objects which are displayed depend on the Primary object selected.

Run Mode for Single Output Type

In the single mode output, a diagram will be created for each primary object you will select.

You can select an object by checking the Generate column (1st column).

When selected, the selected row’s state column will change, below the lists of the available states:

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waiting for generation</td>
<td>The row has been correctly selected, when ready you can then start the generation</td>
</tr>
<tr>
<td>Generation in progress</td>
<td>The diagram is under generation</td>
</tr>
<tr>
<td>Generated</td>
<td>The diagram has been generated; it can be open using the “Open Diagram” column.</td>
</tr>
<tr>
<td>Clearing joiners &amp; shapes</td>
<td>The diagram has been opened and is being cleared, this take time depending on the number of shapes and joiners you have on the diagram.</td>
</tr>
</tbody>
</table>
Once at least one object is selected, you will be able to use the “Start Generation” button and start the generation of the diagram(s).

When a generation finishes, the name of the diagrams appears in the “Open Diagram” column, which should be the last column. You may then click once (like a hypertext link in your browser) and the diagram will open in Modeler.

**Run Mode for Group Output Type**

In the group mode for the group output type, all the objects you are going to select will be displayed on the diagram. You can select an object by checking the Generate column (1st column). Once you have selected at least one object, you can then use the “Start Generation” button to create the diagram. When the generation starts, a new button appears labeled “Generation under progress”. When the diagram is generated the button changes to “Open the Diagram”, if you click it, the diagram will open in Modeler.

You can go back at any time to the Design mode, and return, and your selected items will remain checked.

**Related Items**

- Designing a Layout
- Working with Diagram Designer
Batch Generation of Automatic Diagrams

The diagram designer generation can be automated. You first need to create your diagram design layout, make sure it’s working correctly by running it manually. Once checked you will be able to prepare the automatic execution.

To start configuring the batch mode:

1. Launch the "CMD" tool
2. Browse to your Diagram Designer installation directory
3. Launch the following command

`DiagramDesigner.exe -h`

The following usage will appear:

`DiagramDesigner.exe -connection <connection_to_database> -model <model_filename>
-username <username> -password <password> -id <item_id>`

Below details the arguments available:

<table>
<thead>
<tr>
<th>Argument Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-connection</td>
<td>The name of your connection used to connect Corporate Exchange</td>
</tr>
<tr>
<td>-model</td>
<td>The filename of the model you are going to use</td>
</tr>
<tr>
<td>-username</td>
<td>The Username to connect Corporate Modeler Suite</td>
</tr>
<tr>
<td>-password</td>
<td>The password associated with the username, leave &quot;&quot; if the password is empty</td>
</tr>
<tr>
<td>-id</td>
<td>The id of the design layout, accessible through the properties of the design layout which is available in the Diagram Designer Object Type</td>
</tr>
</tbody>
</table>

Notice that you can use double quotes around your arguments if required.

Related Items

Running a Layout

Log Files

Log Files

The Diagram Designer logs some information depending on the level of log requested.

This level can be configured in the DiagramDesigner.exe.config file which is located next to the DiagramDesigner.exe application.
Values can be \texttt{INFO} or \texttt{DEBUG}.

\textbf{Related Items}

\textbf{Running a Layout}

\textbf{Batch Generation of Automatic Diagrams}
Additional Layouts

Jump and Merge Layout

As of the 2018 release of Evolve, Diagram Designer is now capable of performing a "Jump and Merge". This popular add-on layout for Evolve Designer, has been brought to diagram designer, in order to make it possible to build more complex diagrams.

With this layout the objects of the selected associations will not be put on the diagram. Instead, their parent object(s) will be linked directly to their children. For example, if we have 3 levels and we switch the layout of the 2nd one to "Jump & Merge" this is what we’ll get:

![Diagram showing before and after states of Jump and Merge layout](image)

Jump and merge can be added to your diagram, in the same way that other layout controls are applied. The layout does not have any user defined properties other than the name. See below:
Related Items

Designing a Layout
Running a Layout
Diagram Associations
Diagram Association Layout

As of the 2018 release of Evolve, Diagram Designer is now capable of utilizing the diagram "detailed by" and "diagrammed on" associations. This allows designers to create diagrams that take advantage of diagram hierarchy/lineage.

The only available layout for a Diagram Association is the “Jump & Merge”.

284
From that level the users can add any type of association used by the diagrams and show the linked objects.
The combination of “Jump & Merge” and “Diagram Association” now allows designers to create very complex diagrams without having to draw all intermediate objects or being limited by standard object types and their basic/direct associations.

Single or consecutive “Jump & Merge” layouts and use of Diagram Associations make Diagram Designer even more powerful.

**Related Items**

- Designing a Layout
- Running a Layout
- Jump and Merge
Advance Filtering

Filter by Base Object [2018.0.1+]

Use the base object for this diagram as a filter at a lower level in the diagram query.

On each Association node there is a checkbox. When checked, the only object that will appear on the diagram at this level is the base object (if it is among the objects of this level).

In the following example, on the 3rd level (Transition State - Capability), if “Filter by Base Object” is checked, only the Capability for which this diagram is generated (Base Object) will appear.

Related Items

Designing a Layout

Running a Layout

Intersection Object Filter
Intersection Object Filter [2018.0.1+]

As the name suggests, the Intersection Object Filter, allows filtering at the Intersection level.

Filters are provided against the Intersection Object’s property values.

The syntax of the filter is SQL-like.
As can be seen in the following examples (be aware of the spaces):

- TRANSITIONSTATES LIKE ‘TS%’
- TRANSITIONSTATES NOT LIKE ‘%SEND’
- TRANSITIONSTATES IN (‘TS1’, ‘TS2’)
- TRANSITIONSTATES NOT IN (‘TS3’, ‘TS4’)
- TRANSITIONSTATES = ‘TS1’
- TRANSITIONSTATES >= ‘TS1’

Additionally more complex scenarios can be provided using variables:

- TRANSITIONSTATES LIKE ‘%(ACRONYM)%’

In the following example, on the last level, we show Applications that are associated to Capabilities and the Intersection Object’s property “TRANSITIONSTATES” (which is the property ScriptName) contains a specific string. The variable value used is taken from the first object of the branch (starting from the top of the diagram and moving down) that has the propertyname which is enclosed in curly braces (in this example, ACRONYM). In this case, the value is taken from the second level where we have the "Transition States" that have a property called “ACRONYM” (with values TS1, TS2 etc.).
Related Items

Designing a Layout
Running a Layout
Filter by Base Object
Navigating your Site

Overview

There are many ways in which you can navigate your Evolve site. However, since the 2018 release, two new capabilities were added to help orient yourself while navigating.

- **Smart Crumbs** - a bread crumb trail with inbuilt recent lists, to help quick navigation between frequently visited pages.
  Helps you to see where you are in the Evolve site, and navigate more speedily.

- **Diagram Navigator** (or "Where Am I?") - a diagram hierarchy viewpoint showing parent and child lineage from the current diagram.
  The tool can be used to navigate diagram hierarchies, showing previews of diagrams in the immediate lineage, and allowing drill up and down from the current position.
  Diagrams can be opened at any level, and activity is shown through the Smart Crumb trail.

Both Smart Crumbs and Diagram navigator are available without configuration. You just need to be running version 2018 or above.

Related Topics

**Smart Crumbs**

**Diagram Navigator**
Smart Crumbs

Introduced with Evolve 2018, Smart Crumbs brings a breadcrumb trail to the top of your site page.

- Smart Crumbs can be enabled in the Site Settings.
  1. Select the **Home** tab.
  2. Select the root **Site** node in the Layout's Tree.
  3. See the option to **Enable Smart Breadcrumbs** in the options in the right hand pane.
• The breadcrumb will expand as you navigate from the site menus, showing the menus and objects you navigate through.
• The breadcrumb will offer a drop down list at each page node, showing recent objects/pages of the same type.

Both Smart crumbs and Diagram navigator are available, provided you are running version 2018 or above.

Related Topics

Diagram Navigator
Site Configuration Reference
Diagram Navigator

Prior to Evolve 2018, diagram hierarchy navigation was performed purely through the diagram drill downs, and an in-page bread crumb trail. This trail was only integrated into the page, and could cause a little confusion with regards to the outer page content. Since the 2018 release a new diagram navigation has been added, that offers a much more visual experience.

As with Smart Crumbs, the Diagram Navigator feature is always enabled, and available to all users. You will see this new feature as a simple icon above any diagram in your site. See below:

- When viewing a diagram, pressing the new icon will launch the Diagram Navigator.
- The navigator will show the current diagram at the centre, with arrow-nodes representing each shape on the diagram, that drills down to child diagrams.
- Selecting one of these arrow-nodes will highlight the single/multiple child diagrams that 'explode' from this shape.
- Selecting the child diagram shapes, will display a diagram preview at the top left of the Navigator.
• Double-clicking on a child shape will drill down and re-center the Navigator around that diagram.
• Clicking on the "open" icon on any of the diagram shapes, will open the diagram fully.

Both Smart crumbs and Diagram navigator are available, provided you are running version 2018 or above.

Related Topics

Smart Crumbs

Share Diagram Link

The Share Diagram feature enables you to share a diagram’s link with your collaborators in multiple ways.

To share diagram links via erwin Evolve Designer:
1. Open the browser and login to erwin Evolve Web Platform.
2. Click a model.
   For example, EA Foundation - Sample Model.
3. Click **Application**.

4. Drill down to any application diagram. For example, click **Application > Application Architecture**.

5. Click ⬇️.
The available options to share diagram link appear.

6. Select the appropriate option. Refer to the following table for option descriptions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Diagram Link</td>
<td>Copies the current diagram's link</td>
<td>Even in case of drilled-down diagrams, this option copies the link to the current drilled-down diagram.</td>
</tr>
<tr>
<td>Mail Diagram Link</td>
<td>Opens a draft email with the current diagram's link</td>
<td></td>
</tr>
</tbody>
</table>

Apart from sharing diagram links, you can also open or print the diagram. Refer to the following table for option descriptions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Diagram Here</td>
<td>In case of drilled-down diagrams, this option opens the drilled-down diagram in the same window as the root diagram</td>
</tr>
<tr>
<td>Open Diagram in New Tab</td>
<td>Opens the current diagram in a new tab in the web browser</td>
</tr>
<tr>
<td>Print Current Diagram</td>
<td>Open the Print options for the current diagram</td>
</tr>
</tbody>
</table>
Enhanced erwin Evolve Plugins

Overview

A new module, Administration, has been added to erwin Evolve site, where you can configure new options for object pages.

To be able to use the enhanced plugins, ensure that you have applied upgrade instructions. For upgrade instructions, refer to the Upgrading to Evolve Suite 2023.0 topic in the erwin Evolve Web Platform Installation Guide.

What do you want to do?

Enable Action On Object Page

Enable Validate on Edit properties
Enable Enhanced Custom Display String
Enable Enhanced Diagram Display
Enable Duplicate Object
Enable Custom Homepage
Enable Page Search
Enable Enhanced Property Display
Enable Redirect Edit View
Enable Complex Table
Enable Settings

**Action On Object Page**

The Action On Object Page feature enables condition-based messaging, hiding, or highlighting of object pages.

Hover over '?' to view the feature description.

*To configure the Action on Object Page feature, follow these steps:*

1. Open the browser and login to erwin Evolve Web Platform.
2. Click a model. For example, **EA Foundation - Sample Model**.

3. Click **Administration**.

4. Click **Action On Object Page**.
5. Click the **Evolve view** drop-down list box and select the required option.

6. To create an operation, click the **Add New** icon.
7. Enter appropriate values in the fields. Refer to the following table for field descriptions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies the operation name</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Specifies the description of the operation</td>
<td></td>
</tr>
<tr>
<td>Don't Apply to these Roles</td>
<td>Specifies Evolve roles that do not apply to this operation</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>Specifies the order of operation</td>
<td>Use up or down arrow to change the order of operation</td>
</tr>
<tr>
<td>Filter</td>
<td>Specifies the filter option to filter the values for operation</td>
<td>To add a filter, click the Property drop-down list box, and select the required option.</td>
</tr>
<tr>
<td>Action</td>
<td>Specifies the types of action. For more information, refer to the Types of Action.</td>
<td>The action you select applies to the Filter you select.</td>
</tr>
<tr>
<td>Element affected</td>
<td>Specifies the affected elements</td>
<td>Available when Action is set to Hide or Highlight</td>
</tr>
<tr>
<td>Select Tabs</td>
<td>Specifies the selected tabs</td>
<td>Available when Action is set to Hide or Highlight and Element affected is set to Tabs</td>
</tr>
<tr>
<td>Selected Property Groups</td>
<td>Specifies selected property groups</td>
<td>Available when Action is set to Hide or Highlight and Element affected is set to Property Groups</td>
</tr>
<tr>
<td>Selected View</td>
<td>Specifies selected views</td>
<td>Available when Action is set to Hide or Highlight and Element affected is set to Views</td>
</tr>
<tr>
<td>Class HTML</td>
<td>Specifies an HTML class</td>
<td>Available when Action is set to Hide or Highlight and Element affected is set to Css Class</td>
</tr>
<tr>
<td>ID HTML</td>
<td>Specifies HTML Id</td>
<td>Available when Action is set to Hide or Highlight and Element affected is set to Html Id</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Additional Information</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>jQuery Selector</td>
<td>Specifies the jQuery Selector</td>
<td>Available when Action is set to Hide or Highlight and Element affected is set to jQuery Selector.</td>
</tr>
</tbody>
</table>

8. Click to save the configuration.
   You will be notified that "Configuration draft has been saved".

9. Click to publish the configuration.
   You will be notified that "Configuration published successfully".

Now, on the object page, you can perform the following actions:

**Hide**

Use this option to hide Tabs, Views and Property Groups.

You can also hide the following information if you are more experienced with web development:

- Css Class
- Html Id
- jQuery Selector

**Highlight**

Use this option to highlight Tabs, Property Groups, Views, Css Class, Html Id, or jQuery Selector.

*Highlight works like Hide but adds a color border to the selected element. You can choose what color to use.*

You can change the color of the affected elements. Click and use the color palette to set the color.

**Display Message**

Use this option to display a message on the object page. Use the following options:
• **Select Tabs**
  Use this option to select a tab on which you want to display a message. To select a tab, click the **Select Tabs** drop-down list box and select the required option.

• **Select Picture**
  Use this option to upload a picture to display on the object page.

  To upload a picture, click ![(upload)](image), select the picture and click **Open**.

  ![You can only upload pictures up to 2 MB.](image)

• **Width**
  Use this option to set a picture's width.
  For example, 200.

• **Height**
  Use this option to set a picture's height.
  For example, 200

• **Icon**
  Use this option to select an icon. You can also change the color of an icon. To change the color, click ![icon](image) and use the color palette to set a color.

• **Text**
  Use this option to enter a text to display on the object page.

• **Preview**
  Use this option to preview the picture, icon with color, and text.

**Word Template**

Use this option to add Word document on the object page.

![It only supports .docx file type.](image)

Ensure that you have the word Templar at the following location before adding a url
link: [http://localhost/evolve/data/easamp14/live](http://localhost/evolve/data/easamp14/live).

In the **Url Template** box, enter the word file url.

For example, [http://localhost/evolve/data/easamp14/live/generated/wordfile.docx](http://localhost/evolve/data/easamp14/live/generated/wordfile.docx)

You can now see the ![file](image) added at the top right corner.

Double-click ![download](image) to download the word file.
Validate on Edit Properties

The Validate on Edit Properties feature enables you to fill automatic values for object type properties and add minimum and/or maximum values for associations while editing object properties.

Hover over ? to view the feature description.

To fill automatic values for properties and associations, follow these steps:

1. Open the browser and login to erwin Evolve Web Platform.
2. Click a model. For example, EA Foundation - Sample Model.
3. Click Administration.
4. Click Validate on Edit properties.
5. Click the Evolve view drop-down list box and select the object type that you want to auto-populate. For example, Flow (flow).

The properties and associations of the Flow object type appear.
6. Enter appropriate values in the fields. Refer to the following table for field descriptions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (name)</td>
<td>Specifies the flow name</td>
<td></td>
</tr>
<tr>
<td>Category (type)</td>
<td>Specifies the flow category</td>
<td>Select the required category from the dropdown.</td>
</tr>
<tr>
<td>Criticality (criticality)</td>
<td>Specifies the flow criticality</td>
<td>Select the required criticality from the dropdown.</td>
</tr>
<tr>
<td>Description (description)</td>
<td>Specifies the flow description</td>
<td></td>
</tr>
</tbody>
</table>

You can fill automatic values and add minimum and/or maximum values for any object type properties and associations. Under the Minimum and Maximum columns, use up or down arrow to set the associations.

For example, the following image displays the minimum and maximum values for different association types.

7. Click to save the configuration.
   You will be notified that "Configuration draft has been saved".

8. Click to publish the configuration.
   You will be notified that "Configuration published successfully".

To view automated values, follow these steps:
1. **Open an object.**  
   For example, click Information > Flow List.

2. Click to open the required flow list. For example, CI List.
   The CI List properties opens.

3. Click .

4. Click .
   The Update Summary appears in the right pane.
   You can now see the automated values under Property Changes.

5. Click **Submit**.
   You will be notified that "Your changes have been saved".

   *To add associations as per the minimum and/or maximum values you set in the configuration, follow these steps:*
1. Under Flow, click **Associations**.

![Associations](image1.png)

2. Click ✅

3. In the **Associate Objects** search box, type a keyword.
   A list of related search terms appears.

4. Select the required association or click + to create a new association.

![Associations](image2.png)

5. Click ✅
   The Update Summary appears in the right pane, and you can now see the association changes.

![Update Summary](image3.png)

6. Click **Submit**.
   You will be notified that "Your changes have been saved".
Adding an associate object beyond the maximum value displays a warning in the right pane. For example, the following image displays a warning when more than two associations are added for the application object type.

---

**Enhanced Custom Display String**

The Enhanced Custom Display String feature enables you to add an icon to the custom display string. Clicking this icon opens the object's properties pop-out.

Hover over 🟢 to view the feature description.

*Ensure that a diagram pop-out must be added for the object type for which you want to see icons and object’s properties pop-out.*

**To configure the diagram pop-out in erwin Evolve Designer, follow these steps:**

1. Start Evolve Designer.
2. Click a model. For example, **EA Foundation - Sample Model**.
3. Click **Site**.
4. Expand **Site > Diagram Popouts**.
5. Right-click **Diagram Popouts** and click **Add Diagram Popout for Object Type**.
6. Select the required object type for which you want to configure pop-out. For example, **Process**.
A Diagram Pop-out is created for the **Process** object type.

7. Click **Save**.
8. Click **Dynamic Site**.

---

You can create a diagram pop-out for any object type to view an icon and object's property pop-out.

**To configure the Enhanced Custom Display String feature, follow these steps:**

1. Open the browser and login to erwin Evolve Web Platform.
2. Click a model. For example, **EA Foundation - Sample Model**.
3. Click **Administration**.
4. Click **Enhanced Custom Display String**.
5. Turn the Enable Popout ON to enable the pop-out window.
6. Click the **Select Icon** drop-down list box and select the required icon.
7. Click **to save the configuration.**
   You will be notified that "Configuration draft has been saved".
8. Click **to publish the configuration.**
   You will be notified that "Configuration published successfully".

**To view an icon and an object's pop-out, follow these steps:**

1. In the left pane, click **Business > Process List.**
   You can now see the android icon added to the object type.
2. Clicking opens the pop-out of an object in the right pane.

You can now see the icon and object pop-out in the right pane.

**Enhanced Diagram Display**

This feature allows you to change the behavior of HTML5 diagrams by deactivating drill-down and selecting a highlighting color.

Hover over to view the feature description.

*Before configuring the diagram, an index page, z_diagram_template must be added for the object type Diagram to get the diagram template list.*

**To add an index page, follow these steps:**

1. Start Evolve Designer.
2. Click a model. For example, **EA Foundation - Sample Model**.
3. Click **Site**.
4. Expand Site > Index Pages.
5. Right-click **Index Pages** and select **Add Index Page for Object Page > Diagram**.

An index page "index_diagrams" is created for the Diagram object type.

6. Click **index_diagrams**.
7. In the **Page Name** box, replace "index_diagrams" with "z_diagram_template".
8. Expand `z_diagram_template` and click `Diagram`.

9. In the right pane, under `Filter Properties (AND)`, use the following options:
   - **Property**: Click the Property drop-down list box and select `Template`.
   - **Operation**: Click the Operation drop-down list box and select `=`.
   - **Value**: Click the Value drop-down list box and select `True` value.

10. Expand `Object Pages > diagram > Diagram > Tabs`.

11. Right-click `Tabs` and click `NewTab`.

---

Enhanced erwin Evolve Plugins 309
A Tab2 is created.

12. Click Tab 2.

13. In the Tab Name box, replace "Tab2" with "Vector (HTML5)."

14. In the left pane, right-click Vector (HTML5), and select Add Layout > Casewise > Diagram.
A **Layout Diagram** node is created.

15. Right-click **LayoutDiagram**, and select **Add Behaviours > Diagram > Vector (HTML5)**.

16. Right-click **Diagram Popouts** and select **Add Diagram Popout for Object Type > Diagram**.

A diagram pop-out "diagram_diagram_popout" is created for the Diagram object type.
17. Expand diagram_diagram_popout.


You can select any property group that you want to display on the object page.

19. Click Save.

20. Click Dynamic Site.

To configure diagram display, follow these steps:

1. Open the browser and login to erwin Evolve Web Platform.

2. Click a model. For example, EA Foundation - Sample Model.

3. Click Administration.

4. Click Enhanced Diagram Display.

5. Enter appropriate values in the fields. Refer to the following table for field descriptions.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Object Page on DrillDown</td>
<td>Switch this option on to open the object's object page instead of exploded diagram list.</td>
<td>Clicking on the object's object page.</td>
</tr>
<tr>
<td>Deactivate Where Am I</td>
<td>Switch this option on to deactivate icon from the diagram.</td>
<td>Select the required template from the drop-down option.</td>
</tr>
<tr>
<td>Select Template</td>
<td>Specifies diagram template</td>
<td></td>
</tr>
<tr>
<td>Filter Association Region</td>
<td>Specifies the type and count of association.</td>
<td>Clicking on the diagram opens a Filter section in the right pane. For example, the following image displays the Application and Entity objects' association types.</td>
</tr>
<tr>
<td></td>
<td>Switch this option on to view icon on the diagram.</td>
<td>Clicking displays association name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clicking displays the association count.</td>
</tr>
<tr>
<td>Popout</td>
<td>Switch this option on to view in the diagram.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clicking opens the diagram pop-out in the right pane.</td>
</tr>
<tr>
<td>Diagram Popout to use</td>
<td>Specifies diagram popout created in the Evolve Designer</td>
<td>Select the popout from the drop-down option.</td>
</tr>
<tr>
<td>Enable Highlighting</td>
<td>Switch this option on to highlight the objects.</td>
<td>Enables additional highlighting fields. Also, on the Vector (HTML5) diagram, it enables the focus on and DiagramSearchSearchIcon icons.</td>
</tr>
<tr>
<td>Highlight Color</td>
<td>Specifies the highlight color.</td>
<td>To change the highlight color.</td>
</tr>
<tr>
<td><strong>Transparency of unselected objects</strong></td>
<td>Use this option to adjust the transparency (range from 0-1) of unselected objects.</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Palette Objectypes</strong></td>
<td>Use this option to highlight object types and property types.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1. Click the <strong>Palette Objectypes</strong> section.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Select the Highlight, Steps and Drill Down check boxes of required object and property types.</td>
<td></td>
</tr>
<tr>
<td><strong>Steps</strong></td>
<td>Use this option to highlight date properties under object type.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1. Click the <strong>Steps</strong> section.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Click the <strong>Application</strong> section.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Click + to add step.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. In the Step Name box, enter the step name.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5. Click the Start Property drop-down list box and select the required option.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6. Click the End Property drop-down list box and select the required option.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7. Under Color, click</td>
<td></td>
</tr>
</tbody>
</table>
and use the color palette to set a color.

<table>
<thead>
<tr>
<th>Drill Down Filters</th>
<th>Use this option to display message for object and property types.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Click the Drill Down Filters section.</td>
</tr>
<tr>
<td></td>
<td>2. Click the Application section.</td>
</tr>
<tr>
<td></td>
<td>3. Click the Drill Down Role to not apply list box, and select the required role.</td>
</tr>
<tr>
<td></td>
<td>1. In the Message to Display box, enter a message to display in the notification bar.</td>
</tr>
<tr>
<td></td>
<td>2. Click to add new filter properties.</td>
</tr>
<tr>
<td></td>
<td>3. Click the Property drop-down list box and select the required option.</td>
</tr>
<tr>
<td></td>
<td>4. Click the Operator drop-down list box and select the required option.</td>
</tr>
<tr>
<td></td>
<td>5. Use Value or drop-down list to specify the property value.</td>
</tr>
</tbody>
</table>

6. Click to save the configuration.
   You will be notified that "Configuration draft has been saved".

7. Click to publish the configuration.
   You will be notified that "Configuration published successfully".

**To add date properties for an object type (For example, Application), follow these steps:**

1. Start the erwin Evolve Suite.
2. Click Modeler.
3. In the left pane, click Open.
4. Select the Model. For example, **EA Foundation - Sample Model**.
5. Select the template. For example, **Template: Application Architecture**.
6. Under palette, right-click **Application** and click **Edit Properties**.

Application Palette Properties dialog box opens.
7. Click **Add**.

The Application Shape Region dialog box opens.
8. Click the Region Type drop-down list box and select the Property Value.
9. Under **Content**, click the **Property Type** drop-down list box and select **Go Live Date**.

10. Click **OK**.

Similarly, you can add one more date property. For example, **End of Life**.

---

You must add minimum two date properties and maximum as much you want.

11. Click **OK**.


13. Click a model. For example, **EA Foundation - Sample Model**.

14. Click **Site**.

15. Click **Save**.

16. Click **Dynamic Site**.
To view an object in zoom-in mode, follow these steps:

1. In the focus on search box, type a keyword.
   A list of related search terms appears.
2. Select the required object. For example, Activity Monitoring.
   You can now see the Activity Monitoring appears in zoom-in mode.

To search for an Object Type with highlighted color on the diagram, follow these steps:

3. Click 📋.
   A Search page appears in the right pane.
4. Use the following options:
   - **Object Type**
     Use this option to select the required object type from the drop-down option.
     For example, Application.
     Additional options appear based on the Palette Properties in Modeler. For example, the below options appear for Application Object Type.
   - **Name**
     Use this option to search for an object type name that you are looking for on the diagram.
   - **Category**
     Use this option to search an object type based on category.
   - **Criticality**
     Use this option to search an object type based on criticality. Select the required Criticality from the drop-down option.
   - **Enterprise Standard**
     Use this option to search an object type based on Enterprise Standard.
   - **Contract Type**
     Use this option to search an object type based on the Contract type.
   - **Number of Users**
     Use this option to search an object type based on the number of users.
   - **Date**
     Use this option to search an object type based on date properties. To search start and end date, click 📅, and select the required date.

**Duplicate Object**

The Duplicate Object feature adds a Duplicate button to object pages, which enables you to duplicate objects directly from erwin Evolve. Based on the configuration you set up, it copies all properties, associations, and association properties of the object page.

Hover over 📧 to view the feature description.

To configure the Duplicate Object feature, follow these steps:

1. Open the browser and login to erwin Evolve Web Platform.
2. Click a model. For example, EA Foundation - Sample Model.
3. Click Administration.

4. Click **Duplicate Object**.

The Duplicate Object screen appears.

5. Enter appropriate values in the fields. Refer to the following table for field descriptions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the views to apply</td>
<td>Specifies the list of views to which the Duplicate Object button is added</td>
<td></td>
</tr>
<tr>
<td>Configure View</td>
<td>Based on the selected views, specifies the views for which you want to configure object duplication properties</td>
<td></td>
</tr>
<tr>
<td>Force Duplicate</td>
<td>Specifies whether the Duplicate Object button is added for even the objects with any role-based approvals configured in the Model Explorer</td>
<td>For objects with role-based approvals configured, by default, the Duplicate Object button is hidden. To display the button, switch the Force Duplicate option On.</td>
</tr>
<tr>
<td>Associate to original object</td>
<td>In case of object with associations, specifies whether the duplicate object must replicate associations to the source object</td>
<td></td>
</tr>
<tr>
<td>Exclude Properties</td>
<td>Specifies the object properties that should be excluded in the duplicate object</td>
<td></td>
</tr>
<tr>
<td>Exclude Associations</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Additional Information</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Exclude Associations</td>
<td>Specifies the object associations that should be excluded in the duplicate object</td>
<td></td>
</tr>
</tbody>
</table>

6. Click 📋. You will be notified that "Configuration draft has been saved".

7. Click 📋. You will be notified that "Configuration published successfully" and the Duplicate Object button is added to the object page. For example, on an application screen.

To duplicate objects, follow these steps:

1. Open an object. For example, an application.
2. Click .
The Creation Summary screen appears.

3. Click Submit.
You will be notified that "Your new Application has been created".

Custom Homepage

The Custom Homepage feature offers options to customize your home page by disabling My Menu option from the left pane.

Hover over ? to view the feature description.

To configure home page, follow these steps:

1. Open the browser and login to erwin Evolve Web Platform.
2. Click a model. For example, EA Foundation - Sample Model.
3. Click **Administration**.

4. Click **Custom Homepage**.

5. Switch the **Deactivate the My Menu feature** option on.

6. Click the **add_column** icon.

7. Enter appropriate values in the fields. Refer to the following table for field descriptions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies the column name.</td>
</tr>
<tr>
<td>Approved Roles</td>
<td>Specifies approved roles</td>
</tr>
<tr>
<td>Order</td>
<td>Specifies the column order. Use up or down arrow to change the column order.</td>
</tr>
<tr>
<td>Width</td>
<td>Specifies the width of the column. For example, 300. The width value should be in percent.</td>
</tr>
</tbody>
</table>
8. Click the **Add Display** icon.

You can add multiple displays per column.

9. Enter appropriate values in the fields. Refer to the following table for field descriptions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies the Display name.</td>
</tr>
<tr>
<td>Description</td>
<td>Specifies the description of the display</td>
</tr>
<tr>
<td>Approved Roles</td>
<td>Specifies approved roles</td>
</tr>
</tbody>
</table>

10. Click the **Display settings** section.

11. Enter appropriate values in the fields. Refer to the following table for field descriptions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Specifies the display order</td>
<td></td>
</tr>
<tr>
<td>Transparent</td>
<td>Specifies whether the display is transparent</td>
<td></td>
</tr>
<tr>
<td>Fixed Width</td>
<td>Specifies whether the column width is fixed</td>
<td></td>
</tr>
<tr>
<td>No Padding</td>
<td>Specifies whether there is space between two displays</td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>Specifies the display width</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, 20% or 100px or 20vh.</td>
<td></td>
</tr>
<tr>
<td>Extendable</td>
<td>Specifies whether the display name and display type is displayed in extended mode</td>
<td>Available when you switch on the Extendable option</td>
</tr>
<tr>
<td>Height</td>
<td>Specifies the display height</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, 100px or 50vh.</td>
<td></td>
</tr>
<tr>
<td>Expand Button With Text</td>
<td>Specifies whether the display name header is used as a button and enables viewing display types in collapsed and expanded modes</td>
<td>Available when you switch on the Extendable option</td>
</tr>
<tr>
<td>Collapse By Default</td>
<td>Specifies whether the display is in collapsed mode by default</td>
<td>Available when you switch on the Extendable option</td>
</tr>
<tr>
<td>Type</td>
<td>Specifies the column display type. For more information refer to the Column Display Types</td>
<td>Select the required column display type from the drop-down option.</td>
</tr>
</tbody>
</table>
On the Homepage you can display the following column display types:

**Favorite**
Displays objects marked as a favorite.

**Link Based on Roles**
Displays all roles and my menu items on the homepage.

**Index Page**
Displays configured index page from Evolve view. Selecting Index Page from **Type** drop-down enables additional fields.

*It only works with the **Layout List (Simple)** and **Layout List Box** of the index page.*

**To display an index page, follow these steps:**
1. Click the **Index Page** section.
2. Use the following options:
   - Evolve view: Use this option to display an index page. Select the required index page from the drop-down option.
   - Give Index Context
   - Give Single Context
   - Get Context From: Use this option to get context from different displays.

**Object Page**
Displays configured object page from Evolve view.
Selecting Object Page from **Type** drop-down enables additional fields.

**To display an object page, follow these steps:**
1. Click the **Object Page** section.
2. Use the following options:
   - Evolve View: Use this option to display an object page. Select the required object page from the drop-down option.
   - Give Index Context
   - Give Single Context
   - Get Context From
   - Use this option to get context from different displays.

**Description of an Object**
Displays the description of an object. Selecting the Description of an Object from the **Type** drop-down list enables additional fields.

**To display an object description, follow these steps:**
1. Click the **Description of an Object** section.
2. Click the **Select the object** drop-down list box and select the required object. For example, **Application**.
3. Click the second drop-down list box and select the required option. For example, **Activity Monitoring**.

**Last Modified Objects**
Displays all last modified objects with their custom properties. Selecting Last Modified Objects from the **Type** drop-down list enables additional fields.

*To display all modified objects, follow these steps:*
1. Click the **Last Modified Objects** section.
2. Enter appropriate values in the fields. Refer to the following table for field descriptions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Evolve Page</td>
<td>Specifies whether an Evolve page is displayed</td>
<td></td>
</tr>
<tr>
<td>Link</td>
<td>Specifies the link to evolve page</td>
<td>Available when you switch on the <strong>Show Evolve Page</strong> option.</td>
</tr>
<tr>
<td>Text</td>
<td>Specifies the text with the evolve page link</td>
<td>Available when you switch on the <strong>Show Evolve Page</strong> option.</td>
</tr>
<tr>
<td>Show Icon if Favorite modified</td>
<td>Specifies the icon of modified favorite objects</td>
<td></td>
</tr>
<tr>
<td>Url icon</td>
<td>Specifies the url of the icon</td>
<td></td>
</tr>
<tr>
<td>Show Objects Modified Days</td>
<td>Specifies the object's modified days</td>
<td></td>
</tr>
<tr>
<td>ObjectTypes to display</td>
<td>Specifies the object types to display</td>
<td></td>
</tr>
<tr>
<td>Configure Object Type</td>
<td>Specifies the object type to configure</td>
<td></td>
</tr>
<tr>
<td>Custom Display String</td>
<td>Displays the text in accordance with the specified script name</td>
<td>Available when you select the <strong>ObjectTypes to display</strong> and <strong>Configure Object Type</strong>.</td>
</tr>
<tr>
<td>Enhanced Property display</td>
<td>Specifies an enhanced properties to display</td>
<td>Available when you select the <strong>ObjectTypes to display</strong> and <strong>Configure Object Type</strong>.</td>
</tr>
<tr>
<td>Filter</td>
<td>Specifies the filter option to filter the properties</td>
<td>To add a new filter, click <img src="image" alt="Add Filter" /></td>
</tr>
</tbody>
</table>

1. **Property** drop-down list box, and select the required option.
2. Click the **Operator** drop-down list box and select the required option.

3. Use **Value** or drop-down list to specify the property value.

---

### Carousel
Displays a slide show of images and content.
Selecting Carousel from the **Type** drop-down list, enables additional section.

**To display slide show, follow these steps:**

1. Click the **Carousel** section.

2. Click \(+\) to add slide.

3. Enter appropriate values in the fields. Refer to the following table for field descriptions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Specifies the name of slide.</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Specifies the description of slide</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>Specifies the slide order</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Note: Use up or down arrow to change the column order.</em></td>
<td></td>
</tr>
<tr>
<td>Left Picture</td>
<td>Specifies the left-side picture</td>
<td>Enter a picture link to display on the left side.</td>
</tr>
<tr>
<td>Right Picture</td>
<td>Specifies the right-side picture</td>
<td>Enter a picture link to display on the right side.</td>
</tr>
</tbody>
</table>

### Links In Box
Displays images with links.
Selecting Links In Box from the **Type** drop-down list, enables additional section.

**To display an image with links, follow these steps:**

1. Click the **Link In Box** section and use the following options:

   - **Alignment**
     Use this option to set an alignment of images and links.
   
   - **Image Width**
     Use this option to specify the width of image.
- **Round Shape**
  Switch this option to apply round shape.

- **Font Size**
  Use this option to specify the font size. For example, 20px.

- **Links**
  Use this option to upload picture and add target link and text.

**To add a new link, follow these steps:**

1. Click to add a new link.
2. In the **Order** box, specify order of link.

   *You can add multiple slides.*

1. Click the **Carousel** section.
2. Click to add a slide.
3. Enter appropriate values in the fields. Refer to the following table for field descriptions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Specifies the name of the slide</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Specifies the description of the slide</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>Specifies the slide order</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Note: Use up or down arrow to change the column order.</em></td>
<td></td>
</tr>
<tr>
<td>Left Picture</td>
<td>Specifies the left-side picture</td>
<td>Enter a picture link to display on the left side.</td>
</tr>
<tr>
<td>Right Picture</td>
<td>Specifies the right-side picture.</td>
<td>Enter a picture link to display on the right side.</td>
</tr>
</tbody>
</table>

**Links In Box**

Displays images with links.
Selecting Links In Box from the **Type** drop-down list enables an additional section.

**To display an image with links, follow these steps:**

- **Alignment**
  Use this option to set an alignment of images and links.

- **Image Width**
  Use this option to specify the width of the image.

- **Round Shape**
Switch this option to apply a round shape to the picture.

- **Font Size**
  Use this option to specify the font size. For example, 20px.

- **Links**
  Use this option to upload a picture and add a target link and text.

*To add a new link, follow these steps:*

1. Click + to add a new link.
2. In the Order box, specify the order of link.

  *Use up or down arrow to change the order.*

3. In the Text to Display box, enter a text to display with target link.
4. Under Url of the Picture, click Choose File.
5. Select the required picture and click Open.
6. In the Target Link box, enter a target link.
   Clicking this link, you will be redirected to that link.

**Page Search**

The Page Search feature enables you to configure the filter properties of the search box on all object pages.

Hover over ? to view the feature description.

**To configure the Page Search feature:**

1. Open the browser and login to erwin Evolve Web Platform.
2. Click a model. For example, **EA Foundation - Sample Model**.

3. Click Administration.

4. Click Page Search.
   The Page Search screen appears.
5. Enable appropriate filter configurations. Refer to the following table for descriptions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match Text</td>
<td>Specifies whether the search results return only those results where all terms in a search string occur.</td>
</tr>
<tr>
<td>Ignore case and accent</td>
<td>Specifies whether the case and accent common in non-English languages are ignored.</td>
</tr>
</tbody>
</table>

6. Click 
You will be notified that "Configuration draft has been saved".

7. Click 
You will be notified that "Configuration published successfully". The page search filter feature takes effect. For example, if you enable Match Text property and search for the term prod mon, the search results will display only those results that contain both words, prod and mon.

If you enable the Ignore case and accent property, an é will be considered as an e.

**Enhanced Property Display**

The Enhanced Property Display feature offers formatting options to enhance Display URL, Boolean, Numeric, and Lookup properties.

Hover over '?' to view the feature description.

*To configure property display, follow these steps:*
1. Open the browser and login to erwin Evolve Web Platform.

2. Click a model. For example, **EA Foundation - Sample Model**.

3. Click **Administration**.

4. Click **Enhanced Property display**.

5. Use the following options:

   - **Drop Down**
     Use this option to improve different properties of object types. Clicking this section enables a drop-down, where you select the required object type for which you want to enhance property display. For example, **Technology**. A technology properties section appears.

   - Expanding each property section displays its values.
For example, to enhance the Criticality property, follow these steps:

1. Click the Criticality section.
   A value of criticality appears.
2. Under Image url, click Choose File.
3. Select the required image and click Open.
4. Under Icon, click the drop-down list box and select the required icon.
5. Under Icon Color, click .
   Use the color palette to set the icon color.
   Use the color palette to set the text color.
   Similarly, you can add images and set the color of text and icons for other properties.

Url
Use this option to add a documentation link.

Boolean
Use this option to display the Boolean values such as True and False.

Selecting Use an icon check box, displays a boolean icon. For example, ✓ and ✗.

Number
Use this option to display the minimum and maximum number of enhanced property displays.
To add numeric values to the Enhanced Property display, follow these steps:

1. Click the Number section.
2. Click the drop-down list box and select the required object. For example, Application (application).
You can now add steps for any property that you want to update on the object page. For example, if you want to add steps for the *Number of Users* property, follow these steps:

1. Click the **Add Step** icon.

   ![Add Step Icon]

   The column fields appear.

   ![Column Fields Example]

   For example, if you want to add steps for the Number of Users property, follow these steps:
2. Enter appropriate values in the fields. Refer to the following table for field descriptions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum</td>
<td>Specifies the minimum value of enhanced property</td>
<td></td>
</tr>
<tr>
<td>Maximum</td>
<td>Specifies maximum value of enhanced property</td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td>Specifies the unit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, $, kg, %</td>
<td></td>
</tr>
<tr>
<td>In Front ?</td>
<td>Specifies unit before or after the value</td>
<td>To specify the unit before the value, select the In Front check box.</td>
</tr>
<tr>
<td>Decimal Splitter</td>
<td>Splits the integer and fraction parts using a decimal point or decimal comma</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, 12.50 or 12,50</td>
<td></td>
</tr>
<tr>
<td>Thousand Splitter</td>
<td>Splits thousands in numbers with more than three digits to the left of the decimal separator using a comma or point.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, 78,000 or 78.000</td>
<td></td>
</tr>
<tr>
<td>Image url</td>
<td>Specifies the image url</td>
<td></td>
</tr>
<tr>
<td>Icon</td>
<td>Displays font awesome icon</td>
<td></td>
</tr>
<tr>
<td>Icon Color</td>
<td>Displays icon color</td>
<td>To change the color, click and use the color palette to set the color.</td>
</tr>
<tr>
<td>Text Color</td>
<td>Displays text color</td>
<td>To change the color, click and use the color palette to set the color.</td>
</tr>
</tbody>
</table>

3. Click .

4. Click .

**MemoText**

Use this option to display Object Type and index pages used for MemoText Mapping.

**Global Mapping**

Use this option to display global mapping.

- **Dropdown**
Use this option to improve different properties of object type.
Clicking this section, enables a drop-down where you select the required object type for which you want to enhance property display. For example, **Technology**.
A technology properties section appears.

Expanding each properties section, displays their values.

For example, to enhance the Criticality property, follow these steps:

1. Click the **Criticality** section.
   Values of criticality appear.
2. Under **Image url**, click **Choose File**.
3. Select the required image and click **Open**.
4. Under **Icon**, click the drop-down list box and select the required icon.
5. Under **Icon Color**, click .
   Use the color palette to set the icon color.

   Use the color palette to set the text color.
   Similarly, you can add images and set the color of text and icons for other properties.

- **Url**
  Use this option to add documentation link.

- **Boolean**
  Use this option to display the Boolean values such as True and False.

  Selecting **Use an icon** check box, displays boolean icon. For example, ✔ and ✗.

- **Number**
  Use this option to display minimum and maximum number of enhanced property display.

- **MemoText**
  Use this option to display Object Type and index pages used for MemoText Mapping.

- **Global Mapping**
  Use this option to display global mapping.

### Redirect Edit View

The Redirect Edit View enables you to redirect Evolve users to different views on entering the edit mode.

Hover over 🎨 to view the feature description.

*Redirection works only with more than one object type.*

**To create an object page for an object type, follow these steps:**

1. Start Evolve Designer.
2. Click a model. For example, **EA Foundation Sample Model**.
3. Click **Site**.
4. Expand **Site**.
5. Right-click **Object Pages** and select **Add Object Page for Object Type**.
6. Select the required object type. For example, Application.

7. In the Page Name box, replace “application” with “application1”.

8. Click Save.

9. Click Dynamic Site.

To configure the Redirect Edit View feature, follow these steps:

1. Click Administration.

2. Click Redirect Edit View.

3. Click the Evolve view drop-down list box and select the required object type. For example, Application (application).

4. Click the Redirect to drop-down list box and select the object page where you want to redirect. For example, Application (application1).

5. Click ✽ to save the configuration.
   You will be notified that the “Configuration draft has been saved”.

6. Click ✪ to publish the configuration.
   You will be notified that the “Configuration published successfully”.

To view the redirect URL, follow these steps:

1. In the left pane, click Application and select Application List.

2. Click Application List.

3. Click ✰ to open the object page of the required application.
For example, the following image displays the object page of **Activity Monitoring**.

4. Click ![image](image)

This redirects you to the **application1** view.

In the address bar, you can now see redirected view selected during configuration.

```
localhost/evolve/sites/easamp14/index.html#/cwtype=single&cview=application1&lang=e...
```

**Complex Table**

The Complex Table feature provides an option to display a complex table and object's properties (Title, size of the table, size of the column), and disable all the filters at once.

Hover over ![image](image) to view the feature description.

You can configure complex tables at Table Level, View Level, and Column Level.

**To configure a complex table at Table level, follow these steps:**

1. Open the browser and login to erwin Evolve Web Platform.
2. Click a model. For example, **EA Foundation - Sample Model**.
3. Click ![image](image)
4. Click **Complex Table**.

5. Click the **Table Level Settings** drop-down list box.
   The options for table-level settings appear.

![Table Level Settings](image)

6. Use the following options:
   - **Clear Filter At Start**
     Switch this option on to clear the filter each time.
   - **Group Columns**
     Switch this option on to group multiple columns. To group columns, drag the column header to the **Drag Column Header here to group** section.
     Also, you can open and close column groups to show and hide additional columns.
     For example, the following image displays the grouped columns.

![Grouped Columns](image)

- **Popout button**
  Switch this option on to view the object's properties in the pop-out. To view object properties, click ![Popout Button](image).
  This opens the object's properties in the right pane. For example, the following image displays the Accounting object's properties in the pop-out.

![Popout Button](image)
No. of objects per page
Use this option to set the number of objects to display per page in the table. For example, 2, 4.

To select the number of objects per page, click the Page Size drop-down list box and select the required number.

Favorite Button
Switch this option on to mark the object as a Favorite.
To mark an object type as Favorite, click 🥰.
You will be notified that the "The page has been set as a favourite and is now available on your home page."?

4. Click 📋 to save the configuration.
You will be notified that the "Configuration draft has been saved".

5. Click 🌐 to publish the configuration.
You will be notified that the "Configuration published successfully".

To configure a complex table at View level, follow these steps:
1. Click the Evolve view drop-down list box and select the required view. For example, Organization & Roles (index_organisations).
2. Click the View Level Settings drop-down and use the following options:

   Before enabling Remove Title option, ensure that the Table title is available in the Evolve Designer.

   Remove Title
   Use this option to remove the table title from the table header.

   Table Height (%)
   Use this option to specify table height.

   Remove Options
   Switch this option on to remove the Options column from the table.
3. Click to save the configuration.
   You will be notified that the "Configuration draft has been saved".

4. Click to publish the configuration.
   You will be notified that the "Configuration published successfully".

**To configure a complex table at Column level, follow these steps:**

1. Click the **Column Level Settings** drop-down.
2. Select the required table to configure. For example, **Organization (organisation_grid)**.
3. Click the **Popout to use** drop-down list box and select the required option. For example, **organization_diagram_popout**.
4. Click the required column to configure. For example, **Name**.
5. Use the following options:
   - **Name**
     Use this option to specify the column name.
   - **Order**
     Use this option to set the columns order.
   - **Column Width (px)**
     Use this option to specify the column width.
   - **Freeze Column**
     Switch this option on to freeze the **Name** column.

6. Click to save the configuration.
   You will be notified that the "Configuration draft has been saved".

7. Click to publish the configuration.
   You will be notified that the "Configuration published successfully".

**Settings**

The Settings feature enables you to configure settings at different levels such as Print Settings, Tabs Settings, and Filter Settings.

Hover over to view the feature description.

**To configure settings, follow these steps:**

1. Open the browser and login to erwin Evolve Web Platform.
2. Click a model. For example, **EA Foundation - Sample Model**.
3. Click Administration.

4. Click Settings.

   **To configure settings at Print level, follow these steps:**
   
   Click the Print Settings drop-down and use the following option:
   
   **Hide Print Button**
   
   Switch this option on to hide the print button from views or object pages.

   **To configure settings at the Tabs level, follow these steps:**
   
   Click the Tabs Settings drop-down and use the following option:
   
   **Hide Tabs with no value or association**
   
   Switch this option on to hide the tabs which have no value or association. Also, clicking edit icon on the object page, enables you to unhide the hidden tabs with values or associations.

   **To configure settings at Filter level, follow these steps:**
   
   Click the Filter Settings drop-down and use the following option:
   
   **Reset Filters on Refresh**
   
   Switch this option on to reset the search filter after the page refresh.

5. Click to save the configuration.

   You will be notified that the “Configuration draft has been saved”.

6. Click to publish the configuration.

   You will be notified that the “Configuration published successfully”.

Enhanced erwin Evolve Plugins
Workflow Explained

Overview

Evolve includes a built-in Workflow capability which provides three useful processes:

1. **A new Separate module for Workflow execution** - new module, workflow is added to the Erwin Evolve site, where you can create new applications, process, and business services.

![Workflow module](image)

2. **A review and approval process for data changes** - meaning that when users create objects, delete objects or edit any data in Evolve, those changes are not submitted to the repository until they have been approved.

3. **An object validation request process** - where users can request for an object to be validated by a nominated set of users, and when all users approve the data, properties are set on the object to record the validation.
4. **A review process for Site pages** - where you can **share a page** with a Role and every user in the Role must confirm they have reviewed the content.

Each of these processes are supported by **Task** and **Notification** mechanisms. Tasks are created for every workflow that's initiated and users are alerted to them with notifications in the Site menu when they log in, prompting them to take action.

In addition, users of your Site can **Follow** objects governed by workflows so they are notified of any workflow-related activity affecting those objects.

Workflow can be configured to use SMTP, which enables alerts to be sent to users via email when Tasks are created and completed. The emails, which are customizable, include details of the Task and the latest activity, as well as direct links back to your Site for users to follow.

**What do you want to do?**

**Enable Workflow for your Site**

**Set up the Review and Approval Workflow**

**Set up the Object Validation Workflow**

**Set up the Review Page Workflow**

**Work with Tasks**

**Review and approve, or reject, data changes**

**Confirm you have reviewed an Object Pages**

**See who has reviewed a page you shared**
Enable Workflow for your Evolve Server

Before you can use the Workflow feature you must configure your server to use it.
When you enable Workflow, it is **at the server level** - so any Sites you have can use it once it is enabled.

**To enable Workflow**

1. Start Evolve Designer.
2. On the Evolve Designer Models launcher dialog, click the **Configure Evolve Server** button.

   The Evolve Server Configuration dialog opens.

3. Under Workflow, select the **Enable Workflow** check box.
4. Under Features, select the **Enable Advanced Workflow** check box.

5. **Ensure that you have** Advanced Workflow license and System Manager as a Power Level to view the Administration menu.

5. **Click** Save.
6. Click **Configure IIS** and perform full deployment.
Review and Approval Workflow

The Review and Approval workflow enables you to manage data quality by forcing changes to your model to be approved before they are committed to the repository.

The process covers all changes made to existing data, including the creation of new objects or the deletion of existing objects, as well as changes to associations data.

The workflow does not cover the following:

- Questionnaires
- Social features - Comments, Ratings and Favorites

Who Approves What?

The Review and Approval Workflow has two levels, which can be combined in your Site:

- Page level
- Object Instance level

Page Level Review and Approval

Page Level Review and Approval works by linking a Role to Index Pages and Object Pages in your Site.

Any changes to the data made via these pages, whether creating new objects, editing existing objects or deleting objects, must be reviewed and approved by members of the Role before those changes are applied.

Role members can approve or reject all, or merely some, of the proposed changes.

See how the Page level process works in detail

These steps assume there are no Object Instance level Approvers which would take precedence over the Page level approval process.
The Page Level process works as follows:

1. A **User** (who is not a member of the Approver Role) uses one of the associated Pages to create, edit or delete an object.

2. All **members of the Approver Role** linked to that Page are assigned a new Task informing them of the changes and prompting them to review them.
   - If Evolve Workflow is configured to use SMTP, an email is sent to the Role members notifying them of the Task, including a direct link to the Task in the Site.
   - The User is also able to view their change request - and can even delete it, discarding their changes, as long as it has not already been approved.
   - If the change request relates to the deletion of an object, that object is highlighted with a strike-through wherever it appears in the Site and the UI makes it clear the object is 'marked for deletion'. It cannot be edited while it is in this state.

3. Any **one of the Approver Role members** reviews the changes and either approves or rejects them.
   - The Approver can accept some of the changes and reject others.
   - The Task is cleared when one of the Approver Role members approves or rejects the changes.
   - The Approver can enter comments explaining their decision which the User can see.

4. The approved **changes are submitted** to the repository and any rejected changes are discarded.

5. The **Task** is marked as 'Completed'.

6. A **notification is sent** to the person who made the changes informing them whether they have been approved or rejected.
   - If Evolve Workflow is configured to use SMTP, the notification is sent via email as well.
   - The User can also see the outcome of the Task, including any comments, by viewing the Task in the Site.

Object Instance Level Review and Approval
Object Instance Review and Approval works by linking a Role or User to a specific object instance in your model. If another user edits or deletes the object, then it must be approved before the change is committed to the repository.

See how the Object Instance level process works in detail:

1. A User (who is not an Approver for the object) edits or deletes a governed object.
2. All Approvers linked to that object, whether individual Users or in a Role, are assigned a new Task informing them of the changes and prompting them to review them.
   - If Evolve Workflow is configured to use SMTP, an email is sent to the Approvers notifying them of the Task, including a direct link to the Task in the Site.
   - The User who made the change is also able to view their change request - and can even delete it, discarding their changes, as long as it has not already been approved.
   - If the change request relates to the deletion of an object, that object is highlighted with a strike-through wherever it appears in the Site and the UI makes it clear the object is 'marked for deletion'. It cannot be edited while it is in this state.
3. Any one of the Approvers reviews the changes and either approves or rejects them.
   - The Approver can accept some of the changes and reject others.
   - The Task is cleared when one of the Approver Role members approves or rejects the changes.
   - The Approver can enter comments explaining their decision which the User can see.

   Reviewers can only download and view the attachment, which is attached by the user. They cannot delete the attachment file.

4. The approved changes are submitted to the repository and any rejected changes are discarded.
5. The Task is marked as 'Completed'.
6. A notification is sent to the person who made the changes informing them whether they have been approved or rejected.
   - If Evolve Workflow is configured to use SMTP, the notification is sent via email as well.
   - The User can also see the outcome of the Task, including any comments, by viewing the Task in the Site.

Precedence

If you combine Page level approval with Object Instance level approval, there is an order of precedence to determine who must approve what.

The rules are detailed as follows:

- If an object has both levels of approval, then the Object Instance level takes precedence.
- If a user who is in a Page level approval Role edits an object on one of their governed pages, but the object has Object Instance level approvers (Users or Roles) - then the Object Instance approvers take precedence.

What do you want to do?
Set up Approver Roles and Users, and assign them to the pages or objects they must approve

Work with Tasks
Setup Approval Workflow Roles and Users

This page explains how to set up approvers for the Page level and Object instance level Review and Approval workflows.

These instructions assume you have already enabled Workflow in Evolve.

Set up Page level Approver Roles

To ensure consistent data governance, you should ensure you assign Approval Roles to all pages on your Site where the data you want to govern can be changed - for example on Object Pages, Index Pages using Tables, and so on.

To specify which Roles approve which pages:

1. In your Evolve Site, browse to the Roles administration page.

2. Click the Role you want to edit.

   The Role page is displayed.
3. Click the **Edit** button.

4. In the page sub-menu, click **Approve Views**.

5. The page lists all the pages the Role is the Approver for.

6. Click the **Associate** button at the top-right of the **CW View (approves)** box.

7. Click inside the text box, or start typing the name of the page you want Role members to approve.
8. Select the page from the list.

   The page appears in the box.

9. Click the Save button.

10. In the pop-out Changes window, click the Submit changes button.

   The page is added to the list of pages Role members approve.

You can also configure Approver Roles using the grid on the built-in Governance Administration Page.

To use this method, select a page, click the Edit button and then link the page to Roles using the CW Role (is approved by) association.

Set up Object Instance level Approvers

Both Users and Roles can be assigned as Approvers at Object Instance level.

The simplest way to assign Users or Roles to object instances is using Object Explorer or Model Explorer.

You can do this by selecting an object and associating it to a CW User or CW Role, or by selecting a CW User or CW Role and associating it to an object.

You must have opted to Show the Evolve Object Types using the Show/Hide Object Types function in Evolve Designer in order to be able to see the CW User and CW Role objects in your model.
When assigning Object Instance Approvers:

Associate objects to Roles using 'Any Object (is approved by role) CW Role' or 'CW Role (role approves) Any Object' depending on whether your focus is the object or the Role.

Associate objects to Users using 'Any Object (is approved by user) CW User' or 'CW User (user approves) Any Object' depending on whether your focus is the object or the User.
Object Validation Workflow

The Object Validation workflow enables users to request that an object be validated by one or more nominated users (Reviewers).

Each reviewer then receives a Task prompting them to review the object, and then either approve it for validation or reject the request.

The workflow remains active until all reviewers have responded to their tasks. If all reviewers approve the validation request, the object is marked as validated.

The validation is recorded using three Property Types of the object, one for recording if it is validated or not, one to record the date/time of the validation, and one to record the names of the users who approved it. You can use the standard Validated and Validated Date Property Types for the first two of these.

See how the Object Validation process works in detail

The Object Validation process works as follows:

1. A User views an Object Page on the Site and decides they would like to have that object approved for validation.
2. The User clicks the Create Task button on the page and chooses one or more Users they would like to validate the content. They can optionally enter a message or a comment about the object which the nominated Users can view.
3. Each Reviewer is assigned a new Task asking them to review the object data and either Approve or Reject it.
   1. The workflow remains open until all nominated Users have either Approved or Rejected the object.
   2. When a nominated User responds to their Task, the User who requested the validation is sent a notification informing them of the response.
   3. The object is only considered validated if all Reviewers Approve it.
   4. When the Task is completed, the User who requested the validation is sent a final summary notification including all the response outcomes.
4. If all Reviewers Approve the validation request, the object is marked as validated, the date/time of the approval is logged, and the names of all the Users who approved it are recorded. All this data is captured on the object itself.

**What do you want to do?**

**Set up the Object Validation workflow on your Site**

**Request an object be validated**

**Set Up the Object Validation Workflow**

This page explains how to configure your Site to use the Object Validation workflow.

These instructions assume you have already enabled Workflow in Evolve.

**Required Metadata**

In order to use the Object Validation workflow, you must choose which Object Types from your Model you want the process to be applied to.

The workflow can work with the standard validation properties on objects, or with your own custom properties you may want to use - but the meta data must be identical on each Object Type.

Users will not be able to request object validation on any Object Page where the Object Type is not configured correctly.

The Object Validation workflow requires **two Property Types on each Object Type**, plus an **optional third** property:

- **A Check Box property** - which is set to True when the object is approved for validation.

- **A Date/Time property** - which is set with the date/time when the Task is completed and the validation request is approved.

- **A Multi-Line Text property (optional)** - which is used to list the names of the Users who were requested to validate the object.

If you create custom Property Types to use, they must have matching Scriptnames for each Object Type.

**Configure Site to Enable Object Validation**

To configure your Site to enable Object Validation:

1. In evolve designer, select the Deployments > Model node.
2. Complete each of the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validation Workflow Active Object Types</td>
<td>Enter the Scriptnames of each <strong>Object Type</strong> you want to enable the Object Validation workflow for. <strong>Separate using commas.</strong></td>
</tr>
<tr>
<td>Use Default Validation Property Types</td>
<td>Select this option if you want to <strong>use the standard Validated and Validated Date properties</strong> for the Workflow Validated and Workflow Timestamp properties below. Choosing this option completes the next two fields automatically.</td>
</tr>
<tr>
<td>Validation Workflow Validated Property Type</td>
<td>If you want to use a custom property to record if the object is validated or not, enter the Scriptname of the <strong>Check Box Property Type</strong> you want to use.</td>
</tr>
<tr>
<td>Validation Workflow Timestamp Property Type</td>
<td>If you want to use a custom property to record the validated date, enter the Scriptname of the <strong>Date/Time Property Type</strong> you want to use.</td>
</tr>
<tr>
<td>Validation Workflow Validated By Property Type</td>
<td>Optional If you want to record the names of the users who validated the object, enter the Scriptname of the <strong>Multi-Line Text Property Type</strong> you want to use for this purpose.</td>
</tr>
</tbody>
</table>

3. Save and **Publish your Site.**

*To update meta model for models already configured for Advanced Workflow:*

1. Start Evolve Designer.
2. Click a model. For example, **EDGEWorkflow.**
3. Click **Erwin Demo**.

An Evolve Designer window opens.

You will receive the below error message when you click on 'Update Meta Model & Themes'. To fix this error, you need to first update meta model.

To update meta model:

1. Expand **Erwin Demo > Object Pages**.
2. Right-click `cwworkflowitem` and click **Delete**.

3. Click **Update Meta Model & Themes**.
4. Click **Save**.
5. Click **Dynamic Site**.

Deleting an index page without unlinking it from the menu leads to an error. To fix this error, follow below steps:

*To delete “z_custom_layout_configuration” index page and unlink from menu:*

1. Expand **Erwin Demo > Index Pages**.

2. Right-click `z_custom_layout_configuration` and click **Delete**.
3. Expand **Menu > Configuration.**

4. Right-click **Custom Layout Configuration** and click **Delete.**

5. Click **Save.**

6. Click **Dynamic Site.**
Evolve Workflow Configuration

Workflow configuration is now a part of Administration, alongside Pool/Swimlane Configuration and it enables you to create and customize workflows.

- Workflow configuration is available to Subscribed users only. For access, contact Sales & Support.

- You must have Administrator rights to create or configure workflows.

To create a workflow:

1. Open the browser and login to erwin Evolve Web.
2. Click a model. For example, EDGEWorkflow.
3. Click Administration.
4. Click Configure Workflow.
5. Click the Object Type drop-down list box and select the required object type.
CwRole is used by Workflow Engine, which can be triggered directly from the erwin Evolve home page.

**Add scenario**

When you click add_scenario, a scenario is created and a request is sent for approvals.

**Users with Administrator rights can create multiple Scenarios.**

**To add Scenarios:**

1. Click the add_scenario icon.

2. In the Name box, specify the name of the Scenario.

3. In the Order box, specify the order of the Scenario.
Use up or down arrow to change the order of the Scenario.

4. Click the **Property for document list** drop-down list box and select the required option.

**Graphical View**

You can view the workflow process in a graphical format in the Graphical View section.

**To add step via the Graphical View:**

1. Click the **add_step** icon.

2. In the **Name** box, specify the name of the step.

3. In the **Order** box, specify the order of the step.
Use up or down arrow to change the order of the step.

To restrict the reviewer from unintentionally modifying the document, you can configure the document to be read-only before sending it for review. Select the Document Section in ReadOnly check box.

Document Section in ReadOnly: ☐

Input Configuration
You can create custom approval form with fields, such as Name, Email and Description.

To add form_input:
1. Click the add_form_input icon.

2. Complete each of the following settings:

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Description</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Configuration</td>
<td>label</td>
<td>Specifies the label of input</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Order</td>
<td>Specifies the order of input</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Type</td>
<td>Specifies the type of input</td>
<td>property: Indicates an input type</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>objectType: Indicates a input's object type</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>association: Indicates a relationship between two objects</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>message: Indicates a generic message of input</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>request-name: Indicates the name of workflow creator</td>
</tr>
<tr>
<td>Scriptname</td>
<td></td>
<td>Specifies the script name of the property</td>
<td>Available when Type is set to property. Click the Scriptname drop-down list box and select the required option.</td>
</tr>
<tr>
<td>Object Type</td>
<td></td>
<td>Specifies the input object type</td>
<td>Available when Type is set to objectType. Click the Object Type drop-down list box and select the required option.</td>
</tr>
<tr>
<td>Scriptname to use in</td>
<td></td>
<td>Specifies the script-</td>
<td>Available when Type is set to objectType. Click the Object Type drop-down list box and select the required option.</td>
</tr>
<tr>
<td>Section</td>
<td>Property</td>
<td>Description</td>
<td>Additional Information</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------</td>
<td>--------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>other property value</td>
<td>name of the object Type or request name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Association Type</td>
<td>Specifies the association type of input</td>
<td>Available when Type is set to association. Click the Association Type drop-down list box and select the required option.</td>
<td></td>
</tr>
<tr>
<td>Informative Message</td>
<td>Specifies an informative message about input</td>
<td>Available when Type is set to message</td>
<td></td>
</tr>
<tr>
<td>Read Only</td>
<td>Specifies whether the input is read-only</td>
<td>Available when type is set to property, objectType, association or request-name</td>
<td></td>
</tr>
<tr>
<td>Mandatory</td>
<td>Specifies whether the input is mandatory</td>
<td>Available when Type is set to property, objectType, association or request-name</td>
<td></td>
</tr>
<tr>
<td>Hidden</td>
<td>Specifies whether the input is hidden</td>
<td>Available when Type is set to property, objectType, association or request-name</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Specifies a value of the input type</td>
<td>Available when Type is set to property, objectType, association or request-name</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Specifies the Filter option to filter input value</td>
<td></td>
<td>1. Click Add New  2. Click the Property drop-down list box and select the required option  3. Click the Operator drop-down list box and select the required option  4. Use Value or drop-down list to specify the property value</td>
</tr>
<tr>
<td>Step Mapping Configuration</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>Specifies the label of the step mapping</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>Specifies the order of the step mapping</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step Name</td>
<td>Specifies the name of the step</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Read Only</td>
<td>Specifies whether the step is read only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hidden</td>
<td>Specifies whether the step is hidden for all users</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mandatory</td>
<td>Specifies whether the step is mandatory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CW User</td>
<td>Specifies the case-wise user of mapping</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Section</td>
<td>Property</td>
<td>Description</td>
<td>Additional Information</td>
</tr>
<tr>
<td>---------</td>
<td>----------</td>
<td>-------------</td>
<td>------------------------</td>
</tr>
<tr>
<td></td>
<td>Mapped to the creator of the workflow</td>
<td>Specifies whether the creator of the workflow is mapped</td>
<td>Available only when Mapped to the creator of the workflow is not selected and while configuring Review 1 and Review 2</td>
</tr>
</tbody>
</table>
|         | Cw Role | Specifies the role of casewise user | 1. Click Add Filter  
2. Click Property drop-down list box and select the required option  
3. Click Operator drop-down list box and select the required option  
4. Use Value or drop-down list to specify the property value |
|         | Filter | Specifies the Filter option to filter the value for custom form types | 1. Click Add Filter  
2. Click Property drop-down list box and select the required option  
3. Click Operator drop-down list box and select the required option  
4. Use Value or drop-down list to specify the property value |
| Add Buttons and Next Steps | Label | Specifies the name of buttons and steps | |
| Add Buttons and Next Steps | Order | Specifies the order of buttons and steps | |
| Add Buttons and Next Steps | Step Name | Specifies the name of the step | |
| Add Buttons and Next Steps | Enable Notification | Specifies the notification of new task | |
| Add Buttons and Next Steps | Create the Final Object | Specifies whether the created object is final | To create the final object, user must be contributor or diagrammer. |
| Add Buttons and Next Steps | Ignore Mandatory Fields | Specifies whether the mandatory fields can be ignored | |
| Add Buttons and Next Steps | Filter | Specifies the Filter option to filter the value for custom form types | 1. Click Add Filter  
2. Click Property drop-down list box and select the required option  
3. Click Operator drop-down list box and select the required option  
4. Use Value or drop-down list to specify the property value |
| Add Buttons and Next Steps | Notification Title & Notification message | Specifies the title and message of notification | Available only when you select the Enable Notification check box or the Create the Final Object check box |

To save the workflow configuration, click the **Save Configuration** icon.
The Save icon saves JSON configuration into erwin Evolve Web Platform.

To add an index page in erwin Evolve Web for the workflow

1. Start Evolve Designer.
2. Click a model. For example, EDGEWorkflow.

3. Click Erwin Demo.

An Evolve Designer window opens.

4. Expand Erwin Demo.

5. Right-click the Index Pages node and click Add Index Page For Object Type.
6. Select the required object type for which you want to configure workflow. For example, Architecture Enabler.

An index page (index_architecture_enablers) is added at the end of index pages.

7. Click index_architecture_enablers.

In the Page Name box, change the page name if required. For example, index_architecture_enablers_workflow.


9. Right-click Layout List (Simple) and then, select Switch Layout > Casewise > Workflow.
The Layout List (Simple) nodes changes to Layout Workflow.

10. Click the Layout Workflow node.

11. In the ObjectType Scriptname box, specify the script name of the object type. For example, application.

   Ensure that ObjectType Scriptname is in lowercase.
12. In the **Scenario Name** box, specify the name of the application that you use while configuring workflow in your erwin Evolve site.

![Scenario Name](image1)

13. Right-click on the **Menu** node and click **Add Menu Link**.

![Menu Link](image2)

14. Expand **Menu** node.

15. Right-click **Menu Link** and select **Add Index Page Link > Custom Pages**.

![Custom Pages](image3)

16. Select the index page that you created. For example, `index_architecture_enablers_workflow`.

17. Click **Save**.

18. Click **Dynamic Site**.

To publish the workflow to the server, click the **Publish** icon.
The publish icon publishes the workflow to the server.

To refresh the workflow configuration, click the Refresh Configuration icon,

The Refresh icon discards the workflow's saved changes and reloads it from the server.
Page Review Workflow

The Page Review Workflow is part of the Share functionality in Evolve.

If Workflow is enabled, a user can choose to share the page with a Role. All members of the Role are then assigned Tasks prompting them to review the page - or object - and they must confirm they have reviewed it before the Task is considered complete.

In addition, the user who shared the page is also assigned a Task - with the Task marked as 'My Requests' - and this allows them to view which users have reviewed the page.

Only once all members of the Role have confirmed they have reviewed the page is the Task marked as 'Completed'.

What do you want to do?

Confirm you have reviewed an Object Page

See who has reviewed a page you shared
Working with Tasks

Tasks are an integral part of Evolve Workflow and are assigned to users in the following two instances:

- When users are set as an Approver of Page or Object Instance as part of the Review and Approval workflow, they will receive Tasks when users edit data that they must approve.

  Users cannot delete or modify the attachment unless the status of the request is Resubmit.

- When users share a page with a Role, all members of the Role are assigned Tasks to prompt them to review the page.

Depending on how a Workflow is configured, when Tasks are assigned, users may receive an Email notification as well.

What do you want to do?

Create an approval request/task:

To create an approval request/task:

1. Open the browser and login to erwin Evolve Web.
2. Click a model. For example, **EDGEWorkflow**.
3. Click **Workflow**.
4. Click **New Application**.
An application form appears.

5. Enter details in the required fields. Fields marked with asterisk are mandatory.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies the name of the new application</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Specifies the business category of input</td>
<td>You can customize categories using workflow configuration according to your business usage.</td>
</tr>
<tr>
<td>Code</td>
<td>Specifies an informative message about the application</td>
<td></td>
</tr>
<tr>
<td>Lifecycle Status</td>
<td>Specifies the status of the lifecycle</td>
<td></td>
</tr>
<tr>
<td>Criticality</td>
<td>Specifies the importance of the application</td>
<td>You can customize the criticality options using workflow configuration.</td>
</tr>
<tr>
<td>Tier</td>
<td>Specifies the rank of the application</td>
<td>You can customize the tier options using workflow configuration.</td>
</tr>
<tr>
<td>Business Owner</td>
<td>Specifies the name of</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Additional Information</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Person</td>
<td>Specifies the person who created the application</td>
<td>For example, Malcom Brooks</td>
</tr>
<tr>
<td>Contact Person/Mail</td>
<td>Specifies the name or email address of the person to be contacted</td>
<td>For example, Malcom Brooks (<a href="mailto:person_email@company.com">person_email@company.com</a>)</td>
</tr>
<tr>
<td>Attachment</td>
<td>Specifies the uploaded attachment of the application</td>
<td>Click the button to upload documents. For more information, refer to Attachments Notification Message</td>
</tr>
<tr>
<td>Review 1</td>
<td>Specifies the first level reviewer, which is set in workflow configuration</td>
<td></td>
</tr>
<tr>
<td>Review 2</td>
<td>Specifies the second level reviewer, which is set in workflow configuration</td>
<td></td>
</tr>
</tbody>
</table>

**Attachments Notification Message**

Depending on the scenario, the following messages appear when you upload an attachment to the approval form:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Notification Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate File</td>
<td>This file is already attached. Please select another file if needed.</td>
</tr>
<tr>
<td>Empty file</td>
<td>The attached file is empty. Please select another file.</td>
</tr>
<tr>
<td>Size is over 20 MB</td>
<td>This file has exceeded the size limit. Please Select another file or try reducing the size less than 20 MB.</td>
</tr>
<tr>
<td>Unsupported</td>
<td>This File type is unsupported. Please select the supported file types.</td>
</tr>
</tbody>
</table>

**File types supported for attachments:**

The file types supported for attachments are as follows:

- BMP
- JPG
- PNG
- TXT
- CSV
- PDF
- XML
- JSON
- DOC
- DOCX
- PPT
6. Click **Submit** to submit the form or click **Save For Later** to save the form.

   *Save For Later enables you to save the information for later, and is stored under draft.*
   
   Once you click **Save For Later**, you will be notified that “This request has been saved”.

   *This request has been saved.*

   Once the form is submitted, you will be notified that the form has been submitted and sent to the reviewer for approval.

   *Your request was submitted successfully.*

   **To view the approval request/task:**
   
   1. Under **ADMIN**, click **My Profile**.

      The My Profile screen appears.

   2. Under **Application Request**, click **My Request**.

      The My Request screen appears.

      *The My Request screen displays the status and history of all your requests.*
To review tasks raised by the requestor:

1. Login to erwin Evolve Web with reviewer.
2. Click **Tasks**.
3. Select the application form that you want to review.
4. Click **Assign to Me**.
5. Click **Take Action**.

An application form opens.
6. If you are reviewer 1, enter the review comments in the First Review Comments box and click Validate.
7. If you are reviewer 2, enter the review comments in the **Second Review Comments** box and click **Validate**.

Once you click **Validate**, you will be notified that “Your Action was successfully submitted. Requested User will be Notified”.

**To send the application form back to the user:**

1. If you are reviewer 1, enter the review comments in the **First Review Comments** box and click **ReSubmit**.
2. If you are reviewer 2, enter the review comments in the *Second Review Comments* box and click **ReSubmit**.

You will be notified that “Your Action was successfully submitted. Requested User will be Notified”.

**Your Action was successfully submitted. Requested User will be Notified**

To reject tasks raised by requestors:

1. If you are reviewer 1, enter the review comments in the *First Review Comments* box and click **Rejected**.
2. If you are reviewer 2, enter the review comments in the **Second Review Comments** box and click **Rejected**.

You will be notified that “Your Action was successfully submitted. Requested User will be Notified”.

**Your Action was successfully submitted. Requested User will be Notified**

**View your pending Tasks**

**To view your pending Tasks:**

1. In your Evolve Site, click the **Tasks** menu.

   *The sub-menu lists up to five Tasks that are unread.*
2. Click on a Task to go directly to it, or click **See all tasks** to view all your Tasks.  
   *By default the My Tasks page is shown so the pending Tasks are displayed.*  
3. Select a Task to view its details.

**Review and approve/reject data change requests by another user**

If you are in an Approver Role for a Page or Object Instance, or you are a User assigned as an Object Instance Approver, you are assigned Tasks to review the changes and then accept or reject changes made by other users.

   *Reviewers can only download and view the attachment, which is attached by the user. They cannot delete the attachment file.*

**To review and approve or reject data change requests:**

1. View your Task from the **Tasks** menu or by following the link in the notification email.  
2. The page shows you all the changes made by the user, including the previous and new values.  
3. Go through Review each change and choose whether to **Accept** or **Reject** it.  
   *Alternatively, you can use the Accept All or Reject All buttons.*  
4. Once you have Approved or Rejected all the changes, click the **Submit review** button.  
   *The changes are submitted, and your Task is marked as 'completed'. A notification email with the results of the review is sent to the user who made the changes.*

   *Before you submit, you can enter comments in the comments text box. These will be visible to the user so they can understand why you rejected or approved their change request.*

**Confirm you have reviewed a shared page**

If a user has shared a page with a Role, all members of that Role must confirm they have reviewed the page.

**To confirm you have reviewed a shared page:**

1. Navigate to the Task by using the **Tasks** menu in your Evolve Site, or by following the link provided in the notification email.  
2. Click on **Take Action** button to navigate to the page to be reviewed.  
3. Once you have reviewed the page, click the **Confirm you have reviewed this page** button.  
   *The Task is complete.*

**View pending Tasks you initiated**

If you initiated a Task, either by a data change request, or by sharing a page for review, you can view the details of the Task while it is still incomplete.

**To view pending Tasks you initiated:**

1. Use the Tasks menu to See all tasks.  
2. Click the My Requests sub-menu.  
   *All Tasks you initiated are displayed.*  
3. On the Task you want to check:
Cancel a pending Task you initiated

If you initiated a Task, you can cancel it at any time before the Task is completed.

**To cancel a Task you initiated:**
1. Use the Tasks menu to See all tasks.
2. Click the My Requests sub-menu.
   *All Tasks you initiated are displayed.*
3. Click the Trashcan icon next to the Task that you want to cancel.
   *The Task is deleted and is removed from all Assignees' and Approvers' Task lists.*

View completed Tasks

**To view your completed Tasks:**
1. In your Evolve Site, click the Tasks menu.
2. On the sub-menu, click See all tasks to view all your Tasks.
3. Select My Tasks or My Requests in the sub-menu to see Tasks that have been assigned to you, or ones that you initiated by sharing a page with a Role.

   ![Tasks menu](image)

   *By default, the My Tasks page is active so the pending Tasks are displayed.*
4. Click the Completed filter to view just completed Tasks.
   *Additionally filter the list by time (from now) using the 1 Month, 3 Months and 1 Year filters.*

View Notifications

If you are involved in a Task, you receive notifications in your Evolve Site when the task related activity is performed. These notifications can be accessed using the Notifications link in the main Site menu.

If new notifications exist, they are highlighted in the menu.

**To view your notifications:**
1. Click the Notifications menu.
Click Older and Newer to move through the pages of notifications.
Click 1 Month, 3 Months, 1 Year or All to specify the duration of notifications displayed.

Delete a Notification

To delete a notification:

1. Click the Notifications menu.

2. Use the pagination and date filtering controls to locate the notification you want to delete.
3. Click the trashcan icon at the top-right of the notification.

Transfer a Task

When a task is assigned to you as 'My Tasks', you can either assign it to yourself, or transfer it to another user.

To transfer a task:

By default the 'My Tasks' page is active and displays the pending Tasks.
The Action/Transfer options will display.

A list of users to whom the task could be potentially delegated is displayed.

1. In your Evolve site, click on the Task menu.
2. From the sub-menu, click See All Tasks to view all tasks.
3. Select My Tasks, to view the tasks assigned to you.
4. Select and open the task you wish to transfer.
5. Select the Transfer Task option.
6. Select the user that you wish to transfer the task to, and you will be presented with the option to add a brief message explaining the reason for the transfer.
7. Click on Submit button.

You will be notified that "The task was delegated to the selected user".

The task was delegated to the selected user

All references to the task are removed from the original user's profile and they are no longer associated with it.
The task is added to the transferred user's My Tasks' list.
The task's history is now updated to display the task transfer.

Once the transfer request has been submitted, it cannot be undone.
The Task Delegation function is enabled by default. To switch off this feature, open Evolve Designer and deselect the Enable Task Delegation option on the Model node.

With the function disabled, commit the changes to your Site.

See: Publish your Site

**Request an Object be validated**

If your Site is configured to support Object Validation requests, you can make a request on any page showing a supported Object Type.

**To request an object be validated:**

1. On a supported Object Page, click the Create Task button.
2. In the Validators section, select all the people you want to validate the object.
   
   *Use the Filter box to type people’s names to find them in the list.*
3. In the Message field, optionally enter a message explaining why you want the object validated, or note any information that may be of use to the validators.
4. Click Submit.

**Comment on a Task requiring action**

If you have a pending task to action, you can add a comment to your response.

**To add a comment to a response:**

A Comment field will display.

1. Navigate to the relevant Task using the Tasks menu in your Evolve Site, or by following a link in the Task email.
2. Click on Add Comment (located next to the Submit button).
3. Enter your comments or any information for the requester.
4. Click **Submit**. Your comments will be attached to your response.

   *Comments sent from the Assigner will be stored in the Task’s history and are only visible to the original Requester and associated Assignees.*

**Change Calendar Due Date**

If you have created a task that requires actioning, the Server Configuration automatically sets its Due Date Interval to three days. This date can be changed using the Date Picker.

**To customize a task’s due date:**

1. When creating a Task Request, click on the **Change Due Date** button (located next to the **Submit** button).
2. A date field will display.
3. Click on the field or calendar icon and the Date Picker will display enabling you to select a custom date from the calendar.
4. Review your change, and then click on **Submit**.

**View Object Validation Status**

If an Object has a pending validation request, it is possible to view the status of this request on its Object Page.

**To view the status of an Object's validation requests:**

1. In your Evolve site, open up the desired Object Page.

   *The status message will display at the top of the Page sub-menu.*
Follow an Object

Keep up to date with any workflow-related activity by following objects in your Site.

You can follow any object that is governed by any of the available workflows. Following means, you will receive notifications for any workflow activity related to the object.

If there is new workflow activity for any object you have followed, the Favorites link in the Site menu highlights them, as well as the item itself on your home page.

To follow an object:

1. Navigate to an Object Page displaying the object you want to follow.
2. Favorite the object by clicking the Favorite button (the heart icon).
   Favoriting the object adds it to your home page and Favorites menu.
3. On your home page, locate the object.
4. Click the Follow icon in the bottom right of item.
   The icon changes color from gray to orange showing that it is now being followed.
Social Interaction Features

Social Interaction Features Explained

There are several social interaction features available in Evolve Sites which encourage your users to collaborate and share information.

Comments
The Comments feature is added automatically to every Object Page in a Dynamic Site. It allows up to two levels of comments by users discussing the data.

Ratings
Ratings are available on all pages by default and enable users to rate any page on a scale of one to five.

Favorites
Users can make any page they visit a Favorite by clicking the Add to Favorites icon which is displayed on all Object Pages by default.

Users can view links to their Favorites directly on the Home page, or by using the Favorites link that appears when you click the user picture in the top-right of the interface.

If there are new comments or discussions added to a page you have made a Favorite, then a highlight is displayed next to the Favorites menu link.

Share
The Share button is displayed on all Index and Object Pages by default. When a user clicks the Share button, a pop-out window allows them to share the page with another user by email, or - if Workflow is enabled - share the page with a Role.

If the user chooses Share by email, they can optionally enter a Subject and Message, before a New Email window is opened from the Email client installed on the local machine, containing a link to the page being viewed.

In deployments with Workflow enabled, if the user chooses Share with roles, they are prompted to select a Role to share the page with, and that starts a workflow process which means all members of the Role are assigned Tasks to review the page, and must confirm that they have done so.

Disabling Social Features
Social features can be disabled on the Model node in Evolve Designer.
Questionnaires

Questionnaires Explained

Questionnaires enable you to get feedback and opinion from your users. In Evolve you can create simple questionnaires that gather users' answers, or you can weight questions and answers to determine business values of responses.

There are two types of questionnaire available in Evolve:

1. **Standalone questionnaires** that gather the answers each user provides
2. **Object questionnaires** that are displayed as a Page View on all Object Pages for a specified Object Type, such as Application, and can aggregate the responses from users and **work out a Business Value**.

Whether a questionnaire is standalone or tied to an object is a simple setting in the questionnaire itself which can be edited after it is created - so the process for creating a questionnaire is the same for both types.

*Object questionnaires require a specific property to be created on the Object Type itself to store the aggregated Business Value against the object in question.*

*This should be a Decimal Number property.*

What do you want to do?

- Create a questionnaire
- Edit a questionnaire
- Delete a questionnaire
- View questionnaire responses
Question Weights and Values

Using weights and values to determine an overall Business Value for an object is only really applicable to Single or Multiple choice questions.

Object questionnaires allow you to gather information from your users about individual objects, such as an application. Evolve allows you to weight each question, and put value scores against the possible answers. When users complete the questionnaire, Evolve works out a Business Value score for the object which is based on the values assigned to the answers they provided, measured against the question weighting.

The Business Value is aggregated across all responses and is stored as a property of the object itself, for example you could call it 'User Assessment Score' so you can display this on your Object Page.

As a best practice, we recommend aiming to capture a Business Value of between 0 and 100 - so you can represent the value as a gauge on your Object Page.

Each question in the questionnaire can be given a weight of 0.0 to 1.0. The total of which must equal 1.0 in order for it to work. In addition, each answer to each question is given a score - according to your scale. If we are following the best practice guideline, this again would be between 0 and 100.

The formula for the Business Value is quite simple. The score for a given questionnaire response is (Question Weight * Answer Value) + (Question Weight * Answer Value) + .

Example

In this example we are using a questionnaire to ask users for their assessment of an application.

The application object has a numeric property called 'User Assessment Score' which will be used to store the Business Value.

In the example, let's assume that the questionnaire has three questions and each question has five possible responses.

Following the best practice of aiming to create a score of 0 to 100, and remembering we need to make the combined weights add up to 1.0, I might set the weighting for Question 1 at .5, Question 2 at .3, and Question 3 at .2.

This means I judge that Question 1 should have more impact on the result than Questions 2 and 3.

Each question has the same possible answers, we're asking users how they rate the application, so the answers to all the questions are Very Poor (0), Below Average (25), Average (50), Above Average (75) and Superior (100). Following our best practice, they can only have a maximum value of 100.

Without weighting, or with equal weighting, scores of 100 for Question 1, 50 for Question 2, and 0 for Question 3 would average out to 50 without weighting or with equal weighting. But with our weighting of .5, .3 and .2, the weighted average score is 65 - a higher score because of the weighting.

The score is calculated using the formula (.5 * 100) + (.3 * 50) + (.2 * 0) = 65.

To determine the total score for that application, Evolve tracks the number of questionnaire responses for that application and comes up with a straight average score of all user responses. So if only one other person filled out the survey in our example and their weighted score was 75, the average score would be 70 ((65+75)/2=70).
Create a Questionnaire

The only way you can create a questionnaire is by using the Create Questionnaire built-in administration page on your live Evolve Site.

To create a new questionnaire:

1. On your Evolve Site, follow the menu link to the Create a Questionnaire built-in administration page.
   
   A new questionnaire is created.

2. Enter a Title for your questionnaire.

3. If you want to make this an Object Questionnaire - to link it to a specific Object Type - enter the following:
   - Use Property To Update to enter the scriptname of the Object Type you want to link to, followed by the scriptname of the Property Type you will use to store the Business Value, separated by a colon.

   For example: 'application:businessvalue'

   - Use Cw Questionnaire Object Type Scriptname to enter the scriptname of the Object Type you are linking to

   This should be the same as the first part of the Property To Update value - for example: 'application'

4. Add your questions

   There are three types of question you can add, and you can add as many as you like.

   - Use a single choice question to show one or more possible answers, but only allow the user to select one.

   - Use a multiple-choice question to show one or more possible answers and allow users to choose more than one answer.

   - Use a text question when you want the user to enter some text as the answer, such as a comment or more qualitative answer.

   How to add a single choice or multiple-choice question

   i. Click the Add single choice or Add multiple choice button

   ii. Enter a Question Title

   iii. Enter a Question Weight - see Question Weights and Values

   iv. Click Add an answer

   v. Enter the answer

   vi. If you entered a Question Weight, enter a Value for the answer by editing the zero to the right

   How to add a text question
i. Click the **Add text** button

ii. Enter a **Question Title**

iii. Enter a **Question Weight** - see [Question Weights and Values](#)

iv. Click **Add an answer**

v. Enter any text in the answer - **you must enter some text here**, any text will do

vi. If you entered a **Question Weight**, enter a **Value** for the answer by editing the zero to the right

5. Click the **Save** icon in the top-right of the page to Save your questionnaire.

Once saved, you can edit your questionnaire using the built-in [Questionnaire Index Page](#).

---

*If the Cw Questionnaire Object Type Scriptname value is changed when creating or editing a questionnaire then you must Save & Deploy the Site.*
View Questionnaire Results

How you view questionnaire results depends on whether it is an Object Page questionnaire or a standalone questionnaire.

View the results of a standalone questionnaire

To view the results of a standalone questionnaire:

1. On your Evolve Site, follow the menu link to the built-in 'Questionnaires' Index Page
2. Select the questionnaire you want to view
3. Click the Results sub-menu item to view the results

   The page displays a pie chart for each question, showing how many users chose each answer.

View the results of an Object Page questionnaire

When you view the results of an Object Page questionnaire, the results you see are for a specific object instance. If you want to view the Business Value for the object, you must configure the Object Page to display the Business Value property.

To view the results of an Object Page questionnaire:

1. On your Evolve Site, browse to the object you want to view the questionnaire results for
2. Click the Questionnaire link in the page menu
3. Click the Results sub-menu item to view the results

   The page displays a pie chart for each question, showing how many users chose each answer.
Edit a Questionnaire

To edit an existing questionnaire:

1. On your Evolve Site, follow the menu link to the built-in 'Questionnaires' Index Page
2. Select the questionnaire you want to edit
3. Click the Edit button in the top-right of the page
4. Edit any of the questionnaire's details, questions and answers
5. Click the Save button to save your changes.
Delete a Questionnaire

To delete an existing questionnaire:

1. On your Evolve Site, follow the menu link to the built-in 'Questionnaires' Index Page
2. Select the questionnaire you want to delete
3. Click the Edit button in the top-right of the page
4. Click the Delete button in the top-right of the page

The questionnaire is deleted.
Site Configuration Reference

This page lists and explains all the configuration settings available for Evolve Sites.

**Server-Level Settings**

*See the Server Configuration settings*

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Evolve IIS Site Name  | Specify the name of your IIS Site as it appears in the URL, such as http://<server-name>/<evolve-IIS-site-name>/  
We recommend you leave the IIS Site Name. If you do change it, it must be lower case with no spaces, and you must make sure that the MVC Folder still points to Casewise/Evolve/Site - or wherever your Evolve is installed. |
| Evolve Site Folder    | Specify the path to your Evolve Site directory.  
You can usually leave this as the default, unless you have installed to a different directory. |
| Evolve Data Folder    | Specify the path to your Evolve Data directory where your local resources will be stored.  
You can usually leave this as the default, unless you have installed to a different directory. |
| Server Language       | Choose the language of the top-level Evolve Site, including the Model Selector page, as well as the login screen.                          |
| Server Theme          | Choose the theme of the top-level Evolve Site, including the Model Selector page, as well as the login screen.                           |
| IIS Application Path  | Specify the path to your IIS application.  
You can usually leave this as the default.                                                                      |
| CW Database           | Select the CW repository your Evolve deployment will use.                                                                                   |
| Evolve CM User Name   | Enter the Username of a CW Suite User with System Manager rights that can be used to log on to the CW repository so the Evolve Site can access the Model data.  
You could create a new user dedicated to Evolve use for this purpose.                                               |
| Evolve CM User        | Enter the password for the above user. Ensure you Encrypt the password after entering it.                                                  |
### Setting | Description
--- | ---
Password | 
Javascript Mode | This is an advanced setting which can only be changed in developer debug mode.
IIS User Name | Specify the name of a local user on the web server machine which has **Administrator rights** on the machine. This user is required for the Application Pool to run.
IIS User’s Password | Enter the password for the above user. Ensure you **Encrypt** the password after entering it.

### Authentication

| Authentication Mode | Choose how you want Users to be logged on to Evolve:  
Use **CorporateModelerAuthentication** to only allow existing CW Users to sign in  
Use **ActiveDirectoryAuthentication** to enable Active Directory authentication  
**For a basic site to start with**, we recommend you use CorporateModelerAuthentication. |
| Enable Automatic Logon | If you choose ActiveDirectoryAuthentication, select Enable Windows Authentication to ensure Evolve users are automatically logged in to Evolve when they access the Site. |
| Domain Short Name | If CW Suite is set to use login via **‘any valid Windows user and domain’** (option 3), use this setting to enter the short name of your domain. This is referenced before ‘\’, when used as shortdomainname\username. If you do not use login option 3, leave this setting blank. |
| Use SSL Connection (Active Directory) | Tick this box if you need to connect to Active Directory using LDAP SSL. |
| AD Connection Path | If you choose ActiveDirectoryAuthentication, use this setting to specify the path Evolve can use to connect to your Active Directory server.  
To do this:  
Right-click onto the server/computer and go into Properties. The domain name should be visible at the bottom.  
For example, if your domain is ‘MyDomain.local’ the connection path would be:  
LDAP://mydomain.local/DC=mydomain,DC=local  
Note: for every parameter in the domain, you need to add a “DC=”. |
| AD Port | If you require a specific port for your Active Directory server, enter it here.  
You can usually leave this as the default. |
| AD Group Membership Selection Mode | Leave as the default unless you have special Active Directory requirements.  
Use GetAllGroupsForUser if your Active Directory has multiple domains and nested groups. The method causes Evolve to fetch the user and then try to fetch all the groups where this user belongs to.  
Use GetGroupMembers (default) if your Active Directory operates on a single domain. Supports nested groups.  
Use GetGroupDirectoryServices if your Active Directory has multiple domains and nested... |
Choose how you want Users to be logged on to Evolve:

Use \textbf{CorporateModelerAuthentication} to only allow existing CW Users to sign in

Use \textbf{ActiveDirectoryAuthentication} to enable Active Directory authentication

\textbf{For a basic site to start with}, we recommend you use CorporateModelerAuthentication.

- For a basic site to start with, we recommend you use CorporateModelerAuthentication.

- If left unchecked, browsing is limited to the defined LDAP:// path, and will not extend to all Forest domains.

- If you choose to send Email alerts for Workflow, use this setting to enter the address of your SMTP Server.

- You should leave this set to 'html' unless you have a very specific need.

\begin{tabular}{|m{3cm}|m{12cm}|}
\hline
\textbf{Authentication Mode} & Choose how you want Users to be logged on to Evolve:  

Use \textbf{CorporateModelerAuthentication} to only allow existing CW Users to sign in  

Use \textbf{ActiveDirectoryAuthentication} to enable Active Directory authentication  

\textbf{For a basic site to start with}, we recommend you use CorporateModelerAuthentication. \\
\hline
\textbf{AD Connection Username} & This field is used to specify the property type on Active Directory used for the connection.  

This is an advanced setting that should only be used by someone who is an expert in Active Directory. \\
\hline
\textbf{Connect to Active Directory Forest} & This option is selected to browse and find users across the entire Active Directory Forest.  

If left unchecked, browsing is limited to the defined LDAP:// path, and will not extend to all Forest domains. \\
\hline
\textbf{Workflow} & \begin{itemize}  

- \textbf{Enable Workflow}: Select the check box to enable Workflow on your Evolve server.  

- \textbf{Workflow Due Date Interval}: Set the number of days you want to allow for task completion. Evolve uses this interval to highlight tasks that are due for completion today, or alert you to ones that are overdue.  

- \textbf{Send Email Alerts}: Select the check box if you want alerts to be sent to users by Email. If you choose not to use Email, there are notifications in the Evolve Site itself.  

- \textbf{SMTP Server}: If you choose to send Email alerts for Workflow, use this setting to enter the address of your SMTP Server.  

- \textbf{SMTP Port}: If your SMTP Server requires a port setting, enter it here.  

- \textbf{Email Display Name}: Enter the name you would like to be displayed in the No-Reply email field for Workflow emails.  

- \textbf{No-Reply Email Address}: Enter the No-Reply Email address you would like to use for Workflow emails.  
\end{itemize} \\
\hline
\textbf{Site-Level Settings} & \begin{itemize}  

- \textbf{Site node settings}:  

  \begin{itemize}  

  - \textbf{Node Name}: Non-editable.  

  This is the name of the Site node.  

  - \textbf{Link Extension MIME Type}: Advanced only.  

  This is site page extension. You should leave this set to 'html' unless you have a very specific need.  
  \end{itemize}  
\end{itemize} \\
\hline
\end{tabular}
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Language</td>
<td>Choose the language of the Site if you want to override the global Evolve setting.</td>
</tr>
<tr>
<td>Number Separator</td>
<td>Select 'None' (default), 'Comma' or 'Space' to specify which number separator is used when displaying numbers on your Evolve Site. For example: None - 1000 or 1000000, Comma - 1,000 or 1,000,000, Space - 1 000 or 1 000 000</td>
</tr>
<tr>
<td>JSON Extension</td>
<td>Advanced only. This is JSON file extension. You should leave this set to 'json' unless you have a very specific reason not to.</td>
</tr>
<tr>
<td>Less Theme</td>
<td>Choose the theme of the Site if you want to override the global Evolve setting.</td>
</tr>
<tr>
<td>Enable Cloud APIs</td>
<td>Advanced only. Use this setting to enable the Cloud APIs.</td>
</tr>
<tr>
<td>Export Diagram Images</td>
<td>Static Sites only. Use this option if you are publishing your Site in Static mode and you are showing Diagrams created in CW Modeler using the CW Modeler Diagram behavior. You can leave this option unselected if you are not displaying diagrams or are only using the Vector (HTML5) behavior to prevent images of diagrams being generated when you publish your Site - a process which can take some time.</td>
</tr>
<tr>
<td>Display Date/Time In Local Time Zone</td>
<td>When Set, ensures all dates and times are displayed locally for the end user. Otherwise, uses the server date and time.</td>
</tr>
<tr>
<td>Restrict User Profile Access</td>
<td>When Set, prevents users from reading other user's profiles.</td>
</tr>
<tr>
<td>Remember Diagram Zoom Level</td>
<td>When Set, allows the end-user's browser to remember the zoom position for diagrams they have viewed. This makes navigating back and forth between diagrams, much easier. This can be disabled, if the site design is such that it is preferred to default to showing the full diagram, each time a page is visited.</td>
</tr>
<tr>
<td>Enable Smart Breadcrumbs</td>
<td>When Set, the smart breadcrumb trail is shown for end-users, for this site. Otherwise the display is, as it was pre-version 2018 (no breadcrumb trail).</td>
</tr>
</tbody>
</table>
### Node UUID
- Non-editable. This is the unique identifier for the Site node.

---

### Deployment node settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Model Filename</strong></td>
<td>Do not change this field. This setting represents the Scriptname of your Model.</td>
</tr>
<tr>
<td><strong>Site URL Name</strong></td>
<td>Specify the name of this Site as it appears in the URL, such as: http://&lt;server-name&gt;/&lt;evolve-IIS-site-name&gt;[/&lt;sites</td>
</tr>
<tr>
<td><strong>Site Display Name</strong></td>
<td>Enter the name of your Site. This is only displayed on the top-level Evolve Sites page.</td>
</tr>
<tr>
<td><strong>Deploy Custom Site</strong></td>
<td>This option is used if you have a custom site configuration.</td>
</tr>
</tbody>
</table>

---

### AD Mapping

**Usage:**
- Only used in Dynamic sites if the Evolve Authentication Method is set to Active Directory or SAML2.
- The AD Mapping is used to map first time users to Evolve. This allows your organization to select a Group, Role and License combination for users to be given, the first time they connect to Evolve.
- When they connect the product will check the group/s they are in, and create a user in the administration model with the permissions defined. All subsequent access rights changes can be managed from the product.
- If a user is no longer in the necessary Active Directory group, or is without a required SAML2 claim, then they will be prevented access to Evolve.

*The Active Directory/SAML2 mapping grid*

By default you will be provided 3 entries which correspond to the 3 license types your users can be offered. Any entry without an AD Group name, is effectively not mapped.

For each row you wish to map, specify the name of the Active Directory group or the SAML2 Claim you want to use for that type of Evolve licensed users.

Members of multiple AD Groups will have their rights aggregated, such that they have the super set of permissions acquired by the groups. The license they are provided will be the highest level - e.g. Diagrammer trumps Contributor, which trumps Social user.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rows</strong></td>
<td>Can be added to the bottom of the grid, to enable the addition of further groups or claims.</td>
</tr>
<tr>
<td><strong>AD Group</strong></td>
<td>Specify the name of the Active Directory group or the SAML2 claim you want to use for this row. This is the group the user will need to be a member of, or the claim the user will need to have, in order to receive these rights. A special built-in group called &quot;Anonymous&quot; can be used, to describe anyone who logs in, without access to the other defined groups. Since version 2018, this &quot;Anonymous&quot; group can have CW Group, CW User Type and CW Role defined, such that they can have a default access. This may be desired if, for example, all employees have read access, under a basic Role, but are not associated to any of the EA/BP groups. Then, for example, a select few have Contributor access through a specific Group. E.g.</td>
</tr>
<tr>
<td><strong>CW User Type</strong></td>
<td>Specify the type of user license that will be provided for this group of users. The highest level of license will be awarded if the user is in multiple groups.</td>
</tr>
<tr>
<td><strong>CW Group</strong></td>
<td>Specify the access rights group you wish the users of this group to belong to. This can control the sites/models the user has access too, and also the object types/categories available to them. CW Groups are managed in &quot;Access Rights Manager&quot; or &quot;Model Explorer&quot;</td>
</tr>
<tr>
<td><strong>CW Role</strong></td>
<td>Specify the default Role that will be provided for this group of users. For details on the use of roles in Evolve see here.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use Static Authentication</td>
<td>When checked this option will use the AD Mappings (or the CW_User Type) to enable access to the static generated site. Users without at least 'Static' permissions, will be denied access to the site.</td>
</tr>
<tr>
<td>Display Model in Evolve</td>
<td>Use this option to specify if this Model Site is available or disabled in Evolve.</td>
</tr>
</tbody>
</table>
Validate Repository for Global Search

Introduction

The Validate Repository tool has existed as part of erwin Evolve Suite for some time and helps in maintaining the integrity of the erwin Evolve Suite database.

With the Evolve Web Platform also using this database, the Validate Repository tool has been extended in this release (2020.2.1) to allow validation of the Global Search feature that exists in the web platform. This validation of the global search ensures that the audit history and the global search history are kept fully synchronized.

Running the Validation

To run the global search validation, additional options have been added to the command line. The Validate Repository checks whether the erwin Web Modeler’s global search is installed before running these options.

If erwin Evolve Web Platform is not installed, the Validate Repository feature runs without Global Search checks. You will receive a warning if erwin Evolve Web Platform is not installed. However, this does not affect any of the other tests.

Global Search validation is not part of the default checks. To run it, run the Validate Repository tool with the `-gsmodelname:<modelname>` option in following command format:

```
ValidateRepository.exe -username:admin -applyfixes:all -gsmodelname:<modelname>
```

For example: ValidateRepository.exe -username:admin -applyfixes:all -gsmodelname:EASAMP14

To run global search checks alone, run the Validate Repository tool with the `-testonly` option in the following format:

```
ValidateRepository.exe -username:admin -testonly:globalsearch -gsmodelname:<modelname>
```

For example: If you want to run the test on the erwin Evolve Suite’s default connection to test the EA Sample Model, the following command in a command prompt

```
```

If the checks do not find any changes, the result of the command is as shown:
If the checks find any missing applications, the results of the command is as shown:

In case where the command finds missing applications or out of sync data, you can run the same command with "-applyfixes" instead of "-testonly". You will be asked if you wish to correct the out of sync data.

Choosing yes syncs the data that was out of sync earlier and the results show that there is no out of sync data.

You can run these tests at any time.

**Verify and Fix Issues with the Repository**

When upgrading from older versions of erwin Evolve Suite, or when the application behaves inconsistently, it is advised to check that the repository is in a consistent state. This is done through the following steps:
1. Ensure that you are an Administrator of the CW repository and have db_owner or administrator permissions on the SQL/Oracle database.
2. Press Windows + R keys and type CMD. Then, click OK.
3. To navigate to the erwin Evolve Suite installation directory, in the Command Prompt run the following commands:
   1. C:
   2. cd "program files (x86)\casewise\cm10\bin"
4. Navigate to the CWSuite installation directory, usually:
   C:\Program Files (x86)\Casewise\CM10\bin
   Use the commands:
   Type: C:
   Type: cd "program files (x86)\casewise\cm10\bin"
5. Run the Validate tool to check for errors:
   Type: validate-repository -username:<your-admin-username> -password:<your-password> -testonly
Other ValidateRepository commands can now be run from this point.
Validate Repository for Global Search Re-indexing

Introduction

The Validate Repository tool has existed as part of erwin Evolve Suite for some time and helps in maintaining the integrity of the erwin Evolve Suite database.

With the erwin Evolve Web Platform also using this database, Validate Repository tool has been extended in this release (2022.0.0) to allow validation of the Global Search Re-indexing feature that exists in the erwin Evolve Web Platform. This validation of the global search re-index helps delete the complete data from the global search and re-index the entire erwin Evolve Suite database from scratch into a global search database.

Running the Validation

To run the global search re-index validation, additional options have been added to the command line. The Validate repository will check whether the erwin Evolve web platform’s global search re-indexing is installed before running these options.

To run global search re-indexing:

1. Ensure that you are an Administrator of the CW repository and have db_owner or administrator permissions on the SQL/Oracle database.
2. Press Windows + R keys and type CMD. Then, click OK.
3. Run the Validate Repository tool with the following command:

   C:\Program Files (x86)\erwin\CM10\bin>ValidateRepository.exe -username:admin -applyfixes:gsreindex

   The following screen appears.
4. Open Services.
5. Stop CWS Database Service and CWS Search Service.

6. Return to the already open Command Prompt and enter ‘Y’.

The following output appears.

```
Are you sure that you wish to run this operation? (Yes/(A)ll/(N)o): Y
Operation completed. Total Indexed records : 0180
```

Global Search Re-indexing is done.
Global Search

Enabling Global Search

1. In CWSuite, ensure that the model's auditing option is enabled. See image, on the right to find the location of this setting.

   If you do not see the option to 'Enable Object Revision History' in the Model Properties dialog. Ensure you have turned auditing on in the Repository. See details here.

2. Before deploying a Dynamic Site from Evolve Designer, ensure Enable Global Search is selected by navigating to Site -> Deployments -> [DeploymentMachine] -> Site Name and checking the Enable Global Search checkbox.

3. Also check the location of the temporary search index delta files. This folder will buffer changes from the database, to the search service. It is entirely temporary and should the content be erased, it will automatically be recreated.
   This directory should be server-local (a suitable location is selected by default, however if you need more disc space, this can be placed anywhere else on the server).
   If this server is Primary, the search content will appear at this location first, before being copied to a "Shared Location", for use by the slave servers.
   If this server is a Slave (not Primary), then this location will not be used, as the data is sourced from the "Shared Location". Slave servers must have the "Shared Location" set to the same folder as the Primary
New settings in Evolve 2018.1.0 and above. These control the temporary file location for search index change.

**Searching for Objects**

Finding objects is as simple as entering text into the search field and clicking the search icon or pressing enter.

**Filtering Search Results**

**Filtering by Object Type**

Search results can be filtered to only show objects that are a specific object type.

**Filtering by Category**

Search results can be filtered to only show objects that fall under a specific category.

**Restricting Search**

By default Global Searches are performed on object Names and Descriptions. If this is yielding too many unwanted results you can specify to search based on object names or descriptions separately.
Related Topics

Advanced Search

Using Favorites with Filters
Global Search - Advanced Filters

Before you start

- Ensure Global Search is enabled.

Accessing the Advanced Filters

Access the search window by typing your search text in the left hand pane and clicking the search icon or pressing enter.
This will give an initial result set using the current filter settings. Clicking the down twisty ‘v’ will show the standard filters.
Just above the apply button there is an Advanced twisty ‘v’, this will give access to the advanced filters section.
In order to add an advanced filter you must first select one or more object types.

Using the Advanced Filters

- Click the "Add" button to add a filter.
- Drop down a property (note: if multiple object types are selected, only the intersected set of properties will be available).
- Choose your condition from the second drop-down (e.g. Contains).
- Type the text you wish to use with the condition.
- Press 'Apply' to apply a filter and 'Reset' to remove the filters.

*Note that all filters are "AND"ed together, with the standard filter content.*
Fig. Advanced Filters

Related Topics

Global Search

Using Favorites with Filters
Global Search - Favorite Search Filters [2018.0.2+]

Before you start

- Ensure Global Search is enabled.

Using Favorite Filters

When viewing the filter options you will see a star symbol. Pressing this star will open the favorites options.

By default you will see a place to name a favorite, and the 'Save' button.

- Naming and saving a favorite will store it in your favorites. It will appear in a list on the same page.
- Pressing a favorite name from the list, will switch to this saved filter.
- Pressing the X to the right of the favorite, will delete this favorite.

Viewing Preset Filters

- To the left of the favorites star icon is the presets icon. Pressing this icon, will show the preset filters.
- Preset filters are like favorites, but are available to all users with a given Role.
Preset filters are also available in **Static evolve sites**, where the Roles of the user generating the Static site, will control which filters are available to ALL users. Note: Static sites themselves do not have Roles, hence the preset's availability.

- Preset filters can only be added by an Administrator, and assigned to Roles

---

**Search Results**  
**Critical Applications**  
Found 1 results for "app" (0.033 seconds)

**Filter Results:**

- Presets:
  - Critical Applications

---

**Application Portfolio Manager**  
**Application (Software)**  
28 Feb 2019 - Solution that managed the application portfolio of the enterprise abracadabra

---

**Fig. Choosing to view Preset Filters**

**Sharing Favorite filters as Presets (Administrator option only)**

**In order to configure Presets, it is necessary first to be an Administrator.**

1. Create a filter in the usual way.
2. Make the filter a favorite.
3. From the 'Page Picker', choose the 'Filters' Page.
4. From the list of favorites displayed, choose the edit button
5. Search for a role and associate it to the favorite
6. Save the association.
7. This favorite will now display as a Preset, to all users who share this Role

Remove a Preset (Administrator option only)

In order to remove a Presets, it is necessary first to be an Administrator.

1. From the 'Page Picker', choose the 'Filters' Page.
2. Locate the Preset you wish to remove.
3. Disassociate the Roles from the Preset.
4. It will return to being a favorite and can be deleted in the same way as other favorites.

Related Topics

Global Search
Advanced Search
File Structure

Overview of the folder structure of Evolve Web Platform

If you have configured your site to replicate content from one server to another, for example when using a load balancer, you may need to adjust your 'Copy' scripts for 2020.0.2 onwards. See the details below to determine what folders have moved.

Unlike many Windows applications, including 'Evolve Suite', 'Evolve Web Platform' is typically installed to the root of your C: drive.
While most of the files that are installed are not intended for user serviceability, there are a few folders that contain content, useful for administrators. Most significantly, folders containing customized content, search indexes, and generated content. All of which may be replicated to other servers, when load balancing.

Up to and including Evolve Web Platform 2020.0.1 the folders followed this pattern:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>c:\erwin\evolve [or] c:\casewise\evolve</td>
<td>Main installation folder</td>
</tr>
<tr>
<td>\CWSServices</td>
<td>Global Search services</td>
</tr>
<tr>
<td>\CWSServices\Data</td>
<td>Global Search encrypted audit records, for indexing (and sharing to other servers in a load balanced group)</td>
</tr>
<tr>
<td>\Data\Common</td>
<td>Shared web client content for all sites (javascript)</td>
</tr>
<tr>
<td>\Data\Sites[sitename]</td>
<td>Specific content for the given dynamic site sitename. This would include any temporarily generated content, such as gallery content, images, user pictures, diagrams, hotspot maps etc.</td>
</tr>
<tr>
<td>\Data\Statics[sitename]</td>
<td>Specific content for the given static site sitename. This would include all generated static site content. The static content could also be used by a dynamic site, with static pages.</td>
</tr>
<tr>
<td>\Diagrammer</td>
<td>The new Web Modeler application service</td>
</tr>
<tr>
<td>\ElasticSearch</td>
<td>The elastic search runtimes to operate Global Search</td>
</tr>
<tr>
<td>\Elasticsearch\elasticsearch-6.4.0\data\nodes</td>
<td>The elastic search database files. If upgrading within the same Major release version, these files can be kept, to remove the need for a full search re-index. In large installations this can save many hours of re-indexing.</td>
</tr>
<tr>
<td>\JRE</td>
<td>The Java runtime to support ElasticSearch and other Java components</td>
</tr>
<tr>
<td>\node_modules</td>
<td>The node modules required to support Web Modeler</td>
</tr>
<tr>
<td>\Site\bin\sites</td>
<td>The site configuration files that describe site settings</td>
</tr>
<tr>
<td>\Site\bin\webDesigner\custom</td>
<td>The location for customization files for Evolve Web Platform</td>
</tr>
<tr>
<td>\Site\logs</td>
<td>The Web Designer, Diagram Designer, and Live log files for the platform</td>
</tr>
<tr>
<td>\WebRestAPI</td>
<td>The REST API that replaces Portal Web Services, and supports interaction over a http interface</td>
</tr>
</tbody>
</table>

What has changed from 2020.0.2 onwards, is the location of the static generated content, and any data related content for the dynamic site. The new structure is as follows:
<table>
<thead>
<tr>
<th>Folder</th>
<th>Description</th>
</tr>
</thead>
</table>
| Data\Sites\[sitename] | Site structure and design for the given dynamic site *sitename*  
This NO LONGER includes any site content / data. |
| Data\Statics\[sitename] | Site structure and design for the given static site *sitename*  
This NO LONGER includes any site content / data.  
The generated JSON files are NOT put here. |
| Data\Data\[sitename]\live\ | Content data for the site *sitename*  
This includes images, gallery content, user pictures, temporary diagram images, hotspot maps etc. |
| Data\Data\[sitename]\static\ | Content data for the site *sitename*  
This includes all generated static site content.  
The static content could also be used by a dynamic site, with static pages. |

**Related Topics**

**Global Search**

**Customization Explained**
Required MIME Types

Your web server machine must be configured to understand some specific file formats used by Evolve.

The instructions below alter the settings for the Evolve application only. You can make these settings at a higher level, such as the Default Web Site, that will then ensure they are available to all applications below.

To specify the new MIME Types:

1. On the web server machine, run Internet Information Services (IIS) Manager
2. In IIS Manager’s left-hand pane, select the node for the Evolve application
   - Ensure you have the central pane set to Features View, then double-click MIME Types in the IIS section
   - The MIME Types settings are displayed
3. Check the list of extensions that are already configured and see if any of the following are missing:
   - .eot
   - .json
   - .ttf
   - .woff
4. For each extension that is not already configured, do the following:
   i. Right-click in the central pane and select Add
   ii. Enter the following details, depending on which you need to add
      | File name extension | MIME Type             |
      |---------------------|-----------------------|
      | .eot                | application/octet-stream |
      | .json               | application/json       |
      | .ttf                | application/octet-stream |
      | .woff               | application/font-woff   |
   iii. Click OK
5. Close IIS Manager.
Configuration and Administration

Server Configuration

Configure your Server

The instructions below explain how to configure your Evolve Server so that you can publish your sites on it.

This step must be performed after you have installed Evolve on the server machine, but before you attempt to publish any sites.

To configure your Evolve server:

1. Run Evolve Designer.
2. On the Evolve Designer Models launcher dialog, click the Server Configuration button.
3. Configure the settings according to the table below:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evolve IIS Site Name</td>
<td>Specify the name of your IIS Site as it appears in the URL, such as http://&lt;server-name&gt;/&lt;evolve-IIS-site-name&gt;/</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Evolve Site Folder</strong></td>
<td>Specify the path to your Evolve Site directory. You can usually leave this as the default, unless you have installed to a different directory.</td>
</tr>
<tr>
<td><strong>Evolve Data Folder</strong></td>
<td>Specify the path to your Evolve Data directory where your local resources will be stored. You can usually leave this as the default, unless you have installed to a different directory.</td>
</tr>
<tr>
<td><strong>Server Language</strong></td>
<td>Choose the language of the top-level Evolve Site, including the Model Selector page, as well as the login screen.</td>
</tr>
<tr>
<td><strong>Server Theme</strong></td>
<td>Choose the theme of the top-level Evolve Site, including the Model Selector page, as well as the login screen.</td>
</tr>
<tr>
<td><strong>IIS Application Path</strong></td>
<td>Specify the path to your IIS application. You can usually leave this as the default.</td>
</tr>
<tr>
<td><strong>CW Database</strong></td>
<td>Select the CW repository your Evolve deployment will use.</td>
</tr>
<tr>
<td><strong>Evolve CM User Name</strong></td>
<td>Enter the Username of a CW Suite User with <strong>System Manager</strong> rights that can be used to log on to the CW repository so the Evolve Site can access the Model data. You could create a new user dedicated to Evolve use for this purpose.</td>
</tr>
<tr>
<td><strong>Evolve CM User Password</strong></td>
<td>Enter the password for the above user. Ensure you <strong>Encrypt</strong> the password after entering it.</td>
</tr>
<tr>
<td><strong>Javascript Mode</strong></td>
<td>This is an advanced setting which can only be changed in developer debug mode.</td>
</tr>
<tr>
<td><strong>IIS User Name</strong></td>
<td>Specify the name of a local user on the web server machine which has <strong>Administrator rights</strong> on the machine. This user is required for the Application Pool to run. <strong>NOTE:</strong> To prevent unwanted errors, the IIS user must be different from the remote desktop user.</td>
</tr>
<tr>
<td><strong>IIS User’s Password</strong></td>
<td>Enter the password for the above user. Ensure you <strong>Encrypt</strong> the password after entering it.</td>
</tr>
</tbody>
</table>

**Authentication**

We recommend you leave the IIS Site Name. If you do change it, it must be lower case with no spaces, and you must make sure that the MVC Folder still points to Casewise/Evolve/Site - or wherever your Evolve is installed.
| **Authentication Mode** | Choose how you want Users to be logged on to Evolve:
Use **CorporateModelerAuthentication** to only allow existing CW Users to sign in
Use **ActiveDirectoryAuthentication** to enable Active Directory authentication
Use **SAML2** to enable a SAML2 authentication. Follow this guide to complete the configuration of SAML2
*For a basic site to start with*, we recommend you use **CorporateModelerAuthentication**. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable Automatic Logon</strong></td>
<td>If you choose ActiveDirectoryAuthentication, select Enable Windows Authentication to ensure Evolve users are automatically logged in to Evolve when they access the Site.</td>
</tr>
<tr>
<td><strong>Domain Short Name</strong></td>
<td>If CW Suite is set to use login via 'any valid Windows user and domain' (option 3), use this setting to enter the short name of your domain. This is referenced before '' when used as shortdomainname\username. If you do not use login option 3, leave this setting blank.</td>
</tr>
<tr>
<td><strong>Use SSL Connection (Active Directory)</strong></td>
<td>Tick this box if you need to connect to Active Directory using LDAPS. Note the settings required in the AD Connection Path and AD Port, should match this request.</td>
</tr>
</tbody>
</table>
| **AD Connection Path** | If you choose ActiveDirectoryAuthentication, use this setting to specify the path Evolve can use to connect to your Active Directory server. **To do this:**
Right-click onto the server/computer and go into Properties. The domain name should be visible at the bottom.
For example, if your domain is 'MyDomain.local' the connection path would be:
`LDAP://mydomain.local/DC=mydomain,DC=local`
Note: for every parameter in the domain, you need to add a “DC=”
Also, for SSL Active Directory, unsure the path begins:
`LDAPS://`
| **AD Port** | If you require a specific port for your Active Directory server, enter it here. You can usually leave this as the default. Unless you are using a SSL, in which case the default port is: 636 |
| **AD Group Membership Selection Mode** | Leave as the default unless you have special Active Directory requirements.
Use GetAllGroupsForUser if your Active Directory has multiple domains and nested groups. The method causes Evolve to fetch the user and then try to fetch all the groups where this user belongs to.
Use GetGroupMembers (default) if your Active Directory operates on a single domain. Supports nested groups.
Use GetGroupDirectoryServices if your Active Directory has multiple domains and nested groups, as in option 1 (GetAllGroupsForUser), but you want to use LDAP-oriented protocol codes. |
| **AD Connection Username** | This field is used to specify the property type on Active Directory used for the connection.
*This is an advanced setting that should only be used by someone who is an expert* |
Authentication Mode

Choose how you want Users to be logged in to Evolve:
- **CorporateModelerAuthentication** to only allow existing CW Users to sign in
- **ActiveDirectoryAuthentication** to enable Active Directory authentication
- **SAML2** to enable a SAML2 authentication.

Follow [this guide](#) to complete the configuration of SAML2.

**For a basic site to start with**, we recommend you use CorporateModelerAuthentication.

<table>
<thead>
<tr>
<th>Connect to Active Directory Forest</th>
<th>This option is selected to browse and find users across the entire Active Directory Forest. If left unchecked, browsing is limited to the defined LDAP:// path, and will not extend to all Forest domains.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain Exclusion List</td>
<td>Connections will not be attempted for any domains in this list.</td>
</tr>
</tbody>
</table>
Authentication and SAML2

Configure SAML2 Authentication and SSO

SAML2 is a commonly used, standardized approach of securing logon to web based systems, where the authentication is delegated to another system or third party. The following section will describe both the pre-requisites and the Evolve configuration required to enable SAML2 as your authentication provider. It is largely assumed that you are knowledgeable about the configuration of your SAML2 authority.

For details on how SAML2 is offered when Evolve is hosted and you wish to integrate your corporate authentication with the platform, an overview document can be found here.

SAML2 Configuration for Cloud Service Access (English) and
SAML2 Configuration for Cloud Service Access (French)

The instructions below explain how to configure your Evolve Server so that you can use SAML2 as an authentication method to access your sites.

Changes to these settings will require the re-publication of the site.

Pre-requisites for SAML2 authentication:

Firstly it is a requirement to have a SAML2 authentication provider. This is the service that will provide both authentication responses and offer users a means to logon. One common example is Microsoft Active Directory, which can be configured natively, or through SAML2.

The authentication provider will be able to supply the following:

- Either a SAML2 metadata file, or a URL that links to a SAML2 metadata file
- An EntityID - this is the URL that points to the authentication provider (this may often be found in the SAML2 metadata file)

The Evolve web site will need to be operated over a Secure HTTP protocol (HTTPS). This will mean you are also in possession of:

- An SSL certificate to ensure both end-user clients and the authentication provider can trust Evolve.

Preparing the SSL certificate:

Since Evolve needs to be able to communicate securely with the SAML2 Auth provider, it will need to use an SSL certificate. The certificate which is validating the Evolve site (SSL domain certificate) can be used, however it is necessary to change the password on the certificate to make is usable by Evolve. In order to achieve this:

1. If you have not done so already, import the domain SSL certificate into Windows
2. Export the certificate to a new *.PFX file
3. Use the following password to secure the certificate:
   LQMmsuLpVAZ9ePd
   Note that it is not currently possible to choose an alternative password. However the certificate is stored...
securely on your server, and is not made available externally, so this should not pose a concern.

4. Save the filename: CasewiseAuth.pfx in the folder: c:\Casewise\Evolve\Site\bin

To configure SAML2 on your Evolve server:

1. Run Evolve Designer.
2. On the Evolve Designer Models launcher dialog, click the Server Configuration button.

The Server Configuration dialog opens.

3. Configure the settings according to the table below:

Authentication

<table>
<thead>
<tr>
<th>Authentication Mode</th>
<th>Choose how you want Users to be logged on to Evolve: Use Saml2 to make Evolve expect a SAML2 authentication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Automatic Logon</td>
<td>Leave un-checked</td>
</tr>
<tr>
<td>Domain Short Name</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Use SSL Connection (Active Directory)</td>
<td>Leave un-checked.</td>
</tr>
<tr>
<td>AD Connection Path</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Port</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Group Membership Selection Mode</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Connection Username</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Connect to Active Directory Forest</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Domain Exclusion List</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>SAML2 Entity ID</td>
<td>This is often found in the metadata.xml, and consists of the URL that Evolve needs to check authentication.</td>
</tr>
<tr>
<td>SAML2 Meta Url</td>
<td>This could be a public URL, a private URL or a local file path. The meta data consists of an XML file that contains the settings for the SAML2 configuration. e.g. configured for a local file:</td>
</tr>
<tr>
<td>Authentication Mode</td>
<td>Choose how you want Users to be logged on to Evolve: Use Saml2 to make Evolve expect a <strong>SAML2</strong> authentication</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>~/IDP-QA-Metadata.xml</td>
<td>where the metadata file should be stored in the Site folder</td>
</tr>
<tr>
<td>Evolve's Url</td>
<td>Enter the URL to the Evolve home page - e.g. <a href="https://domain.company.com/evolve/">https://domain.company.com/evolve/</a></td>
</tr>
</tbody>
</table>

4. Click **Save** to save your configuration.

*If you make any further changes to the server configuration in this dialog, you must Save again.*

At this point it will no longer be possible to logon to Evolve, as the final steps are to configure the permissions based on Claims configured on the Authentication Server, and their mapping to groups on the Evolve server.

**To configure Groups and Roles on your Evolve server:**

Groups and Roles for SAML2 are configured in exactly the same way as they are for Active Directory. Take a look at [this](#) to see how they work. You will find this detail in the "AD Mapping" details of the "Site Level Settings" - "Deployment Node Settings".

**Further instructions for specific Identity Providers:**

See here for help on [Integrating with Okta Identity Provider](#)
Configuration and Administration

Server Configuration

Configure your Server

The instructions below explain how to configure your Evolve Server so that you can publish your sites on it.

This step must be performed after you have installed Evolve on the server machine, but before you attempt to publish any sites.

To configure your Evolve server:

1. Run Evolve Designer.
2. On the Evolve Designer Models launcher dialog, click the Server Configuration button.

The Server Configuration dialog opens.

3. Configure the settings according to the table below:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Evolve IIS Site Name| Specify the name of your IIS Site as it appears in the URL, such as http://<servername>/<evolve-IIS-site-name>/  
We recommend you leave the IIS Site Name. If you do change it, it must be lower case with no spaces, and you must make sure that the MVC Folder still points to Casewise/Evolve/Site - or wherever your Evolve is installed. |
| Evolve Site Folder  | Specify the path to your Evolve Site directory.  
You can usually leave this as the default, unless you have installed to a different directory. |
| Evolve Data Folder  | Specify the path to your Evolve Data directory where your local resources will be stored.  
You can usually leave this as the default, unless you have installed to a different directory. |
<p>| Server Language     | Choose the language of the top-level Evolve Site, including the Model Selector page, as well as the login screen. |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server Theme</strong></td>
<td>Choose the theme of the top-level Evolve Site, including the Model Selector page, as well as the login screen.</td>
</tr>
<tr>
<td><strong>IIS Application Path</strong></td>
<td>Specify the path to your IIS application. You can usually leave this as the default.</td>
</tr>
<tr>
<td><strong>CW Database</strong></td>
<td>Select the CW repository your Evolve deployment will use.</td>
</tr>
<tr>
<td><strong>Evolve CM User Name</strong></td>
<td>Enter the Username of a CW Suite User with <strong>System Manager</strong> rights that can be used to log on to the CW repository so the Evolve Site can access the Model data. You could create a new user dedicated to Evolve use for this purpose.</td>
</tr>
<tr>
<td><strong>Evolve CM User Password</strong></td>
<td>Enter the password for the above user. Ensure you <strong>Encrypt</strong> the password after entering it.</td>
</tr>
<tr>
<td><strong>Javascript Mode</strong></td>
<td>This is an advanced setting which can only be changed in developer debug mode.</td>
</tr>
<tr>
<td><strong>IIS User Name</strong></td>
<td>Specify the name of a local user on the web server machine which has <strong>Administrator rights</strong> on the machine. This user is required for the Application Pool to run.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> To prevent unwanted errors, the IIS user <strong>must</strong> be different from the remote desktop user.</td>
</tr>
<tr>
<td><strong>IIS User's Password</strong></td>
<td>Enter the password for the above user. Ensure you <strong>Encrypt</strong> the password after entering it.</td>
</tr>
</tbody>
</table>

**Authentication**

- **Authentication Mode**: Choose how you want Users to be logged on to Evolve:
  - Use **CorporateModelerAuthentication** to only allow existing CW Users to sign in
  - Use **ActiveDirectoryAuthentication** to enable Active Directory authentication
  - Use **SAML2** to enable a SAML2 authentication. Follow **this guide** to complete the configuration of SAML2

  For a basic site to start with, we recommend you use **CorporateModelerAuthentication**.

- **Enable Automatic Logon**: If you choose **ActiveDirectoryAuthentication**, select Enable Windows Authentication to ensure Evolve users are automatically logged in to Evolve when they access the Site.

- **Domain Short Name**: If CW Suite is set to use login via *any valid Windows user and domain* (option 3), use this setting to enter the short name of your domain. This is referenced before '\', when used as shortdomainname\username. If you do not use login option 3, leave this setting blank.

- **Use SSL Connection (Active Directory)**: Tick this box if you need to connect to Active Directory using LDAPS. Note the settings required in the AD Connection Path and AD Port, should match this request.
 Authentication Mode

Choose how you want Users to be logged on to Evolve:

- **Use CorporateModelerAuthentication** to only allow existing CW Users to sign in
- **Use ActiveDirectoryAuthentication** to enable Active Directory authentication
- **Use SAML2** to enable a SAML2 authentication. Follow this guide to complete the configuration of SAML2

*For a basic site to start with*, we recommend you use CorporateModelerAuthentication.

### AD Connection Path

If you choose ActiveDirectoryAuthentication, use this setting to specify the path Evolve can use to connect to your Active Directory server.

**To do this:**

Right-click onto the server/computer and go into Properties. The domain name should be visible at the bottom.

For example, if your domain is 'MyDomain.local' the connection path would be: LDAP://mydomain.local/DC=mydomain,DC=local

*Note:* for every parameter in the domain, you need to add a "DC="

Also, for SSL Active Directory, unsure the path begins: LDAPS://

### AD Port

If you require a specific port for your Active Directory server, enter it here.

You can usually leave this as the default. Unless you are using a SSL, in which case the default port is: 636

### AD Group Membership Selection Mode

- Leave as the default unless you have special Active Directory requirements.
- Use `GetAllGroupsForUser` if your Active Directory has multiple domains and nested groups. The method causes Evolve to fetch the user and then try to fetch all the groups where this user belongs to.
- Use `GetGroupMembers` (default) if your Active Directory operates on a single domain. Supports nested groups.
- Use `GetGroupDirectoryServices` if your Active Directory has multiple domains and nested groups, as in option 1 (`GetAllGroupsForUser`), but you want to use LDAP-oriented protocol codes.

### AD Connection Username

This field is used to specify the property type on Active Directory used for the connection.

*This is an advanced setting that should only be used by someone who is an expert in Active Directory.*

### Connect to Active Directory Forest

This option is selected to browse and find users across the entire Active Directory Forest.

If left unchecked, browsing is limited to the defined LDAP:// path, and will not extend to all Forest domains.

### Domain Exclusion List

Connections will not be attempted for any domains in this list.

---

**Workflow**

---

431
Enable Workflow | Select the check box to enable Workflow on your Evolve server.
---|---
**Workflow Due Date Interval** | Set the number of days you want to allow for task completion. Evolve uses this interval to highlight tasks that are due for completion today, or alert you to ones that are overdue.
**Send Email Alerts** | Select the check box if you want alerts to be sent to users by Email. If you choose not to use Email, there are notifications in the Evolve Site itself.
**SMTP Server** | If you choose to send Email alerts for Workflow, use this setting to enter the address of your SMTP Server.
**SMTP Port** | If your SMTP Server requires a port setting, enter it here.
**Email Display Name** | Enter the name you would like to be displayed in the No-Reply email field for Workflow emails.
**No-Reply Email Address** | Enter the No-Reply Email address you would like to use for Workflow emails.

4. Click **Save** to save your configuration.
5. Click **Configure IIS**.
   
   *The web server is configured and the top-level Evolve Site is created according to the settings you specified.*
6. If running the Server Configuration tool for the first time, click Update Admin Model.
   
   *This adds new meta data to your CW user objects to store Evolve user details.*

   *If you make any further changes to the server configuration in this dialog, you must Save again.*

### Authentication and SAML2

**Configure SAML2 Authentication and SSO**

SAML2 is a commonly used, standardized approach of securing logon to web based systems, where the authentication is delegated to another system or third party. The following section will describe both the pre-requisites and the Evolve configuration required to enable SAML2 as your authentication provider. It is largely assumed that you are knowledgeable about the configuration of your SAML2 authority.

*For details on how SAML2 is offered when Evolve is hosted and you wish to integrate your corporate authentication with the platform, an overview document can be found here.*

**SAML2 Configuration for Cloud Service Access (English)** and **SAML2 Configuration for Cloud Service Access (French)**

The instructions below explain how to configure your Evolve Server so that you can use SAML2 as an authentication method to access your sites.

*Changes to these settings will require the re-publication of the site.*

**Pre-requisites for SAML2 authentication:**
Firstly it is a requirement to have a SAML2 authentication provider. This is the service that will provide both authentication responses and offer users a means to logon. One common example is Microsoft Active Directory, which can be configured natively, or through SAML2.

The authentication provider will be able to supply the following:

- Either a SAML2 metadata file, or a URL that links to a SAML2 metadata file
- An EntityID - this is the URL that points to the authentication provider (this may often be found in the SAML2 metadata file)

The Evolve web site will need to be operated over a Secure HTTP protocol (HTTPS). This will mean you are also in possession of:

- An SSL certificate to ensure both end-user clients and the authentication provider can trust Evolve.

**Preparing the SSL certificate:**

Since Evolve needs to be able to communicate securely with the SAML2 Auth provider, it will need to use an SSL certificate. The certificate which is validating the Evolve site (SSL domain certificate) can be used, however it is necessary to change the password on the certificate to make it usable by Evolve. In order to achieve this:

1. If you have not done so already, import the domain SSL certificate into Windows
2. Export the certificate to a new *.PFX file
3. Use the following password to secure the certificate: LQMrnsuLpVAZ9ePd
   Note that it is not currently possible to choose an alternative password. However the certificate is stored securely on your server, and is not made available externally, so this should not pose a concern.
4. Save the filename: CasewiseAuth.pfx
   in the folder: c:\Casewise\Evolve\Site\bin

**To configure SAML2 on your Evolve server:**

1. Run Evolve Designer.
2. On the Evolve Designer Models launcher dialog, click the Server Configuration button.

   *The Server Configuration dialog opens.*
3. Configure the settings according to the table below:

   **Authentication**
<table>
<thead>
<tr>
<th>Authentication Mode</th>
<th>Choose how you want Users to be logged on to Evolve: Use Saml2 to make Evolve expect a SAML2 authentication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Automatic Logon</td>
<td>Leave un-checked</td>
</tr>
<tr>
<td>Authentication Mode</td>
<td>Choose how you want Users to be logged on to Evolve: Use Saml2 to make Evolve expect a <strong>SAML2</strong> authentication</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Domain Short Name</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Use SSL Connection (Active Directory)</td>
<td>Leave un-checked.</td>
</tr>
<tr>
<td>AD Connection Path</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Port</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Group Membership Selection Mode</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Connection Username</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Connect to Active Directory Forest</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Domain Exclusion List</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>SAML2 Entity ID</td>
<td>This is often found in the metadata.xml file, and consists of the URL that Evolve needs to check authentication.</td>
</tr>
<tr>
<td>SAML2 Meta Url</td>
<td>This could be a public URL, a private URL or a local file path. The meta data consists of an XML file that contains the settings for the SAML2 configuration. e.g. configured for a local file: <code>~/IDP-QA-Metadata.xml</code> where the metadata file should be stored in the Site folder</td>
</tr>
<tr>
<td>Evolve's Url</td>
<td>Enter the URL to the Evolve home page - e.g. <code>https://domain.company.com/evolve/</code></td>
</tr>
</tbody>
</table>

4. **Click Save** to save your configuration.

- **If you make any further changes to the server configuration in this dialog, you must Save again.**

At this point it will no longer be possible to logon to Evolve, as the final steps are to configure the permissions based on Claims configured on the Authentication Server, and their mapping to groups on the Evolve server.

**To configure Groups and Roles on your Evolve server:**

Groups and Roles for SAML2 are configured in exactly the same way as they are for Active Directory. Take a look at [this](#) to see how they work. You will find this detail in the "AD Mapping" details of the "Site Level Settings" - "Deployment Node Settings".

Further instructions for specific Identity Providers:
See here for help on Integrating with Okta Identity Provider
Authentication and SAML 2

Configure SAML2 Authentication and SSO

SAML2 is a commonly used, standardized approach of securing logon to web based systems, where the authentication is delegated to another system or third party. The following section will describe both the pre-requisites and the Evolve configuration required to enable SAML2 as your authentication provider. It is largely assumed that you are knowledgeable about the configuration of your SAML2 authority.

For details on how SAML2 is offered when Evolve is hosted and you wish to integrate your corporate authentication with the platform, an overview document can be found here.

SAML2 Configuration for Cloud Service Access (English) and
SAML2 Configuration for Cloud Service Access (French)

The instructions below explain how to configure your Evolve Server so that you can use SAML2 as an authentication method to access your sites.

Changes to these settings will require the re-publication of the site.

Pre-requisites for SAML2 authentication:

Firstly it is a requirement to have a SAML2 authentication provider. This is the service that will provide both authentication responses and offer users a means to logon. One common example is Microsoft Active Directory, which can be configured natively, or through SAML2.

The authentication provider will be able to supply the following:

- Either a SAML2 metadata file, or a URL that links to a SAML2 metadata file
- An EntityID - this is the URL that points to the authentication provider (this may often be found in the SAML2 metadata file)

The Evolve web site will need to be operated over a Secure HTTP protocol (HTTPS). This will mean you are also in possession of:

- An SSL certificate to ensure both end-user clients and the authentication provider can trust Evolve.

Preparing the SSL certificate:

Since Evolve needs to be able to communicate securely with the SAML2 Auth provider, it will need to use an SSL certificate. The certificate which is validating the Evolve site (SSL domain certificate) can be used, however it is necessary to change the password on the certificate to make it usable by Evolve. In order to achieve this:

1. If you have not done so already, import the domain SSL certificate into Windows
2. Export the certificate to a new *.PFX file
3. Use the following password to secure the certificate:
   LQMmsuLPVAZ9ePd
   Note that it is not currently possible to choose an alternative password. However the certificate is stored
securely on your server, and is not made available externally, so this should not pose a concern.

4. Save the filename: CasewiseAuth.pfx in the folder: c:\Casewise\Evolve\Site\bin

To configure SAML2 on your Evolve server:

1. Run Evolve Designer.
2. On the Evolve Designer Models launcher dialog, click the Server Configuration button.

The Server Configuration dialog opens.
3. Configure the settings according to the table below:

<table>
<thead>
<tr>
<th>Authentication Mode</th>
<th>Choose how you want Users to be logged on to Evolve: Use Saml2 to make Evolve expect a SAML2 authentication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Automatic Logon</td>
<td>Leave un-checked</td>
</tr>
<tr>
<td>Domain Short Name</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Use SSL Connection</td>
<td>Leave un-checked.</td>
</tr>
<tr>
<td>Authentication Mode</td>
<td>Choose how you want Users to be logged on to Evolve: Use Saml2 to make Evolve expect a <strong>SAML2</strong> authentication</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>(Active Directory)</td>
<td></td>
</tr>
<tr>
<td>AD Connection Path</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Port</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Group Membership Selection Mode</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Connection Username</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Connect to Active Directory Forest</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Domain Exclusion List</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>SAML2 Entity ID</td>
<td>This is often found in the metadata.xml file, and consists of the URL that Evolve needs to check authentication.</td>
</tr>
<tr>
<td>SAML2 Meta Url</td>
<td>This could be a public URL, a private URL or a local file path. The meta data consists of an XML file that contains the settings for the SAML2 configuration. e.g. configured for a local file: <code>~/IDP-QA-Metadata.xml</code> where the metadata file should be stored in the Site folder</td>
</tr>
<tr>
<td>Evolve's Url</td>
<td>Enter the URL to the Evolve home page - e.g. <code>https://domain.company.com/evolve/</code></td>
</tr>
</tbody>
</table>

4. Click **Save** to save your configuration.

*If you make any further changes to the server configuration in this dialog, you must Save again.*

At this point it will no longer be possible to logon to Evolve, as the final steps are to configure the permissions based on Claims configured on the Authentication Server, and their mapping to groups on the Evolve server.

*To configure Groups and Roles on your Evolve server:*
Groups and Roles for SAML2 are configured in exactly the same way as they are for Active Directory. Take a look at this to see how they work. You will find this detail in the "AD Mapping" details of the "Site Level Settings" - "Deployment Node Settings".

Further instructions for specific Identity Providers:

See here for help on Integrating with Okta Identity Provider
Authentication and SAML 2

Configure SAML2 Authentication and SSO

SAML2 is a commonly used, standardized approach of securing logon to web based systems, where the authentication is delegated to another system or third party. The following section will describe both the pre-requisites and the Evolve configuration required to enable SAML2 as your authentication provider. It is largely assumed that you are knowledgeable about the configuration of your SAML2 authority.

For details on how SAML is offered when Evolve is hosted and you wish to integrate your corporate authentication with the platform, an overview document can be found here. SAML2 Configuration for Cloud Service Access (English) and SAML2 Configuration for Cloud Service Access (French)

The instructions below explain how to configure your Evolve Server so that you can use SAML2 as an authentication method to access your sites.

Changes to these settings will require the re-publication of the site.

Pre-requisites for SAML2 authentication:

Firstly it is a requirement to have a SAML2 authentication provider. This is the service that will provide both authentication responses and offer users a means to logon. One common example is Microsoft Active Directory, which can be configured natively, or through SAML2.

The authentication provider will be able to supply the following:

- Either a SAML2 metadata file, or a URL that links to a SAML2 metadata file
- An EntityID - this is the URL that points to the authentication provider (this may often be found in the SAML2 metadata file)

The Evolve web site will need to be operated over a Secure HTTP protocol (HTTPS). This will mean you are also in possession of:

- An SSL certificate to ensure both end-user clients and the authentication provider can trust Evolve.

Preparing the SSL certificate:

Since Evolve needs to be able to communicate securely with the SAML2 Auth provider, it will need to use an SSL certificate. The certificate which is validating the Evolve site (SSL domain certificate) can be used, however it is necessary to change the password on the certificate to make is usable by Evolve. In order to achieve this:

1. If you have not done so already, import the domain SSL certificate into Windows
2. Export the certificate to a new *.PFX file
3. Use the following password to secure the certificate :
   LQMmsuLpVAZ9ePd
   Note that it is not currently possible to choose an alternative password. However the certificate is stored securely on your server, and is not made available externally, so this should not pose a concern.
4. Save the filename: CasewiseAuth.pfx
   in the folder: c:\Casewise\Evolve\Site\bin
To configure SAML2 on your Evolve server:

1. Run Evolve Designer.
2. On the Evolve Designer Models launcher dialog, click the Server Configuration button.

   The Server Configuration dialog opens.
3. Configure the settings according to the table below:

   **Authentication**

<table>
<thead>
<tr>
<th>Authentication Mode</th>
<th>Choose how you want Users to be logged on to Evolve: Use Saml2 to make Evolve expect a SAML2 authentication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Automatic Logon</td>
<td>Leave un-checked</td>
</tr>
<tr>
<td>Domain Short Name</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Use SSL Connection (Active Directory)</td>
<td>Leave un-checked.</td>
</tr>
<tr>
<td>AD Connection Path</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Authentication Mode</td>
<td>Choose how you want Users to be logged on to Evolve: Use SAML2 to make Evolve expect a <strong>SAML2</strong> authentication</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AD Port</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Group Membership Selection Mode</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Connection Username</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Connect to Active Directory Forest</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Domain Exclusion List</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>SAML2 Entity ID</td>
<td>This is often found in the metadata.xml file, and consists of the URL that Evolve needs to check authentication.</td>
</tr>
<tr>
<td>SAML2 Meta Url</td>
<td>This could be a public URL, a private URL or a local file path. The meta data consists of an XML file that contains the settings for the SAML2 configuration. e.g. configured for a local file: <code>-~/IDP-QA-Metadata.xml</code> where the metadata file should be stored in the Site folder</td>
</tr>
<tr>
<td>Evolve's Url</td>
<td>Enter the URL to the Evolve home page - e.g. <a href="https://domain.company.com/evolve/">https://domain.company.com/evolve/</a></td>
</tr>
</tbody>
</table>

4. Click **Save** to save your configuration.

*If you make any further changes to the server configuration in this dialog, you must Save again.*

At this point it will no longer be possible to logon to Evolve, as the final steps are to configure the permissions based on Claims configured on the Authentication Server, and their mapping to groups on the Evolve server.

**To configure Groups and Roles on your Evolve server:**

Groups and Roles for SAML2 are configured in exactly the same way as they are for Active Directory. Take a look at [this](#) to see how they work. You will find this detail in the "AD Mapping" details of the "Site Level Settings" - "Deployment Node Settings".

Further instructions for specific Identity Providers:
See here for help on **Integrating with Okta Identity Provider**
Configuring SAML2 Authentication and SSO with Google Suite

If your organization uses Google (gsuite.google.com) as an Identity provider, these instructions will help you to configure Single Sign On, between Evolve and your IdP.

Create new Application in G Suite

1. Go to the homepage of your G Suite Admin Console. Choose Apps (top right icon in below screenshot).

2. Choose SAML Apps (top right icon in below screenshot).
3. Press the Yellow (+) button at the bottom right of the window (see below). This will create a new App in your G Suite.

4. Choose “SETUP MY OWN CUSTOM APP” at the bottom of the list (see below).
SAML Meta Data - Part 1

1. Download the IDP metadata file, using the “DOWNLOAD” button in Option 2 (see below).
Select this link and download it to your evolve server. (Saving the File as an XML file).

2. Press NEXT.

**Configure the Application**

Provide App name, Description and provide a Picture to represent it.

Then press NEXT.
1. Configure the Settings.

Set the ACS URL to:

https://\{your-domain\}/evolve/AuthServices/Acs

e.g. https://evolvemain.host.casewise.com/evolve/AuthServices/Acs

Set the Entity ID to:

https://\{your-domain\}/evolve/AuthServices

e.g. https://evolvemain.host.casewise.com/evolve/AuthServices

Set the Start URL to:
https://(your-domain)/evolve/
e.g. https://evolvemain.host.casewise.com/evolve/
Set Name ID Format to: EMAIL
2. Press NEXT.
3. Set the Attributes.

Using the "ADD NEW MAPPING" button add attribute mappings for the following 4 attributes:

**Add 4 new Attributes**

**Application Attribute**: http://schemas.xmlsoap.org/ws/2005/05/identity/claims/emailaddress
**Category**: Basic Information
**User Field**: Primary Email

**Application Attribute**: http://schemas.xmlsoap.org/ws/2005/05/identity/claims/surname
**Category**: Basic Information
**User Field**: Last Name

**Application Attribute**: http://schemas.xmlsoap.org/ws/2005/05/identity/claims/givenname
**Category**: Basic Information
**User Field**: First Name

**Application Attribute**: http://schemas.xmlsoap.org/claims/Group
**Category**: Employee Details
**User Field:** Department

Accept all other defaults

**SAML Meta Data - Part 2**

1. Taking the file you downloaded in **SAML Meta Data (Part 1)**

2. Place your metadata file on the Evolve server in the following location “C:\Casewise\Evolve\Site” **(ensure it's an XML file)**

3. Now in Evolve Designer under server Configuration/Authentication tab

   i. Select Authentication mode to “Saml2”

   ![Evolve Designer Authentication Settings]

   ii. SAML2 Entity id = taken from your Metadata xml File

   ![Sample SAML2 Entity id]

   iii. SAML2 Meta url = “~/NAME OF YOU METADATA FILE.xml”

   e.g. ~/GoogleIDPMetadata-erwingsuite.net.xml

4. Evolve’s url = YOUR EVOLVE URL

450
5. Save and Configure IIS.

**Publishing Evolve Site**

1. For each model you publish under the deployment of the model you must specify the Department names in the “AD Group” Fields this must Match the G Suite Department Names you have set up along with the Values you specified in the attribute statement.

2. Once set you must save. Then deploy the full site.
HOW AD GROUP WORKS: In G Suite you already setup SAML Groups and mapped the value from a User’s “Department” to be used as the Group in Evolve.

When the value returned by G Suite matches one of the values in "AD Group", Evolve creates the user with the permissions specified on that line.

e.g. A User who has the "Department" = "EvolveContributor", will be created with a "Contributor" Licence, in the Group "EvolveContributor". This will mean in Model Explorer you will see a new User added, with a Category "Contributor", and they will be associated with the group "EvolveContributor", which will give them access to whatever models are available to that group. In addition, we see that it will also give them a Role, "Administrator". This is an Evolve role, and will dictate what views and pages they see in the Evolve site.

See below, where a User’s department is set in the profile.

Naturally, other properties can be used to act as the Group, although we have not yet worked out how to persuade G Suite to pass the ACTUAL Google Group information. If you are able to solve this, please let us know, and we’d be happy to update the page, to let others know.
Configuring SAML2 Authentication and SSO with Okta

If your organization uses Okta (www.okta.com) as an Identity provider, these instructions will help you to configure Single Sign On, between Evolve and your IdP.

Create new Application in Okta

1. Select Create new App
2. Platform = Web
3. Sign on Method = SAML2.0

4. Click create

Configure the Application

1. Provide app name
2. General

a. **Single Sign on URL**: Your Evolve URL followed by “/AuthServices/Acs”
   
   Example: https://EvolveTest/evolve/AuthServices/Acs

b. Ensure “Use this for Recipient URL and Destination URL” is checked

c. **Audience URI (SP Entity ID)**: Your Evolve URL followed by “/AuthServices”
   
   Example: https://EvolveTest/evolve/AuthServices

d. **Name ID format**: EmailAddress

e. **Application username**: Email

### SAML Settings

**GENERAL**

- **Single sign on URL**: https://ecogntc.host.casewise.com/evolve/AuthServices/Acs
  - Use this for Recipient URL and Destination URL
  - Allow this app to request other SSO URLs

- **Audience URI (SP Entity ID)**: https://ecogntc.host.casewise.com/evolve/AuthServices

- **Default RelayState**: 
  - If no value is set, a blank RelayState is sent

- **Name ID format**: EmailAddress

- **Application username**: Email

Show Advanced Settings
3. ATTRIBUTE STATEMENTS

Add 4 new Attributes

**Name:** http://schemas.xmlsoap.org/ws/2005/05/identity/claims/emailaddress
**Name Format:** URI Reference
**Value:** user.emailaddress

**Name:** http://schemas.xmlsoap.org/ws/2005/05/identity/claims/surname
**Name Format:** URI Reference
**Value:** user.surname

**Name:** http://schemas.xmlsoap.org/ws/2005/05/identity/claims/givenname
**Name Format:** URI Reference
**Value:** user.givenname

**Name:** http://schemas.xmlsoap.org/claims/Group
**Name Format:** URI Reference
**Value:** isMemberOfGroupName("Evolve Contributor") ? "Evolve Contributor" : (isMemberOfGroupName("Evolve Social") ? "Evolve Social" : "NO")

**IMPORTANT NOTE:** In the above value we have specified the name of the Okta Groups in this case the group names are “Evolve Contributor” and “Evolve Social”. These are the Group names you must specify in Evolve Designer.

This states that any user that is in the Okta group “Evolve Contributor” will be passed as a Contributor user and any user in the Okta group “Evolve Social” will be passed as a Social user. Finally, any user that is not a member of either Okta groups will be passed as “No” and will gain no access.
Accept all other defaults

SAML Meta Data

1. In the Okta Admin Page under “Sign On” you will find the “Identity Provider metadata” link to download you’re the metadata.

Select this link and download it to your evolve server. (Saving the File as a XML file)

2. Place your metadata file on the Evolve server in the following location “C:\Casewise\Evolve\Site” (ensure it’s a XML file)

3. Now in Evolve Designer under server Configuration/Authentication tab
   a. Select Authentication mode to “Saml2”
   b. SAML2 Entity id = taken from your Metadata xml File
   c. SAML2 Meta url = “~/NAME OF YOU METADATA FILE.xml”
d. Evolve’s url = YOUR EVOLVE URL

4. Save and Configure IIS Publishing Evolve Site

1. For each model you publish under the deployment of the model you must specify the Okta group names in the “AD Group” Fields this must Match the Okta group Names you have set up along with the Values you specified in the attribute statement

2. Once set you must save. Then deploy the full site.
Configuring SAML2 Authentication and SSO in Azure AD

**Prerequisites for SAML2 authentication:**

If you have Evolve configured for HTTPS, you need to create three URLs in Azure:

- Mail URL: https://YOURURL/evolve/
- Entity ID URL: https://YOURURL/evolve/AuthServices
- Assertion Consumer Service (ACS) URL: https://YOURURL/evolve/AuthServices/Acs

**Setting up Single sign-on in Azure:**

1. In Azure's Enterprise application, select Single sign-on and SAML.
2. Enter your Entity ID and Assertion Consumer Service (ACS) URLs in the "Basic SAML Configuration" below.

![Basic SAML Configuration](image)

Now you can change your Attributes and Claims. Mail, Given name, Surname, and Principal name are already set up.

**To change Attributes and Claims:**

1. Click Add new claims.
2. Under Group Claims, click Groups assigned to the application to limit the list of AD groups assigned to this Azure application.
3. Under Advanced option, select Customize the name of the group claim check box.
4. In the Name box, enter the name of the group claim. For example, Group.
5. In the Namespace box, enter the namespace. For example, http://schemas.xmlsoap.org/claims.
6. Click Save.
Federation Metadata XML is now available for download. Copy the downloaded XML to Evolve Web Server (C:\Casewise\Evolve\Site).

To configure Evolve and Evolve Model:

1. Start Evolve Designer.
2. On the Evolve Designer Models launcher dialog box, click the **Configure Evolve Server** button.
3. Under Authentication, click **Authentication Mode** drop down and select **saml2**.
4. In the **SAML2 Entity Id** box, enter the entity id.

You can find this information in the meta data file you downloaded from Azure

5. In the **SAML2 MetaUrl** box, enter the meta url.

The metadata URL has been copied to the Evolve server (C:/Casewise/ Evolve/Site).

6. In the **The Evolve Web Platform url** box, enter the evolve url.

7. Click **Save**.

8. Click **Configure IIS** and perform full deployment.
To configure Model in Evolve Designer:

1. Start Evolve Designer.
2. Click a model. For example, EA Foundation - Sample Model.
3. Click Site.
4. Expand Site > Deployment > evolve-with-sam.
5. Click EASAMP14.
6. Under AD Mapping, enter AD group ID.
   
   Azure group ID must match the 32 mixed character ID separated by hyphen in every group, For example, 7e1cf831-83ff-47fc-896d-dfba641382c7.
7. Click Save.
8. Click Dynamic Site.
You can now test and access the site https://YOURURL/evolve/ by following the above steps (as long as you are granted access within Azure AD). When you access the evolve site, the Azure Auth provider will redirect you to Evolve after authentication.

Authentication and Active Directory

Configure Active Directory Authentication and SSO

Active Directory is a commonly used Microsoft standard approach to securing logon to Windows and Web systems. The following section will describe both the pre-requisites and the Evolve configuration required to enable Active Directory (AD) as your authentication provider. It is largely assumed that you are knowledgeable about the configuration of Active Directory.

The instructions below explain how to configure your Evolve Server so that you can use AD as an authentication method to access your sites.

Changes to these settings will require the re-publication of the site.

Pre-requisites for AD authentication:

Before proceeding with the connection, there are some preparatory steps you need to complete, in Modeler, Evolve and in the client’s Active Directory configuration in order for the synchronisation to work.

First let's setup the CW Roles:

1. Launch Model Explorer and create two (2) distinct objects within the CW Role object.

2. You can create as many roles as you want, but make sure that two of them can be used as generic roles for all
incoming users. For example, you can create a role named “Read-Only Users” (which will ultimately contain all Social Users) and another called “Administrators” (or “Contributors”) (which will ultimately contain all Normal Users).

3. Connecting Roles to CW Views.

At this point, you should connect those default roles to the appropriate views to define which pages each user group will be able to access once logged in. To do this please refer to the appropriate section of the Evolve user guide (here).

If you choose not to connect any views to the roles, then both roles will be able to view the exact same pages.

**Next configure the Client Active Directory:**

1. Creating new AD Groups:
   You need to arrange with your customer’s system administrator to create two (2) distinct groups within their Active Directory. They can choose to name them anything they want, but should keep those names distinct and recognizable so they can then be connected to Evolve.

2. Adding users to the AD Groups:
   The client system administrator should then, in conjunction with your main contact within the client, ensure that the appropriate number of users is added in each group.

**Configure the Active Directory Connection:**

1. Change Authentication Mode:
   Launch Evolve Designer (in Administrator mode) and choose “Server Configuration”. Navigate to the "Authentication" tab. In the Authentication Mode drop-down list, switch the default value (CwAuthentication) to ActiveDirectoryAuthentication.
Configuring the AD Connection Path:

1. If you have not done so already, import the domain SSL certificate into Windows
2. Export the certificate to a new *.PFX file
3. Use the following password to secure the certificate:
   LQMmsuLPvAZ9ePd
   Note that it is not currently possible to choose an alternative password. However the certificate is stored securely on your server, and is not made available externally, so this should not pose a concern.
4. Save the filename: CasewiseAuth.pfx
   in the folder: c:\Casewise\Evolve\Site\bin

To configure SAML2 on your Evolve server:

1. Run Evolve Designer.
2. On the Evolve Designer Models launcher dialog, click the Server Configuration button.

   The Server Configuration dialog opens.
3. Configure the settings according to the table below:

**Authentication**

<table>
<thead>
<tr>
<th>Authentication Mode</th>
<th>Choose how you want Users to be logged on to Evolve: Use SAML2 to make Evolve expect a SAML2 authentication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Automatic Logon</td>
<td>Leave un-checked</td>
</tr>
<tr>
<td>Domain Short Name</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Use SSL Connection (Active Directory)</td>
<td>Leave un-checked.</td>
</tr>
<tr>
<td>AD Connection Path</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Port</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Group Membership Selection Mode</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Connection Username</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Connect to Active Directory Forest</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Domain Exclusion List</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>SAML2 Entity ID</td>
<td>This is often found in the metadata.xml file, and consists of the URL that Evolve needs to check authentication.</td>
</tr>
<tr>
<td>SAML2 Meta Url</td>
<td>This could be a public URL, a private URL or a local file path. The meta data consists of an XML file that contains the settings for the SAML2 configuration. e.g. configured for a local file: ~/IDP-QA-Metadata.xml where the metadata file should be stored in the Site folder</td>
</tr>
<tr>
<td>Authentication Mode</td>
<td>Choose how you want Users to be logged on to Evolve: Use Saml2 to make Evolve expect a SAML2 authentication</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>

| Evolve's Url | Enter the URL to the Evolve home page - e.g. https://domain.company.com/evolve/ |

4. Click **Save** to save your configuration.

*If you make any further changes to the server configuration in this dialog, you must **Save again**.*

At this point it will no longer be possible to logon to Evolve, as the final steps are to configure the permissions based on Claims configured on the Authentication Server, and their mapping to groups on the Evolve server.

**To configure Groups and Roles on your Evolve server:**

Groups and Roles for SAML2 are configured in exactly the same way as they are for Active Directory. Take a look [at this](#) to see how they work. You will find this detail in the "AD Mapping" details of the "Site Level Settings" - "Deployment Node Settings".

*Further instructions for specific Identity Providers:*

See here for help on [Integrating with Okta Identity Provider](#).
Authentication and Active Directory

Configure Active Directory Authentication and SSO

Active Directory is a commonly used Microsoft standard approach to securing logon to Windows and Web systems. The following section will describe both the pre-requisites and the Evolve configuration required to enable Active Directory (AD) as your authentication provider. It is largely assumed that you are knowledgeable about the configuration of Active Directory.

The instructions below explain how to configure your Evolve Server so that you can use AD as an authentication method to access your sites.

Changes to these settings will require the re-publication of the site.

Pre-requisites for AD authentication:

Before proceeding with the connection, there are some preparatory steps you need to complete, in Modeler, Evolve and in the client’s Active Directory configuration in order for the synchronisation to work.

First let’s setup the CW Roles:

1. Launch Model Explorer and create two (2) distinct objects within the CW Role object.

2. You can create as many roles as you want, but make sure that two of them can be used as generic roles for all
incoming users. For example, you can create a role named “Read-Only Users” (which will ultimately contain all Social Users) and another called “Administrators” (or “Contributors”) (which will ultimately contain all Normal Users).

3. Connecting Roles to CW Views.
At this point, you should connect those default roles to the appropriate views to define which pages each user group will be able to access once logged in. To do this please refer to the appropriate section of the Evolve user guide (here).

If you choose not to connect any views to the roles, then both roles will be able to view the exact same pages.

**Next configure the Client Active Directory:**

1. Creating new AD Groups:
   You need to arrange with your customer’s system administrator to create two (2) distinct groups within their Active Directory. They can choose to name them anything they want, but should keep those names distinct and recognizable so they can then be connected to Evolve.

2. Adding users to the AD Groups:
   The client system administrator should then, in conjunction with your main contact within the client, ensure that the appropriate number of users is added in each group.

**Configure the Active Directory Connection:**

1. Change Authentication Mode:
   Launch Evolve Designer (in Administrator mode) and choose “Server Configuration”. Navigate to the "Authentication" tab. In the Authentication Mode drop-down list, switch the default value (CwAuthentication) to ActiveDirectoryAuthentication.
Configuring the AD Connection Path:

1. If you have not done so already, import the domain SSL certificate into Windows
2. Export the certificate to a new *.PFX file
3. Use the following password to secure the certificate:
   LQMmsuLPVAZ9ePd
   Note that it is not currently possible to choose an alternative password. However the certificate is stored securely on your server, and is not made available externally, so this should not pose a concern.
4. Save the filename: CasewiseAuth.pfx in the folder: c:\Casewise\Evolve\Site\bin

To configure SAML2 on your Evolve server:

1. Run Evolve Designer.
2. On the Evolve Designer Models launcher dialog, click the Server Configuration button.
The Server Configuration dialog opens.

3. Configure the settings according to the table below:

### Authentication

<table>
<thead>
<tr>
<th>Authentication Mode</th>
<th>Choose how you want Users to be logged on to Evolve: Use SAML2 to make Evolve expect a SAML2 authentication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Automatic Logon</td>
<td>Leave un-checked</td>
</tr>
<tr>
<td>Domain Short Name</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Use SSL Connection (Active Directory)</td>
<td>Leave un-checked.</td>
</tr>
<tr>
<td>AD Connection Path</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Port</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Group Membership Selection Mode</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Connection Username</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Connect to Active Directory Forest</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Domain Exclusion List</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>SAML2 Entity ID</td>
<td>This is often found in the metadata.xml file, and consists of the URL that Evolve needs to check authentication.</td>
</tr>
<tr>
<td>SAML2 Meta Url</td>
<td>This could be a public URL, a private URL or a local file path. The meta data consists of an XML file that contains the settings for the SAML2 configuration. e.g. configured for a local file: ~/IDP-QA-Metadata.xml where the metadata file should be stored in the Site folder</td>
</tr>
</tbody>
</table>
Authentication Mode
Choose how you want Users to be logged on to Evolve:
Use Saml2 to make Evolve expect a SAML2 authentication

Evolve's Url
Enter the URL to the Evolve home page - e.g.
https://domain.company.com/evolve/

4. Click Save to save your configuration.

If you make any further changes to the server configuration in this dialog, you must Save again.

At this point it will no longer be possible to logon to Evolve, as the final steps are to configure the permissions based on Claims configured on the Authentication Server, and their mapping to groups on the Evolve server.

To configure Groups and Roles on your Evolve server:
Groups and Roles for SAML2 are configured in exactly the same way as they are for Active Directory. Take a look at this to see how they work. You will find this detail in the "AD Mapping" details of the "Site Level Settings" - "Deployment Node Settings".

Further instructions for specific Identity Providers:
See here for help on Integrating with Okta Identity Provider.
Authentication and Active Directory

Configure Active Directory Authentication and SSO

Active Directory is a commonly used Microsoft standard approach to securing logon to Windows and Web systems. The following section will describe both the pre-requisites and the Evolve configuration required to enable Active Directory (AD) as your authentication provider. It is largely assumed that you are knowledgeable about the configuration of Active Directory.

The instructions below explain how to configure your Evolve Server so that you can use AD as an authentication method to access your sites.

*Changes to these settings will require the re-publication of the site.*

Pre-requisites for AD authentication:

Before proceeding with the connection, there are some preparatory steps you need to complete, in Modeler, Evolve and in the client’s Active Directory configuration in order for the synchronisation to work.

First let’s setup the CW Roles:

1. Launch Model Explorer and create two (2) distinct objects within the CW Role object.

2. You can create as many roles as you want, but make sure that two of them can be used as generic roles for all incoming users. For example, you can create a role named “Read-Only Users” (which will ultimately contain all Social Users) and another called “Administrators” (or “Contributors”) (which will ultimately contain all
Normal Users).

3. Connecting Roles to CW Views.
   At this point, you should connect those default roles to the appropriate views to define which pages each user group will be able to access once logged in. To do this please refer to the appropriate section of the Evolve user guide (here).
   If you choose not to connect any views to the roles, then both roles will be able to view the exact same pages.

**Next configure the Client Active Directory:**

1. Creating new AD Groups:
   You need to arrange with your customer’s system administrator to create two (2) distinct groups within their Active Directory. They can choose to name them anything they want, but should keep those names distinct and recognizable so they can then be connected to Evolve.

2. Adding users to the AD Groups:
   The client system administrator should then, in conjunction with your main contact within the client, ensure that the appropriate number of users is added in each group.

**Configure the Active Directory Connection:**

1. Change Authentication Mode:
   Launch Evolve Designer (in Administrator mode) and choose "Server Configuration". Navigate to the "Authentication" tab. In the Authentication Mode drop-down list, switch the default value (CwAuthentication) to ActiveDirectoryAuthentication.
Configuring the AD Connection Path:

1. If you have not done so already, import the domain SSL certificate into Windows
2. Export the certificate to a new *.PFX file
3. Use the following password to secure the certificate:
   LQMrnsuLpVAZ9ePd
   Note that it is not currently possible to choose an alternative password. However the certificate is stored securely on your server, and is not made available externally, so this should not pose a concern.
4. Save the filename: CasewiseAuth.pfx
   in the folder: c:\Casewise\Evolve\Site\bin

To configure SAML2 on your Evolve server:

1. Run Evolve Designer.
2. On the Evolve Designer Models launcher dialog, click the Server Configuration button.
3. Configure the settings according to the table below:

### Authentication

<table>
<thead>
<tr>
<th>Authentication Mode</th>
<th>Choose how you want Users to be logged on to Evolve: Use Saml2 to make Evolve expect a SAML2 authentication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Automatic Logon</td>
<td>Leave un-checked</td>
</tr>
<tr>
<td>Domain Short Name</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Use SSL Connection (Active Directory)</td>
<td>Leave un-checked.</td>
</tr>
<tr>
<td>AD Connection Path</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Port</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Group Membership Selection Mode</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>AD Connection Username</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Connect to Active Directory Forest</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>Domain Exclusion List</td>
<td>Leave this setting blank.</td>
</tr>
<tr>
<td>SAML2 Entity ID</td>
<td>This is often found in the metadata.xml file, and consists of the URL that Evolve needs to check authentication.</td>
</tr>
<tr>
<td>SAML2 Meta Url</td>
<td>This could be a public URL, a private URL or a local file path. The meta data consists of an XML file that contains the settings for the SAML2 configuration. e.g. configured for a local file: ~/IDP-QA-Metadata.xml where the metadata file should be stored in the Site folder</td>
</tr>
</tbody>
</table>
### Authentication Mode

Choose how you want Users to be logged on to Evolve:

Use Saml2 to make Evolve expect a SAML2 authentication

<table>
<thead>
<tr>
<th>Evolve's Url</th>
<th>Enter the URL to the Evolve home page - e.g. <a href="https://domain.company.com/evolve/">https://domain.company.com/evolve/</a></th>
</tr>
</thead>
</table>

4. Click **Save** to save your configuration.

*If you make any further changes to the server configuration in this dialog, you must Save again.*

At this point it will no longer be possible to logon to Evolve, as the final steps are to configure the permissions based on Claims configured on the Authentication Server, and their mapping to groups on the Evolve server.

**To configure Groups and Roles on your Evolve server:**

Groups and Roles for SAML2 are configured in exactly the same way as they are for Active Directory. Take a look at this to see how they work. You will find this detail in the "AD Mapping" details of the "Site Level Settings" - "Deployment Node Settings".

**Further instructions for specific Identity Providers:**

See here for help on Integrating with Okta Identity Provider.
Sites Explained

There are two types of Evolve Site - **Static Sites** and **Dynamic Sites**. Which type of Site you can deploy depends on the type of license you have for Evolve and what you want your users to be able to do on the Site.

A **Static Site** is a read-only deployment which displays data from your repository taken at a fixed point in time and is therefore is a great way to communicate your approved model data to a wide audience.

**See more about Static Sites**

Static Sites have the following features:

- **Read-only data** - users cannot edit any data they see.
- **Fixed data taken at the time of publication** - no live connection to the repository.
- **Open access** - no user login required.
- **Portability** - can be accessed via URL on a web server, or directly as files.

A **Dynamic Site** shows live data from the repository and requires users to log in to access it. It can be configured to allow users to edit data, and you can control data visibility and permissions with Role-based access.

**See more about Dynamic Sites**

Dynamic Sites can enjoy all the features offered by Evolve - such as Workflow, Comments Questionnaires, and Favorites.

In summary, Dynamic Sites offer the following features:

- **Live data** - the Site connects directly to your CW repository showing current data from your model.
- **Restricted access** - Users are required to log in to access the Site, with Active Directory and Windows Authentication supported.
- **Access Rights** - Roles and Access Rights can be used to restrict a User’s view of the data and also whether they can edit data using the Site.
- **Workflow** - The Workflow component can be used to implement an Approval procedure for editing data, as well as a Review procedure for validating data.
- **Social features** - Dynamic Sites have the Evolve social features built-in as standard, enabling your users to collaborate using Comments, provide feedback with Questionnaires, and create their own quick links to important pages using Favorites.

For a table comparing the features of Static and Dynamic Sites, see the **Site Comparison Chart**.

---

Creating a Site makes changes to your Model’s meta model, resulting in new Object Types and Associations being added to the Model.

If you are using Evolve for the first time and want to experiment with creating a Site, we recommend that you create a copy of an existing Model and use that as the basis of your Site.

**Deployment**

Evolve Sites should be deployed to a web server machine running Microsoft Internet Information Services (IIS).
What do you want to do?

Create a Site
# Site Comparison Chart

The following table shows the differences between Static and Dynamic Sites.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Static</th>
<th>Dynamic</th>
</tr>
</thead>
<tbody>
<tr>
<td>View data</td>
<td>Users can view data from your repository in Evolve.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Home page diagram</td>
<td>Display a diagram on the home page.</td>
<td>✔️</td>
<td>✗</td>
</tr>
<tr>
<td>Show live data</td>
<td>Evolve displays data directly from your live repository.</td>
<td>✗</td>
<td>✔️</td>
</tr>
<tr>
<td>Edit data</td>
<td>Users can edit data where permissions allow.</td>
<td>✗</td>
<td>✔️</td>
</tr>
<tr>
<td>User login</td>
<td>Users must log in to access the Site.</td>
<td>✗</td>
<td>✔️</td>
</tr>
<tr>
<td>Access controls</td>
<td>You can use Role-based access to specify which data users can see and what they can edit.</td>
<td>✗</td>
<td>✔️</td>
</tr>
<tr>
<td>Workflow</td>
<td>The Workflow component can be used to implement Approval and Review workflows.</td>
<td>✗</td>
<td>✔️</td>
</tr>
<tr>
<td>Comments</td>
<td>Users can collaborate using the in-page comment facility.</td>
<td>✗</td>
<td>✔️</td>
</tr>
<tr>
<td>Questionnaires</td>
<td>You can create and publish questionnaires to gather feedback from your users.</td>
<td>✗</td>
<td>✔️</td>
</tr>
<tr>
<td>Favorites</td>
<td>Users can mark pages as Favorites, and then access those pages directly from the Site home page.</td>
<td>✗</td>
<td>✔️</td>
</tr>
</tbody>
</table>
Change the URL Name of your Site

This page explains how to change the Site URL Name for a model Site in Evolve.

The Site URL Name is the part of the URL which is specific to a particular site.

For Dynamic Sites this is:

   http://<server-name>/<evolve-IIS-site-name>/sites/<site-url-name>/

For Static Sites, this is:

   http://<server-name>/<evolve-IIS-site-name>/statics/<site-url-name>/

Change the Site URL Name for a Dynamic Site

To change the Site URL Name for a Dynamic Site:

1. In Evolve Designer, navigate to the Deployments > [server-name] > Model node
2. Change the Site URL Name to the new name you want to use, ensuring the text is lower case, and has no spaces or special characters
3. Publish the Site

   The Site is Published, is displayed on the Evolve Multi-Sites page, and can be accessed directly at the new URL.

Change the Site URL Name for a Static Site

To change the Site URL Name for a Static Site:

1. In Evolve Designer, navigate to the Deployments > [server-name] > Model node
2. Change the Site URL Name to the new name you want to use, ensuring the text is lower case, and has no spaces or special characters
3. Publish the Site

   The Site is Published and can be accessed directly at the new URL.

   When you publish the Site with a changed Site URL Name, the original Site still exists and can still be accessed via the original URL.

   To completely remove the original Site, you must:

   1. On the Evolve server machine, browse to <your-evolve-install-path>\Data\Statics
   2. Delete the folder named as your original Site URL Name.
Evolve REST API (2018.1.0.79 and above)

The Evolve REST API was added to provide backwards compatibility support for the discontinued Web Portal SOAP API.

Where it differs slightly is in the method of calling the API. This has been modified to use the more standard RESTful http approach, using POST, GET, PUT and DELETE protocols.

All of the calls return a json response, but can optionally return XML. The XML returned is equivalent to the older Portal API, and so should ensure it is relatively simple to integrate, in-place of the older service.

To configure the API, it is first necessary to enable it from within Evolve:

1. Having configured and ensured the Evolve server is functioning.
   Start Evolve Designer with Administrator Permissions.

2. Goto your Evolve server settings

3. Check the box 'Enable Web REST API'

4. Save the configuration

5. Press "Configure IIS"

The default endpoint for the API will be:

http://<your-server>/WebRESTAPI/api/<path to endpoint>

To use the REST API, please see the documentation, located here
When using the API, always remember to use the /auth endpoint to authenticate first, and remember to include the returned token in all subsequent calls to the API. This token should be encoded in the header of the http request.

Advanced Configuration

Configure TLS 1.2 (Transport Layer Security)

In line with industry security recommendations the erwin CW products now support Transport Layer Security version 1.2. This security layer is a low level network encryption protocol which can optionally be used between applications and MS SQL Server. Many large organizations have been disabling TLS1.0 and TLS1.1 in favor of the newer TLS1.2, as it has certain improvements that make it less susceptible to security vulnerabilities.

In order to configure erwin EA/BP for TLS1.2 there are some steps required that go beyond a simple install. This document will guide you through these steps.

1. Run the following Microsoft Installer "sqlncli.msi" which can be obtained from here

   sqlncli.msi

   for either x64 (64bit) or x86 (32bit) - as is appropriate to your environment.

2. Set the following Entries in the registry. These can be copied into a file that is given the extension .reg and then run in windows, or downloaded with your erwin software.
   Most of the entries are to disable TLS 1.0 and TLS1.1, then enable TLS1.2. The final entry is to configure erwin EA/BP to use the correct SQL Server client.

   Windows Registry Editor Version 5.00
   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols]
   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 2.0]
   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 2.0\Client]
   "DisabledByDefault"=dword:00000001
   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\TLS 1.0]
After changing the registry settings, it may be necessary to reboot your machine.

3. Once this has completed, start "erwin EA/BP Modeler" and when the logon dialog appears click the “Edit” button. This will display all the available connections.
4. Click on the connection you want to use and "Edit" it.
5. Next to the server name there will be a check box to enable the use of TLS1.2. Check this box and press "OK" to close the dialogs.
6. Having made these changes the erwin EA/BP applications should run as normal.

Troubleshooting:
On some operating systems this additional msi file may also be required to get the application to run successfully

Run the following Microsoft Installer "msoledbsql_18.1.0.0_x64.msi" which can be obtained from here

Advanced Configuration

Configure TLS 1.2 (Transport Layer Security)

In line with industry security recommendations the erwin CW products now support Transport Layer Security version 1.2. This security layer is a low level network encryption protocol which can optionally be used between applications and MS SQL Server. Many large organizations have been disabling TLS1.0 and TLS1.1 in favor of the newer TLS1.2, as it has certain improvements that make it less susceptible to security vulnerabilities.
In order to configure erwin EA/BP for TLS1.2 there are some steps required that go beyond a simple install. This document will guide you through these steps.

1. Run the following Microsoft Installer “sqlncli.msi” which can be obtained from here

   sqlncli.msi

   for either x64 (64bit) or x86 (32bit) - as is appropriate to your environment.

2. Set the following Entries in the registry. These can be copied into a file that is given the extension .reg and then run in windows, or downloaded with your erwin software.
   Most of the entries are to disable TLS 1.0 and TLS 1.1, then enable TLS1.2. The final entry is to configure erwin EA/BP to use the correct SQL Server client.

   Windows Registry Editor Version 5.00

   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols]

   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 2.0]
   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 2.0\Client]
   "DisabledByDefault"=dword:00000001

   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\TLS 1.0]
   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\TLS 1.0\Server]
   "Enabled"=dword:00000000

   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\TLS 1.1]
   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\TLS 1.1\Client]
   "DisabledByDefault"=dword:00000000

   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\TLS 1.1\Server]
   "DisabledByDefault"=dword:00000000

   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\TLS 1.2]
   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\TLS 1.2\Client]
   [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\TLS 1.2\Server]
After changing the registry settings, it may be necessary to reboot your machine.

3. Once this has completed, start "erwin EA/BP Modeler" and when the logon dialog appears click the “Edit” button.
   This will display all the available connections.
4. Click on the connection you want to use and “Edit” it.
5. Next to the server name there will be a check box to enable the use of TLS1.2.
   Check this box and press "OK" to close the dialogs.
6. Having made these changes the erwin EA/BP applications should run as normal.

Troubleshooting:
On some operating systems this additional msi file may also be required to get the application to run successfully

Run the following Microsoft Installer “msoledbsql_18.1.0.0_x64.msi” which can be obtained from here

Evolve REST API (2018.1.0.79 and above)

The Evolve REST API was added to provide backwards compatibility support for the discontinued Web Portal SOAP API.

Where it differs slightly is in the method of calling the API. This has been modified to use the more standard RESTful http approach, using POST, GET, PUT and DELETE protocols.
All of the calls return a json response, but can optionally return XML. The XML returned is equivalent to the older Portal API, and so should ensure it is relatively simple to integrate, in-place of the older service.

To configure the API, it is first necessary to enable it from within Evolve:

1. Having configured and ensured the Evolve server is functioning. Start Evolve Designer with Administrator Permissions.
2. Goto your Evolve server settings
3. Check the box 'Enable Web REST API"
4. Save the configuration
5. Press "Configure IIS"

The default endpoint for the API will be:
http://<your-server>/WebRESTAPI/api/<path to endpoint>

To use the REST API, please see the documentation, [located here](#)

When using the API, always remember to use the /auth endpoint to authenticate first, and remember to include the returned token in all subsequent calls to the API. This token should be encoded in the header of the http request.
Site Administration

Site Administration Pages

Evolve Dynamic offers a number of built-in pages for administering your site via the web front-end.

You can create new menu items which directly link to these pages, and using Roles you can restrict access to them to prevent them being seen by normal users.

Administration pages are only available on Evolve Dynamic.

The table below details each type of page and how to create the menu link to it:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>cw_appstore</td>
<td>This is the default page picker page.</td>
<td>Add Index Page Link &gt; Standard Pages &gt;</td>
</tr>
<tr>
<td>index_cw_user_usage</td>
<td>Shows users of your Site arranged by type.</td>
<td>Add Index Page Link &gt; Standard Pages &gt;</td>
</tr>
<tr>
<td>index_gov_roles</td>
<td>Used for managing Roles.</td>
<td>Add Index Page Link &gt; Standard Pages &gt;</td>
</tr>
<tr>
<td>index_gov_users</td>
<td>Shows all the users of your Site.</td>
<td>Add Index Page Link &gt; Standard Pages &gt;</td>
</tr>
<tr>
<td>index_governance</td>
<td>Used for managing which roles can see which</td>
<td>Add Index Page Link &gt; Standard Pages &gt;</td>
</tr>
<tr>
<td>index_questionnaires</td>
<td>Lists existing questionnaires and allows you to edit</td>
<td>Add Index Page Link &gt; Standard Pages &gt;</td>
</tr>
<tr>
<td>cw_questionnaire</td>
<td>This page is the only way you can create a new</td>
<td>Add Create Page Link &gt; Standard Pages &gt;</td>
</tr>
</tbody>
</table>

See here for help on Creating and Editing a Menu.
Working with Roles

The instructions on this page explain all the activities relating to creating, editing and managing Roles.

For instructions on assigning Roles to Pages or objects for the Review and Approval workflows, see: Set Approval Roles and Users.

Create a Role

To create a Role:
1. In your Evolve Site, browse to the Roles administration page
2. In the page menu, click Grid
3. Click the Add CW Role button
4. In the pop-up dialog, enter the Name of the Role
5. Click Create

The Role is created.

Add Users to a Role

To add Users to a Role:
1. In your Evolve Site, browse to the Roles administration page
2. Click the Role you want to add Users to
   The Role page is displayed
3. Click the Edit button
4. In the page sub-menu, click Users
5. Click the Associate button at the top-right of the Users (are in this role) box
6. Click inside the text box, or start typing the name of the User you want to add
7. Select the User from the list
   The User appears in the box
8. Click the Save button.
9. In the pop-out Changes window, click the Submit changes button.
   The User is added to the Role.

Specify which Site pages a members of a Role can view

You can link Roles to any Index Page, Object Page, Object Page View or built-in Administration Page in your Site.

Once you link a Role to a page, members of the Role are only able to view the pages they are linked to.
If a Role is not linked to any pages, they can view all pages in the Site.

To specify which Site pages members of a Role can see:
In your Evolve Site, browse to the Roles administration page

1. Click the Role you want to edit
   The Role page is displayed

2. Click the Edit button

3. Click the Edit button

4. In the page sub-menu, click See Views

5. The page lists all the pages in the Site members of the Role can view

6. Click the Associate button at the top-right of the CW View (owner) box

7. Click inside the text box, or start typing the name of the page you want Role members to be able to view

8. Select the page from the list
   The page appears in the box

9. Click the Save button

10. In the pop-out Changes window, click the Submit changes button.
   The page is added to the list of pages Role members can view.

   You can also edit the links between pages and Roles using the grid on the built-in Governance Administration Page

   To use this method, select a page, click the Edit button and then link the page to Roles using the CW Role (is owned by) association.

IMPORTANT: After assigning pages to a role you must Save & Deploy your Evolve site.

Set which pages appear on Role members' home pages

You can specify which pages appear on the Evolve Site home page - and Home menu - for members of a Role.

To specify the home page links for a Role:

1. In your Evolve Site, browse to the Roles administration page
2. Click the Role you want to edit
   The Role page is displayed
3. Click the Edit button
4. In the page sub-menu, click Has Views on Home
5. The page lists all the pages which will appear on the Role members' home pages
6. Click the Associate button at the top-right of the CW View (has on a menu) box
7. Click inside the text box, or start typing the name of the page you want to appear on the home page
8. Select the page from the list
The page appears in the box

9. Click the **Save** button

10. In the pop-out **Changes** window, click the **Submit changes** button.

   A link to the page will now appear on all home pages for members of that Role, as well as a link in the Home menu.

---

You can also configure home page links for a Role using the grid on the built-in **Governance Administration Page**

To use this method, select a page, click the Edit button and then link the page to Roles using the CW Role (is on the menu of) association.
Customizing Your Site

Customization Explained

This page explains how to do basic customization of your Evolve Site. It does not cover more advanced topics such as how to create themes, or how to create custom layouts and behaviors. If you are interested in bespoke customization, please speak with your Account Manager.

There are several ways you can customize Evolve.

You can:

- Change the logos of the top-level Evolve Site, or on your individual model Sites
- Use custom images for your Sites on the multi-sites page
- Use custom menu icons for pages in your Site.

In addition, some layouts or behaviors used in Evolve may also require some tasks that fall under the banner of customization in order to work - for example using the External Picture layout requires uploading images to a Custom Site folder.

Custom Sites

Most Evolve customizations, and some built-in layouts or behaviors, require that you publish your Site as a Custom Site. What this means is that you create a Custom Site folder on your Evolve web server, where you can store any CSS, images or other files you may need, and then ensure you reference this folder on your Deployment node settings before publishing your Site.

Depending on the particular customization, or the specific layout or behavior you plan to use, there may be special requirements for additional folders in this Custom Site folder structure. The help explaining those elements will detail any such requirements.

To create and use a basic Custom Site folder:

1. On your Evolve server, browse to `<your-evolve-install-path>/Site/bin/webDesigner/custom/`.
2. Create a new folder.
   *The folder name must not have any special characters or spaces.*
3. In your new folder, create a sub-folder and name it `images`.
4. When you Publish your Site, ensure you select the folder in the Deploy Custom Site setting on the Deployment node.
If Evolve Designer was already running when you created the new folders, close it and re-open it again for it to be able to see the new folder exists.
Basic Customization

Customizing Styles using LESS variables

LESS variables are used to change the properties of various elements within Evolve easily and simultaneously. By changing the value of a single LESS variable, you can alter the appearance of multiple HTML elements within the Evolve webpage. This enables simple customization through only a small subset of variables.

The following sections detail what to be aware of when using LESS variables, particularly when upgrading between product versions. The Appendix also covers an overview of the key variables and what they impact.

Upgrading Custom Themes with LESS variables

Since Evolve 2016.2.1 the Themes (LESS variables) are automatically upgraded when performing an 'Update Meta Model & Themes' within Evolve Designer. However, if you find that the variables have not updated correctly, the following instructions will help you to diagnose the issues.

Should a theme still be incompatible with the installed version of Evolve, the following error can appear in Evolve Designer when you Deploy Dynamic/Static site:

```
Create Css file C:\Casewise\Evolve\Data\Common\css/casewise/grey.theme.evolve.css from theme.
Create Css file C:\Casewise\Evolve\Data\Common\css/casewise/grey.theme.evolve.min.css from theme.
Input string was not in a correct format.
Operation Ends - Run for 00:00:24, 5888619 seconds.
```

To upgrade the theme to be compatible with the installed version, follow these steps:

1. Ensure you know which default theme your custom theme was based on
   e.g. Evolve7, Grey, Blue
2. Locate a copy of this theme in the new version of Evolve
   nb: This can be found in `<Evolve-Install-Location>Casewise\Evolve\Site\bin\webDesigner\themes`
3. Using a comparison tool (e.g. WinMerge) compare your custom theme with the theme located in step 2
   - This will highlight the new variables which have been added since your custom theme was created.
   - Each new variable will contain a comment (e.g. //v4.0.2) showing in which version it was added.

```
@cwLoginTextBoxFocusBorderColor: @cwColor2; // v4.0
@cwSiteSelectionTextBackground: @cwColor2; // v4.0
@cwSiteSelectionTextColor: whitesmoke; // v4.0.3
@cwLoginSubmitButtonTextColor: whitesmoke; // v4.0.3
```

4. Copy over the new variables so that the custom theme contains the same number of variables as the default theme.
5. Restart Evolve Designer and Deploy Dynamic/Static Site
**Theme File Labelling Convention**

Evolve’s LESS variables are named using camelCase whereby the first letter of each word is capitalized - except for the first letter of the whole string. Evolve version numbers are commented out next to any variables that relate to specific Evolve versions. I.e: //v4.0

**Appendix - LESS: Global Variables**

Click the groups below to see the LESS variables that are available and the elements that they will affect. Note that for the sake of brevity, not all available variables are listed below - only the main variables that alter colors and fonts have been included.

### Primary Colors

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwColor1Shade</td>
<td>The primary color used for borders and shading.</td>
<td>-</td>
</tr>
<tr>
<td>@cwColor1</td>
<td>The primary color used for various backgrounds</td>
<td>-</td>
</tr>
<tr>
<td>@cwColor2Shade</td>
<td>The secondary color used for borders and shading.</td>
<td>-</td>
</tr>
<tr>
<td>@cwColor2</td>
<td>The secondary color used for various backgrounds</td>
<td>-</td>
</tr>
<tr>
<td>@cwColor2Tint</td>
<td>The secondary color used as a highlight</td>
<td>-</td>
</tr>
<tr>
<td>@cwShadowColor</td>
<td>The color used to add a shadow to elements</td>
<td>-</td>
</tr>
</tbody>
</table>

### Global Variables

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwFont</td>
<td>The font family used by a majority of text elements in Evolve</td>
<td>p, span, li, a</td>
</tr>
<tr>
<td>@cwFontTitle</td>
<td>The font family used by various titles in Evolve</td>
<td>h1, h2, h3, h4, h5, h6</td>
</tr>
<tr>
<td>@cwFontTextColor</td>
<td>The color used by a majority of text elements in Evolve</td>
<td></td>
</tr>
<tr>
<td>@cwGlobalLinkTextColor</td>
<td>The color of text links in Evolve</td>
<td></td>
</tr>
<tr>
<td>@cwPageTitleColor</td>
<td>The color of various titles in Evolve</td>
<td></td>
</tr>
<tr>
<td>@cwPageTitleBackGroundColor</td>
<td>The background color of the page title at the top of the screen.</td>
<td></td>
</tr>
<tr>
<td>LESS Variable</td>
<td>Evolve Page Element(s)</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>@cwBodyBackgroundColor</td>
<td>The background color of the main content area</td>
<td></td>
</tr>
<tr>
<td>@cwLoginBackgroundColor</td>
<td>The background color of the login dialogue that appears on the login page</td>
<td></td>
</tr>
<tr>
<td>@cwLoginTextColor</td>
<td>The color of the text on the login dialogue that appears on the login page</td>
<td></td>
</tr>
<tr>
<td>@cwLoginSubmitButtonTextColor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>@cwLoginSubmitButtonBackgroundColor</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Diagrams

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwDiagramBreadCrumbBackgroundColor</td>
<td>The color of the area surrounding the breadcrumbs</td>
<td></td>
</tr>
<tr>
<td>@cwDiagramBreadCrumbBoxBackgroundColor</td>
<td>The background color of the breadcrumbs themselves</td>
<td></td>
</tr>
<tr>
<td>@cwDiagramBreadCrumbBoxTextColor</td>
<td>The color of the text that appears on the breadcrumbs</td>
<td></td>
</tr>
<tr>
<td>@cwDiagramEditorIconColor</td>
<td>The color of the editor icons within eModeler</td>
<td></td>
</tr>
<tr>
<td>@cwDiagramEditorMenuBackgroundColor</td>
<td>The background color of the eModeler menu</td>
<td></td>
</tr>
<tr>
<td>@cwDiagramEditorMenuMainHeaderBackgroundColor</td>
<td>The background color of the eModeler menu's main header</td>
<td></td>
</tr>
<tr>
<td>@cwDiagramEditorMenuSubHeaderBackgroundColor</td>
<td>The background color of the eModeler menu's subheaders</td>
<td></td>
</tr>
<tr>
<td>@cwDiagramTileNameBackgroundColor</td>
<td>The background color of a tile in eModeler</td>
<td></td>
</tr>
<tr>
<td>@cwDiagramTileNameBackgroundColorHover</td>
<td>The</td>
<td></td>
</tr>
<tr>
<td>LESS Variable</td>
<td>Evolve Page Element(s)</td>
<td>Example</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>background color of a tile in eModeler when you hover over it</td>
<td></td>
</tr>
<tr>
<td>@cwDiagramTileNameTextColor</td>
<td>The background color of a tile in eModeler</td>
<td></td>
</tr>
</tbody>
</table>
### Left-Hand-Side Menu

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwMenuLeftTabBackgroundColor</td>
<td>This is the background color of the pop-out tab</td>
<td>![Example Image 1]</td>
</tr>
<tr>
<td>@cwMenuLeftTabTitleColor</td>
<td>This is the color of the title that appears on the top of the pop-out tab</td>
<td>![Example Image 2]</td>
</tr>
<tr>
<td>@cwMenuLeftTabSelectedViewBackgroundColor</td>
<td>This is the background color of items that are selected in the pop-out tab</td>
<td>![Example Image 3]</td>
</tr>
<tr>
<td>@cwMenuLeftMainNavigationBackgroundColor</td>
<td>This is the background color of the main navigation menu</td>
<td>![Example Image 4]</td>
</tr>
<tr>
<td>@cwMenuLeftMainNavigationTextColor</td>
<td>This is the color of the text in the main navigation menu</td>
<td>![Example Image 5]</td>
</tr>
<tr>
<td>@cwMenuLeftMainNavigationBackgroundColorHover</td>
<td>This is the background color of the menu item in the main navigation menu when the cursor is hovered over it</td>
<td>![Example Image 6]</td>
</tr>
<tr>
<td>@cwMenuLeftMainNavigationTextColorHover</td>
<td>This is the color of the text in the main navigation menu when</td>
<td>![Example Image 7]</td>
</tr>
<tr>
<td>LESS Variable</td>
<td>Evolve Page Element(s)</td>
<td>Example</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>@cwMenuLeftMainNavigationTextColorActive</td>
<td>the cursor is hovered over it</td>
<td></td>
</tr>
<tr>
<td>@cwMenuLeftMainNavigationBackgroundColorActive</td>
<td>This is the color of the text in the main navigation menu when the menu item or one of its sub-menus is active</td>
<td></td>
</tr>
<tr>
<td>@cwMenuLeftMainNavigationBackgroundColor</td>
<td>This is the background colour of the menu item in the main navigation menu when the menu item or one of its sub-menus is active</td>
<td></td>
</tr>
<tr>
<td>@cwMenuLeftSubNavigationBackgroundColor</td>
<td>This is the background color of the navigation sub-menu</td>
<td></td>
</tr>
<tr>
<td>@cwMenuLeftSubNavigationTextColor</td>
<td>This is the color of the text in the navigation sub-menu</td>
<td></td>
</tr>
<tr>
<td>@cwMenuLeftSubNavigationBackgroundColorHover</td>
<td>This is the background color of the menu item in the navigation sub-menu when the cursor is hovered over it.</td>
<td></td>
</tr>
</tbody>
</table>

![Diagram](image-url)
### Drop-down Notifications

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwNotificationMessageBackgroundColor</td>
<td>The background colour for notifications</td>
<td><img src="image1.png" alt="Example" /></td>
</tr>
<tr>
<td>@cwNotificationMessageTextColor</td>
<td>The text colour for notifications</td>
<td><img src="image2.png" alt="Example" /></td>
</tr>
<tr>
<td>@cwNotificationErrorBackgroundColor</td>
<td>The background colour for Error notifications</td>
<td><img src="image3.png" alt="Example" /></td>
</tr>
<tr>
<td>@cwNotificationErrorTextColor</td>
<td>The text colour for Error notifications</td>
<td><img src="image4.png" alt="Example" /></td>
</tr>
</tbody>
</table>
### Properties Group

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwPropertiesTableHeaderBackgroundColor</td>
<td>The background color of the header on the Properties table</td>
<td></td>
</tr>
<tr>
<td>@cwPropertiesTableHeaderTextColor</td>
<td>The color of the text on the header on the Properties table</td>
<td></td>
</tr>
<tr>
<td>@cwPropertiesContainerBorderColor</td>
<td>The color of the Properties table's border</td>
<td></td>
</tr>
<tr>
<td>@cwEditPropertiesValueHoverBackgroundColor</td>
<td>The color of a data row in the properties table when the cursor is hovered over it</td>
<td></td>
</tr>
<tr>
<td>@cwEditPropertiesValueHoverTextColor</td>
<td>The color of text in a data row in the properties table when the cursor is hovered over it</td>
<td></td>
</tr>
</tbody>
</table>

### Buttons
<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwButtonSubmitBackgroundColor</td>
<td>The background color of the submit button.</td>
<td></td>
</tr>
<tr>
<td>@cwButtonSubmitTextColor</td>
<td>The color of the text on the submit button.</td>
<td></td>
</tr>
<tr>
<td>@cwButtonSubmitBorderColor</td>
<td>The color of the submit button's border</td>
<td></td>
</tr>
<tr>
<td>@cwButtonTextColor</td>
<td>This isn’t often used as the text on the buttons is hidden.</td>
<td></td>
</tr>
<tr>
<td>@cwButtonBackgroundColor</td>
<td>The colour of the background for icons that appear in the top-right of the Evolve page</td>
<td></td>
</tr>
<tr>
<td>@cwButtonIconColor</td>
<td>The colour of icons that appear in the top-right of the Evolve page</td>
<td></td>
</tr>
<tr>
<td>@cwButtonBorderColor</td>
<td>The colour of the border for icons that appear in the top-right of the Evolve page</td>
<td></td>
</tr>
</tbody>
</table>

**Accordions**

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwAccordionHeaderBackgroundColor</td>
<td>The background colour of accordion menu headers</td>
<td></td>
</tr>
<tr>
<td>@cwAccordionHeaderTextColor</td>
<td>The colour of the text on accordion menu headers</td>
<td></td>
</tr>
<tr>
<td>@cwAccordionHeaderHoverBackgroundColor</td>
<td>The background colour of accordion menu headers when a cursor is over</td>
<td></td>
</tr>
<tr>
<td>LESS Variable</td>
<td>Evolve Page Element(s)</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>@cwAccordionHeaderHoverTextColor</td>
<td>The colour of the text on accordion menu headers when a cursor hovers over it</td>
<td></td>
</tr>
<tr>
<td></td>
<td>hovers over it</td>
<td></td>
</tr>
</tbody>
</table>

**Discussions**

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwDiscussionsBackgroundColor</td>
<td>The background color of the Discussions panel header</td>
<td><img src="image" alt="Discussion Panel Example" /></td>
</tr>
<tr>
<td>@cwDiscussionsTextColor</td>
<td>The text color of the Discussions panel header</td>
<td><img src="image" alt="Discussion Panel Example" /></td>
</tr>
</tbody>
</table>
### World Map

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>@cwJVectorMapCircleBackgroundColor</code></td>
<td>The background color of circles that appear on vector maps</td>
<td></td>
</tr>
<tr>
<td><code>@cwJVectorMapCircleBorderColor</code></td>
<td>The border color of circles that appear on vector maps</td>
<td></td>
</tr>
<tr>
<td><code>@cwJVectorMapPathDefaultBackgroundColor</code></td>
<td>The default background color of a map vector</td>
<td></td>
</tr>
<tr>
<td><code>@cwJVectorMapPathDefaultBorderColor</code></td>
<td>The default border color of a map vector</td>
<td></td>
</tr>
<tr>
<td><code>@cwJVectorMapPathFilledBackgroundColor</code></td>
<td>The default background color of a filled map vector</td>
<td></td>
</tr>
<tr>
<td><code>@cwJVectorMapPathFilledBorderColor</code></td>
<td>The default border color of a filled map vector</td>
<td></td>
</tr>
<tr>
<td><code>@cwJVectorMapLabelTextColor</code></td>
<td>The color of the text on the map labels</td>
<td></td>
</tr>
<tr>
<td><code>@cwJVectorMapLabelBackgroundColor</code></td>
<td>The background color of the map labels</td>
<td></td>
</tr>
<tr>
<td><code>@cwJVectorMapIconLinesColor</code></td>
<td>The color of the + and - signs in the zoom icons</td>
<td></td>
</tr>
<tr>
<td><code>@cwJVectorMapIconBackgroundColor</code></td>
<td>The background color of the zoom icons</td>
<td></td>
</tr>
<tr>
<td>User Zone</td>
<td>LESS Variable</td>
<td>Evolve Page Element(s)</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------</td>
<td>------------------------</td>
</tr>
<tr>
<td></td>
<td>@cwProfileTextColor</td>
<td>The color of the text in the user-area</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pop-ups</th>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>@cwPopupBackgroundColor</td>
<td>The background color of the left-hand-side pop-out menu</td>
<td><img src="image" alt="Example" /></td>
</tr>
<tr>
<td></td>
<td>@cwPopupTitleBackgroundColor</td>
<td>The background color of the title on the left-hand-side pop-out menu</td>
<td><img src="image" alt="Example" /></td>
</tr>
<tr>
<td></td>
<td>@cwPopupTitleTextColor</td>
<td>The color of the title text on the left-hand-side pop-out menu</td>
<td><img src="image" alt="Example" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Badges</th>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>@cwBadgeBackgroundColor</td>
<td>The background color of Badges</td>
<td><img src="image" alt="Example" /></td>
</tr>
<tr>
<td></td>
<td>@cwBadgeTextColor</td>
<td>The color of the text that appears on Badges</td>
<td><img src="image" alt="Example" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tasks &amp; Notifications</th>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>@cwWorkflowTaskListTaskActionsColor</td>
<td>The background color of the action panel associated with pending tasks</td>
<td><img src="image" alt="Example" /></td>
</tr>
<tr>
<td>LESS Variable</td>
<td>Evolve Page Element(s)</td>
<td>Example</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>@cwWorkflowTaskApprovalApproved</td>
<td>The color of the task’s approved tag</td>
<td><img src="image1.png" alt="Example Image" /></td>
<td></td>
</tr>
<tr>
<td>@cwWorkflowTaskApprovalRejected</td>
<td>The color of the task’s rejected tag</td>
<td><img src="image2.png" alt="Example Image" /></td>
<td></td>
</tr>
<tr>
<td>@cwWorkflowDelegatedTaskColor</td>
<td>The color that highlights a task to signify that it has been delegated to you</td>
<td><img src="image3.png" alt="Example Image" /></td>
<td></td>
</tr>
<tr>
<td>@cwWorkflowTaskBackgroundColor</td>
<td>The background color of a task</td>
<td><img src="image4.png" alt="Example Image" /></td>
<td></td>
</tr>
<tr>
<td>@cwWorkflowTaskTextColor</td>
<td>The text color of a task</td>
<td><img src="image5.png" alt="Example Image" /></td>
<td></td>
</tr>
<tr>
<td>@cwWorkflowNotificationBackgroundColor</td>
<td>The background color of workflow notifications</td>
<td><img src="image6.png" alt="Example Image" /></td>
<td></td>
</tr>
<tr>
<td>@cwWorkflowNotificationTextColor</td>
<td>The text color of workflow notifications</td>
<td><img src="image7.png" alt="Example Image" /></td>
<td></td>
</tr>
<tr>
<td>@cwWorkflowDueDateCalendarBackgroundColor</td>
<td>The background colour for due date calendar</td>
<td><img src="image8.png" alt="Example Image" /></td>
<td></td>
</tr>
<tr>
<td>LESS Variable</td>
<td>Evolve Page Element(s)</td>
<td>Example</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>calendars that appear next to tasks</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>@cwWorflowDueDateCalendarOverdueMonthTextColor</td>
<td>The colour of the month that appears on the calendar for tasks that are overdue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>@cwWorflowDueDateCalendarDueBackgroundColor</td>
<td>The background colour on the calendar for tasks that are due</td>
<td></td>
<td></td>
</tr>
<tr>
<td>@cwWorflowDueDateCalendarOverdueBackgroundColor</td>
<td>The background colour on the calendar for tasks that are overdue</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Global Search

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwGlobalSearchFocusColor</td>
<td>The color of the text in the global search input field when the cursor is focused on it</td>
<td></td>
</tr>
<tr>
<td>@cwGlobalSearchTextColor</td>
<td>The color of the text in the global search input field</td>
<td></td>
</tr>
<tr>
<td>@cwGlobalSearchBackgroundColor</td>
<td>The background color of the global search input field</td>
<td></td>
</tr>
</tbody>
</table>
### LESS Variable | Evolve Page Element(s) | Example
--- | --- | ---
@cwGlobalSearchResultsTextColor | The color of the search results text | ![Search Results](image)
@cwGlobalSearchResultsBackgroundColor | The background color of the search results |  
@cwGlobalSearchResultShadowColor | The color of the shadow on the search results box |  

**Top Bar**

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
</table>
| @cwTopBarHeight | The height of the top bar | ![Top Bar](image)
| @cwTopBarBackgroundColor | The background color of the top bar |  
| @cwTopBarProfileLinkColor | The color of the profile links within the top bar |  
| @cwTopBarProfileLinkHoverColor | The color of the profile links within the top bar when you hover over it |  

510
### Home Page

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwHomePageFavoriteIconBackgroundColor</td>
<td>The color of the favorite icons on the home page. Note that a 'lighten' filter is applied to each row of icons so it is recommended to choose a slightly darker color to begin with.</td>
<td><img src="https://via.placeholder.com/150" alt="Example Image" /></td>
</tr>
<tr>
<td>@cwHomePageFavoriteTextColor</td>
<td>The color of the text that appears on the favorite icons.</td>
<td><img src="https://via.placeholder.com/150" alt="Example Image" /></td>
</tr>
<tr>
<td>@cwHomePageRoleIconBackgroundColorHover</td>
<td>The color of the icon that appears on the favorite icons.</td>
<td><img src="https://via.placeholder.com/150" alt="Example Image" /></td>
</tr>
</tbody>
</table>

### Side Menu

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwMenuLeftSubNavigationBackgroundColorHover</td>
<td>The background color a sub-menu menu item when the cursor is hovered over it</td>
<td><img src="https://via.placeholder.com/150" alt="Example Image" /></td>
</tr>
<tr>
<td>LESS Variable</td>
<td>Evolve Page Element(s)</td>
<td>Example</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>@cwMenuLeftTabSelectedViewTextColor</td>
<td>The text color of a selected menu item</td>
<td>![Example Image 1]</td>
</tr>
<tr>
<td>@cwMenuLeftTabSelectedViewTabSelectedTextColor</td>
<td>The text color of a selected tab menu item</td>
<td>![Example Image 2]</td>
</tr>
<tr>
<td>@cwMenuLeftTabSelectedViewTabSelectedBackgroundColor</td>
<td>The background color of a selected tab menu item</td>
<td>![Example Image 3]</td>
</tr>
<tr>
<td>@cwMenuLeftTabSelectedViewTabTextColorHover</td>
<td>The text color of a selected tab menu item when the cursor is hovered over it</td>
<td>![Example Image 4]</td>
</tr>
<tr>
<td>@cwMenuLeftTabSelectedViewTabBackgroundColorHover</td>
<td>The background color of a selected menu item when the cursor is hovered</td>
<td>![Example Image 5]</td>
</tr>
<tr>
<td>LESS Variable</td>
<td>Evolve Page Element(s)</td>
<td>Example</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>@cwMenuLeftBorderColor</td>
<td>The color of the border that separates menu items on the left hand menu</td>
<td><img src="image1" alt="Example" /></td>
</tr>
<tr>
<td>@cwMenuLeftTabBorderColor</td>
<td>The background color of the left-hand menu pop-out tab</td>
<td><img src="image2" alt="Example" /></td>
</tr>
<tr>
<td>@cwMenuLeftToggleZoneBackgroundColor</td>
<td>The background color of the 'hamburger' menu-toggle icon</td>
<td><img src="image3" alt="Example" /></td>
</tr>
<tr>
<td>@cwSocialRatingStarBackgroundAndBorder</td>
<td>The background &amp; border color of the Social Ratings section</td>
<td><img src="image4" alt="Example" /></td>
</tr>
</tbody>
</table>

**Grids**

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwGridButtonsColor</td>
<td>The color of the grid buttons</td>
<td><img src="image5" alt="Example" /></td>
</tr>
<tr>
<td>LESS Variable</td>
<td>Evolve Page Element(s)</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>@cwGridPaginationBackgroundColor</td>
<td>The background color of the pagination section of the grid</td>
<td><img src="example1.png" alt="Example" /></td>
</tr>
<tr>
<td>@cwGridColumnHeaderText</td>
<td>The color of the text in the grid header</td>
<td><img src="example2.png" alt="Example" /></td>
</tr>
<tr>
<td>@cwGridColumnHeaderBackground</td>
<td>The color of the grid header's background</td>
<td><img src="example3.png" alt="Example" /></td>
</tr>
</tbody>
</table>

### Miscellaneous

<table>
<thead>
<tr>
<th>LESS Variable</th>
<th>Evolve Page Element(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwSiteSelectionTextColor</td>
<td>The color of the text that displays the site name</td>
<td><img src="example4.png" alt="Example" /></td>
</tr>
<tr>
<td>@cwButtonSelectedBackgroundColor</td>
<td></td>
<td><img src="example5.png" alt="Example" /></td>
</tr>
<tr>
<td>LESS Variable</td>
<td>Evolve Page Element(s)</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>@cwButtonBoxShadowColor</td>
<td>The color of the shadow on the rounded buttons</td>
<td></td>
</tr>
<tr>
<td>@cwAccordionHeaderTextColor</td>
<td>The color of the title text on accordion menus</td>
<td></td>
</tr>
<tr>
<td>@cwDiscussionsBackgroundColorHover</td>
<td>The background color of the discussions icon when you hover the cursor over it</td>
<td></td>
</tr>
</tbody>
</table>
Use Custom Site Logos

To make your Evolve Sites match your own corporate branding, you can change the default Evolve logos.

You can change the logos at a global level, so affecting the top-level Evolve Site which you see if you have Dynamic Sites, as well as the logos used on individual Sites you publish.

In addition, you can override the global setting on an individual Site basis to create custom logos for one or many of your Sites.

On the top-level Evolve Site, the logo is displayed on the login dialog and then in the top-left of the Site. A second, smaller logo is displayed in the top-left for smaller screen sizes, such as mobile devices.

On your own Sites, the logo is only displayed in the top-left of each page, with a smaller version when the site is viewed on a mobile device.

Create new logos

To replace either the global logos or create custom logos for your own Sites, you have to create two new images. These images must have the following details:

<table>
<thead>
<tr>
<th>Image 1</th>
<th>Image 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>logo.png</td>
</tr>
<tr>
<td>Dimensions</td>
<td>146 x 30 px</td>
</tr>
</tbody>
</table>

There are different processes for changing the global logos and adding custom logos to an individual Site.

What do you want to do?

Change the global Evolve Site logos

To replace the logo on the top-level Site:

1. On the Evolve server machine, in Windows Explorer, navigate to:

   <your-evolve-install-path>\Site\bin\webDesigner\images\logos

2. Replace logo.png and logo-m.png with your new images.

Next time you Publish one of your Sites, the logos will be changed. You may need to delete your browser cache in order to see the change reflected.

Alternatively, if you do not want to wait until you Publish one of your Sites, you can copy the logo.png and logo-m.png files to the following location which will cause them to be changed immediately:

   <your-evolve-install-path>\Data\Common\images\logos

Use a custom logo on an individual Site

To use a custom logo on an individual Site:

1. On the Evolve server machine, in Windows Explorer, navigate to:
2. If you do not already use a custom folder for your Site, create one here and name it as you wish.

If you already use custom content with your Site, open the folder you already use.

3. In your custom folder, create an 'images' folder, then create a 'logos' folder within it.

You should now have the following structure:

4. Copy your custom logo.png and logo-m.png files to the 'logos' folder.

5. Create a CSS file named 'main.css' and place it in

   `<your-custom-directory>\css`

   If you already have a main.css file, do not create a new one, instead add the code detailed in the next step.

6. Copy the following code and paste it directly into main.css

```css
/* Change the logo on evolve site */
.logo
{
    background: transparent url('..\images\logos\logo.png') center no-repeat;
}

/* Change the logo on the login page */
#cw-authentication-zone .cw-authentication-top
{
    background: transparent url('..\images\logos\logo.png') center no-repeat;
}

/* Change the logo for smartphone and tablet devices */
@media screen and (min-width: 240px) and (max-width: 1023px){
    .logo
    {
        background: transparent url('..\images\logos\logo-m.png') center no-repeat;
    }
}
```
7. Open your Site in Evolve Designer
8. On the Deployments > [server name] > [model] node, choose your new custom folder in the Deploy Custom Site drop-down
9. Save and Publish the site by using the Dynamic Site or Static Site button on the Home menu.

If instead you use the Save & Deploy Site function, you must click Theme & Pictures first.

Use Custom Site Images on the Multi-Sites Page

If you publish Dynamic Sites, you can use the top-level Multi-Sites page which lists all the Model Sites you have access to.

By default, these Sites are shown with an Evolve logo, but you can change it to an image of your choice.

To use your own custom image for a Site on the Multi-Sites page:

1. Create a new PNG image file
   Ideally the dimensions should be 200 x 130 pixels, however if the image is larger, it will be scaled down automatically in the page
2. Name the image file with the same name as the Site URL Name used for your Site
   You can find this value on the Deployments > [server-name] > [model] node in Evolve Designer
   For example: m48yxeuv.png
3. Place the image at the following location on your Evolve web server machine
   <evolve-install-path>\Data\Common\images\sites
   Usually <evolve-install-path> is: C:\Casewise\Evolve\n4. Publish your Site, ensuring you choose the Theme & Pictures option if you do not do a full Dynamic Site generation.
   You may need to clear your browser cache in order to see the new image immediately.

Use Custom Icons for Pages

When you create an Index Page or a Create Object Page in your Site, you can choose an image for that page which is used as an icon in the menu.

While Evolve ships with a set of default images for this purpose, you can also use your own icons if you wish.

Any custom images you add are available to be used on any Site you create in Evolve.

Custom icons must be .png files and the recommended size is 128px x 128px.

The easiest way to create a custom image is to copy and edit an existing one. This ensures it is the correct size and format and will fit neatly into your Evolve Site.

To use a custom icon:
1. In Windows Explorer, navigate to `<your-evolve-install-path>/Site/bin/webDesigner/images/views/sources/custom`
   NB: If the `custom` folder does not exist, you can create a folder of this name in the `sources` folder

2. Create a copy of one of the existing images from the path `\Site\bin\webDesigner\images\views\sources\CW` into the `custom` folder. Then rename the file - e.g. `mytest.png`

3. Open the image in an image editing application to change it
   If you want to use color transformation with the image, you must make sure the parts you want to change are kept in black, and you should keep the circle and only edit the middle of the graphic

4. Save the image.
   Your icon will now be available in the Custom Image field on your pages.

**Style Development**

Style information should always be contained in a file separate to the functioning code. In Evolve this can be produced in one of two ways.

Each new visualization / layout should have its own stylesheet with the filename the same as it’s matching JavaScript file, this file should be placed in the same folder as the JavaScript file.

**CSS**

Language: CSS

File Extension: .css

Reference: [www.w3schools.com/css/](http://www.w3schools.com/css/)

CSS is the most common format for producing stylesheets in web development, this method requires no building of the code but does not give you access to the global style variables that are available through Evolve.

For more information on CSS development see the reference linked above.

**LESS**

Language: LESS

File Extension: .less

Reference: [lesscss.org](http://lesscss.org)

Tools: [winless.org/](http://winless.org/)

LESS lets you to be more flexible with the styles you write and allows the use of methods & variables (amongst other things) when developing a style file. This LESS file is then compiled to a CSS output.

Through less you can gain access to global theme variables by adding the following to the top of your style file.

See [LESS: Global Variables](http://www.w3schools.com/css/variables) for a full list of variables available.

```css
@import "../variables";
```
LESS files are automatically compiled by Evolve when they are placed in the correct location and ‘Apply Themes’ is run through Evolve Designer. To compile LESS files outside of Evolve and learn more about LESS and its development take a look at the tools and references above.
Advanced Customization

Evolve Advanced Customization Guide

Welcome to the CW Evolve Advanced Customization Guide.

Who is this guide for?

This guide is for CW consultants or advanced users of Evolve - those interested in extending the basic capabilities of Evolve by creating custom layouts or visualizations, or changing the appearance of Evolve Sites.

What do you want to do?

Getting Started

To prepare for customizing Evolve, see Get Ready For Development.

Layouts

To create custom layouts, see Creating Custom Layouts.

Visualizations

To create custom visualizations see Custom Visualizations.

CSS & JavaScript

To create custom CSS or JavaScript see Custom CSS & JavaScript

Styles

To learn about style development, see Style Development
Advanced Customization

Evolve Advanced Customization Guide

Welcome to the CW Evolve Advanced Customization Guide.

Who is this guide for?

This guide is for CW consultants or advanced users of Evolve - those interested in extending the basic capabilities of Evolve by creating custom layouts or visualizations, or changing the appearance of Evolve Sites.

What do you want to do?

Getting Started

To prepare for customizing Evolve, see Get Ready For Development.

Layouts

To create custom layouts, see Creating Custom Layouts.

Visualizations

To create custom visualizations see Custom Visualizations.

CSS & JavaScript

To create custom CSS or JavaScript see Custom CSS & JavaScript

Styles

To learn about style development, see Style Development
Custom CSS & JavaScript

Evolve allows you to extend its functionality and styles by creating your own CSS classes and JavaScript methods which can be used within the layouts and behaviors you create.

Creating a Custom File

Location: \\webDesignerStatics\\webDesigner\\custom\\{yourFolder}

1. Create a folder in the location above
2. Place the CSS and / or JavaScript files of the following files inside (See the CSS or JavaScript sections below)
3. Open Evolve Designer for the site you’re making the changes to
4. Expand down to the model node in the left hand tree

5. On the right hand side Select {yourFolder} name from the list of ‘Deploy Custom Site’

6. From the ‘Advanced’ tab select the ‘Save & Deploy Site’ button
7. Hard refresh your browser by pressing Ctrl + F5 to pick up your changes

CSS
Language: CSS
File Extension: .css
Location: \\webDesignerStatics\\webDesigner\\custom\\{yourFolder}\\css
Reference: www.w3schools.com/css/

The CSS file created should be named main.css, this file is added to the Evolve style list after the standard Evolve styles, so will overwrite any existing classes of the same name. This allows you to tweak any UI styling to suit your specific needs by simply adding a class with the same name to the main.css file.

JavaScript
Language: JavaScript
File Extension: .js
Location: \\webDesignerStatics\\webDesigner\\custom\\{yourFolder}\\js
Reference: www.w3schools.com/js/
The JavaScript file created should be named main.js, any custom JavaScript you wish to be made available within Evolve should be added to this file, which will be included when Evolve is run.
Using Custom Images

To use custom images in Evolve:

1. Go to Site/bin/webDesigner/custom (if it doesn’t exist, create it)
2. Create a folder inside there with the name of your customization
3. Inside the customization folder create a folder named ‘images’
4. Inside ‘images’ you must add the new image files in the same position and the same name as the file you want to replace in Content/images

If you want to replace Content/images/logos/logo.png you must name your file logo.png and put it in Site/bin/webDesigner/custom/images/logo/logo.png

5. Run Evolve Designer and select the Model Deployment Node
6. In the drop down next to Deploy Custom Site select the name you set in step 1
7. You must run Themes & Pictures then Save & Deploy for changes to take effect.
Creating Custom Layouts

What Files Do You Need?
The setup of a new custom layout requires one of each of these files to be placed in the correct locations so they are recognized by Evolve.

• Layout File
• Style File
• Layout Configuration File

Layout File
Language: HTML, JavaScript, jQuery
File Extension: .js
Location: C:\Casewise\evolve\Site\bin\webDesigner\custom\client\libs\cwLayouts\
Reference: www.w3schools.com/html/, www.w3schools.com/js/, www.w3schools.com/jquery/
The layout file contains the code that describes how the content on the page should be displayed. The methods are called when the page is being drawn.

(function(cwApi) {
    var myLayout = function(options) {
        cwAPI.extend(this, cwAPI.cwLayouts.CwLayout, options);
        this.drawOneMethod = myLayout.drawOne.bind(this);
        cwApi.registerLayoutForJSActions(this);
    };

    myLayout.drawOne = function(output, item, callback, nameOnly) {};
    cwApi.cwLayouts.myLayout = myLayout;

})(cwAPI);

The file should be structured as followed:

The drawOne Method
The drawOne method should contain all the code to describe how one object should be displayed on a page.

Parameters
output
This parameter contains an array of the HTML structure to be output. Each object that is to be displayed should be added as a HTML list item (<li>) containing the information and / or HTML structure of how you want that object to be displayed on the page.

myLayout.drawOne = function(output, item, callback, nameOnly) {
Here is an example of how to display the information as a simple list.

**item**

This parameter is an object that contains all the information available to you for the object that is being displayed including the current user’s rights to update and delete the object, for a more detailed look at the information contains in this object. See Data Structure: item for an example of the data structure.

**callback**

This parameter is no longer used so will always be ‘undefined’.

**nameOnly**

This will be passed as true, false or undefined. If true the output should not contain a link to any other page, if false or undefined, the output will usually link to the matching object page.

**Style File**

Location: C:\Casewise\evolve\Site\bin\webDesigner\custom\client\libs\cwLayouts\

A style file should accompany the layout file in the same directory defining the styles used in the HTML output. See Style Development for more information on how to produce this and the options available in Evolve.

**Layout Configuration File**

Language: JSON

File Extension: .config.json

Location: C:\Casewise\evolve\Site\bin\webDesigner\custom\client\layouts\

Reference: [www.w3schools.com/json/](http://www.w3schools.com/json/)

```json
{
    "name" : "myLayout",
    "display-name" : "My Layout",
    "description" : "This is a new layout created by me",
    "js-class-name" : "myLayout"
}
```

The layout configuration file is a JSON file that sets properties for the layout. It is used by Evolve Designer to make the layout available for selection when configuring Evolve, the display-name and description are displayed when making a layout selection of a node. The js-class-name must match the name of your new layout.
Custom Visualizations

Custom visualizations currently require changes to be made to server side code, so an Evolve development environment to develop a new visualization and a new build of Evolve are required.

What Do You Need?

The setup of a new custom visualization requires one of each of these files to be placed in the correct locations so they are recognized by Evolve.

- Visualization File
- Style File
- Evolve Designer Configuration File

It also require the following file to be updated with a reference to the new visualization.

- Visualization List File

A rebuild of Evolve is required for a new custom visualization to be used in Evolve Designer.

Visualization File

Language: HTML / JavaScript / JQuery

File Extension: .js

Location: \webDesignerStatics\webDesigner\custom\client\libs\cwBehaviours\n
Reference: [www.w3schools.com/html](http://www.w3schools.com/html/) [www.w3schools.com/js](http://www.w3schools.com/js/) [www.w3schools.com/jquery](http://www.w3schools.com/jquery)

The visualization file contains the code that describes how the visualization will be displayed on a page.

```
(function () {
    var myVisualization = function () { };  
    myVisualization.setup = function (properties, allItems, searching) { };  
    cwBehaviours.myVisualization = myVisualization;

})();
```

The file should be structured as followed:

The setup Method

```
$('div.'+properties.NodeID).html("HTML String");
```
The setup method is the first method that is called when the visualisation is loaded, it should contain any code that will manipulate the data available and build up a HTML string the UI for the visualisation you wish to create. The HTML string should then be appended to the page’s DOM like so:

**Parameters**

**properties**

This parameter contains all the information for the visualisation you have created. You will need this information in the next section to access the correct data list from the allItems parameter. See DataStructure: properties for an example of the full data structure.

**allItems**

`allItems[properties.NodeID];`

This parameter contains the list of object and their data for each page in Evolve, to access the data for the page you’re coding against use the link of code below.

The list will contain all the objects and it’s information that should be displayed on the page, when searching this list will be updated to show only objects that match the search criteria. See Data Structure: allItems for an example of the full data structure.

**searching**

This is a Boolean parameter that tells you whether the page is currently being searched using Evolve’s in-page searching capability. You do not need to do anything special to have your page be searchable, this is provided as default by default.

**Style File**

Location: `\webDesignerStatics\webDesigner\custom\client\libs\cwBehaviours\`

A style file should accompany the visualisation file in the same directory defining the styles used in the HTML output. See Style Development for more information on how to produce this and the options available in Evolve.
**EvolveDesigner Configuration File**

Language: C#

File Extension: .cs

Location: \webDesigner\Sources\Nodes\Behaviours\ class cwWebDesignerTreeNodeBehaviourMyVisualisation: cwWebDesignerTreeNodeBehaviour
{
public cwWebDesignerTreeNodeBehaviourMyVisualisation(cwWebDesignerGUI cwWebIndexGui,
cwPSFTreeNode parent)
    : base(cwWebIndexGui, parent, "myVisualisation"
        wWebDesignerTreeNodeBehaviour.CategoryBehaviourOtherCharts)
{
    updateText("My Visualisation");
}
}

public override bool checkNodeStructureCustom()
{
    return true;
}
}


**Visualisation List File**

Language: C#

Location: \webDesigner\Sources\Libs\cwWebDesignerBehaviourManager.cs


The Visualisation List File contains a list of the visualizations available in Evolve by linking to their configuration file (described above), so any new visualisation should be added to this list so EvolveDesigner can recognise it and make it available for use.
this.AddBehaviour(new cwWebDesignerTreeNodeBehaviourAccordion(webDesignerGui, parentLayout));

this.AddBehaviour(new cwWebDesignerTreeNodeBehaviourGoogleMap(webDesignerGui, parentLayout));

this.AddBehaviour(new cwWebDesignerTreeNodeBehaviourMyVisualisation(webDesignerGui, parentLayout));

this.SortBehaviours();

}

The line of code should be added as the example in red (below) shows.

**Further Development**

**Layout Restriction**

this.allowedLayouts.Add("Layout Name");

You can restrict the layout your visualisation can be attached to in EvolveDesigner by adding an extra line of code in the EvolveDesigner Configuration File. The following line of code should be added for each layout you will allow your visualisation to be attached to.

**Additional Properties**

**Object Properties**

If you require extra properties for the objects that are being provided to you, this can be configured in Evolve designer.

1. Load EvolveDesigner with the model and site you’re configuring.
2. Expand the tree for the Index page you have attached your visualisation to and select the object type. The example below shows this for a process object type.

3. On the right hand side select the additional properties you require in your visualisation, these will then be available in the allItems properties payload. See **Data Structure: allItems** for an example of the data structure.

**Data Structure: allItems**

```json
{
  project1: Array[4]
}
```
0 {
    accessRights {
        CanDelete: true
        CanUpdate: true
    }
    associations { }
    iName: null
    iObjectAccessRights: Object
    iObjectTypeName: ""
    iProperties: Object
    label: "Object Name"
    layoutName: "cwLayoutEmpty"
    name: "Object Name"
    nodeID: "project1"
    objectTypeScriptName: "project"
    object_id: 23
    properties {
        name: "Object Name"
    }
}
1: Object
2: Object
3: Object
4: Object
project2: Array[17]
}

Data Structure: item

{
    accessRights {
        CanDelete: true
        CanUpdate: true
    }
}
Associations {
    iName: null
}

iObjectAccessRights {
    iObjectTypeScriptName: ""
}

iProperties {
    label: "Object Label"
    layoutName: "myLayout"
    name: "Object Name"
    nodeID: "diagram"
    objectTypeScriptName: "diagram"
    object_id: 1234
}

properties {
    cwaveragerating: 0
    exportflag: 0
    name: "Object Name"
}

Data Structure: properties

{
    Behaviour {
        AuthorizedLayouts: Array[0]
        JSMethodName: "cwCostBenefit"
        Name: "My Visualisation"
        Options: Object
            node_name: "My Visualisation"
    }
    LayoutName: "empty"
    LayoutOptions {
        DisplayPropertyScriptName: ""
    }
}

533
Get Ready For Development

Before you begin your new project you should take some time to setup an environment where you can easier develop and debug your code. This will allow you to be able to view and insert breakpoints into source code through your browser’s debugging window during development, it will also ensure that any saved changes made are reflected in the browser by a simple refresh.

**Set Evolve Debug Mode**

1. Load Evolve designer and open the model & site you’re currently using. Expand down to the Deployments node and select your machine name.
2. In the list of properties on the right hand side, for the ‘JavaScript Mode’ select ‘debug’.
3. Specify the path of the server where the debug files are located

**Connect Debug Folders in IIS**
This assumes a default Evolve installation, if you have made changes to the install location and IIS settings for Evolve please adapt the steps to your installation.

1. Open Internet Information Services (IIS) manager from your windows programs
2. Expand ‘Sites’, right click on ‘Default Web Site’ and select ‘Add Virtual Directory…’
   - Set the ‘Alias’ to Libs-Debug
   - Set the ‘Physical path’ to C:\Casewise\evolve\Site\bin\webDesigner
   - Set the ‘Connect as...’ to Application User (pass-through authentication)
   - Test your settings to make sure they’re correct

3. Repeat step 2 using the following:
   - Set the Alias to Libs-Debug-External
   - Set the Physical path to C:\Casewise\evolve\Site\bin\webDesigner
   - Grant the ‘Users’ group the following permissions on the C:\Casewise\evolve\Site folder
Troubleshooting

In the event you have issues setting up or using your Evolve Sites, please refer to the information here to attempt to resolve any problems before contacting the erwin Support Team.

## Issues

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
</table>
| Users cannot log on using Internet Explorer - screen just refreshes | Check that the server name (http://<server-name>/<evolve-IIS-site-name>) does not include any underscores.  
There is an issue with Internet Explorer which results in this behavior if there is an underscore in the server name.  
Either change the server name, stop using Internet Explorer, or access the Evolve Sites using the server IP address. |
| Unable to use Text Editor in Internet Explorer 11 or Evolve          | It may be that the font setting is not enabled in Internet Explorer 11.  
To enable the setting, please see: [Enable Enhanced Multi-line Text Editor for Internet Explorer](#) |
| A Shape based on a Style                                            | Open the Style in Model Explorer or from the Corporate Modeler Palette Entries and Save the Style. Publish the change to your Dynamic or Static Site. The Style will display correctly. |
Users cannot create Diagrams in eModeler

If Users are unable to create Diagrams, it is likely that an Index Page has been used. Open Evolve Designer and check whether the Dynamic Template Configuration was created using an Index Page or an Object Page.

The following table details the benefits associated with each Page Type:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Edit</th>
<th>Create</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Object</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Once in Evolve Designer, adjust the Dynamic Template Configuration to use an Object Page Type instead.

Duplicate associations do not usually cause issues, and are not a regular occurrence. In fact for Evolve Workflows, they are necessary to support workflow history data. But occasionally, they can be a problem and need tidying. Validate Repository has a fix mode which can assist in this process, but should be used with care, hence its semi-hidden status. To enable the fix mode, please contact support for details.

Errors reported in the log files for Global Search and CMI

Global Search

Log Files:

- DatabaseData.txt
- CWS.CWS.Search-[current date].log current date is YYYYMMDD (For example, CWS.CWS.Search-20230308.log)

Both are located in “C:\erwin\Evolve\CWSServices\logs” if installed in the default location.

<table>
<thead>
<tr>
<th>Running Errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR Table: Last Audit Id {Last Audit Id}</td>
</tr>
</tbody>
</table>
CurrentAudit Id = {Current Audit Id}

For example, AR Table: Last Audit Id 932089
CurrentAudit Id = 912089

"CurrentAudit Id" then fetching has had a problem - no more audit data has been generated but that has not been detected. (DatabaseData.txt)

Troubleshooting Steps:
1. Stop DB Service.
2. Restart DB Service.
If the above doesn’t work, contact Service Desk or Support Team.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polling failed</td>
<td>It mostly happens due to invalid or incorrect data. No workaround. For more information, contact Service Desk or Support Team.</td>
</tr>
<tr>
<td>Watcher Error: {Exception Message}</td>
<td>It mostly happens due to invalid or incorrect data. No workaround. For more information, contact Service Desk or Support Team.</td>
</tr>
<tr>
<td>Indexing (indexNameLatest) creation error: {ServerError}</td>
<td>It mostly happens due to invalid or incorrect data. No workaround. For more information, contact Service Desk or Support Team.</td>
</tr>
<tr>
<td>Failed to GetLastResultId()</td>
<td>It mostly happens due to invalid or incorrect data. No workaround. For more information, contact Service Desk or Support Team.</td>
</tr>
<tr>
<td>Failed to GetObjectTypeNameFromElasticSearch()</td>
<td>It mostly happens due to invalid or incorrect data. No workaround. For more information, contact Service Desk or Support Team.</td>
</tr>
<tr>
<td>Failed to GetRecordsFromModel()</td>
<td>It mostly happens due to invalid or incorrect data. No workaround. For more information, contact Service Desk or Support Team.</td>
</tr>
<tr>
<td>InitializationErrors</td>
<td>Search has not been initialized</td>
</tr>
</tbody>
</table>
| Failed to create watch folder | Troubleshooting steps:  
1. Verify that the user has access to the desired folder.  
If the above doesn’t work, contact Service Desk or Support Team. |
| Error: Failed to create Copy Path | Search has not been initialized |
| | Troubleshooting steps:  
1. Verify that the user has access to the desired folder  
If the above doesn’t work, contact Service Desk or Support Team. |
DatabaseFetchService ERROR - Error: No Watch Path set in configuration file

Search has not been initialized.
This issue occurred in CWS.CWS.Search - [current Data].log
This is accomplished by configuring and saving the site in Evolve designer.
Troubleshooting steps:
1. Save the configuration in Evolve Designer.
2. Republish the Site.
If the above doesn’t work, contact Service Desk or Support Team.

Error: No Watch Path set in configuration file

Search has not been initialized
This issue occurred in DatabaseData.txt.
This is accomplished by configuring and saving the site in Evolve designer.
Troubleshooting steps:
1. Save the configuration in Evolve Designer
2. Republish the Site.
If the above doesn’t work, contact Service Desk or Support Team.

Connection Status: The ConnectionString property has not been initialized.

Search has not been initialized
This issue occurred in DatabaseData.txt.
This is accomplished by configuring and saving the site in Evolve designer.
Troubleshooting steps:
1. Save the configuration in Evolve Designer
2. Republish the Site.
If the above doesn’t work, contact Service Desk or Support Team.

---

**CMI (Casewise Analytics)**

Log Files:
Path and name can be set in the Load automation application.

<table>
<thead>
<tr>
<th>Error: Illegal XML characters detected in column(s): (Column Name(s))</th>
<th>Data Error: May or may not stop the load</th>
</tr>
</thead>
<tbody>
<tr>
<td>Troubleshooting steps:</td>
<td></td>
</tr>
<tr>
<td>1. Run Validate Repository to collect the error.</td>
<td></td>
</tr>
<tr>
<td>1. Use <code>- applyfixes:1005</code> with the validate repository in the command line.</td>
<td></td>
</tr>
</tbody>
</table>

If the above doesn’t work, contact Service Desk or Support Team.
<table>
<thead>
<tr>
<th>Error: {Object Type} is an intersection object (or intersection-like object) without an association type</th>
<th>Data Error: This may not stop data loading. The association may have been deleted from the original model, but it hasn’t been cleaned up.</th>
</tr>
</thead>
<tbody>
<tr>
<td>{Time} {Model File Name} Operation Duration: 01:48:06.216 (6.48622e+006 ms) [Errors: {NrErrors} Warnings: {NrWarnings}]</td>
<td>When the load finishes, if it stops the load then would need checking. Troubleshooting steps: 1. Examine the error log for errors. 2. Fix the error manually or apply fixes. If the above doesn’t work, contact Service Desk or Support Team.</td>
</tr>
<tr>
<td>Model: {Model File Name} Table: Validating: CMOBJECTTYPE (Time) Error: Errors occurred during data validation</td>
<td>If validation errors occur, they may or may not stop the load, but if you need to know which model it applies to, you must read the 4 lines (including a blank line) during loading. No Troubleshooting steps, contact Service Desk or Support Team.</td>
</tr>
<tr>
<td>ERROR: Model '{Model File Name}' failed to load - Error code: {Error Code} LoadAutomation Summary: Error: CM Unload for model DEVCINSP failed with error code 1. Model 'DEVCINSP' successfully loaded. Model 'DEVOPSW' successfully loaded. Model 'DEVOPSTS' successfully loaded.</td>
<td>If an unload fails, it will be reported here but may not stop the load. Occurs due to above scenarios. No Troubleshooting steps, contact Service Desk or Support Team.</td>
</tr>
<tr>
<td>FAILED: {Some Error}</td>
<td>If the error is Obvious from the logs, then user may be able fix it or contact Service Desk.</td>
</tr>
<tr>
<td>ERROR: Failed to</td>
<td>If the error is Obvious from the logs, then user may be able fix it or contact Service Desk</td>
</tr>
</tbody>
</table>

Troubleshooting
<table>
<thead>
<tr>
<th>Issue</th>
<th>Troubleshooting Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>unload the Administration model into CMI - Can not continue!</td>
<td>Troubleshooting steps:</td>
</tr>
<tr>
<td>Passed log file path could not be created!</td>
<td>1. Make sure the Location path is correct.</td>
</tr>
<tr>
<td></td>
<td>2. Verify that the user can access the location.</td>
</tr>
<tr>
<td>If the above doesn’t work, contact Service Desk or Support Team.</td>
<td></td>
</tr>
<tr>
<td>Could not find CM install folders</td>
<td>Troubleshooting steps:</td>
</tr>
<tr>
<td></td>
<td>1. Make sure the desktop tool and CMI are on the same machine.</td>
</tr>
<tr>
<td>If the above doesn’t work, contact Service Desk or Support Team.</td>
<td></td>
</tr>
</tbody>
</table>

**Rarely occurring Errors**

<table>
<thead>
<tr>
<th>Issue</th>
<th>Troubleshooting Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot; (Shape) Symbol { Symbol Id } on diagram {Diagram Id} does not exist.</td>
<td>Warnings: Maintaining the Data's Integrity</td>
</tr>
<tr>
<td>(Line Ending) Symbol { Symbol Id } on diagram {Diagram Id} does not exist.</td>
<td>Warnings: Maintaining the Data's Integrity</td>
</tr>
<tr>
<td>Diagram definition is unreadable. Rejecting diagram.</td>
<td>Contact Service Desk or Support Team.</td>
</tr>
<tr>
<td>Duplicate Record, ID = {Unique Identifier}</td>
<td>Troubleshooting steps:</td>
</tr>
<tr>
<td></td>
<td>1. Examine the error to identify its root cause.</td>
</tr>
<tr>
<td></td>
<td>If the above doesn’t work, contact Service Desk or Support Team.</td>
</tr>
<tr>
<td>Built in Object Type { Object Type } is missing</td>
<td>Occurs when the source data is corrupt or incomplete</td>
</tr>
<tr>
<td>Built in Property Type { Object Type }. { Property Type } is missing</td>
<td></td>
</tr>
<tr>
<td>Built in Pane {Object Type }.&quot; { Pane } is missing</td>
<td>Occurs when the source data is corrupt or incomplete</td>
</tr>
<tr>
<td>Built in Lookup { Object Type }.&quot;</td>
<td></td>
</tr>
<tr>
<td>Property Type</td>
<td>{ LookupUUID } ) is missing</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Built in Association Type</td>
<td>{ Association Type) is missing</td>
</tr>
<tr>
<td></td>
<td>Occurs when the source data is corrupt or incomplete</td>
</tr>
</tbody>
</table>

### Initialization Errors

<table>
<thead>
<tr>
<th>No Models in the parameter List</th>
<th>Command line is not set correctly.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Troubleshooting steps:</td>
</tr>
<tr>
<td></td>
<td>1. Set command line correctly.</td>
</tr>
</tbody>
</table>

## Error messages

Use the table below to understand any error messages you may encounter:

**Upgrade for grid failed because of the intersection node is missing inside the page `<attribute_associations>` on node Table (Complex) which is a cwWebDesignerTreeNodeBehaviourKendoGrid**

This happens when the Intersection Grid option is selected in a Table (Complex) behavior, but there is no intersection node for the table.

To resolve this error, use the Selected Properties to add the properties.

## Font Size Too Big on Diagrams

*To change the palette version the user needs to be able to run SQL management studio.*
1. Open SQL Management studio select the model and expand the tables

![SQL Management Studio](image1.png)

2. Select the diagram table and chose edit top 200 rows

![Diagram Table](image2.png)

3. Change to the SQL view and replace the text with:

   ```sql
   SELECT TOP (200) MODEL_NAME, DI_ID, ANO_ID, ANO_TABNR, DI_NAME, DI_SYMBOLS, DI_TEMPLATE, DI_TITLE
   FROM DIAGRAM
   WHERE (DI_ID = 2) AND (MODEL_NAME = 'CWFREX09')
   Replace DI_ID with your diagram ID and replace CWFREX09 with the correct model file name
   ```

   *This must be upper case, if upgrading all diagrams, omit DI_ID and change (200) depending on how many models you require*

4. In the DI_SYMBOLS column click inside the cell to edit the palette XML.

5. Set the element `<OriginalVersion OriginalVersion="2">` to `<OriginalVersion OriginalVersion="4">`

6. Close SQL Management studio when complete.

Troubleshooting 543
7. When all of these have been changed using one of the CM applications (Corporate Modeler, Model Explorer or Object Explorer) the font size in styles that are referenced in the palette are reduced by 20%. Open every object on the palette, go to its style (if it has one) and reduce the font to the nearest whole number that is 20% smaller (e.g. a 10pt font becomes an 8pt font).

Elastic/Global Search Using Too Much Memory

Introduction

The latest release of the EvolveWebPlatform has had the version of Elastic Search that it uses upgraded to 7.16. If this version when installed with evolve is using too much memory, then it can be reduced by changing some settings in the options file.

For these settings to take effect, the Elastic Search service needs to be uninstalled and reinstalled. While this operation does not take too long, we recommend that it is done when the evolve application is not being used or during a relatively quiet period.

Option File Changes

If the EvolveWebPlatform has been installed using the default location, then you need to change the file.

- The file to be changed is in the folder:
  ```
  "C:\erwin\Evolve\Elasticsearch\elasticsearch-7.16.2\config"
  ```
- The file required to change is called "jvm.options"
  
  Edit this file with any text editor, but don’t set it as the default.

  Locate these lines
  ```
  ################################################################
  ## IMPORTANT: JVM heap size
  ```
After a short description you should find these lines

```
# -Xms4g
# -Xmx4g
```

Change them to the following

```
-Xms500M
-Xmx1g
```

So that whole section should look like this

```
IMPORTANT: JVM heap size
```

The heap size is automatically configured by Elasticsearch based on the available memory in your system and the roles each node is configured to fulfill. If specifying heap is required, it should be done through a file in jvm.options.d, and the min and max should be set to the same value. For example, to set the heap to 4 GB, create a new file in the jvm.options.d directory containing these lines:

```
-Xms500M
-Xmx1g
```

See https://www.elastic.co/guide/en/elasticsearch/reference/7.16/heap-size.html for more information

```
```

- Save the file.
Updating the Service

1. Start the Windows Services (eg. by typing services in the windows search and clicking the application that appears)

2. Locate the “CWS.elasticsearch-service-x64” and stop it, this will also stop the “CWS.Search” service

3. Open a command prompt and navigate to the folder “C:\erwin\Evolve\Elasticsearch” assuming the default location.
   In the command prompt type: `UninstallService`  
   When complete type: `InstallService`  

4. When completed open the Windows Services application. If it did not open, refresh it, and start the “CWS.elasticsearch-service-x64” service. Wait a minute or so and start the “CWS.Search” service.
   DO NOT start the “CWS.Search” first as a small amount of time is required for the Elastic Search service to initialize before search requests are made.

5. The memory usage for the service should now be at a reasonable level.
Upgrading

Upgrading from Evolve Web Platform 2020.1.x

If you are upgrading to the latest Evolve 2020.1 from any 2020.1.x version.

When uninstalling any recent version of Evolve, it is also necessary to uninstall "Evolve Services" - the service that operates the Global Search, and Web Modeler.

The Evolve Web Platform uninstaller does NOT remove Evolve Services when uninstalling.

The following steps also ensure compatibility between Evolve Web Platform and Evolve Suite (CWSuite) when run on the same machine.

1. First BACKUP your SQL Database, to ensure any updates can be reverted should there be a problem.

   To do this you may need to first stop the CWS Services from running

3. Then uninstall your previous version of Evolve Web Platform 2020
   A restart may be required.

4. Now uninstall your previous version of Evolve Suite 2020 * only if previously installed *
   A restart may be required.

5. Follow the steps below:
   • Go to your previous Evolve Web Platform folder (defaults to C:\erwin\Evolve) right-click on the 'Evolve' sub-folder, then choose 'Send to >' - 'Compressed (zipped) folder'
   • Let Windows compress the remnants of this folder to a backup file This zip will contain any customizations made to Evolve Web Platform, various settings, and your Global Search cache
     This is a useful backup to keep, should you need to revert any changes.
   • Finally delete all the contents of the Evolve folder EXCEPT these 2 folders (if you want to preserve your Global Search cache):
     * CWSServices - folder
     * Elasticsearch - folder
6. Install the latest Evolve Suite release (aka CWSuite) *If only the Web Platform is required, this step can be skipped.* *(The Suite should be installed first, if both Desktop and Web components are to co-exist on a single machine)*

7. Install Evolve Web Platform 2020
And copy any custom files back to their respective folders (nb: only copy files customized by your organization)

8. **ENSURE YOU HAVE BACKED UP YOUR DATABASE**
Follow the instructions to upgrade your database

9. Any version upgrade can be performed from a previous version but the below is required when updating to 2020.0.2 or later in the 2020 series
Continuing on from the database upgrade instructions, also run the following command
validateRepository.exe -connection:YourConnectionName -
  username:YourUserName password:YourPassword -applyfixes
When prompted to apply fixes, review the changes (there may be other faults that need fixing, check you are happy with them) then press 'a' for all.

10. Your upgrade is complete - continue to configure Evolve Web Platform and re-publish the sites.

When a version of Evolve Web Platform (Evolve) is installed on the same machine as Evolve Suite (CWSuite), the version of Evolve Suite installed must be the same version (including revision, e.g. 2020.1.0) to ensure full compatibility.

Other machines on the network can continue to use Evolve Suite matching the same Major Version, e.g. 2020.x if desired. Although upgrading to Evolve Suite (CWSuite) at the newer version, may offer additional features / fixes.
Upgrading

Upgrading from Evolve Web Platform 2020.1.x

If you are upgrading to the latest Evolve 2020.1 from any 2020.1.x version.

Warning: When uninstalling any recent version of Evolve, it is also necessary to uninstall "Evolve Services" - the service that operates the Global Search, and Web Modeler.
The Evolve Web Platform uninstaller does NOT remove Evolve Services when uninstalling.

**The following steps also ensure compatibility between Evolve Web Platform and Evolve Suite (CWSuite) when run on the same machine.**

1. First BACKUP your SQL Database, to ensure any updates can be reverted should there be a problem.
   To do this you may need to first stop the CWS Services from running
3. Then uninstall your previous version of Evolve Web Platform 2020
   A restart may be required.
4. Now uninstall your previous version of Evolve Suite 2020 *only if previously installed*
   A restart may be required.
5. Follow the steps below:
   * Go to your previous Evolve Web Platform folder (defaults to C:\erwin\Evolve)
     right-click on the 'Evolve' sub-folder, then choose
     'Sent to ->' - 'Compressed (zipped) folder'
   * Let Windows compress the remnants of this folder to a backup file
     This zip will contain any customizations made to Evolve Web Platform, various settings, and your Global Search cache
     This is a useful backup to keep, should you need to revert any changes.
   * Finally delete all the contents of the Evolve folder EXCEPT these 2 folders (if you want to preserve your Global Search cache):
     * CWSServices - folder
     * Elasticsearch - folder
6. Install the latest Evolve Suite release (aka CWSuite) *If only the Web Platform is required, this step can be skipped.*
   (The Suite should be installed first, if both Desktop and Web components are to co-exist on a single machine)
7. Install Evolve Web Platform 2020
   And copy any custom files back to their respective folders (nb: only copy files customized by your organization)
8. **ENSURE YOU HAVE BACKED UP YOUR DATABASE**
   Follow the instructions to upgrade your database
9. Any version upgrade can be performed from a previous version but the below is required when updating to 2020.0.2 or later in the 2020 series

   Continuing on from the database upgrade instructions, also run the following command

   ValidateRepository.exe -connection:YourConnectionName -username:YourUserName password:YourPassword -applyfixes

   When prompted to apply fixes, review the changes (there may be other faults that need fixing, check you are happy with them) then press 'a' for all.

10. Your upgrade is complete - continue to configure Evolve Web Platform and re-publish the sites.

    When a version of Evolve Web Platform (Evolve) is installed on the same machine as Evolve Suite (CWSuite), the version of Evolve Suite installed must be the same version (including revision, e.g. 2020.1.0) to ensure full compatibility.

    Other machines on the network can continue to use Evolve Suite matching the same Major Version, e.g. 2020.x if desired. Although upgrading to Evolve Suite (CWSuite) at the newer version, may offer additional features / fixes.

### Upgrading from Evolve Web Platform 2020.0.x

If you are upgrading to the latest Evolve 2020.1 from any previous version of.

When uninstalling any recent version of Evolve, it is also necessary to uninstall "Evolve Services" - the service that operates the Global Search, and Web Modeler.

The Evolve Web Platform uninstaller does NOT remove Evolve Services when uninstalling.
The following steps also ensure compatibility between Evolve Web Platform and Evolve Suite (CW Suite) when run on the same machine.

1. First BACKUP your SQL Database, to ensure any updates can be reverted should there be a problem.
2. Now uninstall Evolve Services
   To do this you may need to first stop the CWS Services from running
3. Then uninstall your previous version of Evolve Web Platform 2020
   A restart may be required.
4. Now uninstall your previous version of Evolve Suite 2020 * only if previously installed *
   A restart may be required.
5. Follow the below steps:
   - Go to your previous Evolve Web Platform folder (defaults to C:\erwin\Evolve)
     Inside you will find a folder called 'Data'
     **Delete this folder** - it contains generated content from your sites, that will be recreated when you republish your sites in Evolve Web Platform 2020.
   Due to the changes to several folder structures, the above step is important.
   - Go back up a folder, to your previous Evolve Web Platform root directory (defaults to C:\erwin)
     right-click on the 'Evolve' sub-folder, then choose
     ‘Sent to >’ - ‘Compressed (zipped) folder’
   - Let Windows compress the remnants of this folder to a backup file
     This zip will contain any customizations made to Evolve Web Platform, various settings, and your Global Search cache
     This is a useful backup to keep, should you need to revert any changes.
   - Finally delete all the contents of the Evolve folder EXCEPT these 2 folders (if you want to preserve your Global Search cache):
     * CWSServices - folder
     * Elasticsearch - folder
6. Install the latest Evolve Suite release (aka CWSuite) * If only the Web Platform is required, this step can be skipped. *
   (The Suite should be installed first, if both Desktop and Web components are to co-exist on a single machine)
7. Install Evolve Web Platform 2020
   And copy any custom files back to their respective folders (nb: only copy files customized by your organization)
8. ** ENSURE YOU HAVE BACKED UP YOUR DATABASE **
   Follow the instructions to upgrade your database
9. Continuing on from the database upgrade instructions, also run the following command:

ValidateRepository.exe -connection:YourConnectionName -
username:YourUserName password:YourPassword -applyfixes

When prompted to apply fixes, review the changes (there may be other faults that need fixing, check you are happy with them) then press 'a' for all.

10. Your upgrade is complete - continue to configure Evolve Web Platform and re-publish the sites.

When a version of Evolve Web Platform (Evolve) is installed on the same machine as Evolve Suite (CWSuite), the version of Evolve Suite installed must be the same version (including revision, e.g. 2020.1.0) to ensure full compatibility.

Other machines on the network can continue to use Evolve Suite matching the same Major Version, e.g. 2020.x if desired. Although upgrading to Evolve Suite (CWSuite) at the newer version, may offer additional features / fixes.

---

**Upgrading from Evolve Web Platform 2018 or older**

If you are upgrading to the latest Evolve 2020 from any previous version 2018 or older and you have CWSuite installed on the same machine.
When uninstalling any version of Evolve from 4.0 upwards, it is also necessary to uninstall "Evolve Services" / "CWS Services" - the service that operates the Global Search, and Web Modeler.

The following steps ensure compatibility between Evolve Web Platform and Evolve Suite (CW Suite) when run on the same machine.

1. First BACKUP your SQL Database, to ensure any updates can be reverted should there be a problem.
2. Now uninstall CWS Services for 2018 and older
   To do this you my need to first stop the CWS Services from running
3. Then uninstall your previous version of Evolve 2018 or Evolve 2016
   A restart may be required.
4. Now uninstall your previous version of CWSuite 2018 or CWSuite 2016 * only if previously installed *
   A restart may be required.
5. Go to your previous Evolve installation folder (defaults to C:\Casewise\Evolve) and rename it to "Evolve_ OLD")
   This folder is not removed by the installer, as it contains files that were not part of the installation.
   Keeping this folder can be useful, if you have customizations that you need to copy across.
   Once you are sure you have all you need from this directory, it can be removed.
6. Install the latest Evolve Suite release (aka CWSuite) * If only the Web Platform is required, this step can be skipped. *
   (The Suite should be installed first, if both Desktop and Web components are to co-exist on a single machine)
7. Install Evolve Web Platform 2020
   And copy any custom files back to their respective folders (nb: only copy files customized by your organization)
8. ** ENSURE YOU HAVE BACKED UP YOUR DATABASE **
   Follow the instructions to upgrade your database.
9. Continuing on from the database upgrade instructions, also run the following command

   ValidateRepository.exe -connection:YourConnectionName -
   username:YourUserName password:YourPassword -applyfixes

   When prompted to apply fixes, review the changes (there may be other faults that need fixing, check you are happy with them) then press 'a' for all.

10. Your upgrade is complete - continue to configure Evolve Web Platform and re-publish the sites.

**Upgrading from Evolve 3.x**

If you are upgrading from a version earlier than Evolve 4.0, please first ensure you have completed the steps in the Database Migration Guide, and then follow the appropriate steps listed below in order to complete the migration process and have your Sites running the new version.

If you have any custom themes, you must copy all of the lines below and paste it in all theme files for every Evolve site that you are deploying.

   @cwDiagramEditorIconColor: #b7b7b7; //v4.0
   @cwDiagramEditorMenuBackgroundColor: #f1f1f1; //v4.0
   @cwDiagramEditorMenuMainHeaderBackgroundColor: #2372a7; //v4.0
   @cwDiagramEditorMenuSubHeaderBackgroundColor: #2881bd; //v4.0

Adding this text to the end of the theme files will upgrade the theme files for the new version.

If you are using a custom logo, it is important to note that the new dimensions for the top left logo are 146px x 30px.
Upgrading Custom Themes / Less Variables

This section applies to users that have customised their Evolve theme. You can skip this section if you are using the default Evolve theme and have not made any changes of your own.
Failure to Update - Theme Errors
Failure to update your custom theme with Evolve 4’s new LESS variables will result in an error.
Merging Changes Into Custom Theme

To ensure that Evolve 4.0’s pages appear as they should, you must copy the new variables into your custom theme files. These variables are listed on the next page.
New Variables in 4.0

The following variables are new to Evolve 4.0:
## Global search

<table>
<thead>
<tr>
<th>Variable</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwGlobalSearchFocusColor</td>
<td>@cwMenuLeftMainNavigationBackgroundColorActive</td>
</tr>
<tr>
<td>@cwGlobalSearchTextColor</td>
<td>@cwMenuLeftMainNavigationTextColor</td>
</tr>
<tr>
<td>@cwGlobalSearchBackgroundColor</td>
<td>@cwMenuLeftMainNavigationBackgroundColor</td>
</tr>
<tr>
<td>@cwGlobalSearchResultsTextColor</td>
<td>@cwFontTextColor</td>
</tr>
<tr>
<td>@cwGlobalSearchResultsBackgroundColor</td>
<td>whitesmoke</td>
</tr>
</tbody>
</table>
## Top Bar

<table>
<thead>
<tr>
<th>Variable</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwTopBarHeight</td>
<td>40px</td>
</tr>
<tr>
<td>@cwTopBarBackgroundColor</td>
<td>#ECEFF1</td>
</tr>
<tr>
<td>@cwTopBarProfileLinkColor</td>
<td>@cwColor2</td>
</tr>
<tr>
<td>@cwTopBarProfileLinkHoverColor</td>
<td>@cwColor2Shade</td>
</tr>
</tbody>
</table>

Upgrading
## Login Page

<table>
<thead>
<tr>
<th>Variable</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>@cwLoginTextColor</td>
<td>@cwTextColor</td>
</tr>
<tr>
<td>@cwLoginLabelColor</td>
<td>@cwColor2</td>
</tr>
<tr>
<td>@cwLoginTextBoxBorderColor</td>
<td>#CFD8DC</td>
</tr>
<tr>
<td>@cwLoginTextBoxFocusBorderColor</td>
<td>@cwColor2</td>
</tr>
<tr>
<td>@cwSiteSelectionTextBackground</td>
<td>@cwColor2</td>
</tr>
<tr>
<td>@cwLoadingIconColor</td>
<td>@cwAccentColor</td>
</tr>
</tbody>
</table>
Theme File Labelling Convention

Evolve's LESS variables are named using camelCase whereby the first letter of each word is capitalized - except for the first letter of the whole string. Evolve version numbers are commented out next to any variables that relate to specific Evolve versions. I.e: //v4.0
Custom Logos
The dimensions of custom logos have been changed, they are now:

**Image 1**
logo.png
146 x 30 px

**Image 2**
logo-m.png
112 x 30px

Upgrading from Evolve 2.2, 2.3, 2.3.1, 3.0 or 3.1
There are no changed configuration options required for your upgrade, but you must still do the following:

- *Run the Server Configurator* to complete the upgrade.
- *Upgrade Your Database* so it works with the new version.
- *Update each of your Sites* so they work with the new version.
**Evolve eModeler**

Evolve 3.1 introduces eModeler. To ensure that this new feature is enabled for use across your Sites, see Enable BP modeler.

**Upgrading from Evolve 2.1**

If you are upgrading from Evolve 2.1, quite a lot has changed in terms of Site configuration and setup. As such, there are a series of steps you should follow in order to complete the upgrade process.

*Instructions for upgrading from Evolve 2.1*

These instructions assume you have already upgraded the Evolve application on the web server in accordance with the Installation Guide.

---

**Upgrading your database to support CW Suite / Evolve 2016 and above**

These instructions explain how to update your database for new releases of CWSuite and Evolve.

*IMPORTANT:* Before beginning the upgrade process you must make sure that your database user has DBA permissions. It is also STRONGLY advised that you backup your SQL database prior to upgrade, as any failures during upgrade may not be reversible.

**Step 1 - Backup and Preparation**

- It is recommended that you **back up your database prior to following these steps**.

**Step 2 - Ensure you have installed your new version of CW Suite**

- Follow the install guide for CW Suite until the step to upgrade your database.

**Step 3 - Upgrade the Database**
1. Run Command Prompt as an administrator and navigate to the 'bin' directory where CW Suite is installed.

```
C:\>cd "C:\Program Files (x86)\Casewise\CM\bin"
```

2. Type the following: `ValidateRepository.exe -connection:YourConnectionName -username:YourUserName password:YourPassword -upgradedb`

3. The Validate Repository tool will do various checks and will display the results of these checks as well as a prompt to commence the upgrade.

If your user does not have DBA permissions, you will see the following message:

```
If you see this message, you should not proceed with the database upgrade.
```

**Step 4 - Continue with you install instructions for Evolve as required**
• Install Evolve following the information detailed in the installation guide.

Upgrading to Evolve 2.3 from Evolve 2.1

If you are upgrading from Evolve 2.1 there are several steps you must follow to ensure your Sites are updated to run with the new version.

There are also some changes to file paths and the URLs your Sites can be accessed via that you should understand.

If you previously used Workflow in Evolve, please read this important message:

**Important message for Workflow users**

The mechanism for providing workflow capabilities within Evolve has **changed completely** in this release.

While any workflows you may have previously configured will still work in Evolve 2.3, **all existing Tasks and Notifications will be lost**.

If you need assistance preserving existing Tasks and Notifications, please contact the erwin Support Team.

**Steps for Updating Sites**

> These instructions assume you have already upgraded the Evolve application on the web server machine in accordance with the Installation Guide.

**To ensure a smooth transition to the new version, follow the steps below:**

1. Understand multiple Sites, the new URLs, file paths and directories
   
   **Learn about the URLs, file paths and directories used in Evolve 2.3.**

2. Run the Server Configuration utility
   
   **Use the Server Configuration utility to ensure your Evolve IIS Site is configured correctly.**

3. Update and publish existing Sites
   
   **For each existing Site you want to use in Evolve 2.3, ensure you follow the instructions for Updating an existing Site.**

4. Learn how to create and configure a new Site
   
   **Now Evolve supports multiple Sites, learn how to Create a Site.**

Update an Existing Site

These instructions explain how to update an existing Site and configure the settings so it can be published in the latest version. These steps should be followed for **each existing Site** you want to publish in the new version of Evolve.

These instructions assume you have already **upgraded the Evolve application** on your server, and used the [Server Configuration](#) tool to configure it.
As long as the model containing your Site is in your repository, when you launch Evolve Designer the Model and its Site should be listed so you can open the Site in the designer application.

There is a **new warning message** displayed when publishing a Site if your model has **more than one template diagram for a Rule and Category** combination. **We strongly recommend** that if you see this message you revisit your model to **eliminate duplicate diagram templates** for the same Rule and Category, otherwise you could have issues displaying diagrams in your Site.

**Step 1 - Check existing custom data and files**

**Custom Site content**

Check that any custom Site content you may have is in the correct location in the Evolve/Site directory. This is in your Site\bin\webDesigner\custom\<customization-name> directory. See [URLs, file paths and directory structures](#).

**Custom logos**

If you use custom logos in your Evolve Site or Sites, the configuration required to use them has changed. Please read these [instructions on how to use custom logos on your Site](#) to ensure they continue to work after upgrading.

**Custom Workflow Emails**

If you have customized the default Email templates for Workflow, ensure they are copied to the Site\bin\SMTP\Email Templates directory.

**Step 2 - Update the Site's Meta Model**

To update the meta model:

1. In Evolve Designer open your Site
2. Click the **Update Meta Model** button
   
   *The Model is updated with the latest required meta data.*
3. Save your Site, the close and re-open Evolve Designer when prompted.

**Step 3 - Update Diagram Designer layouts**

1. Ensure Evolve Object Types are displayed in Object Explorer by using the **Show/Hide Object Types** button in Evolve Designer
2. In Object Explorer, view the CW Diagram Designer objects in your model
3. Edit the properties of each object and set the **Freeze Level** to ‘Unfrozen’
4. In Diagram Designer, open each layout and click the **Run** tab.

**Step 4 - Update the Site settings**

To update the Site settings:

1. Open the Site in Evolve Designer
2. Select the top-level **Site** node
3. Check the following settings and edit where necessary:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server Language</strong></td>
<td>Choose the language of the Site if you want to override the global Evolve setting.</td>
</tr>
<tr>
<td><strong>Server Theme</strong></td>
<td>Choose the theme of the Site if you want to override the global Evolve setting.</td>
</tr>
</tbody>
</table>

Note: These are the basic settings required to publish your Site. For the full configuration reference, see: [Configuration Reference](#).

4. Select the Deployments > [server name] > Model node (showing the Scriptname of the Model your Site is in)

5. Complete the following fields:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Site URL Name</strong></td>
<td>Specify the name of this Model Site as it appears in the URL, such as http://&lt;server-name&gt;/&lt;evolve-IIS-site-name&gt;/&lt;sites</td>
</tr>
<tr>
<td><strong>Site Display Name</strong></td>
<td>Enter the name of your site. This is only displayed on the top-level Evolve Sites page.</td>
</tr>
<tr>
<td><strong>Deploy Custom Site</strong></td>
<td>If you publish using custom content, select the custom site reference here.</td>
</tr>
<tr>
<td><strong>Deploy Custom Site</strong></td>
<td>If you publish using custom content, select the custom site reference here.</td>
</tr>
<tr>
<td><strong>AD Group for Social Users</strong></td>
<td>Only used if the Evolve Authentication Method is set to Active Directory. Specify the name of the Active Directory group you want to use for Evolve Social users.</td>
</tr>
<tr>
<td><strong>AD Group for Contributor Users</strong></td>
<td>Only used if the Evolve Authentication Method is set to Active Directory. Specify the name of the Active Directory group you want to use for Evolve Contributor users.</td>
</tr>
<tr>
<td><strong>AD Default Social Role Name</strong></td>
<td>Only used if the Evolve Authentication Method is set to Active Directory. Specify the default Role you want newly-created Evolve Social users to be given.</td>
</tr>
<tr>
<td><strong>AD Default Contributor Role Name</strong></td>
<td>Only used if the Evolve Authentication Method is set to Active Directory. Specify the default Role you want newly-created Evolve Contributor users to be given.</td>
</tr>
<tr>
<td><strong>Display Model in Evolve</strong></td>
<td>Applies to Dynamic Sites only. Use this option to specify if this Model Site is available or disabled in Evolve.</td>
</tr>
</tbody>
</table>
Note: These are the basic settings required to publish your Site. For the full configuration reference, see: Configuration Reference.

6. Save the Site.
The settings are updated.

**Step 5 - Publish your Site**

Now the Site and IIS are configured, you must publish your site so that all the required files are generated and placed in the correct location on the web server.

**To publish your Site:**

In Evolve Designer, click Dynamic Site or Static Site in the Publish area on the Home menu.

**Accessing a Dynamic Site**

Dynamic Sites are published at the following URL:

http://<server-name>/<evolve-IIS-site-name>/sites/<site-url-name>/

**Accessing a Static Site**

Static Sites are published at the following URL:

http://<server-name>/<evolve-IIS-site-name>/statics/<site-url-name>/

**Evolve Suite Addendum**

**Map Imported Associations to Existing Source and Target Objects**

When importing data into an existing model using the XML file import format, the user can now choose to map associations by the source and target object for an existing user-defined association, as opposed to by the Unique Identifier.

NB: Traditional associations such as Reason for involvement, Data Model Usage, and Entity Synonym are not affected.

This means that when a user imports an association from another model, if an association of the same type exists between the same source and target objects (having the same source and target, Unique Identifiers) in the target model, the importer will consider it to be the same association, even if the Association's Unique Identifier is different. Without this option, duplicates are created if for example, the same association between the same two objects is created separately in two models, and then the data is merged. This is because they were created separately, so will have different Unique Identifiers and when one is imported into the other, they will be treated as separate Associations and thus be duplicated.

This option, when it has identified an Association that matches by Source, Target and Association Type, irrespective of Association Identifier, will then proceed to update the Target Association, rather than duplicate it.

For the user to be able to do this, there is a new check box in the import options called "Map associations to existing source and target object" (it only applies to the import wizard for XML), as shown on the image below.
Note: Choosing this option does not change the original XML in any way.

For example, a user creates a new model, say "Master." Within that model, the user creates their own Association Type between Application and Process. They create one instance of Process and one instance of the Application and then Associate the two items using the this new Association Type.

The model is exported to another model, say "Working," and some work is done on it. In this "Working" model, they remove the user-defined Association between the original Process and Application. Do some further work, including making changes to the actual Process and Application, and then decide they need the Association between the original Process and Application back, so recreate it. As it has been recreated, it will now have a different unique identifier. This working model now needs importing into the "Master" model. If the "Working" model is imported using any standard options, the user will now have two Associations between the original Process and Application.
Ticking the check box will stop this and map any changes made to the Association in the "Working" model to the Association in the "Master" model.

**Evolve Suite Addendum**

**Map Imported Associations to Existing Source and Target Objects**

When importing data into an existing model using the XML file import format, the user can now [2020.1.1] choose to map associations by the source and target object for an existing user-defined association, as opposed to by the Unique Identifier.

NB: Traditional associations such as Reason for involvement, Data Model Usage, and Entity Synonym are not affected.

This means that when a user imports an association from another model, if an association of the same type exists between the same source and target objects (having the same source and target, Unique Identifiers) in the target model, the importer will consider it to be the same association, even if the Association's Unique Identifier is different. Without this option, duplicates are created if for example, the same association between the same two objects is created separately in two models, and then the data is merged. This is because they were created separately, so will have different Unique Identifiers and when one is imported into the other, they will be treated as separate Associations and thus be duplicated.

This option, when it has identified an Association that matches by Source, Target and Association Type, irrespective of Association Identifier, will then proceed to update the Target Association, rather than duplicate it.

For the user to be able to do this, there is a new check box in the import options called "Map associations to existing source and target object" (it only applies to the import wizard for XML), as shown on the image below.
Note: Choosing this option does not change the original XML in any way.

For example, a user creates a new model, say "Master." Within that model, the user creates their own Association Type between Application and Process. They create one instance of Process and one instance of the Application and then Associate the two items using the this new Association Type.

The model is exported to another model, say "Working", and some work is done on it. In this "Working" model, they remove the user-defined Association between the original Process and Application. Do some further work, including making changes to the actual Process and Application, and then decide they need the Association between the original Process and Application back, so recreate it. As it has been recreated, it will now have a different unique identifier. This working model now needs importing into the "Master" model. If the "Working" model is imported using any standard options, the user will now have two Associations between the original Process and Application.
Ticking the check box will stop this and map any changes made to the Association in the "Working" model to the Association in the "Master" model.

**Communicator for Word Filtering**

Communicator for Word is an application that allows users to export the data from the Evolve Suite to a Word document. As part of this process, the data is initially exported in XML format using the application CMXMLApp. Depending on the model's size, this export can potentially produce a huge XML file, which may take a long time to load or may even exceed memory limits.

To reduce the XML files' size, the user can select the specific objects and the properties to export. In addition, the ability to filter objects based on a property value is also available. These filter options are saved with the filter configuration [2020.1.1 onwards].

**How to apply filter**

- Start the application CMXMLApp from the erwin bin folder, usually "C:\Program Files (x86)\erwin\CM10\bin".
- Run through the wizard until you get to the "Filter by Properties" page.

![Filter by Properties](image)

- Click on "Show Filter" in the top right, then the filter options will appear on the right side as shown in the picture below.
The type of filter shown and the data entered will depend on the property. In the example above, it is a category property with known values and the user can choose one or more. The application will then only output results where the category matches this selection. If the user chooses to save this file by clicking the “Save As” button, opening the file again will show the user’s original selection.

**About Us**

Quest creates software solutions that make the benefits of new technology real in an increasingly complex IT landscape. From database and systems management to Active Directory and Office 365 management, and cyber security resilience, Quest helps customers solve their next IT challenge now. Around the globe, more than 130,000 companies and 95% of the Fortune 500 count on Quest to deliver proactive management and monitoring for the next enterprise initiative, find the next solution for complex Microsoft challenges and stay ahead of the next threat. Quest Software. Where next meets now. For more information, visit [www.quest.com](http://www.quest.com).

**Technical support resources:**

Technical support is available to Quest customers with a valid maintenance contract and customers who have trial versions. You can access the Quest Support Portal at [support.quest.com](http://support.quest.com).

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a day, 365 days a year. The Support Portal enables you to:

- Submit and manage a Service Request
- View Knowledge Base articles
- Sign up for product notifications
- Download software and technical documentation
• View how-to-videos
• Engage in community discussions
• Chat with support engineers online
• View services to assist you with your product.